Per sonal Embroidery Design Software System

PE#DESIGN J()

| nstruction M anual

Before using this software, first read the Reference Guide for details on installing or upgrading the software.
In addition, be sure to read this Instruction Manual before using the software.
We recommend that you keep this document nearby for future reference.



Congratulations on choosing our product!

Thank you very much for purchasing our product. To obtain the best performance from this device
and to ensure safe and correct operation, please read this Instruction Manual carefully, and then
keep it in a safe place together with your warranty.

Please read before using this product

For designing beautiful embroidery designs

e This system allows you to create a wide variety of embroidery designs and supports a wider
range of sewing attribute settings (thread density, sewing pitch, etc.). However, the final result
will depend on your particular sewing machine model. We recommend that you make a trial
sewing sample with your sewing data before sewing on the final material.

For safe operation
« Do not save any files on the "PE-DESIGN Software Key" for transferring or storage.
e Do not plug the "PE-DESIGN Software Key" into your sewing machine.

For alonger service life

* When storing the "PE-DESIGN Software Key", avoid direct sunlight and high humidity
locations. Do not store the "PE-DESIGN Software Key" close to a heater, iron or other hot
objects.

» Do not spill water or other liquids on the "PE-DESIGN Software Key".

e Do not drop or hit the "PE-DESIGN Software Key".

For repairs or adjustments

« Inthe event that a malfunction occurs or adjustment is required, please consult your nearest
service center.

Notice
* Since this "PE-DESIGN Software Key" device is required to run the software, its replacement
value is the retail price of the software. Please keep in a safe place when not in use.
* Neither this Instruction Manual nor the Reference Guide explains how to use your computer
under Windows®. Please refer to the Windows® manuals.

Copyright acknowledgment

Windows® is a registered trademark of Microsoft Corporation. Other product names mentioned in
the Instruction Manual and Reference Guide may be trademarks of registered trademarks of their
respective companies and are hereby acknowledged.

Caution
The software included with this product is protected by copyright laws. This software can be used
or copied only in accordance with the copyright laws.

SAVE THESE INSTRUCTIONS
This product is intended for household use.

For additional product information and updates, visit our website at:
http://www.brother.com/ or http://support.brother.com/
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How To Use Manuals

The following manuals are included with this software.

Reference Guide

Read this guide before using the software. This guide contains instructions and precautions necessary to
begin using the software. The second half is filled with tutorials that use key features to create embroidery
patterns as well as project examples.

Instruction Manual

This manual contains instruction on how to use the PE-DESIGN software.

First, read "PE-DESIGN Software Key", "Starting Up/Exiting Application”, "Comparison of Types of Data
Created With PE-DESIGN 10", "Example of Importing Embroidery Data" and "Understanding Windows" to
gain a general understanding of the basic software applications.

Next, read "Basic Layout & Editing Operations". This chapter provides procedures for creating embroidery
patterns as examples for performing basic Layout & Editing operations and transferring patterns to the
embroidery machine. Follow the procedures to create actual embroidery patterns.

The chapters dedicated to each application provide descriptions of the useful functions and the various
settings. Each descriptive title allows you to easily find the information that you need. In the chapters
containing tutorials, follow the procedures to practice the various operations. Afterward, read the detailed
descriptions.

Additional information is provided in the following chapters. Read the appropriate chapter when necessary.

Support/Service: Provides warranty information for this product in addition to the procedure for updating the
software.

Supplement: Provides function introductions, details on the settings available in the [Options] dialog box and
troubleshooting procedures in addition to tips and precautions to maximize the use of this software.

Menus/Tools and Reference: Provides lists of sew types, sewing attributes and fonts in addition to the various
commands.

The procedures in this manual are written for use in windows® 8.1. If this software is used on an operating
system other than Windows® 8.1, the procedures and appearance of the windows may differ slightly.

B Opening the Instruction Manual (PDF format)

This manual is provided in a PDF format on the included "PE-DESIGN Software Key". The Instruction Manual
is also installed during software installation.

Click the down arrow in the bottom-left corner of the [Start] screen to show the [All Apps] view, and then Click

[Instruction Manual] under the title [PE-DESIGN 10] in the screen. (For Windows® 7 or Windows Vista®
users: Click [All Programs], then [PE-DESIGN 10], then [Instruction Manual].)

Otherwise, with any application other than Design Database, click & ° , then [Instruction Manual].

With Design Database, click [Help], then [Instruction Manual].

M

« Adobe® Reader® is required for viewing and printing the PDF version of the Instruction Manual.

« If Adobe® Reader® is not on your computer, it must be installed. It can be downloaded from the Adobe
Systems Incorporated Web site (http://www.adobe.com/).




Support/Service

Technical Support

Contact Technical Support if you have a problem. Please check the company web site
(http://www.brother.com/) to find the Technical Support in your area. To view the FAQ and information for
software updates, visit the Brother Solutions Center at (http://support.brother.com/).

a

« Have the information ready before contacting Technical Support.
+ Make sure your computer's operating system is current with all updates.
+ Have the make and model of your computer and Windows® Operating System. (Refer to the Reference
Guide for system requirements.)
+ Information on error messages that appear. This information will help expedite your questions more
quickly.
¢ Make sure PE-DESIGN 10 is current with any updates.

Online Registration

If you wish to be contacted about upgrades and provided with important information such as future product
developments and improvements, you can register your product online by following a simple registration
procedure.

Click & * inLayout & Editing, then [Online Registration] to start up the installed Web browser and open the

online registration page on our Web site.
The online registration page on the Web site appears when the following address is entered in the address bar
of the Web browser.

http://www.brother.com/registration/

M

Online registration may not be available in some areas.




Support/Service

Checking for the Latest Version of the
Program

Click & * in Layout & Editing, then [Check for Updates].

The software is checked to determine whether or not it is the latest version.
If the message shown below appears, the latest version of the software is being used.

Check for Most Recent Version

(i The st recent update for PE-DESIGHN iz already installed.

oy

[~ Always check for most recent version at startup

If the message shown below appears, the latest version of the software is not being used. Click [Yes], and
then download the latest version of the software from the Web site.

Check for Most Recent Version

The most recent version of thiz program iz

(i available on the ‘web.
\:

Do you want to download it and update wour
program?

[~ Always check for most recent version at startup

Mo Check Details...

If the [Always check for most recent version at startup] check box is selected, the software is checked
at startup to determine whether or not it is the latest version.




PE-DESIGN Software Key

In order to use PE-DESIGN 10, the included "PE-DESIGN Software Key" must be plugged into a USB port of
the computer.

The "PE-DESIGN Software Key" prevents unauthorized use of this software. The software cannot be started
if the "PE-DESIGN Software Key" is not plugged in.

a

« The "PE-DESIGN Software Key" cannot be used as USB media. Do not save embroidery files on the "PE-
DESIGN Software Key" for transferring or storage.

« When the "PE-DESIGN Software Key" is plugged into a USB port of the computer, the [AutoPlay] dialog

box appears. Do not use this dialog box. Click @ to close the dialog box, and then start up PE-DESIGN
10.

Removable Disk (E:)

Chaose what to do with remavable drives.

{9 Configure this drive for backup
File History

r‘ Open folder to view files

-

File Explorer

@ Take no action

« When the message "Do you want to scan and fix Removable Disk (E:)?" appears, select [Continue
without scanning] and then start up PE-DESIGN 10. The drive name for the Removable Disk differs
depending on computers.
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« To unplug the "PE-DESIGN Software Key" from the computer, click [Start] - [Computer], right-click the
"PE-DESIGN Software Key", and then click [Eject].

» Do not format the "PE-DESIGN Software Key".
* We recommend that you back up this software in order to prepare for unexpected problems.




Comparison of Types of Data Created

With PE-DESIGN 10

Three types of data are used in PE-DESIGN 10.

Stitch pattern: Built-in embroidery data (created through a conversion in PE-DESIGN 10)

Text pattern: Data created with the [Text] tools

Shape pattern (Outline pattern): Data created with the [Shapes] tools. A uniform/multiple sewing

direction(s) are applied to the entire region.

Each data can be converted to another type as shown below. The arrows indicate the directions in which data
can be converted. The methods of editing the data differ depending on the data type.

Change the shape by
editing needle drop points.

Stitch pattern

Change the shape \-
by editing paths. /

——

Text pattern Shape pattern

v

E

Edit the text or
change the font.

Stitch pattern

You can edit (reshaping by moving/deleting points
or splitting/connecting lines at points) points (needle
drop points) and split stitches; however, you cannot
specify region and line sew types or sewing
attributes.

Text pattern

You can edit text by entering/deleting characters,
specify text attributes (such as the font or the
transformation shape) and specify sewing
attributes.

Shape pattern

You can specify region and line sew types as well as
sewing attributes, edit paths (by moving/deleting
points, reshaping through handle movements or by
splitting/connecting lines at points), change the
sewing direction, input/edit stamps, apply
embossing/engraving effects, remove/merge
overlapping regions, set hole sewing, split outlines
and create offset lines and floral patterns.

For example, when a stitch pattern is converted to

shapes, the sew types and sewing attributes can be
changed, and the shapes can easily be edited and
resized. When text pattern is converted to shapes,
the sewing direction and character shapes can be

edited and offset lines can be created.

-
e o 1‘%‘-’-‘
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Functions that are not available with one data type
may be performed if the data is converted to a
different type. Convert data to the type that allows
you to perform the operations necessary for creating
the desired embroidery data.




Starting Up/Exiting Applications

Starting Up the Application

Click the down arrow in the bottom-left corner of the [Start] screen to show the [All Apps] view, and then Click
[PE-DESIGN 10 (Layout & Editing)] under the title [PE-DESIGN 10] in the screen.

When the application starts up, the Startup Wizard appears.
»» "About the Startup Wizard" on page 10

For Windows® 7 or Windows Vista® users: Click ﬁ then [All Programs], then [PE-DESIGN 10], and then
click [PE-DESIGN 10 (Layout & Editing)].

Exiting the Application

Click (&), then [Exit].

1% - Lol i




About the Startup Wizard

When [Layout & Editing] starts up, the following e Open Embroidery Design
wizard appears. Click this button to open embroidery data
(-pes).
e o © © ® , o
— | — | —— | »» "Opening a Layout & Editing file" on
T . page 90
-]
Cemmte Fsh e [FTETN ey L | e
" 9 Start Design Database to Manage

Embroidery Files
Click this button to start up Design
srbd Lo Database.

1 g s o -

Y, T

»» "Design Database" on page 240

By e | Bl o T B

A - ™ i e = —
(10 JA=]
= 'i B —l Click this button to open the Instruction
O 600 ® ® O 0 Manual (in PDF format).

0 Always show Wizard at Startup
Select this check box to start up the
wizard each time Layout & Editing is

o Use Template Designs
Click this button to start the [Template
Wizard].

started up.
»» "Tutorial 2: Using Templates" on
page 101 @ Close this Wizard
Click this button to close the Startup
e Create Embroidery Patterns Using Wizard without performing an operation.
Images
Click this button to start the wizard for
creating an embroidery pattern from an [I]
image. To open the wizard while you are using the
»» "Stitch Wizard: Automatically Converting [Layout & Editing], click |[==] at the top of the
an Image to an Embroidery Design” on window (in the [Quick Access Toolbar]), or click
gggg 1:5% and "Importing Image Data" on &y and then select [Wizard] from the command

menu.

9 Set Hoop Size and Fabric
Click this button to specify the size of the
Design Page (embroidery hoop size).
The fabric to be embroidered can be
selected, and the sewing attributes
appropriate for that fabric can be
specified.

»» "Specifying the Design Page Settings" on
page 14 and "Recalling a group of
settings from the list" on page 192

O A . @ % 0 %
Click these buttons to import the pattern
shown on the button from the [Import]
pane.

0 Most Recently Used Files
Select a thumbnail of the most recently
used file from the list, and then click
[Open] to recall the file.

10




Understanding Windows

Layout & Editing Window
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Application button

Click to display a menu containing commands
for file operations, such as [New], [Save],
[Print] and [Design Settings].

Ribbon

Click a tab at the top to display the
corresponding commands.

Refer to the name below each group when
selecting the desired command. Clicking a

command with the ~ mark displays a menu

containing a choice of commands.

Some other tabs may appear depending on the
tool or embroidery pattern that is selected.
These tabs contain various commands for
performing operations with the selected tool or
embroidery pattern.

13- |— L15

Example: When the Shapes (Rectangle) tool is
selected

h-" EEHYSE
h- L] n

Quick Access Toolbar

This contains the most frequently used
commands. Since this toolbar is always
displayed, regardless of the Ribbon tab that is
selected, adding your most often used
commands makes them easily accessible.

»» "Customizing Quick Access Toolbar" on
page 300

Option button
Click this button to start up other applications

and specify application settings, such as user
thread charts.




10
11

12

13

14

15

Help button
Click this button to display the Instruction

Manual and view information about the software.

Sewing Order pane

This pane shows the sewing order. Click the
buttons at the top of the pane to change the
sewing order or thread color.

Import/Color/Sewing Attributes/Text
Attributes panes

This pane combines tabs for importing
embroidery patterns as well as for specifying
thread colors, sewing attributes and text
attributes. Click a tab to display the available
parameters.

Stitch Simulator pane
The Stitch Simulator shows how the pattern will

be sewn by the machine and how the stitching
will appear.

Design Page

The actual part of the work area that can be
saved and sewn.

Work area

Status Bar

This displays the size of the embroidery data,
the number of stitches or a description of the
selected command.

View mode buttons
Click a button to change the View mode.

Show grid button

Click to switch between displaying and hiding
the grid.

Design Property button

Click to display a dialog box containing sewing
information for the embroidery data.

Zoom slider
This displays the current magnification ratio.

Click to specify a value for the magnification
ratio.

Drag the slider to change the magnification ratio.

M

« Panes 6, 7 and 8 can be displayed or hidden
from the [Show/Hide] group in the [View] tab. In
addition, these panes can be displayed as
separate dialog boxes (Floating) or attached to
the main window (Docking).

 Position the pointer over a command to display
a ScreenTip, which provides a description of the
command and indicates its shortcut key.

X e o A
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Example of Importing Embroidery Data

Using the Import pane

Embroidery data can be imported by using the
[Import] pane.
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Select a pattern location.

e Category
Select a pattern category.
The categories in the pattern location

selected in the [From] selector are listed.

9 The patterns in the category selected in
the [Category] selector appear in the list.
Pointing to a pattern and holding down the
left mouse button displays a dotted box in
the Design Page. This allows you to
check the size of the pattern.

® import

Click this button to import the selected
pattern.

M

« The pattern can also be imported by double-
clicking it in the list or by dragging it to the
Design Page.

» Multiple files cannot be selected to be imported
at the same time.

»» "From a folder" on page 91 and "From an
original card" on page 92

Using Import commands
1  Click the [Home] tab.

2 Click [Import Patterns] in the [Import] group,
and then click [from Design Library], [from
File], [from Card] or [Decorative Pattern]
from the [Import] menu.

Ui e - Lapoed & Foliting

A i “_

i+

— The [Import] pane appears on the right
side of the screen.

M

The [Import] pane can also be displayed by
selecting the [Import Pane] check box in the
[View] tab.
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When the [Color] pane, [Sewing Attributes]
pane or [Text Attributes] pane is displayed, click
the [Import] tab to display the [Import] pane.
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Basic Software Settings

Specifying the Design Page Settings
The color and size of the Design Page can be changed. You can select a Design Page size according to the

size of hoop that you will be using with your embroidery machine. You can also specify a custom size for the
Design Page for embroidery patterns that will be split and embroidered in multiple sections.

1 Click @ then [Design Settings].

i need i

2 Specify the settings for the Design Page, and
then click [OK].

©00 (5]

11| s | e B

7] © O

o Machine Type
Select your machine type. The settings
available in the [Page Size] selector differ

depending on the selected machine type.

e Hoop Size
Select the desired hoop size from the
selector.

9 Rotate 90 Degrees
Select this check box to arrange the
pattern in a Design Page rotated 90°.

e Custom Size
Specify a custom size for split embroidery
patterns.
Select this option, and then type or select
the desired width and height for the
Design Page.

»» "Tutorial 9-1: Creating Split Embroidery
Designs" on page 177

6 Page
Select the desired color for the Design
Page.
@ Background
Select the desired color for the work area.
0 Default

To return to the default settings, click this
button.

e Edit User Hoop
Click this button to display the [User
Hoop Settings] dialog box, where a user
hoop size can be added. The added user
hoop size appears at the bottom of the list.

»»  "Specifying a user hoop size" on page 15

14



a

« The Design Page sizes 130 x 300 mm, 100 x
172 mm indicated by the "*", are used to
embroider multi-position designs using a special
embroidery hoop attached to the embroidery
machine at three installation positions.
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»» “Tutorial 9-2: Creating Design for Multi-
Position Hoops" on page 183

» Do not select a hoop size larger than the
embroidery hoop that can be used with your
machine.

* When Cap Frame, Cylinder Frame or Round
Frame has been selected, the Design Page
cannot be rotated 90°.

15

Specifying a user hoop
size

User Hoop Settings

o T (140« 140 rarn MyHoop
180 & 140 mm MyHoop2 up L
10 % 10 ram MyHaoopd %]_ e
Down ‘
Delete Hoo ‘ e
|
o ] width:  |100 J mm Add Hoap
Height: 100 JZI M
e Comment:

—
|

Cancel |

© width, Height
Type in the size of the hoop to be added.

e Comment
If text was entered in this box, that text
appears beside the size.

9 Add Hoop
Click this button to add the hoop size.

e User Hoop List
The added hoop size appears in the list.
Select a hoop size in this list to change the
display order or to delete it.

6 Up, Down
Click these buttons to move the selected
hoop size up or down in the display order.

@ Delete Hoop
Click this button to delete the selected
hoop size.

a

¢ A User Hoop cannot rotate 90°.

« A User Hoop cannot be added to the Section
Size (for Hoop Size) selector under Custom
Size.

« Do not create a Custom Hoop larger than the
embroidery hoop that can be used with your
machine.

< Embroidery data created in a user hoop size

cannot be saved in a format for a previous
version.




Specifying the sewing area

The pattern drawn in the Design Page is sewn
differently depending on the sewing area setting.

1 Click [Output] tab.

2  Select the desired sewing area ([Design
Page area] or [Use existing design area)).
Design Settings

Design Page  Output I

Sewing Area
" Design Page area

¥ |se sdsting design area

Optimize hoop change

-

Jump Stitch Trimming

10 J:I mm

Minimum jump stitch length for thread timming:

Design Page area

The patterns will be sewn so that the needle
position when you start sewing is aligned with
the center of your Design Page. The
dimension of the pattern matches the size of
the Design Page, therefore reducing the ability
to move a pattern around the layout screen of
your embroidering machine.

A

Sewing area =
Design Page area

Design Page (on
your screen)

Use existing design area

The patterns will be sewn so that the needle
position when you start sewing is aligned with
the center of the actual patterns. The actual
pattern size is maintained, therefore allowing
greater mobility when using the layout
functions of your embroidering machine.

A

Design Page (on
your screen)

Sewing area = Use
existing design area

Optimize hoop change

This setting can be selected if a multi-position hoop
(100 x 172 mm or 130 x 300 mm) has been selected
as the Design Page size.

Design Settings
Design Page  Output I

Sewing Area
(@

=

Optimize hoop change

I Optimize the number of times to change the hoop's position ;

Select the check box to optimize the sewing order/
order of hoop position changes so that the number
of times that the hoop position is changed is
reduced to the minimum.

This reduces the risk of misalignment in the
embroidery pattern or uneven stitching from
changing the hoop position too often.

Jump Stitch Trimming

These settings are applied only when embroidering
with our multi-needle embroidery machines. Before

these settings can be specified, select @ % under

[Machine Type] in the [Design Settings] dialog
box.

Design Settings

Design Page  Output

Sewing Area
" Design Page area

¥ Use ewisting design area

Optimize hoop change
r

Jump Stitch Trimming

Minimum jump stitch length for thread timming: 1.0 j mm

Specify the minimum jump stitch length for thread
trimming.

a

These settings are not applied with any other
embroidery machine. For details, refer to the
Operation Manual provided with your machine.

»»  "Jump Stitch Trimming" on page 87,
"Specifying trimming settings in Layout &
Editing" on page 297 and "Adding jump
stitch trimming to new patterns” on
page 302
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Using Fabric Selector

A group of sewing attribute settings appropriate for the major types of fabric can be recalled from the [Fabric
Selector] dialog box. Select the fabric to be embroidered to view a description of the fabric and advice on
embroidering.

1 Click @ then [Fabric Selector]. &

i - T  The sewing attributes of imported shapes and
i text are not changed.
fuis « Perform atrial sewing before embroidering your
project.

=] »»> "For Basic Operations" on page 295

H
M

M

L s Original settings can be saved to be later used in

the [Fabric Selector]. Click @452—" inthe [Sewing

Attributes] tab, click [Save As], and then click
[OK] without changing the name for the settings.
The group of settings that you have saved will
Fabric Selector appear with “*” beside its name.

2  Select the group of settings to be recalled.

Cotton fabric

e B » "Saving the settings in a list" on page 192
Default

Q —=

Enit fabric

Linen

Sheer fabric

Symbelc esher v

Stting for derim fabics
Jeans are made with this fabric:

Fiecommended stabiizers
Front; None
Rear: Tear-away stabiizer/Fusible Cut-away Stabiizer

Caes

o Select the type of fabric to be
embroidered to specify the recommended
settings for that fabric.

When a fabric type is selected, a
description appears.

3  Click [OK].

When shapes and text are entered, the
sewing attributes will be set to those
recommended for the selected fabric.

»»  "Specifying sewing attributes" on page 54
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Specifying Basic Display Settings

Changing the grid settings

A grid of dotted lines or solid lines can be displayed
or hidden, and the spacing for the grid can be
adjusted.

1  Click [View] tab.
2  Specify the grid settings.

@ —[| show Grid  Interval:|25  *

1] it e L—eo

Q—ID Snap to Grid

Grid

o Show Grid
Select this check box to display the grid.

e with Axes
Select this check box to display the grid as
solid lines.

9 Interval

Specify the grid spacing.

e Snap to Grid
Select this check box to align patterns
with the grid. The snap feature works
whether or not the grid is displayed.

M

The |[::]| button can also be used to switch the
grid between being displayed or hidden.

—_—— e el

o1 L-EI 1 S i iri

Changing theruler settings
The ruler can be displayed or hidden.
1  Click the [View] tab.

2 To display the ruler, select the [Ruler] check
box in the [Ruler] group.

To hide the ruler, clear the [Ruler] check box.

7] Guideline |

Ruler

M

Click mm to switch the measurement units
between millimeters and inches.

E-" EEYE
D00 o EEEs

ok
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Changing the guideline
settings

Guidelines can also be used when the ruler is
displayed.

1  Click the [View] tab.

2 Selectthe [Ruler] check box, and then select
the [Guideline] check box in the [Ruler]
group.

[¥] Ruler

[¥] Guideline

I Ruler

3 Click aruler in the Design Page.

- G appears, and a guideline is drawn.
4+—>r
—(O) =
N

10 v) VA

@

o)

@ Guideline
« To move a guideline, drag G
+ To delete a guideline, click L:]

M

M

When a pattern is saved, the guidelines are saved
with it. However, the guidelines are deleted if the
pattern is saved in a format for a version earlier
than version 10.

« A guideline is added each time the ruler is
clicked. In addition, up to 100 guidelines each
can be added to the horizontal and vertical
rulers.

« While a guideline is being dragged, its position is
shown in the status bar.

* When the [Ruler] check box or the [Guideline]

check box is cleared, the guidelines are hidden.

« If both the [Show Grid] and [Snhap to Grid]
check boxes are selected, the guidelines will be
added/moved along the lines of the grid.

»» "Changing the grid settings" on page 18

Adjusting on-screen
measurements (Screen
Calibration)

Measurements can be adjusted so that objects will
be displayed at the same size as the actual
embroidery at a zoom ratio of 100%. Once this
adjustment is made, it will not need to be done again
later.

1 Click &‘:) then [Options].

(] T

I=l
2]

=

2 Click [Screen Calibration]. Hold a ruler
against the screen to measure the length of
&. Next, enter the value at e and then click
[OK].
[ 4]

==
o0

Be sure to enter the length in millimeters. A
value in inches is invalid.

19



Basic Software Settings

—

2  Click [System Unit], and then select the
desired measurement units ((mm] or [inch]).

I;-:_- ———
(-

==
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Basic Software Settings
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Basic Layout & Editing Operations

This section describes the basic operations
performed in Layout & Editing, such as drawing
shapes, editing the embroidery design, specifying
sewing attributes, saving the file and printing it.




Tutorial 1: Drawing shapes to create an embroidery design

Tutorial 1: Drawing shapes to create an
embroidery design

This section will describe how to combine various shapes to create an embroidery design.

We will use an Outline tool to draw the stem. Then, we will create the leaves, flower and flower pot by importing
shape patterns.

The sampile file for this tutorial is located at Documents (My documents)\PE-DESIGN 10\Tutorial\Tutorial_1.

Step 1 Drawing, importing and moving shapes
Step 2 Duplicating, flipping and moving shapes
Step 3 Specifying hole sewing

Step 4 Applying a pattern to stitching

Step 5 Editing points and modifying shapes

2 To import a shape, select [Outline Shapes]
from the [From] selector of the [Import] pane,
then [Basic Shapes] from the [Category]

Step 1 Drawing, importing and
moving shapes

Shapes can be created either by drawing them with selector. Select the shape, and then click
the Shapes tools or by importing sample shape [Import].
patterns. - . - _' ?
A i -
1 Todrawa shape, select a Shapes tool, and P
then drag the pointer in the Design Page to = = Cr (] it W S
draw the shape. | S [ T——
aw the shap 2
i\' 5 0 ] mied ik | . —
| .‘1 —T&.L| e T "T l e -v_-..'. Ly
I_E- 1 :Er._-_ _— :-rr _.I' I e
i el Ha g
N < i Specify the sew types for the shape on the
| R f [Shapes] tab, and the thread colors on the
| s > ¥ [Shapes] tab or the [Color] pane.
. ¥ .I 'S 1

@ Shapes tools

23




Tutorial 1: Drawing shapes to create an embroidery design

| T
|M~ | vwasarsan Zigzag Stitch =
(- B3EEREREE P stiten 7
| SE‘l\l
1
®

If

il (R -
I

I r

Line color button

Line sew type selector

Region color button

Region sew type selector

Selected thread color and color name
Thread color palette

@OeEOO

Draw the stem.
(A) Click the [Home] tab.
(B) Click [Shapes] in the [Tools] group, and

then click
il .
| i A B | i B
BT X [T T - ;
HHIIl'nll LA R HH L

=1 e

(C) Click the [Color] tab to display the color

palette.
tid - Lot & Tetbng - =l
e

R

Tl
o -‘#-"_-h i

(D) Click [LIME GREEN].
If the desired color is not displayed, move
the scroll bar until it appears.

L]
| B
RN N T -
[ I8 HEE
mEe R
CrEEEEE

ol |

M

To view the thread colors in a list so that the
desired color can more easily be found, click [To
list mode].

»p» "Setting the sew type" on page 49

(E) Click the [Line sew type] selector, and
then select [Zlgzag Stitch].

E“ ':'EH r‘. I P-n
i [, ey ool
h. i o W —— meaimr
s T e
Y |m-|.w\.-\. by = EUIL)
"
———— = R i |
:-l-:l:;-: % :F==:==" =
- W I
I-\. ; | BEE verow
IM’ ’
-l L i g
LLEAA |
|} Y e e

(F) Click the start point 1, and then double-
click the end point 2.

n % . . . 10 . . . . [ Colol

| i 5 [}

o)

1 Th

1

i ]
| 2 i
r

=

M

The color, sewing attributes and size can also be
changed after the shape is drawn.
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Tutorial 1: Drawing shapes to create an embroidery design

2 Create the leaf on the right.

This time, we will import a shape pattern. We
will also specify the color and sew type for the
region.

(A) Click the [Import] tab.
(B) Select[Outline Shapes] from the [From]

selector and [Basic Shapes] from the
[Category] selector.

(C) Select [BS_shapes27.pes], and then
click [Import].

- Lo B :-.
A frmaig 8 -

(D) Click the [Shapes] tab.
(E) Click /I~ for line sewing, and then click

| under [Colors Used] to select [LIME
GREEN].

(F) Click the [Line sew type] selector, and
then select [Zigzag Stitch].

g Lirita Bl - Lisyinrt o Edimg
ihape
r [ [ s |5
TR (i R Y ] #
e e LU L L

(G) As with the line color, click ]~ for region

sewing, and then click ' under [Colors
Used] to select [LIME GREEN].

e Lt - Lot B S0

B eeene Tgeeg D

[ - o e s

[Ty [ RoE ] Lo

M

The thread colors being used are listed under
[Colors Used].

(H) Drag the handle to adjust the leaf to the
desired size.

(I) Place the pointer over the leaf so that the

shape of the pointer changes to G%D and
then drag the leaf to the desired position.

Step 2 Duplicating, flipping and
moving shapes

Now, we will duplicate the leaf on the right side, flip
it horizontally, and then move it to the left side of the
stem.

1  To duplicate the leaf on the right.

(A) Select the leaf.

(B) While holding down the <Ctrl> key, drag
the leaf to move it.

(C) Release the mouse button.




Tutorial 1: Drawing shapes to create an embroidery design

2  To flip the duplicated leaf horizontally.

Bl ceami SHT

(A) Right-click on the duplicated leaf.
— A drop down menu will appear.
(B) Click [Flip], then [Horizontal].

3  Drag the duplicated leaf to the left side of the

stem.
[
]

To move an object horizontally, hold down the
<Shift> key while dragging the object.

4  Align the leaves on the left and right sides.

Sl - |
e
i = -
i = &
[
| i mmike o
2
=
-] Wy Al Ly
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| s |
—= o | e T
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]
L |
AR Llca |

(A) While holding down the <Ctrl> key, click
the leaf on the right side, then the leaf on
the left side to select the two leaves.
Then, right-click the selected leaves.

(B) Right-click the leaves, and then click
[Align], then [Top].

M

» Multiple embroidery patterns can be selected in
any of the following ways.
¢ Click the first pattern, and then, while holding

down the <Ctrl> key, click the next pattern.
+ Drag the pointer to draw a selection frame
around the patterns to be selected.

* Flipped copies can also be created by clicking
[Arrange Copy] in the [Clipboard] group of the
[Home] tab, then clicking [Vertical Mirror
Copy].

»» "Using the Mirror Copy tool" on page 35.

Step 3 Specifying hole sewing

Now, we will create the flower and a circle at the
center. Then, we will apply a setting so that the
overlapping areas are not sewn twice.

1 Create the flower petals.
(A) Click the [Import] tab.

(B) Select [BS_shapes26.pes], and then
click [Import].

— L mrmErEE i -

e
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(C) Click the [Shapes] tab.
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Tutorial 1: Drawing shapes to create an embroidery design

(D) Select [RED] in the color palette as the
line color and [Zigzag Stitch] as the sew
type @.

yil — Lo fas - Lavos i Faiveg
S -
o : T S
e BT H
—_ - - [
R 1 [, | -
C — o

R RSN N Ny —,

®. |
| S

(E) Select [Radial Stitch] as the sew type

(F) Drag the handle (9) to adjust the flower
petals to the desired size.

(G) Drag the flower petals to adjust their
position.

2 Create the circle at the center.

(A) Click the [Import] tab.

(B) Select [BS_shapesO0l.pes], and then
click [Import].

e Nl i -
— &
AR G ® .
| -]

| &

(C) Click the [Shapes] tab.

27

(D) Select [YELLOW] in the color palette as
the line color and [Zigzag Stitch] as the
sew type o

(E) Select [YELLOW] in the color palette as
the region color and [Concentric Circle
Stitch] as the sew type 9

(F) Drag the circle to the center of the flower
petals.

(G) While holding down the <Shift> key, drag
the handle (9) to adjust the circle to the
desired size.

a

If the <Shift> key is held down while a handle is
dragged, the pattern is enlarged or reduced from
the center of the pattern.

3  Selectthe patterns where hole sewing is to be
applied.

(A) While holding down the <Ctrl> key, click
the yellow circle o and the flower petals

il - anymnsic B B




Tutorial 1: Drawing shapes to create an embroidery design

4  specify hole sewing.
(A) Click the [Home] tab.

(B) Click [Modify Overlap] in the [Edit]
group, and then click [Set hole sewing].

prim Ul - Liyost s Gy

=T —=

| e la N2

Hole sewing cannot be applied if one of the
patterns is not completely enclosed within the
other pattern.

»» "Hole sewing" on page 39.

Step 4 Applying a pattern to
stitching
Detailed line and region attribute settings can be
specified from the [Sewing Attributes] pane. Now,

we will specify settings for region sewing for the
flowerpot.

1  Specify the color and sew type for the line and
region of the flowerpot.

(A) Click the [Import] tab.

(B) Select [BS_shapes13.pes], and then
click [Import].

oot i
IE.'n- B e i |, il T R
Fios Clatires g i,
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(C) Click the [Shapes] tab.

(D) Select [CLAY BROWN] in the color
palette as the line color and [Zigzag
Stitch] as the sew type

i Ui el - Lappsd & Eid

- ERBIEHAE e
1+ ods ] .

(E) Select [DEEP GOLD] in the color palette
as the region color and [Prog. Fill Stitch]
as the sew type
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Tutorial 1: Drawing shapes to create an embroidery design

2  Specify the sewing attributes.

(A) Click the [Sewing Attributes] tab.
If the [Sewing Attributes] pane is not
displayed, click the [View] tab, then

[Attributes], then [Sewing Attributes].

T A

(B) ——{_ Ikt wrks ||| Huiri | o

= | ——l— g F

B | AL i - S L]

The effects of the specified settings
can be previewed. This preview can
be displayed/hidden by clicking the

Show Hint/Hide Hint button.

Click this button to return the attribute
to its default setting.

(B) There are two display modes for the
[Sewing Attributes] pane. For this
example, we will specify settings in
Beginner mode.

(C) Inthe [Density] box, type "5.0".

(D) In the [Direction] section, drag the red
arrow to 90°. Otherwise, type "90".

(E) Click | in the [Programmable fill]
section.

29

(F) Select [net4], and then click [OK].

Browse

= CAProgram Files (+36)\Brother\PE-DESIGN 104Pattern’,

vl

netl net2 net3 et d)

i R XX @

patin patDZ patia patid
Carcel

(G) Type "7.6" to specify the pattern size.

1 AU

% Programmable Fill

Hide Hint | oF

@ The selected pattern is displayed.

M

« If the dialog box is displayed in Expert mode,
click [To Beginner mode] to display the dialog
box in Beginner mode.

» More detailed settings can be specified in Expert
mode.

»» "Specifying sewing attributes" on page 54
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Tutorial 1: Drawing shapes to create an embroidery design

Step 5 Editing points and
modifying shapes

Now, we will delete one corner from the pentagon to
create a flowerpot.
1  Drag the handle to adjust the flowerpot to the
desired size.
Drag the flowerpot to adjust its position.

2 Delete a point.
(A) Click the [Home] tab.
(B) Click [Select] in the [Select] group, and
then click ¥ .

o ;EI.:'.\,;‘__: S
(A) 'E—-"Jl TR £

o et T i i v
ko A R it
(B) _ U=t e i

— —L T
w 1"

(C) Click the shape for the flowerpot.

— The points in the shape appear.

(D) Right-click the top point to be deleted, and
then click [Delete].

,,,,,,,,, M, split at Point

I w
‘?c Delete >

— The point is deleted to form a trapezoid.

" 50 ) . ) [ ) ) 150

A

10

150

If you want save or export

»» For details on saving embroidery
patterns, refer to "Saving" on page 95.

For details on transferring designs to an

embroidery machine, refer to
"Transferring Embroidery Designs to
Machines" on page 201.
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Editing Embroidery Designs

Editing Embroidery Designs

Selecting patterns
1  Click the [Home] tab.

2  Click [ in the [Select] group.

e =
) e E e Thoiprt
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3  Click the pattern.

@ Rotation handle
® Handles

M

o If T is not displayed in the [Select] group,
click the arrow at the bottom of the button, and
then click | & .

 The status bar shows the dimensions (width and
height) of the pattern.

4 Toselect an additional pattern, hold down the
<Ctrl> key and click the other pattern.

M

* You can also select patterns by dragging the
pointer across the pattern.

» Pressthe <Tab> key to select the next pattern in
the order that they were created.

« If multiple patterns are selected, a pattern can
be deselected by holding down the <Ctrl> key
while clicking the pattern.

B Selecting all embroidery patterns
1  Click the [Home] tab.

2  Click [Select] in the [Select] group, and then
click [Select All].

NIRT=1 R WAL

e

K = | AN
:h F;. "ll : T |

 All patterns can also be selected by pressing the
shortcut keys <Ctrl> + <A>.

» Locked embroidery patterns cannot be selected.
»» "Locking embroidery patterns" on page 86

Moving patterns

B Moving manually
Drag the selected pattern(s) to the desired location.

M

» To move the pattern horizontally or vertically,
hold down the <Shift> key while dragging it.

» Pressing the arrow keys moves the selected
pattern.

 Holding down the <Ctrl> key and dragging the
pattern creates a duplicate of the pattern at the
destination.
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B Moving embroidery patterns to
the center

1  Select the pattern(s), and then click the
[Home] tab.

2 Click [Arrange] in the [Edit] group, and then
click [Layout], then [Move to Center].
Arrdps iy b [dbing

Lmr gl
- ~ I [T = m——
R =T

L]

M Aligning embroidery patterns

1  Selectthe patterns, and then click the [Home]
tab.

2  Click [Arrange] in the [Edit] group, click
[Layout], and then click the desired command
under [Horizontal] or [Vertical].

mbiind Ly Eey -

— The selected patterns are aligned as
shown below.

Editing Embroidery Designs

®

® Top
® Middle
® Bottom
@ Left
® Center
® Right

Scaling patterns

B Scaling manually

1  Select the pattern(s).

@ Handles

2 Drag the handle to adjust the selected

pattern(s) to the desired size.

We recommend not scaling patterns imported from
original cards.

32
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Editing Embroidery Designs

M

* If the <Shift> key is held down while a handle is
dragged, the patternis enlarged or reduced from
the center of the pattern.

« As you drag the handle, the current size is
displayed on the status bar.

* When scaling stitch patterns, the number of
stitches remains the same, resulting in a loss of
quality. To maintain the density and fill pattern of
the embroidery pattern, hold down the <Ctrl>
key while scaling. Even stitch patterns with a
non-uniform stitch density and needle drop point
pattern can be scaled while maintaining the
density and fill pattern.

»» "Enlarging/Reducing Stitch Patterns" on
page 295.

M Scaling numerically

1  Select the pattern(s), and then click the
[Home] tab.

2  Click [Arrange] in the [Edit] group, and then
click [Size].
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3 Specify the size, and then click [OK].

Size
Width Height
: | =] -
ORI |1nn =

r |?‘9.9 :Il " IED.D :Il -

9 —— v Maintain azpect ratio
© 1 Keep dengity and fill pattern

F'reviewl Cancel |

o Select the whether the width and height
will be set as a percentage (%) or a
dimension (millimeters or inches). Set the
width and height.

33

@ To change the width and height
proportionally, select the [Maintain
aspect ratio] check box.

9 To resize the selected pattern while
maintaining the original density and fill
pattern, select the [Keep density and fill
pattern] check box.

M

The [Keep density and fill pattern] check box is
available only if stitch pattern is selected.

»» “Enlarging/Reducing Stitch Patterns" on
page 295

Rotating patterns

M Rotating manually

1  Select the pattern(s).

2  Drag the rotation handle.

O

o The shape of pointer changes to {)
® Rotate

@ Rotation handle

M

To rotate the pattern in 15° increments, hold down
the <Shift> key while dragging the handle.




Editing Embroidery Designs

M Rotating numerically Flipping patterns

1  Select the pattern(s), and then click the

(Home] tab. horizontally or vertically
2 Click [Arrange] in the [Edit] group, and then 1 Select the pattern(s), and then click the
click [Rotate], then [Rotate]. [Home] tab.
Linhtispone - Lot & Ecting 2 Click [Arrange] in the [Edit] group, and then
= = click [Flip], then [Flip Vertically] or [Flip
R |-|_-_ ’ - _-:"-I'"'_-I'_"m b Horizontally].
Plemmicl| | gty | = it v - Lovst Bt
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Click [Rotate Right] or [Rotate Left] to rotate the — . s Dre L

pattern 90° clockwise or counterclockwise.

3  Type or select the rotation angle. Click [OK].

Rotate

@ IE' i| degree

Previewl Cancel |

M

An angle can also be selected by dragging @ in
the [Rotate] dialog box.
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a

Some patterns imported from original cards cannot
be flipped.
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Editing Embroidery Designs

Arrange Copies

a

It may not be possible to create mirror copies of
some embroidery data read from original cards.

M Using the Mirror Copy tool

Select the pattern(s), and then click the
[Home] tab.

-

2 Click [Arrange Copy] in the [Clipboard]
group, and then click [Vertical Mirror Copy],
[Horizontal Mirror Copy] or [Four-Way
Mirror Copy].
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Move the pointer, and then click when the
patterns are arranged as desired.

m 50 ) ) , ‘ 1o
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B Using the Circle Copy tool

F
Fo o wie &Fe
I3 JA JA
QFog’ ~y  «F»
b737 e T

Select the pattern(s), and then click the
[Home] tab.

Click [Arrange Copy] in the [Clipboard]
group, and then click [Circle Copy].
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3  Specify the pattern arrangement and spacing.

Circle Copy
V-Arrange :
»ig | [ a7
0 H-Arrange :
e
® — spadng :

o Select the desired arrangement.

e Specify the spacing between patterns.
The higher the value, the wider the
patterns are spaced from each other.

4  Drag the pointer to draw a circle or an oval.

Ela Frem

i
i e

M

» To draw a circle, hold down the <Shift> key
while dragging the pointer.

» To redraw the ellipse, right-click the Design
Page to return to before the ellipse was drawn.

Editing Embroidery Designs

5  Move the pointer to select the desired angle.

S e | —

Rotating the line changes the orientation of
the patterns.

M

* To rotate the line in 15° increments, hold down
the <Shift> key while moving the pointer.
The angle of the line appears in the status bar.

» While changing the orientation by moving the
pointer, the pattern arrangement and spacing
can still be changed in the [Circle Copy] dialog
box.

6  Click to finish the copies.

36

W
QD
(28
o
5
<
o
c
=
R0
m
o
=
=)
(o]
@]
©
)
-
2
o
>S5
[72)



Editing Embroidery Designs

B Using the Matrix Copy tool

¥
YOVVY
YVVVY
YVVVY
YoVVeY

1 Select the pattern(s), and then click the
[Home] tab.

2 Click [Arrange Copy] in the [Clipboard]
group, and then click [Matrix Copy].
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3 Specify the spacing between patterns. The
higher the value, the wider the patterns are
spaced from each other.

Matrix Copy

Spadng :

0.0 = mm

4  Click in the Design Page, and then move the

pointer.

A rectangle and the patterns that can be
arranged within it appear as dotted lines.

|0

M

» To redraw the rectangle, right-click the Design
Page to return to before the rectangle was
drawn.

» While resizing the rectangle by moving the
pointer, the pattern spacing can still be changed
in the [Matrix Copy] dialog box.

5 Click to finish the copies.
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Editing Embroidery Designs

M Optimizing the sewing order
Before using an [Arrange Copy] tool, optimizing the

Adding a decorative

sewing order adjusts the sewing order of the pattern
patterns created with the [Arrange Copy] tool in )
order to reduce the number of thread color changes. A decorative pattern can be added to selected

embroidery pattern.
[Optimize Sewing Order] [Optimize Sewing Order]

not selected selected 1 Select the pattern(s).
e Ry 2 Display the [Import] pane, and select
} b ¥, [Decorative Pattern] from the [From]
e . v . selector.
L 3 Selecta category from the [Category]
selector, select the desired decorative pattern
L o » - from the list, and then click [Decorative
& Import].
o i
- & & —— L
b o ooy iy ey ik A e s
[ 9 LS
o Fre [Decesshre Porms =
4 0
e et oy [T} B
The sewing order is the Patterns will be sewn so | ey
order in which patterns that those with the same |4 pcram [acmation
are created. thread colors will be v ‘ r
connected.

Bl o Dol B2 s 1 oL ot
1  Select the pattern(s), and then click the

[Home] tab. d pd B >

2 Click [Arrange Copy] in the [Clipboard] ]
. L. . [Cacdiipw: Deolfom  Decald pon
group, and then click [Optimize Sewing

Order] so that the check mark appears.
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L’ f o iy © Maintain aspect ratio
y [ - When the check box is selected
¥ o The original height-to-width proportion of
L | =] the added decorative pattern is
maintained.
3  Perform the Arrange Copy operation. —
P
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L 4
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Editing Embroidery Designs

When the check box is cleared

The height-to-width proportion of the
decorative pattern changes with the
height-to-width proportion of the selected
embroidery pattern.

=,
-l. q..
¥ %
# !
i

If no pattern is selected, the button will appear as
the [Import] button. Clicking this button will import
the decorative pattern at its standard size.

Grouping/Ungrouping
embroidery patterns

B Grouping patterns

1 Select several patterns, and then click the
[Home] tab.

2  Click [Group] in the [Edit] group, and then
click [Group].
Unifer - Lapoud B Friting
e |= e s || g

1
sy Tepyn | P Spre | 0

B2 kit i |
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B Ungrouping patterns

1  Select grouped patterns, and then click the
[Home] tab.

2  Click [Group] in the [Edit] group, and then
click [Ungroup].
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M Editing grouped patterns
individually

Even after patterns are grouped, they can be edited

individually.

1 Toselecta single pattern within a group, hold
down the <Alt> key while clicking the pattern.

2  Edit the pattern.

Hole sewing

By specifying hole sewing, the stitching in
overlapping regions will not be sewn twice. Hole
sewing can be set only when one region completely
encloses another.

Embroidery patterns created with the Shapes tools
can be selected to set hole sewing.

" >

Hole sewing set

®

Hole sewing not set

@ Sewn twice
® Sewn once




Editing Embroidery Designs

1  Select a pair of patterns, for example, a star W Canceling hole sewing

included in a pentagon.
P 9 1  Select a pattern that has been set for hole

While holding down the <Ctrl> key, click the sewing.
star, then the pentagon.
2  Click the [Home] tab.

3  Click [Modify Overlap] in the [Edit] group,
and then click [Cancel hole sewing].
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® Invalid .
Changing shapes of
! 3 overlapped patterns
Hole sewing cannot be specified with the following
shape patterns. Embroidery patterns created with the Shapes tools
« Patterns with an intersecting outline. can be selected to remove overlapping regions or to

« Patterns with multiple sewing direction lines. be merged.

B Removing overlapping

Overlapped patterns can be set so that the
overlapping region is removed.

2  Click the [Home] tab.

3  Click [Modify Overlap] in the [Edit] group,
and then click [Set hole sewing].
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T |m | [FT T TR — e p————— _ // o
il | R ————— B WAL
gl . Frm r [ty s | il Lo
n . L 1  While holding down the <Ctrl> key, click two
— '“_'I" pose | [ £ or more overlapped patterns to select them.
i bermes | _—
- — 2  Click the [Home] tab.

To see better what the hole sewing setting does,
preview the patterns before and after setting hole
sewing.

»» "Stitch View" on page 78
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Edit

3

ing Embroidery Designs

Click [Modify Overlap] in the [Edit] group,
and then click [Remove Overlap].

Lndthed - Ligcus B Ertaing

| [ B mtraress - | i s s T
— | | o
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* When partially overlapped

41

* When enclosed

First pattern in the sewing order
Second pattern in the sewing order

Third pattern in the sewing order

M Merging
Overlapped pattern can be merged together.
0

7)
7

.

.
7 4

o

— The color and sew type of the last pattern
drawn (topmost pattern) is applied to the
merged pattern.

1  While holding down the <Ctrl> key, click two
or more overlapped patterns to select them.

2  Click the [Home] tab.

3  Click [Modify Overlap] in the [Edit] group,
and then click [Merge].

e u-B:ﬂ:ln.p"
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— If this cannot be applied to the selected
patterns, an error message appears.

* When partially overlapped

. 4
.

.
|

After removing or merging an overlapping region
of patterns with sewing directions specified, the
sewing direction returns to the uniform default
direction.

»» "Specifying the sewing direction” on page 51




Editing Embroidery Designs

Splitting Shape pattern M

To remove the last point that was entered, right-

click the mouse button.
5 Double-click in the Design Page to specify the

section to be split off.

a

- ’ ' * Only closed patterns with no
intersecting lines can be split. The
pattern shown at the right cannot be

split.

1  Select a shape pattern, and then click the * The inside pattern with hole sewing applied

[Shapes] tab. cannot be split.
. « If the enclosing line that was drawn intersects
»»> For detail on the shape pattern, refer to itself, the section cannot be split off, and a
page 8 message appears.

2 Click [Split Outline] in the [Tools] group to « After splitting a pattern with fit text to outline

select the [Split Outline] tool. applied, fit text to outline will be canceled.
-2 revr 2 « If the entered patterns are not in the desired
i:. & e : - tpa sewing order, change it in the [Sewing Order]
B p——— pane.
"._ "’;._II . ' . - : » "Sewing order optimization" on page 83, and
tnn ’ =l "Changing colors" on page 85

yos | TR | D Oy L L
»» "Checking and Editing the Sewing Order" on
— If the design contains overlapping patterns, page 82

the selected pattern will appear in front of
the others. All patterns other than the

selected pattern will appear in gray. Creati n g a ﬂO raI pattern

Line stitching in a floral pattern can be created
based on the selected shape.

3 Clickinthe Design Page at the point where Q

you want to start drawing the enclosing lines.
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4  Continue clicking in the Design Page to 1 Drawashape, and then select t.

specify each corner of the enclosure around
the area to be cut off. 0\

Be sure to select a closed line.

»» "Changing the attributes of line ends" on
page 64

2  Click the [Shapes] tab.
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Editing Embroidery Designs

3  Click [Create Floral Pattern] in the [Edit] 2  Click the desired pattern, and then click [OK].
group. R R |
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M Detailed mode

M Basic mode More detailed settings can be specified in Detail
mode.
1  Dragthe [Density] slider to adjust the pattern.

Floral Pattern

1 Click[To detailed mode] in the [Floral
Pattern] dialog box.

| SRS | T | ees |

Density
E

[

i Ta detalled mode ok

2 Drag the [Density] slider and the [Pattern]
slider to adjust the pattern.

Density 3, Pattern 251 Density 10, Pattern 251

Density 6, Pattern 251 Density 6, Pattern 0
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3 After the pattern has been adjusted as
desired, click [OK].

150 O .
N
\

o
o)

M

The running stitch is specified for the floral line
pattern.

Creating an offset line
pattern

Line stitching in a concentric pattern can be created
based on the selected shape.

1 Draw a shape, and then select it.

a

Be sure to select one closed line.

»» "Changing the attributes of line ends" on
page 64

2  Click the [Shapes] tab.

3

Editing Embroidery Designs

Click [Create Offset Lines] in the [Edit]
group.

-J -

T
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Specify the desired settings for the offset line
pattern, and then click [OK].

Offset Line Settings

Offzet Directior:

Spacing: 5-03 mm

Offzet Line Count: I 1;|

[ Rounded Comers

(]4 I Preview | Cancel
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Check box cleared.
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Specifying Thread Colors and Sew Types for Lines and Regions

Specifying Thread Colors and Sew Types
for Lines and Regions

Setting the thread color

The [Sew] group in the [Shapes] tab allows you to
set the thread color of shapes

IJ-__I L.l'l'l"lﬂ'-l Lt & B

II.II"'I.I

®

@ Line color
® Region color

B Color W~

Click the [Color] button, and then select the desired
color from the list of thread colors.

i Wit - it & EATR

L} — S A

" L L LAY

o Thread brand name or name of user
thread chart and its thread color list:
Displays the brand name and its thread
color chart for the currently selected
pattern.

e Colors Used
Displays all thread colors being used in
the embroidery design.

9 Show Color Palette
Click to display the [Color] pane.

W Color pane
Palette mode
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Specifying Thread Colors and Sew Types for Lines and Regions

o Select the type of stitching ([Line] or
[Region]) to display the corresponding
colors being used.

Line

Line color
Region
Region color

e Select the check box to apply gradation/
blending. Click the [Pattern] button to
specify a gradation/blending pattern.
(Only available when a shape pattern is
selected)

»» "Creating a gradation/blending" on
page 47

9 From the [Thread Chart] selector, select
a thread brand or your user thread chart.

e From the list of thread colors, select the
desired color.

@ Click to switch the mode.

@ Displays all thread colors being used in
the embroidery design. When an
embroidery pattern is selected, a frame
appears around the colors used in that
pattern. The same thread colors can be
specified by selecting them here.

B Creating a gradation/blending

The density of one or two colors can be adjusted at
various locations to create a custom gradation
pattern.

-

1 Select an embroidery pattern with region
sewing specified.

- e —aw «

-

2

3

Click the [Color] tab, select the [Gradation]
check box, and then click [Pattern].
- = N

rird - Lopoie B koties

Tl By s e B E Wibers e ' :.
(1
E VR Y
1T BLIE

o — == =) -— -

Specify the desired settings in the [Gradation
Pattern Setting] dialog box, and then click
[OK].

2] 5] © 0
Gradauoll Patter Setting | |

Selectpaten W Berd | oensiy

THHL L | = [50 =] ine/mn
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TFOT o
| i | | Cace
© 0 9

o To change the thread color, click o .
Select a color in the [Thread Color]
dialog box that appeared, and then click
[OK].

e To select a preset gradation pattern, click
the desired pattern under [Select
pattern].

9 Move the sliders to adjust the density of
the gradation pattern.
The overall density of the gradation can
be adjusted with the [Max] and [Min]
sliders.
Drag the [Max] slider to adjust the
maximum value and the [Min] slider for
the minimum value. The values between
the maximum and minimum are
automatically adjusted.

e To blend two colors, select the [Blend]

check box, and then click | I |. Select a

color in the [Thread Color] dialog box
that appeared, and then click [OK].

@ The preview area shows the setting
changes that you make.

@ Specify the density.
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Specifying Thread Colors and Sew Types for Lines and Regions

0 Specify a direction, or drag the red arrow
to adjust it.

M

» Gradation/blending can be specified if satin
stitches, fill stitches or programmable fill stitches
have been selected for the region sewing and
[Manual] has been selected as the sewing
direction.

« If the [Blend] check box is cleared, the
gradation settings are applied to the remaining
color.

» Gradation/blending can also be specified under
[Density] when the [Sewing Attributes] pane
is displayed in Expert mode.
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M Special colors

B
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I o it e | |—e
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2]

@ NOT DEFINED
If you want to be able to manually select
the color for a monochrome pattern, you
can select [NOT DEFINED].

Colors for creating appliqués:
You can create appliqués using the
following three special colors.

e APPLIQUE MATERIAL
marks the outline of the region to cut from
the appliqué material.

© APPLIQUE POSITION
marks the position on the backing
material where the appliqué must be
sewn.

@ APPLIQUE
sews the appliqué on the backing
material.

M

By using the Applique Wizard, appliqués can

easily be created.

»» "Tutorial 8-1: Creating Appliqués"” on
page 161
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Specifying Thread Colors and Sew Types for Lines and Regions

Setting the sew type

The [Sew] group in the [Shapes] tab allows you to
set the sew type.

O)

ey Liistlad « L & S

e b

|E|EHE v

R L ] |

®

==

@ Line sew type selector
® Region sew type selector

BMLine sew types

sy Tigzag Stitch |Z||| '”'”

@ | FFreeey Mot Sewn (Lineg) Page
s Zigzag Stitth ——ou—" pp 325
————— Running 5titch ——— pp 325
== === Triple Stitch ———— pp 325

Matif Stitch ————pp 326
Stem Stitch —=—pp 327
Candlewicking Stitch ——— pp 327
E/V Stitch »» 328
Chain Stitch ——— pp 329
Cutting »» 329

2]

The sew type for lines in shapes and text can be
selected in the [Line sew type] selector.

Click the [Line sew type] selector, and then select
the desired sew type.

© Not Sewn (Line)
Select this setting to turn off line sewing
(line will not be sewn).

e Cutting
Select this setting to specify the line as a
cutting line in a cutwork pattern.

»» "Specifying sewing attributes" on
page 54, "Practical use of Satin Stitch
and Cutting Line" on page 168 and "Line
sewing attributes" on page 325

49

M Region sew types

FEEEEEEEE Fil stitch E|||Qé,

o Mot Sewn (Region) Page
AAAAMA - satin Stitch »» 331
FEEEEEEE Fil stiten »» 333
H1tbELE Prog. Fill stitch ————pp 333
———= Piping Stitch »» 336
SEBEEE Motif Stitch »» 337
XXXXX Cross Stitch »» 338
[({@M)) Concentric Circle Stitch ————— PP 338
—=3e&—— Radial Stitch —————— pp 338
(({(@))) spiral stitch »» 338
NS stippling Stiteh ————— PP 338
HEHEHHEE Met Fill Stitch ————Pp 339
HHHEEH zigzag Net Fill Stitch ——————— PP 339

The sew type for regions in shapes, and text can be
selected in the [Region sew type] selector.

Click the [Region sew type] selector, and then
select the desired sew type.

— The available region sew types differ
depending on whether a shape pattern or
text pattern is selected.

o Not Sewn (Region)
Select this setting to turn off region
sewing (region will not be sewn).

»» "Specifying sewing attributes" on

page 54 and "Region sewing attributes"
on page 331




Specifying Thread Colors and Sew Types for Lines and Regions

Moving entry/exit points,
the center point and stitch
pattern reference point

B Moving the entry/exit points
1  Click the [Home] tab.

2 Click [Select] in the [Select] group, and then
click . ® to select the Select Entry/Exit Point

tool.
&'1_., e = R thoms
h_ e ] [ BN o
ol R
FEm—— o e el S LA LK 1l
h - - | = [}
| Bl we n
3
L2
L1 This is the entry point for the outline

N__ stitching. The previous pattern is
Ng,! g p' : p
connected to this point.

L2 This is the exit point for the outline
!?I-”’ stitching. Stitching continues from this
point to the next pattern.
‘ﬁa,:
A

This is the entry point for the inside
region stitching. The previous pattern
is connected to this point.

=" This is the exit point for the inside
N 2 region stitching. Stitching continues
from this point to the next pattern.

The codes that appear indicate the following.
L: Line sewing R: Region sewing
1: Entry point 2: Exit point

r1. This is the entry (or exit) point for the
next (or previous) pattern that is
connected to the exit (or entry) point of
the currently selected pattern.
This point is connected to the entry/exit
point with the same code in the
currently selected pattern. In this
example, R1 in the currently selected
pattern and R1 in the previous pattern
are connected.

4 Drag the arrow for the point to the desired
location on the outline.

A dotted line appears between the entry (or
exit) point being moved and the cross
indicating the exit (or entry) point of the
previous (or next) pattern.

« Ifthe outline or the inside region are set to not be
sewn, the corresponding point does not appear.

» The entry and exit points can be checked in the
[Sewing Order] pane. Select the Select Entry/
Exit Point tool, and then click a frame in the
[Sewing Order] pane. The entry and exit points
of the selected pattern appear.
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In this case, finish the operation by clicking a
blank area in the [Sewing Order] pane.
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Specifying Thread Colors and Sew Types for Lines and Regions

a

Only entry and exit points for patterns created with
the Shapes tool can be edited. Stitch patterns or
patterns created with the Text tools cannot be
edited.

B Moving the center point and stitch
pattern reference point
The center point and reference point for arranging

the stitch pattern can be repositioned for a more
decorative effect.

M

» Regions with the concentric circle stitch or radial
stitch specified have a center point.

» Regions with the prog. fill stitch, motif stitch,
cross stitch, net fill stitch or zigzag net fill stitch
specified have a stitch pattern reference point.

1  Click the [Home] tab.

2 Click [Select] in the [Select] group, and then
click & .

E- .,-H ,||.. Thoipri

E e e

3 Clicka region with the concentric circle stitch,
radial stitch, prog. fill stitch, motif stitch, cross
stitch, net fill stitch or zigzag net fill stitch
specified.

Center Point (Radial  Stitch pattern reference
Stitch) point (Motif Fill Stitch)

@ Handle

51

4 Drag the handle to the desired location.

Center Point (Radial  Stitch pattern reference
Stitch) point (Motif Fill Stitch)

@ Handle

Specifying the sewing
direction

When the Outline tools, Rectangle/Circle/Arc tools
or Shapes tools are used, shapes with a single
sewing direction will be created. When the Manual
Punch tools are used, shapes with multiple sewing
directions are created.

The sewing direction is indicated by a sewing
direction line (red arrow). These lines can be edited
by moving the end points, or new sewing direction
lines can be added.

- bl

These settings can be adjusted for regions with the
satin stitch, fill stitch, prog. fill stitch, piping stitch or
motif stitch specified.

a

This feature can be used when [Direction] in the

[Sewing Attributes] pane is set to [Manual]
(default setting).




Specifying Thread Colors and Sew Types for Lines and Regions

W Specifying multiple sewing
directions

1  Click the [Home] tab.

2  Click [Select] in the [Select] group, and then

click _-'F to select the Select Point tool.

E-- .,-H ,||.. Thoipri

,..-t;| ———

3  Click a shape pattern.

— The sewing direction lines appear.

4  Click the [Shapes] tab.

5 Click [Add Direction Line] in the [Sewing
Direction Line] group.

E_'I .|_7‘L]"~||.' Tarmnn
n _ -
. (T eviabinisnlnil 16 LT

] T ® bl Gkl Lol | nanimrw

6 Clickthe point for one end of the sewing
direction line being added, and then click the
point for the other end.

- P
O 1> =¥ il
i P

M

 Specify the sewing direction lines as described
below.

+ Position both end points outside of the pattern.

¢ Only the lines can be positioned over the
pattern.

+ When specifying multiple sewing direction
lines, they must not intersect within the
pattern.

Sewing direction lines specified in any way other

than described above will not be added.

a

If hole sewing has been applied, sewing direction
lines cannot be added.

M Changing the sewing angle
1  Select the Select Point tool.

2 Click ashape pattern, and then click an empty
square or empty triangle on the sewing
direction line to select the point.

3  Drag the point to the new location.

LY

i} é]é al ul
Selected point —>h
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Specifying Thread Colors and Sew Types for Lines and Regions

M

The sewing angle can also be set to a specific
direction (one sewing direction line) with the
settings under [Direction] in the [Sewing
Attributes] pane.

»» "Specifying sewing attributes” on page 54

M Reversing the sewing direction

1  Select the Select Point tool.
2 Clicka shape pattern.

3  Click the [Shapes] tab.
4

Click [Reverse Direction Line] in the
[Sewing Direction Line] group.

G EaRE T
= P [ryres gy
Y e R

\ 4

"? ? ?

T o

If there are multiple sewing direction lines, all
lines will be reversed.

M Deleting sewing direction lines

1 Select the Select Point tool.

2 Click a shape pattern, and then click an empty

square or empty triangle on the sewing
direction line to select the point.

3  Click the [Shapes] tab.

4 Click [Delete Direction Line] in the [Sewing
Direction Line] group, and then click [Delete
Selected Line] or [Delete Lines Not

Selected].
E-". P = R = LELEEE - Ly
" o = " y
by [ e
————
: I
. (s | / -\.I -
L I !

Delete Selected Line

Click this command to delete the selected
sewing direction line. Otherwise, press the
<Delete> key to delete the sewing direction.

Delete Lines Not Selected

Click this command to delete all sewing
direction lines except the currently selected
one. The sewing direction will become
uniform.
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Specifying Thread Colors and Sew Types for Lines and Regions

Sample patterns with sewing directions
changed

When the sewing direction is changed, the pattern
stitching changes as shown below.

Sewing direction Satin Stitch
B
o
(default)
2 e
[

Fill Stitch Programmable Fill Stitch
(Prog. Fill Stitch)
Piping Stitch Motif Stitch

]
] =

The sewing direction is also changed when the
pattern size and shape are changed.

Specifying sewing
attributes

1 Select an embroidery pattern, a Shapes tool
or a Text tool.

2  Click the [Sewing Attributes] tab.

Beginner mode Expert mode

(1) (1)
R—C— ] - e . -] -
| Pl e [Fimasns
[ vi—" T epee—"
e - B ‘ug g D - i
re—i - o [ = o=
| T . | B s
FRre—— el FR
I : = a | i L
l_—— T T
= = B .
i g k= o
- Ceersy - 1
| e = o |
i
i H I".I— _51 ?;WE
il © — i
-.'.!'nluéu_' --Ir :I\- J.uL.iLu_ --I-": '.‘*I-
e 0 © e 0 o

o Click to return to the default setting.

9 Click to switch the attributes between
those for Beginner mode and those for
Expert mode.

9 Click to load/save the sewing settings.

0 Click to switch between displaying and
hiding the hint view.

@ Hint view
With each change in the settings, a
preview of the stitching can be checked
here. By moving the pointer over each
setting, a preview of the setting can be
displayed.

M

The sewing attributes displayed in the dialog box
depend on the selected sew type.
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Specifying Thread Colors and Sew Types for Lines and Regions

3  Change the sewing attributes displayed under
[Line sew] or [Region sew].

— The settings are applied to the embroidery

pattern each time the settings are changed.

»» For details on the different sewing
attributes and settings, refer to "Line
sewing attributes" on page 325 and
"Region sewing attributes" on page 331.

M

Frequently used sewing attributes can be saved.

»» For details, refer to "Saving the settings in a
list" on page 192

Copying sewing attributes

The thread colors, sew types and sewing attributes
can be copied from one pattern and pasted onto
another to apply the same settings to the pattern.

@ Original

1  Select the shape pattern or text pattern whose
settings are to be copied, and then press the
shortcut keys <Ctrl> + <C> to copy.

2  Selectthe shape pattern or text pattern where
the settings are to be pasted, and then click
the [Home] tab.

»» For details on the shape pattern and text
pattern, refer to page 8.

3  Click [Paste] in the [Clipboard] group, and
then click [Paste Attributes].

TR e R Tarmn
E-.-.I ik L ] s (L
'h -"-7:_ -g.-_. : .!"".L i B
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M

* When copying attributes from a shape, text,
monogram or small text pattern and pasting
them to a pattern of a different type, only the
colors will be pasted. The sew types and sewing
attributes cannot be pasted.

Original Target

ABC
¥

[
—

Original Target

* When copying a text pattern with different
sewing attributes applied to each character, the
sewing attributes of the first character will be
copied.

a

This function cannot be used with stitch patterns.




Specifying Thread Colors and Sew Types for Lines and Regions

B Copying only specific attributes 4  Select the check boxes of the attributes to be

Specific attributes, such as the line thread color, can pasted, and then click [Paste].
be copied and pasted onto another pattern.

Paste Selected Attributes
1  Selectthe shape pattern or text pattern whose

settings are to be copied, and then press the 7 Hie Al
shortcut keys <Ctrl> + <C> to copy. [¥ Line Calor
2  Selectthe shape pattern or text pattern where I Line Sewing Attributes
the settings are to be pasted, and then click
the [Home] tab. — Region Attributes
3  Click [Paste] in the [Clipboard] group, and ™ Fiegion Color
then click [Paste Selected Attributes]. [¥ Region Sewing Athributes

Cancel |
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Specifying Thread Colors and Sew Types for Lines and Regions

Embossing/Engraving

Multiple shape patterns can be selected to create an
engraved/embossed effect.

0) TR
.
] = KUT’
@ Top
® Bottom

1 Draw a shape.

In this example, the fill stitch is selected for
region sewing.

2 Draw a shape overlapping the shape drawn in

step 1.
MW —_ P~ 1-‘
A — i Bt e e

—_— s e ol

3  Select the two shapes, and then click the
[Home] tab.

4  Click [Emboss/Engrave] in the [Edit] group,
and then click the desired command under
[Convert from Outline].

miived - Ligr B Exdtmg

Example: When the [Engraved Line] command
is selected

[F] Engraved Line
The bottom shape is
engraved with the outline
of the shape on top.

[F1 Engraved Region IrL
An engraving is made in
the bottom shape from the i \',
shape on top.
For best result, select
[Satin Stitch] for region
sewing of the bottom
shape.

B Embossed Region
An embossing is made in
the bottom shape from the
shape on top.
For best result, select [Fill
Stitch] for region sewing
of the bottom shape.

<

M

This effect can be edited with the Edit Stamp tool.
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a

» These commands can only be used with shape
pattern.

» The bottom shape pattern must have one of the
following sew types specified for region sewing.

¢ Satin stitch
+ Fill stitch
+ Programmabile fill stitch

« In order to use the [Engraved Line] command,
[Line sew type] for the shape pattern must be
set to any setting other than [Not Sewn (Line)].
In order to use the [Engraved Region] or
[Embossed Region] commands, [Region sew
type] for the shape pattern must be set to any
setting other than [Not Sewn (Region)].

Applying and editing
stamps

You can create engraved/embossed effects by
stamping stamp patterns into a shape. This appears
as stitching sewn in different directions.

T,
Wy

~
N | & '»ki:?

M Applying a stamp

1 Draw ashape.

= [ —
N =

—

2  Click the [Home] tab.

3  Click [Emboss/Engrave] in the [Edit] group,
and then click [Input Stamp Tool].

e et - Lagrart A Fifting

4  Select a stamp pattern (.pas file with stamp
settings applied).

? o ? ©

Stamp Attribute Settin|
:\Program Files b 81\Brother\PE-D...\Patiem
i Q? I 00 _‘;l -
—

100 < wm

[~ Diregtion
@ 0 =] degiess |
Close

]

| =

© sclecta stamp pattern.

e Specify the size of the stamp pattern.

9 Specify the direction of the stamp pattern.
@ 7o select a different folder, click |[Z .

M

Engraving and embossing stamp settings appear
as red- and blue-filled areas.

5 Click the shape pattern drawn in step 1 to
select it.

— "Marching lines" appear around the
selected shape pattern.

6  Click the desired locations within the shape
pattern.

You can preview the effect of the created
stamp in Realistic View.
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Specifying Thread Colors and Sew Types for Lines and Regions

M

» Stamps can be applied to regions of shape
pattern that have the satin stitch, fill stitch and
programmable fill stitch specified.

» Using Programmable Stitch Creator, you can
edit stamp pattern that have been provided or
you can create your own.

»» "Programmable Stitch Creator" on page 258

M Editing a stamp
1  Click the [Home] tab.

2 Click [Emboss/Engrave] in the [Edit] group,
and then click [Edit Stamp Tool].

it - Lyt & Exfzng

P (O 128
.k d
- T T
S
i i TR T
e | i KRS TRTTE SRoH 7 oprdE

2] EEETE L ToE s

v

3  Click the shape pattern with the stamp.

— "Marching lines" appear around the
selected shape pattern.

4  Click the stamp.

@ Rotation handle
® Scale handles

M

* Only one stamp can be selected at a time.
» To enlarge the stamp, drag a scale handle.
 To rotate the stamp, drag the rotation handle.
» To delete the stamp, press the <Delete> key.

5  Edit the stamp.

Stamp Attribute Setting

[ C:\Program Files (+6]\Brother\PE-D...\Pattem

B
*x00 O

—

stamps_ stamps stamp_
=

(3 F 3 e

stampT_ stampé,
=] B Close

» To change the stamp pattern, select a
different pattern, and then click [Apply].

e
e EEa

« Ifthe size of a shape pattern is changed, the size
of the stamp does not change. Be sure to check
the stamp after editing a shape pattern.

« If a shape pattern containing a stamp is edited,

be sure to check the stamp after editing is
finished.
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Drawing Shapes

Drawing Shapes
Drawing rectangle, circle n[ O]

Drag the pointer in the Design Page.

or arc shape —
Rectangle
Circle Oval Arc '
*.__ .:u-,': s AR el RS
N R Ri—=

Fan shape Arc & string

-

Click the [Home] tab.

Click [Shapes] in the [Tools] group, and then
click a tool icon under [Rectangle]/[Circle]/
[Arc] to select the desired [Rectangle]/
[Circle]/[Arc] tool.
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T ) T
] 3 R Pl To draw a circle or square, hold down the <Shift>

Fesirire key while dragging the pointer.

§ = : | | ._-_ _‘.||I _1' —
ik B S P e T [
S : Rectangle
‘ | |@ess || Rectang

[:] : Rectangle with rounded corners
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Drawing Shapes

2  Move the pointer to the start point of the arc,

m and then click.

Rectangles with rounded corners —> The radial line disappears.

To change the radius of the corners, click the _ ) )
[Edge radius] selector in the [Outline] tab. Then, 3 Movethe pointer until the arc/arc & string/fan
type the desired radius, or select the desired has the desired shape, and then click.

value.

Specify the radius of the corners before drawing D:I

the rectangle. The setting cannot be changed after

the rectangle has been drawn. Dragging the pointer while holding down the

I ) <Shift> key moves it in 15° increments. The
E“ L OBt s e current angle is shown in the status bar.

= i g - V=

I s
= L= = BIEIEEramms Arc

F "I.' |
-
—|—@

Click at start point.

Example 1 Example 2
Edge radius: 0.0 mm Edge radius: 20.0 mm

g

Move to end point.

[ | Q/’D/Q _’_ Click at end point.

28

Q. Fan Arc & String

1 Proceed as you would to draw a circle or an
oval. j]L
O AR ¢ e [ — Click at start point.

L ' B e 1

|
i
ﬂ‘l_

Move to end point.

—’— Click at end point.

— Arradial line appears on the oval when the
mouse button is released.

B
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Click at start point.

_|_

Move to end point.

—’— Click at end point.

M

* You can change the color and sew type either
before or after drawing the shape.

»» "Setting the sew type" on page 49

* You can also use the settings in the [Sewing
Attributes] pane to define other attributes of the
shape before or after drawing the shape.

»» "Specifying sewing attributes" on page 54

Drawing Shapes

Drawing various shape
1  Click the [Home] tab.

2 Click [Shapes] in the [Tools] group, and then
click a tool icon under [Shapes] to select the
desired Shapes tool.

; mi--l.'-.u'h'lr.u:rn_

i

A;_'ﬂ_;';k1 :
L rmarn Y -

3  Drag the pointer in the Design Page.

M

» Todraw the shape while maintaining the original
height-to-width proportion, hold down the
<Shift> key while dragging the pointer.

« Various sample shape patterns are available in
the [Import] pane when [Outline Shapes] is
selected in the [From] selector and [Basic
Shapes] is selected in the [Category] selector.

»» "Using the Import pane" on page 13
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Drawing Shapes

Drawing outlines (straight
lines and curves)

End point
Start point

Open line Closed line

End point
Start point
Open curve Closed curve

1  Click the [Home] tab.

2 Click[Shapes] in the [Tools] group, and then
click a tool icon under [Outline] to select the
desired Outline tool.

| SRS AL '\.""‘-"Hlﬁ"?
Bag e
g | [ i
| E s
LA T T
s ® o /

g . Click points to draw a closed line

constructed of straight lines.
(Shortcut key: <Z>)

6 . Click points to draw a closed curve.
(Shortcut key: <X>)

Q/ . Drag the pointer to draw a closed
freehand curve.

<> : Click points to draw an open line

constructed of straight lines.
(Shortcut key: <Z>)

J : Click points to draw an open curve.
(Shortcut key: <X>)

“2! . Drag the pointer to draw an open
freehand curve.

63

3  Clickin the Design Page or drag the pointer to

draw the line.

The shortcut keys are available only after an
Outline tool has been selected.

M Straight lines/curves

1 Click in the Design Page to specify the start
point.

2  Click in the Design Page to specify the next
point.

=

— The dotted lines change to solid lines.

M

» To remove the last point that was entered, right-
click the mouse button, or press the
<BackSpace> key.

» The Curve tool is used in the same way.

3  Continue clicking to specify every point, and

then double-click the last point, or press the
<Enter> key.




Drawing Shapes

M Changing the attributes of

« You can freely switch between the different line line ends
types either by clicking a different button or by

pressing the shortcut key.

* When drawing a straight line, hold down the
<Shift> key while moving the pointer to draw #
vertically or horizontally. /

« Even after the pattern is drawn, you can change
the attributes of line ends.

After selecting a shape pattern, right-click it, and

> "Changing the attributes of line ends" on then click [Open] or [Close] to change the line
page 64. ending.
» Even after the pattern is drawn, you can - F— T
transform straight lines into curves and vice al = o cormbi o Lo |
L]

versa. !
e
»» "Transforming straight lines into curves or /‘

curves into straight lines" on page 70.

M Freehand lines | .

1  Drag the pointer to draw the line.

2  Release the mouse button to finish drawing.

M

In addition, closed shape patterns can be split at
points to create open lines, or the end points of
open shape patterns can be connected to create
closed lines.

»» "Connecting points/splitting outlines (shape
patterns)" on page 67
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Drawing Shapes

Embroidery attributes of
shapes

The [Shapes] tab allows you to set the embroidery
attributes (thread color and sew type).

Example: When a rectangle is selected.

T Lkl - Ly & Sebfng
l AR e
W ndnieTy | :a-l |
(1) (3] (2]

o Line color/Region color
Click this button to set the thread color for
lines and regions.

For special colors:

»» "Special colors" on page 48

e Line sew type selector
All lines in a shape can be set to the same
sew type.
Use these selectors to set the sew type for
lines.

»» "Line sewing attributes" on page 325

9 Region sew type selector
All regions in a shape can be set to the
same sew type.
Use these selectors to set the sew type for
regions.

»» "Region sewing attributes" on page 331

»» "Specifying Thread Colors and Sew
Types for Lines and Regions" on page 46

M

» Toturn off line sewing, select [Not Sewn (Line)]
from the [Line sew type] selector.

 To turn off region sewing, select [Not Sewn
(Region)] from the [Region sew type] selector.
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Reshaping Embroidery Patterns

Reshaping Embroidery Patterns

Patterns can be reshaped by moving, adding or deleting points. While creating shape patterns, a clicked

location becomes a point.

Selecting points
1  Click the [Home] tab.

2 Click [Select] in the [Select] group, and then

click _-"f to select the [Select Point] tool.

-E-'- -_-H .|||. Thepcy

'l.

- ! -l
[T

[ ww g el b
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3  Click the pattern.

4  Toselectasingle point, click an empty square.

Multiple points can be selected in any of the
following ways.

 Drag the pointer.
— All points within the box are selected.
« Hold down the <Ctrl> key while clicking the
points.
— To deselect a point, click the selected
point.

« Hold down the <Shift> key while pressing an
arrow key to select multiple points.

» Hold down the <Ctrl> key while pressing an
arrow key to change the point that is selected.

Moving points
1 Select the point.

2 Drag the point to the new location.

]

N

Selected point =

M

» To move the point of a broken line, a curve, or
stitch data horizontally or vertically, hold down
the <Shift> key while dragging it.

A selected point can also be moved with the
arrow keys.

 Points in patterns set for hole sewing can also
be moved. However, the point cannot be moved
to cross an outline. In order to move the point in
this way, cancel hole sewing first.

« Ifyou start dragging by clicking elsewhere on the
outline of the pattern, a new point will be inserted
or the selected point(s) will be deselected.
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Reshaping Embroidery Patterns

Inserting points
1  Click the [Home] tab.

2  Click [Select] in the [Select] group, and then
click ¥ to select the Select Point tool.

l.._—H ,|l. i Thopch

h o B

E
= o

NS i

3  Click the pattern.

Click the outline to add a point.

PR

Deleting points
1  Select the point.
2  Click the [Shapes] tab.

3  Click [Delete Point] in the [Edit Point] group.
Otherwise, press the <Delete> key to remove

the point.

- i 3 B Tammmn
e, BT s g
I £ Byian . A fosi B W=
-4

'.h- . ¥ % T=5)
il G ™ L
Delete

=

Selected point

Connecting points/
splitting outlines (shape
patterns)

M Splitting outlines of open shape

patterns

The outline of an open shape pattern can be split at
a point.

1  Select a point in an open shape pattern.
2  Click the [Shapes] tab.

3 Click [Split at Point] in the [Edit Point] group
to split the line.
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Reshaping Embroidery Patterns

M Splitting outlines of closed shape

patterns an
The closed path of a shape pattern can be split. The * When the outline of a closed shape pattern is
closed path consists of the points that are split to create an open shape pattern, region
connected to create the shape pattern. sewing attributes can no longer be specified.

1  Selecta point in a closed shape pattern.

’5 ________ e i

» The [Open] command is also available to
change a closed shape pattern to an open
shape pattern.

2  Click the [Shapes] tab.

. . . W

3  Click[Split at Point] in the [Edit Point] group »»> “Changing the attributes of line ends" on &
to split the line. page 64 s
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« If a shape pattern is split in a shape with hole
sewing applied, hole sewing will be canceled.

« If a shape pattern is split in a shape with fit text
to outline applied, fit text to outline will be
canceled.
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Reshaping Embroidery Patterns

B Connecting two open shape
patterns

The end points of two shape patterns can be
connected to create a single shape pattern.

1  Select an end point (entry point or exit point).

2  Press the <Alt> key.

— The points that can be connected appear
as x.

The other end point of the shape pattern whose
point is selected as well as the end points (entry
points and exit points) of other shape patterns
appear as x.

3 While holding down the <Alt> key, drag the
selected point to the other point that you want
to connect to it.

— The shape of the pointer changes to é;ﬂ ,

and a red square appears when the two
points are overlapping.

4 Release the mouse button to connect the two
points.

69

W Connecting the two end points of
a shape pattern

The two end points of an open shape pattern can be
connected to create a closed shape pattern.

1  Select an end point (entry point or exit point).

2  Press the <Alt> key.

— The other end point appears as x.

3 While holding down the <Alt> key, drag the
selected point to the other end point.

4  When the two points are overlapping and the
red square appears, release the mouse
button.

When a shape pattern is closed, its region sewing
attributes may appear.

M

The [Close] command is also available to change
an open shape pattern to a closed shape pattern.

»» "Changing the attributes of line ends" on
page 64




Reshaping Embroidery Patterns

Transforming straight Changing the curve type
lines into curves or curves 1 Selecta point on a curve.
Into stralght lines 2 Click the [Shapes] tab.
1 Select the point. 3 click [Edit Point] in the [Edit Point] group,
2  Click the [Shapes] tab. and then click [To Smooth], [To Symmetry]

or [To Cusp].
3 Click [Edit Point] in the [Edit Point] group,

. . E:I -\*L‘I"“..' T
and then click [To Straight] or [To Curve]. e VU ST
E-" e Thwprn ,F'L - E: W e -: _Il
R AR ") Al W, o 4 L o
Al :ﬁ;-r- I . :. A I-'_';':"":' =R ":J 1 - T
| L i B i s | ; - |
— wl :

To Straight To Symmetry

To Cusp
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4  Drag the solid black handle to adjust the
shape of the line.

The shape can be changed by dragging the solid
black handle on either side of the point.
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Editing a Stitch Pattern

Editing a Stitch Pattern

Converting shape pattern
or text pattern to a stitch
pattern

Shape pattern or text pattern can be converted into
a stitch pattern, allowing you to make detailed
changes by modifying the position of individual
stitches.

1  Select the shape pattern, and then click the
[Shapes] tab.

2 Click [Convert to Stitches] in the [Edit]

group.
i - Lapour b Exdiing
. _on_ el e T g -
i~ Sl mumuan o Tiach
- =

M

» [Convert to Stitches] can also be used with text
pattern to convert it to stitch patterns.

« In stitch patterns, stitches appears as solid lines
( ), and jump stitches appear as dotted
lines (—-—).

« If any part of grouped patterns, patterns set for
hole sewing, and text arranged on shapes is
selected, all patterns in the entire group are
converted to stitch patterns.

 Patterns that do not have stitches are deleted
when the pattern is converted to a stitch pattern.

Selecting stitch patterns
by thread color

Hold down the <Alt> key and click the thread color
for the stitch patterns that you wish to select.

» The thread color can be changed when patterns
are selected using this method.

»» "Setting the thread color" on page 46

« If stitch patterns are grouped, patterns cannot be
selected by color using this method.
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Selecting stitch points of
stitch pattern
1  Click the [Home] tab.

2  Click [Select] in the [Select] group, and then

click _-"f to select the Select Point tool.

E-- '\-'H ,||.. Thoipri

e o R

Dhads S T T T [T

= 't" = .

3 Click the stitch pattern.

4 7o select a single stitch point, click an empty

square.
T

[ £l

A\ |

@ ®

@ Selected point
®@ Unselected point

Editing a Stitch Pattern

M

* When selecting stitch points, be sure to click the
stitch point (do not click a blank area of the
Design Page), otherwise all of the selected
points will be deselected.

« If you click on a jump stitch, the points at both
ends are selected.

» Multiple stitch points can be selected in the
same way that embroidery pattern points are
selected.

»» "Selecting points" on page 66

a

Stitch points cannot be edited if the pattern is not a
stitch pattern. The pattern can be viewed in Solid
View.

B Moving stitch points
Drag the selected stitch points to the new location.

M

Stitch points are moved in the same way that
embroidery pattern points are moved.

»» "Moving points" on page 66

M

* Press the <Tab> key.
— All stitch points in the next color are
selected.
» Press the <Shift> and <Tab> keys.
— All stitch points in the previous color are
selected.
* Press the <Ctrl> and <Home> keys.
— The entry point of the first thread color is
selected.
* Press the <Ctrl> and <End> keys.
— The exit point of the last thread color is
selected.
» Select at least one point in a given color, and
then press the <Home> key.
— The entry point of the color is selected.
» Select at least one point in a given color, and
then press the <End> key.

— The exit point of the color is selected.

M Inserting stitch points

Click a line between two stitch points to add a new
point at that position.

M Deleting stitch points

Press the <Delete> key to delete the selected stitch
point.

M

« If the end point of a jump stitch is deleted, that
jump stitch segment is deleted and the stitches
before and after the jump stitch are connected.

» Toinsert a stitch point and change the previous
line into a jump stitch, hold down the <Ctrl> and
<Shift> keys while clicking on the line.
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Editing a Stitch Pattern

Connecting points/ 1}
Splitti ng stitches (StitCh If an entry point or an exit point is selected, the
[Split at Point] is not available.
patterns)
A single color pattern can be divided into two by
splitting stitches at a point, and two color patterns . .
B Connecting two stitch patterns to

can be combined into one by connecting points. If a

stitch pattern is divided into multiple parts, each part create a single one

can be edited separately, such as changed to 1 Select an end point (entry point or exit point) of
different colors. -
a stitch pattern.
'.‘""”,'.‘ i -.l_.r - -
(\_,‘ _— S
g . S
- B ‘* 3 * :
f 2 @, R
i L |
n 5 L e ;
| 1 - IIII'.__ll
-\."',h.
i

M Splitting one stitch pattern into I
two at the selected point

1  Select a point in a stitch pattern.

Select the entry point of the stitch pattern by

pressing keys <Ctrl> + <Home>. Select the exit

point by pressing keys <Ctrl> + <End>. For

3  Click[Split at Point] in the [Edit] group to split details, refer to "Selecting stitch points of stitch
the stitch pattern. pattern” on page 72.

2  Click the [Stitches] tab.

B - =3 Fa Frim ¥k g
e e il 2  Press the <Alt> key.
T LR
|17 Pt v — The points that can be connected appear
T = . _ . as x.
. e " .-\.:_u > “__,:‘ SEN 1 -.-r_:_
g - RS ik 20
i 3 SRR L} R
- G- - R 4
¥ i . L
| 2 NS @ SRR T
. ' .'l’." L] ; ¥
= S 8 ; o
= eyt
— The stitch pattern is split at the point. | :
B — b — IR
A — ki — ar
B = D& & M
) = R If the entry point of a stitch pattern is selected, the
L ; - F exit points of the other stitch patterns appear as x.
- 8- i If the exit point of a stitch pattern is selected, the
: g W entry points of the other stitch patterns appear as
= - . X
L = » ¥ O : .
1& , By
1] e "':'_- '..I:':" '1 T
1 v .. .“.,. .::l: M-
u e ':_ LR 'h.._ 2 i’
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3  While holding down the <Alt> key, drag the
selected point to the other point that you want
to connect to it.

— The shape of the pointer changes to Q;ﬂ ,
and a red square appears when the two
points are overlapping.

S T . - J

3
r- B I-q.-r-‘_._
i E -\.l - r
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4 Release the mouse button to connect the two

points.
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After the points are connected, the pattern will
have the thread color of the pattern that was firstin
the sewing order before the points were
connected.

Splitting off parts of a
stitch pattern

1 Select a stitch pattern, and then click the
[Stitches] tab.

Editing a Stitch Pattern

2  Click [Split Stitches] in the [Tools] group to

select the [Split Stitches] tool.
PT= = B

— r ma  Milidw

&

kel

— All other patterns will appear in gray.
Selected pattern will appear in front of other
patterns.

3 Click in the Design Page at the point where

you want to start drawing the enclosing lines.

4  Continue clicking in the Design Page to

specify each corner of the enclosure around
the area to be cut off.

M

To remove the last point that was entered, right-
click the mouse button.

5 Double-click in the Design Page to specify the
section to be split off.

The cutoff piece moves to the end of the sewing
order.

»» "Checking and Editing the Sewing Order" on
page 82
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Editing a Stitch Pattern

Dividing stitch pattern by
color

Before dividing

1  Select the stitch pattern(s), and then click the
[Stitches] tab.

2 Click [Divide by Color] in the [Edit] group.

way) EEAE e
— iy L e ey M
= — 1
" - :
K i3 L S
i ST i L A E i
Eoer | iy il 3 s Dl

— Dotted lines appear around each part of the
stitch pattern.

Converting stitch patterns

Stitch patterns can be converted into two types of
shape patterns.

Stitch

Shapes

*Blocks: A group of shape patterns with multiple
sewing direction lines

After being converted, various editing operations
can be performed.

75

Convert to Blocks

The pattern is converted while maintaining the
multiple sewing direction lines.

Use this when you want to enlarge or reduce an
embroidery pattern that uses satin or fill stitches.

Convert to Outline

The pattern is converted following the shape of the
outline.

M

« After being converted, the outline patterns can
be edited.

»» "Setting the sew type" on page 49
"Specifying the sewing direction" on
page 51
"Specifying sewing attributes" on
page 54
"Reshaping Embroidery Patterns” on
page 66

* For details on the shape pattern and stitch
pattern refer to page 8.

B Converting stitch pattern to
blocks

Stitch patterns can be converted into blocks (group
of shape patterns with multiple sewing direction
lines). In blocks (shapes) pattern, the sew types and
sewing attributes can be changed, and the pattern
can easily be edited.

1 Select the stitch pattern(s), and then click the
[Stitches] tab.

2 Click [Convert to Blocks] in the [Edit] group.
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3 Move the slider to select the desired
sensitivity. Click [OK].

Sensitivity
Fine Mormal Coarse

" Cancel

M

The [Normal] setting should provide satisfactory
results in most cases, but depending on the
complexity of the pattern, you may need to select
a setting more towards [Coarse] or [Fine].

— The stitch pattern is converted to grouped
shape patterns. Being converted to shape
patterns, the outlines of the stitch pattern
can be edited.

»» For details see the following instructions;
"Setting the sew type" on page 49
"Specifying sewing attributes” on

page 54

"Reshaping Embroidery Patterns" on
page 66

"Specifying the sewing direction" on
page 51

a

The [Convert to Blocks] command cannot be
used with some stitch pattern imported from
original cards.

W Converting stitch pattern to
outline pattern

Outline patterns can be created from each colorin a
stitch pattern or from an outline around the entire
pattern.

y
® =

@ Convert Whole to Outline
® Convert Parts to Outlines

Editing a Stitch Pattern

1  Select the stitch pattern(s).

2  Click the [Stitches] tab.

Click [Convert to Outline] in the [Edit] group,

and then click [Convert Whole to Outline] or

[Convert Parts to Outlines].

&H i B - Ll
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— The outline patterns are created, and the

original stitch patterns are deleted.

M

« Line sewing in the created outline patterns is set
to [Not Sewn (Line)], and region sewing is set

to [Fill Stitch].
« If the [Convert Whole to Outline] command

is

selected, the thread color will be set to the first
thread color in the sewing order for the original

stitch pattern.

« If multiple outline patterns are created from a
single stitch pattern, the outline patterns are
grouped.

« If there is an opening (area with no stitching, but

surrounded by stitching) in the original stitch
pattern, hole sewing may be applied.

nEL - IR,
ARPRC AR,

-
-
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Checking Embroidery Patterns

Checking Embroidery Patterns

Zooming

1  Click the [Home] tab.

2 Click K or 7\ in the [Tools] group.

Uitk -

g Wik
[T i
T s ﬂ S :E —_ X e
T = || =3
= TRl Rl | gt || B
e = 1]
(-1 e [ i

"s\ . Click the Design Page to zoom in.

(Right-click the Design Page to zoom
out.)

‘= Click the Design Page to zoom out.
(Right-click the Design Page to zoom

in.)

Otherwise, click | beside =, and then

click [Zoom all], [Selected object zoom] or
[Actual size zoom].

[Ty —

:.I_'\'I.-:I.- ﬁ "Il:| ! T jl. |:|I_.

L] i

Zoom all
The entire Design Page is displayed to fit
within the window. The same operation can be

performed by clicking in the [Tools]
group.
Selected object zoom

The Design Page is zoomed to display only
the selected objects.

Actual size zoom

The Design Page is displayed at its actual
size.

Using the Pan tool

The part of the work area that is displayed can easily
be changed by using the Pan tool.

1  Click the [Home] tab.

2 Click | in the [Tools] group.

= L e
—r ol [ -

A Al
..... i iR EI
-3} [t jam

3  Drag the work area to view the desired part.

M

* You can also pan the work area when any other
tool is selected by holding down the <Space>
key while dragging the pointer.

 To scroll horizontally, hold down the <Alt> key
while rotating the mouse wheel.

M

e Zooming is also possible by dragging the
[Zoom] slider in the status bar or clicking the
Zoom ratio.

¢ You can also zoom in or out when any other tool
is selected by holding down the <Ctrl> key while
rotating the mouse wheel.

»» “Layout & Editing Window" on page 11

1




Checking Embroidery Patterns

Using the Measure tool Changing the display of
1 Click the [Home] tab. the embroidery design
2 Click | inthe [Tools] group. 1 Click the [View] tab.
ﬁ;‘}' IJH :: ﬁ ' 2 [C\:liic;I\(N[onolijdg], g?ct;::h] or [Realistic] in the
N T Ay
00 0|, R
3  Click the two points, one on each end of the — i

distance that you want to measure.
— The length appears in the status bar.

H Solid View

® oy}
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(28
3
—
2
o
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m
[
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[ ey = I W Stitch View pa
3
@ Length <
® Width 2
® Height =)
@® Angle a

M

When the rulers are displayed, click mm / in. to
switch the measurement units between millimeters

and inches.
B | L L rﬂi L You can Qisp!ay a stitch view of it in order to see how
el | LIS, | A oy o i \nbia T the stitching is connected.
v ™ Nt
fakri = ;v:ri Foods
o e B N
B e

el k| B
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Checking Embroidery Patterns

M

If ® is selected under [Machine Type] in the
[Design Settings] dialog box, click the [View] tab,
and then select the [View Thread Trimming]
check box to view the thread trimming locations in
the Design Page.
Eﬂ::;;— i
E'-"l'l iy 'ﬂd-ﬂ-
=
ﬂ‘{fl a nl‘:n.-\.l-\.'lﬂrq L:,EJ Illl'\- Ir

il LR R
LI e 2 W

e Bhgay, wrre

ij =»

M Realistic View

You can display a realistic view of it in order to see
how the design will appear once it is sewn.

M

Changing realistic view settings

1. Click the [View] tab.

2. Click [Realistic View Settings] in the [View
Mode] group

‘E'“ '\._*H ST TR
e [rares
. E‘I' b i
».:I P
135
LA [ B
St

3. If necessary, specify settings for [Thread
Width], [Contrast] and [Brightness], and
then click [Apply] ([OK]).

Realistic View Settings
Thread Width:

Thin LJL Thick
Contrast:

Flat LJL Sharp
Erightress:

Drark LJL Bright

Cancel |
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Checking Embroidery Patterns

Checking the stitching with the Stitch Simulator

1 Click the buttons to view a simulation of the stitching.

! EI,
[ ] - iy B vl b | m el kb
|-.-:-:f.' Kao | K 2§ srromEr § sl kem |.=|a:||| -1 1mm :nllr:::l | 14 r_!Tl-l
Imeﬂl-lrmtlﬂ | O 17 6 T B o

6] (7] o

o Starts the stitching simulation. During
stitching simulation, this button changes

to ]
temporarily stop the simulation.

, which can be clicked to

e Stops the simulation and returns to the
previous display.

9 The slider shows the current location in
the simulation. In addition, the slider can
be moved to change the position in the
simulation.

I : Returns to the beginning of stitching
and stops the simulation.

k| : Advances to the end of stitching and
stops the simulation.
e Drag the slider to adjust the simulation
stitching speed.

6 Select this check box to automatically
scroll the simulation of the pattern when it
is too large to be fully displayed.

@ Click to hide the bottom section of the
Stitch Simulator. Click |4/ to display it
again.

0 Shows the number of the current stitch/
total number of stitches.

WAoo Yo | ¥ 1 | Reverses the
simulation by the indicated number of
stitches.

i +1 | §+10) Y+100: Advances the
simulation by the indicated number of
stitches.

e Shows the number of the color being
drawn/total number of colors used.

O - |: Returns to the beginning of
stitching for the current or previous thread
color.

OO + |: Advances to the beginning of
stitching for the next color.

@ Shows the currently displayed pattern
section/total number of hoop sections in
the pattern.

(Appears only for split embroidery
patterns.)

BH - |: Returns to the beginning of
stitching in the current or previous hoop
section.

EH = : Advances to the beginning of the
design in the next hoop section.

a

If the Stitch Simulator is not displayed at the
bottom of the window, click [Stitch Simulator] on
the [View] tab.

M

« The zoom tools and pan tool can be used while
a simulation is being viewed. If any other
command is selected, the simulation stops.

* If a value is entered at 0 @ or e the
simulation is reversed/advanced to the indicated
location.

a

« If a pattern was selected when the stitching
simulation was started, only the selected pattern
is drawn in the simulation.

» The [Auto Scroll] check box is not available in
Realistic View.
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Checking Embroidery Patterns

Viewing design in the
Reference Window
1  Click the [View] tab.

2  Selectthe [Reference Window] check box in
the [Show/Hide] group.

Unitbed - Lapad & Ebting

=-a 5'-:|".L B |l EE e e | EeE e [ B ]
s | (R v ;
| vl L ([
T | il

The display are a frame (red rectangle) indicates the
part of the pattern displayed in the Design Page.

81

MW Zooming

The Reference Window can be switched to display
either the entire Design Page or only the embroidery
pattern.

- A e ==
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Reference Window [
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B Moving/Resizing/Redrawing the
display area frame

The part of the design displayed in the Design Page
can be selected from the Reference Window.

Instead of moving the display area frame, the frame
can be redrawn to display the desired part of the
pattern in the Design Page.

Reference Window [EJ

Reference Window [EJ

]

a

With the frame, you can select the area in the
Reference Window to be displayed enlarged.

Checking Embroidery Patterns

Checking and Editing the
Sewing Order

0O 6 0
Six\ringﬂiim | 31 g
- %3 - ||| OO
| &=

I I I

(5] 6 © 0

o Select how patterns are displayed in the
[Sewing Order] pane.

9 Select the desired command to change
the sewing order.

9 Optimize Sewing Order
Click to rearrange the sewing order so
that the parts of the entered objects with
the same thread color will be sewn
together.

0 Thread Color
Set the color of the selected object.

6 Showr/hides in the work area the stitched
objects.

@ Lock
Click to lock the selected object so it
cannot be edited.

0 Jump Stitch Trimming
The Jump Stitch Trimming function can
be turned on or off.

6 Select Patterns
Selects the patterns in the Design Page.

Click the [View] tab.

2 Click [Sewing Order] in the [Show/Hide]

group.
Clicking the button switches between
displaying and hiding the Sewing Order.

i_'l _t:-u:.‘;._- =1
T 21}

o u A =

‘e SR,
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Checking Embroidery Patterns

3 click in the [Sewing Order] pane, and o Sewmg order optimization
then click [Zoom] and [Show by color order]. The sewing order and entry and exit points can be
; automatically adjusted to reduce the number of
i i thread color changes and jump stitches
o %o %O '
Zoom Click 7, to optimize the 1 2
n’: Sr.ww by-ColorOrde.r sewing order.
.17 | Hide Objects Not Stitched For the pattern at the right
(the numbers indicate the
Zoom sewing order), the sewing
Click to enlarge each pattern to fill its order will be adjusted as
frame. shown below. 4 3
Da Show by color order Sewing Qrder rox
Click to display in one frame all - X - ||S)| O
patterns of the same color that will be S ] T
sewn together.
OFF ;o ON 1T A » &
>
LS 2 > >
2 2
> 2 v > ©
2 > > * >
L= 3 * 3
> > - v ©
; 3 [ x
. ‘ ' L2 4 4
>£ © ©
> 4 ¢ = ¢ =
“ €3
it >
> The sewing order is adjusted so that patterns of the
C 5 5 same color are grouped in the most optimized
o % z sequence.
> E® 6 In addition, patterns of the same color are optimized
so that the exit point of the previous pattern and the
m entry point of the next pattern are the closest points.
When multiple same color i B a
patterns are combined into - - % _
one frame, appearstothe | o | However, f’ll"gﬂapp'”g di
left of that frame. B - ﬂ_ patterns will be arranged in
. . the most appropriate
Click to display the E 3 L& sewing order.
combined same color patterns b
in separate frames. 5
[-] appears under the first T
frame, and each frame is =
displayed with a subnumber =| L
following the first, to indicate @n
its sewing order within the £ P PO
patterns of the same color. & : z
Click [=] to recombine all of N‘E\a‘ Ly v:? v:?
the same color patterns back = © ©
into one frame. C= > » %
3 3
= S . 3
> ¢
i - a
4 4
L > * L=
L S >
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M

» The patterns in locked frames and hidden
frames will also be optimized.

» The sewing order of multi-position patterns will
not be optimized.

»» "Optimizing the sewing order" on page 38

M Editing the sewing order

The sewing order can be Sewing 010N 0w

Checking Embroidery Patterns

M Selecting a pattern

1 Click a frame containing the pattern in the
[Sewing Order] pane.

@ Blue line
® Marching line

M

To select multiple patterns, hold down the <Shift>
or <Ctrl> key while clicking the frames for the
desired patterns. In addition, multiple frames can
be selected by dragging the pointer over them.

changed by selecting the frame . %4 ]
containing the pattern, then = 0 ¥
dragging the frame to the new . ﬂ
location. A red line appears, £
indicating the position where the ¥
frame is being moved. p-—:--—-2 <
The frame can also be moved by ':“'
clicking ¥ in the [Sewing
Order] pane, then clicking the C
desired command in the menu L
that appeared.
4
R e | it
e B faw!
T e i
o] L t L =
i ) :
©
Sew First

Click to move the selected pattern to the beginning
of the sewing order.

Sew Previous
Click to move the selected pattern ahead one
position in the sewing order.

Sew Next
Click to move the selected pattern back one position
in the sewing order.

Sew Last
Click to move the selected pattern to the end of the
sewing order.

a

Check the stitching after changing the sewing
order to be sure that overlapping patterns will not
be sewn in the wrong order.

2 Click 'D{ in the [Sewing Order] pane to

select the pattern in the Design Page
corresponding to the frame selected in the
[Sewing Order] pane. The pattern can also
be selected by double-clicking its frame in the
[Sewing Order] pane.
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Checking Embroidery Patterns

B Changing colors

1  Select one or more frames in the [Sewing
Order] pane, and then click | I | at the top of
the [Sewing Order] pane.

— The Color pane appears in front of the other
panes.

2 Click the desired color in the [Color] pane.
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»» "Color pane" on page 46

B Changing sewing attributes

1 In the [Sewing Order] pane, select one or

more frames containing a pattern other than a
stitch pattern.

— The sew type selector for the selected
frame appears.

2  Click the [Sewing Attributes] tab.

If the [Sewing Attributes] pane is not
displayed, click the [View] tab, then
[Attributes], and then click [Sewing
Attributes].

3  Change the sewing attributes and sew type.

»» "Line sew types", "Region sew types" on
page 49 and "Specifying sewing
attributes" on page 54

85

W Displaying/hiding frames not
sewn

Frames containing patterns that will not be sewn
can be displayed or hidden.

Click ||, then [Hide Objects Not Stitched].

Sewing Order o x mm

|;||TE?' % | O g!
Zoom

E*I Show by Color Order

[¥| Hide Objects Not Stitched

ON

1 1
L= L=
¥ ¥
2
L= L=
75

2

S

As a default, frames containing patterns that will not
be sewn will be hidden.

When frames containing patterns that will not be
sewn are displayed, that frame can be selected and
its pattern can be edited.




M Displaying embroidery patterns

Each embroidery patterns can be displayed or
hidden in the Design Page. Overlapping embroidery
patterns can easily be edited if the pattern not being
edited is hidden.

Select a frame, and then click |§*|.

[ Samd ey 01 B i X

» Frames with contain multiple patterns of the
same color. If these frames are selected to be
displayed, all patterns in the frame are
displayed.

« [@] appears if the display setting is not the

same for all patterns in a frame with beside
it.

« Displaying either the line or region of an
embroidery pattern made up of an outline and
inside region displays the entire embroidery
pattern.

Checking Embroidery Patterns

M Locking embroidery patterns

Embroidery patterns can be locked to prevent them
from being moved or deleted. Locked embroidery
patterns cannot be selected or edited in the Design
Page.

Select a frame, and then click (3.

M

« Frames with contain multiple patterns of the
same color. If these frames are selected to be
locked, all patterns in the frame are locked.

. appears if the lock setting is not the same for

all patterns in a frame with beside it.

 Locking either the line or region of an
embroidery pattern made up of an outline and
inside region locks the entire embroidery
pattern.

 Locking any part of a combined pattern, such as
grouped patterns, text arranged on a curve or
patterns with hole sewing specified, locks the
entire embroidery pattern.
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Checking Embroidery Patterns

Jump Stitch Trimming

The Jump Stitch Trimming function can be turned on
or off.

a

These settings are applied only when
embroidering with our multi-needle embroidery
machines. Before these settings can be specified,

select @ under [Machine Type] in the

[Design Settings] dialog box.

»» "Specifying the Design Page Settings" on
page 14

The Jump Stitch Trimming button ([>€]) is available
in the [Sewing Order] pane.

Select a frame, and then click .
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. appears if the thread trimming setting is not

the same for all patterns in a frame with
beside it.

* The thread is cut before the thread color is
changed, even if [Jump Stitch Trimming] has
been turned off for the frame.

 Click the [View] tab, and then select the [View
Thread Trimming] check box in the [View
Mode] group. To view the thread trimming
locations in the Design Page.
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About Minimum jump stitch length for thread
trimming

* The jump stitch length can be specified on the
[Output] tab into the [Design Settings] dialog

box. (To displayed it, click @ then [Design
Settings]).

Design Settings

Design Page  Output |

Sewing Area
( " Design Page area

@ |Use existing design area

Optimize hoop chang
’V ™ Optimize the number of times b change the hoop's position

Minimum jump stitch length for thread timming: 1.0 _:I mm

"Jump Stitch Trmming

« If the jump stitch length is less than the length
specified for [Minimum jump stitch length for
thread trimming], the thread will not be cut,
even if [Jump Stitch Trimming] has been set.

e Whether or not [Minimum jump stitch length
for thread trimming] is available differs
depending on the selected machine model. For
details, refer to the Operation Manual for the
machine.
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M

The default setting can be specified for whether or
not thread trimming is applied to objects that are
created.

Click [Option] above the Ribbon, and then click
[Options] to display the [Options] dialog box.
Next, click [Jump Stitch Trimming], and then
select or clear the [Add jump stitch trimming to
the entered patterns.] check box.

rem

A

it . [ il i

[T

»» "Adding jump stitch trimming to new patterns"”
on page 302

»» "Jump Stitch Trimming" on page 16,
"Machine thread trimming according to
settings specified in Layout & Editing" on
page 297 and "Adding jump stitch
trimming to new patterns" on page 302

Checking embroidery
design information

Click @ then [Design Property].

& ! i‘-’:l-"":..h AR

T ey ity | | i

Checking Embroidery Patterns

Design Property
7 Shaw aboul seleoted Obiect(s).
Unititled Design Name
100
Category
87.80 mm Author
7310 mn
m Keywords
1 min Comment t
4
2
Color List @ Lolorchanges " Total colors
Color | Code | Brand [ Descrption [ Basic Color I
1M 800 EMBROIDERY  RED RED
2 M 900 EMBROIDERY BLACK BLACK.
3 M 800 EMBROIDERY RED RED
4 BB 500 EMBROIDERY  BLACK BLACK.
OK Cancel

You can enter comments and information about the
pattern to a saved .pes file.

M

The information shown in the color list can be
switched.

» Color Changes
The thread color information for each color
change is displayed. This allows you to check
the total number of thread color changes.

Calar List © Total colors
Color | Code | Brand | Desciiption | Basic Color ]
1 =0 EMBROIDERY  RED RED
2 MM 900 EMBROIDERY  BLACK BLACK
3 M 200 EMBROIDERY RED RED
4 MM 00 EMBROIDERY  BLACK BLACK.

« Total Colors
The thread color information for the necessary
threads is displayed. This allows you to check
the total number of thread colors.
Color List " Color changes lors I

Color | Code | Brand | Description | Basic Calor |
1 =0 EMBROIDERY  RED RED
2 MM 00 EMBROIDERY  BLACK BLACK
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Checking Embroidery Patterns

M

* You can select and check the properties of
individual patterns within the embroidery design
by selecting the pattern before opening this
dialog box. In this case, clearing the [Show
about selected Object(s)] check box switches
the dialog box to display properties for all
patterns in the Design Page.

« If the Design Page was set to [Custom Size] or
[Hoop Size] was set to a multi-position hoop
(100 x 172 mm or 130 x 300 mm) or the jumbo
frame (360 x 360 mm), a [Design Property]
dialog box appears with the sewing information
for each hoop of the pattern in the Design Page.

Design Property
‘bout hoop positon 1 /2
I Show about selected Object(s).

FieName:  Uriiled DesignName

Fil Version: 100 .

i

Modfied Date: ety

Widh 10000 mm Auther

Height 10000 mm

Siitchoount: 1054 IS

Fmin Conmert
2

otal 2

Color List @ Colorchanges Total colors

Color | Code | Brand | Description Basic Color |
1M 515 EMBROIDERY MOSSGREEN  MOSS GREEN
2 [ 513 EMBROIDERY  LIME GREEN LIME GREEN

[ Cancel

« Files can be searched for in Design Database
according to the entered information.
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Opening/Importing Embroidery Designs

Opening/Importing Embroidery Designs

Creating anew embroidery
design

Click (&), then [New].

E_ TZ1R0T e IWAL,

o B e T

The size of the Design Page can be changed.

»» "Specifying the Design Page Settings" on
page 14

Opening a Layout &
Editing file
1 Click @ then [Open].

,& | e )

A B T

2  Select the drive, the folder and the file, and
then click [Open], or double-click the file's
icon.

éﬁ'

(&) |® i
l-'!'i
7

f aRTERar
SEESEi cRE
| T IRl

)

M

e To view the data in the selected folder as
thumbnails in the [Browse] dialog box, click
[Browse].

Browse

ol R g

ithdayl1Lpes  Bithday115 pes  Bithdap12L pes  Birthday125 pes

W ¥

Hithday1L.pes  BithdaplS.pes  BirthdayZl.pes

o |

To see a more detailed design, select a file, and
then click [Preview].

N\

Preview

» To open the displayed file, click [Open].

« If nofiles are listed, there are no .pes files in the
selected folder. Select a folder containing a .pes
file.

« If the selected file is in a format other than the
.pes format, the message "Unexpected file
format" appears in the [Preview] window.

M

A file can be opened in any of the following ways.

» Drag the embroidery design from file Windows
Explorer into the Layout & Editing window.

» Double-click the embroidery design file in
Windows Explorer.

» Double-click the embroidery design file in
Design Database.
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Opening/Importing Embroidery Designs

Importing embroidery
designs

Embroidery designs can be imported from the
[Import] pane. For more details on the [Import]
pane, refer to "Example of Importing Embroidery
Data" on page 13.

B From Design Library
1  Click the [Home] tab.

2 Click [Import Patterns] in the [Import] group,
and then click [from Design Library].

IR qu

3  From the [Category] selector, select a
category to display the corresponding
embroidery data.

e im

| hmaar Bltets Sdavag Al KT st

R ﬁ:‘-r'p'll.hw =}

Ceimgn Pl -_i
"
=TT wn
ol
o
o
i Fi b,
e O 17 e .-\.:.:r
Pdorogrere [ scprmon
e o e o

201 DO et 00 ARG il ST DO i

.
] *ﬂi

| R Sy TS e IR

4  Select the file icon for the design to be
imported, and then click [Import].
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M From afolder
1  Click the [Home] tab.

2 Click [Import Patterns] in the [Import] group,
and then click [from File].
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@ Indicates the path to the currently selected
folder.




4  Select a folder, and then click [OK].
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5 Click[File Type] in the [Import] pane. Select
the file name extensions of the corresponding
embroidery data to be displayed, and then
click [OK].

File Type

v PES ¥ PHC ¥ DST ¥ EXP v PCS
¥ HUS ¥ wvIP ¥ SHY ¥ JEF ¥ SEw
¥ CSD IV =4 W PEC

Cancel |

6  select the file icon, and then click [Import].

a

When importing designs from other vendors, be
sure to choose a design that will fit in the Design
Page.

M

Since .dst files do not contain thread color
information, the colors of an imported .dst file may
not appear as expected. You can change the
thread colors by using functions in the [Sewing
Order] pane or by holding down the <Alt>key and
selecting a stitch pattern.

»» "Selecting stitch patterns by thread color" on
page 71

* When importing .dst files, the number of jump
stitches for thread trimming can be specified.

»» "Specifying the number of jumps in
embroidery design of the DST format" on
page 301

Opening/Importing Embroidery Designs

M From an original card

1 Insert an original card into the USB card writer
module.

»» Refer to "Transferring to a machine by
using an original card" on page 202

2  Click the [Home] tab.

3 Click [Import Patterns] in the [Import] group,
and then click [from Card].
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— After the card has been read, the
embroidery designs on the card are

displayed.
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4  Select the file icon, and then click [Import].

a

Due to copyright issues, some original cards
cannot be used with this function.
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Opening/Importing Embroidery Designs

Importing vector images
(WMF/EMF/SVG)

Vector image data in the ".wmf" (Windows Metafile),
".emf" (Enhanced Metafile) and ".svg" (Scalable
Vector Graphics) file formats can be converted to
shape patterns.

1  Click the [Home] tab.

2 Click[Import Patterns] in the [Import] group,
and then click [Import from Vector Image].

AR A

A % Al _'-_ ine e

g i

Vi —

3 Select the drive, folder and file, and then click
[Open].

[EiE]: Flj; .

Page.

3

93

a

» Image, text, width of the line, gradient, opacity,
and any other styles or attributes of graphics will
not be imported. With files in the ".emf" and
".svg" formats, the data is converted while
retaining curves.

» The data on all layers of an SVG file, regardless
of whether it is displayed or hidden, will be
converted into the embroidery pattern.

B Creating an embroidery pattern
using vector images drawn with
other image-editing applications

Being converted to the ".svg" file format, vector

image files created with other commercially

available applications (e.g., ".ai" (Adobe lllustrator

Artwork) and ".cdr" (CorelDraw file)) can be

imported.

First convert the vector image files into either of
WMF, EMF or SVG file format with your
applications, and then import them to PE-DESIGN
by following the steps described in "Importing vector
images (WMF/EMF/SVG)".

M

Raster image files (e.g., ".bmp" and ".jpg") can be
used as background images in PE-DESIGN, or
they can be converted to embroidery patterns
using the Image To Stitch Wizard.

»» For details, refer to page 131.




Opening/Importing Embroidery Designs

Importing embroidery
design from Design Center

1 Start up Design Center and open the file.

»» "Original Image Stage" on page 212 and
"Opening a file" on page 223

2  Click the [Home] tab.

3  Click[Import Patterns] in the [Import] group,
and then click [from Design Center].
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4 Specify the desired settings beside [Import],
[Magnification] and [Orientation], and then
click [Import].

Import Options
Irnprt: * Az Stitches
Az Dutlines
Magnification : |1 0o _% %
Actual size : W 97.9% H 81.8 mm
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Orientatior : * & e m
| 4_|

Cancel |

Import

As Stitches:
Imports, as stitch patterns, embroidery data
created in Design Center.

As Outlines:
Imports, as outline patterns, embroidery data
created in Design Center. This data can be
edited in the same way as outline patterns
created in Layout & Editing.

a

The maximum magnification ratio that can be
specified is the ratio that enlarges the design to the
size of the Design Page.
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Saving and Printing

Saving and Printing

Saving

W Overwriting
Click (&), then [Save].

..Eh’l-f;- AL

A R =%

a

If you select a file type of a previous software
version, saved .pes files can be opened with that
version of the software; however, all saved
designs will be converted to stitch pattern.

If no file name has been specified or if the file
cannot be found, the [Save As] dialog box
appears.

M Saving with a new name

1 Click @ then [Save As].

_..,'-_EE.|-:';;|.' | i®

P e T L =

2  Select the drive and the folder, and then type
in the file name.

95

3  Click [Save] to save the data.

— The new file name appears in the title bar of
the Layout & Editing window.

W Outputting design in a different
format

The data shown in the Design Page can be exported
as a file of a different format (.dst, .hus, .exp, .pcs,
.vip, .sew, .jef, .csd, .xxx, and .shv).

1 Click fi@, then [Export].
_._: EET

* " I.

—— i i s

2  Select the drive and the folder, and then type
in the file name.




3  Select aformat (.dst, .exp, .pcs, .hus, .vip,
.shv, .jef, .sew, .csd, or .xxx) that the file will be
exported as.

M

The [Number of jumps for trim] setting can be
specified for outputting to the .dst format. Before
outputting, click the [Option] button, then
[Options], then [DST Settings] to specify the
settings.

»» "Specifying the number of jumps in
embroidery design of the DST format" on
page 301

a

* Some patterns imported from original cards
cannot be exported.

« Divided embroidery patterns and embroidery
patterns for the jumbo frame or multi-position
hoop will be exported as a single file, and will not
be split into sections.

Printing

M Specifying print settings
Before printing, you may need to change the print
settings for the embroidery design files.

1 Click @ then [Print], then [Print Setup].
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Print Setup

Saving and Printing

o Specify the paper size.
e Specify the paper orientation.

9 To print the embroidery pattern, select
[Embroidery print mode].

e Print type

Actual Size:
Select this option to print the design at
actual size and the sewing information
(dimensions of the embroidery pattern,
sewing color order, stitch count and
hoop position) on separate pages.

Reduced Size:
Select this option to print a reduced
image together with all of the above-
mentioned information on a single
page.
@ Print option

Print image:
Select this check box to print the image
imported into the Design Page in
addition to the embroidery pattern.
However, any part of the image
extending out of the print area for the
embroidery will not be printed.

Print sewing area box & center axes:
(This setting is only available when
[Actual Size] is selected.)

+ : Select this option to print black
lines to indicate the sewing area
(refer to "Specifying the sewing
area" on page 16) and the center
axes for the data.

@ : Select this option to print an
embroidery positioning mark in
the center of the axes.
(This setting cannot be selected if
[Jumbo Frame] has been selected as
the Design Page size.)

Print template grid:
Select this check box to print green
lines to represent the grid printed on
the embroidery sheet included with the
hoop. (This setting cannot be selected
if User Hoop, [Cap Frame], [Cylinder
Frame], [Jumbo Frame], [Clamp
Frame] or [Round Frame] has been
selected as the Design Page size.)
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Saving and Printing

Print hoop section boundaries onto the
first page:
Select this check box to print the
sections of a design where the Design
Page has been set to a custom size or
to [Jumbo Frame]. The pattern
sections are printed in red.

Divide embroidery image into 2 pages:
Select this check box to print at actual
size and on A4- or Letter-size paper a
design that is larger than the paper size
by dividing it in two and printing each
half on different pages.

(This setting is only available when
[Actual Size] is selected in the [Print
Setup] dialog box and when the
Design Page is set to the larger hoop
sizes. This setting is not available if a
[User Hoop] size is selected.)

With this split printing feature, ﬂ / J;L
or I/ (M is printed in the lower-right
corner of the paper to indicate which
half is printed.

Color Changes:
Select this check box to print the thread
color change information for the
pattern.
When this check box is cleared, the
information for the necessary threads
is printed. This allows you to check the
total number of thread colors.

e Stitch image

Normal:
Select this option to print the design as
lines and dots.

Realistic:
Select this option to print a realistic
image of the design. To change the
settings of the realistic image, click
[Attributes].

»» "Changing realistic view settings" on
page 79

a

If the [Divide embroidery image into 2 pages]
check box is cleared and you print on paper of a

2

M

0 When printing an imported image onto

iron-on paper or printable fabric, or when
printing the sheet for positioning the
embroidery in the printed image, select
[Image print mode], and then select an
option under [Material].

Material

Print the image on printable fabric or an
iron-on transfer sheet:
Select this option to print the
background image on iron-on paper or
fabric that can be printed on. Only the
image is printed.

Print a flipped image:
Select this check box to print the image
flipped on a vertical axis. When printing
on iron-on paper, the image is normally
printed flipped (mirror image). (For
details, refer to the instructions for the
iron-on paper that you are using.)
Select this option if your printer does
not have a function for printing a flipped
(mirror) image. (For details, refer to the
instructions for your printer.)

Print a sheet of paper for aligning the

printed image and the embroidery:
Select this option to print a sheet for
aligning the positions of the image and
embroidery. Positioning marks and
guide lines indicating the embroidering
area are printed on the image.

Change Position

The position where the image is printed
on the paper can be changed. (Any part of
the image extending out of the print area
of the paper is not printed.) Click [Change
Position] to display the [Image Print
Position Setting] dialog box, and then
drag the image to the desired printing
position in the paper.

Click [OK].
»» "Changing the display of the embroidery

design" on page 78.

With embroidery patterns for the jumbo frame
The pattern in Side 2 of an embroidery pattern for
the jumbo frame is printed with the orientation of
the actual embroidery (rotated 180°).

larger size, the design does not print in two halves.
Likewise, if you print on paper of a smaller size, the
design might be cut off.
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Saving and Printing

B Checking a print image M Printing a Design Page with
You can preview the contents of the Design Page sewing information
before printing. You can print the Design Page together with its

T ) ) ) sewing information.
Click @ then [Print], then [Print Preview].
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H

1 Click (@), then [Print], then [Print].
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R 2  Select the necessary settings.

Print H

- Printer

Neme: [ Microsoft XPS Document Wrter | Propetiss

Status:  Ready

Type:  Microsoft XPS Document Wiiter v4

Where:  PORTPROMPT:

Commert: I~ Print to file

it rangs Copi
Al Numberof gopies: [1 =]
 Pages from:[1 to:[2

23] K23 F Colate
€ Selection 1 1

cocs

M

The print image can also be displayed by clicking 3  Click [OK] to begin printing.
[Print Preview] in the [Print Setup] dialog box.
4  Follow the instructions for the printer to finish

printing.
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Saving and Printing

99




Creating Embroidery Patterns
Containing Text

This section provides descriptions for entering
text and the various operations for arranging
them. In addition, details are provided for creating
embroidery patterns whose text can easily be

replaced.

From Layout & Editing, various embroidery
patterns can be created for text.

The following types of text can be created.

Built-in fonts:

TrueType fonts:

Small text:

Monogram:

User-defined
fonts:

This software is provided with 130 built-in
fonts. (10 built-in fonts are specifically for
small text)

TrueType fonts installed on your computer
can be used to create embroidery patterns.

These small fonts have sizes between 3 and
6 mm (0.12 and 0.24 inch).

Because of their size, these fonts are useful
for beautifully sewing small text.

Design custom monograms by combining
text and decorative patterns.

User-defined fonts can be created by using
the Font Creator.

In addition, text can be arranged in the following

ways.

Text
arrangement:

Transforming:

The text can be arranged along an outline or
an arc.

Text can be transformed into any of the 26
Transform styles.




Tutorial 2: Using Templates

Tutorial 2: Using Templates

Using the [Template Wizard], you can easily create custom embroidery patterns by simply changing the text
in the patterns that are already available. Follow each step to create a custom embroidery pattern.

The sample file for this tutorial is located at Documents (My documents)\PE-DESIGN 10\Tutorial\Tutorial_2.

Step 1 Starting the Template Wizard

Step 2 Selecting the type of template to be used
Step 3 Editing the text

Step 4 Outputting the edited template

Step 1 Starting the Template
Wizard

When Layout & Editing starts up, the first dialog box
of the wizard appears.

1  Plug your USB media into the computer.

2 Click [Use Template Designs].
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Step 2 Selecting the type of
template to be used

Select [shirtsCH11B.pes] from the category
[Shirts_Chest], and then click [Next].

Select Template Patten
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M

Various templates are available when [Template]
is selected in the [From] selector of the [Import]
pane.

Select [shirtsCH11B.pes] from the category
[Shirts_Chest], and then click [Template
Wizard] to open the Template Wizard.
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Tutorial 2: Using Templates

Click "R" in the text edit box, to be changed,

and then click [Edit Text
— The text is highlighted

1.

Edit Text

FiloName-

widh

Height

SHISCHTTE pes
7150 mm

5920 om

Step 3 Editing the text

Edit Text

FleNeme:  shitsCHTIE pes

Widh 7150 om

Height 5920 om
Stichcount: 3695

Cobr changes  §

Totalcolars: &

oot

o Text list: Edit the text here.

e Preview window: Check the results of the
edited text.

9 Embroidery information for the template

Stchcount: 3696

Colorchenges 5

Totalcoes: 5

s

2 Type "S", and then press the <Enter> key.

— The results of editing appear in the preview
window.
The text "Sweetheart" in the second row is
highlighted.

FleNeme:  shitsCHTIE pes

Widh 7150 om

Height 5920 om
Sticheount: 3973
Cobr changes  §

Totalcolars: &

westhear]

3 Type "Championship", and then press the
<Enter> key.

4  Click [Next].

Edit Text

FleName:  shitsCHTTE pes

wdh 7150 om

Height 5920 om
Stichcout: 4374

Cobrchanges 5

Totalcolars: 5

Cancel Ne>
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Tutorial 2: Using Templates

Step 4 Outputting the edited W Outputting the edited template

USB media, a sewing machine, an original card or
template . o :
P the Link function can be selected as output
destinations.
canssimrer: ————— @) 1  Depending on the desired output destination,
Sedlo prepare the USB media or original card.
§ [F1UsB Meda — 0 Otherwise, connect the embroidery machine

—- [3) to the computer.

2  Select the output destination from the [Send
To] selector, and then click [Send].

Edit in Design Page

~Sendto

< Previous Cancel Create New Embioidery Dasign it o
P ————

# [FIUSE Media
o Edit in Design page
Click this button to open the template in a

Design Page, where it can be edited or 1Dh10M W,

saved. 1 USE Meda
e Send to selector 5}[B] Sewing Machine
Select the output destination. ;Card\vriler
< Previous Cancsl Link.
9 Send
Click this button to output the template. n
@ cCreate New Embroidery Design o )
Click this button to return to the dialog box * Select an output destination according to the
for selecting a template. A different method used to transfer data to your embroidery

machine.

« When no output destination is found, the [Send]
button will be grayed out and unavailable.

template can be edited.

1 In the [Send To] selector, select your USB

. ) »» "Transferring Embroidery Designs to
media to be used, and then click [Send].

Machines" on page 201 and "Using the Link
Function to Embroider From the Computer” on
page 204

Editin Design Page

[ Sendto

i [F]USE Media -

< Fievious Cancs! ||+ [ Crmote News Enbrricy Desion

2 Tocreate another embroidery pattern using a
different template, click [Create New
Embroidery Design]. The dialog box from
Step 2 appears.

To close the Template Wizard, click [Cancel].

103




Template Feature

Template Feature

Saving your design as a
new template

A design that you have created can be used as a
template.

1  Create an embroidery pattern that contains
text.

2  Apply the [Name Drop] attribute to the text.

»» "Tutorial 5: Creating Name Drop" on
page 124 and "Name Drop Feature
(Replacing Text)" on page 127

3 Click @), then [Save As].

7= R

@.

e EEEA s =y

fﬂq:lT;

4  Save the created embroidery pattern in a
folder of the [Template Library] folder. Select
the folder (Drive where PE-DESIGN was
installed)\Program Files (x86)\Brother\PE-
DESIGN 10\Template Library\Sample, type
in the file name, and then click [Save].
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Tutorial 3: Entering text

Tutorial 3: Entering text

This section describes the procedures for importing a transformed text pattern and editing the text.

»
.
.
.
-
-~
El
. -
- -
E
1
Ll
i)
| : ]

The sample file for this tutorial is located at Documents (My documents)\PE-DESIGN 10\Tutorial\Tutorial_3.

Step 1 Importing a transformed text pattern

Step 2 Editing entered text

Step 1 Importing a transformed
text pattern

Import a text pattern from the [Import] pane.
1  Display the [Import] pane.
2

Select [Text] from the [From] selector and
[Transformed] from the [Category] selector.

Select [TT_001.pes], and then click [Import].

I 1 =
Bl e Mg il Mg sts

i Cimpud

|Hl|. I'll.-\.'

=
|:..m [Tomsmmd _|

""’.pf" TEET

11_0I8 psa

B,
[FT 8 |

TT K

TExy THEET TELT

T T 00Gpee  TT_ N

*EXT TExXx TFEXT

T MTpai 11 00 Ea

it ]

T W08 e

M

Sample built-in font patterns are available in the
[Import] pane when [Text] is selected in the
[From] selector.

105

Step 2 Editing entered text

1

2

M

Select the imported text pattern, and then click
the [Text Attributes] tab.
Click in the text field.

— The text pattern appears as dotted lines,
and the cursor appears at the end of the
text.

Press the <BackSpace> key to delete the

text, and then click characters in the character
table to enter text. Finally, press the <Enter>
key to apply them.

o W rome By ARy

For details on other ways to edit text, refer to the
section indicated below.

4

'Editing entered text" on page 107




Advanced Operations for Entering Text

Advanced Operations for Entering Text

6  Press the <Enter> key or click the Design

Entering text

Page.
1  Click the [Home] tab. SR 1, i
2  Click [Text] in the [Tools] group, and then e L | »

1 ‘: F
click & . i [» | :-A-B ]
PIT= - I — !
et -+ |1
I H n ; .Ai ! {I R I a
e Ll | O e |
e =T =

<Enter> key to enter a new line of text.

' * Hold down the <Ctrl> key and press the
' « Characters can also be entered by clicking them

i R — in the character table. This is particularly useful
- ; if you have to enter accented characters that are
oo i de not available on your keyboard.

3 If necessary, change the font, text size, color
and sew type.

L]

»p» "Setting text attributes" on page 107 and
"Embroidery attributes for text" on
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page 117 '__..........-u.u_....'.' 12|
4  Click in the Design Page. * Click [Hide List] to hide the character table.
_ While it is hidden, click [Show List] to display
19 . . . . 150 Text Attributes
~ - limport El Color Hifsen the character table.
|
If the entered character is not available with the
5 Type the text. selected font or if the character cannot be
5 o pyr— converted to an embroidery pattern, the character
A | flimport B color filfseni appears as | | in the Design Page. If this occurs,
ABC enter a different character.
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Advanced Operations for Entering Text

Editing entered text

Switch to one of the following text edit modes, and
then type text as needed using the cursor appearing
at the end of the text.

M Using Text Attributes tab

1  Select a single text pattern.

2  Click the [Text Attributes] tab, and then click
in the text field.

Bl [T, - T H'mnl.u-l.
‘AE-'H

HEFANRNNE N -
IFI'-H-nEr q Ii__
IBICIDiE F kM1 I Iniok

B Using Edit text tool

1  Select a single text pattern.

2  Click the [Text] tab, and then click [Edit Text]
in the [Edit] group.

Unified - Lnpons B Exdiing

S E——

W A e L |

B Using keyboard

1  Select a single text pattern.

2  Press a character key in the keyboard.

B Using Text tool
1  Click [Text] in the [Tools] group of the

[Home] tab, and then select # .

-E‘"'.'- e S L

g =

|h E . ' .-\.I-ﬁ-i-l = : it

Tried e T

2 Click a text pattern to edit.

107

Setting text attributes

Text attributes can be specified with the [Font]
selector and [Text Size] selector in the [Text] tab.

P TEAE -

h A: 0l P a1 T | ==

(L E Vil =1 | i i | R
sz L= e

M

The [Text] tab appears when a text pattern or a
Text tool is selected.

M Font

Click the [Font] selector, and then select the
desired font.

o 6 © o0
1 | |
[oo1][ABC] [s=r 01][i10mm -]

o™ ABC s=t01 comm-)

T ABC Aal

001 ABC Serf 01 {10mm -)

002 m Script 01 (10mm -)

113 (AP Totaly Gothic (10mm -)
120 A'Bc \ista Sans At Regular (10mm - )
h ABG Sample

T ABC Ahaoni
T asc Aldhabi
T sBc Andalus

ol |-

o Font Type
* A number identifies built-in fonts.

« Iy identifies user-defined fonts.
. '.ﬂj identifies TrueType fonts.

e Font sample
If a single string of text is selected, the
fonts in the list appear with the selected
characters.

9 Font name
0 Recommended minimum size
6 Most recently used fonts




M

» User-defined fonts

PEF files created with Font
Creator and saved in the [MyFont]
folder where PE-DESIGN was
[h installed appear as userdefined
fonts after the fonts listed in the
table above.
The UD icon appears on user-
defined fonts.

»» "Font Creator" on page 274

* TrueType fonts
The installed TrueType fonts appear after the
user-defined fonts.

M

TrueType font settings can be changed in the
[TrueType Font Attribute Setting] dialog box.

»» "Specifying TrueType font attributes" on
page 110

Advanced Operations for Entering Text

4  Select the check boxes for the fonts to be

displayed, and clear the check boxes for the
fonts to be hidden.

Font Filter Settings
The selected fonts will be displaved in the font fizts.

v Buil-ln Forits

¥ Elack W Serif
¥ Script v Gothic
¥ Decorative ™ Monoaram

¥ User-Defined Fonts

¥ TrueType Fonts

Default | Cancel |

The [Monogram] check box is available when
a pattern with a monogram font or the
[Monogram] tool is selected.

5  Click [OK] to apply the filter settings.

M

To return the fonts to the default (all fonts
displayed), click [Default].

a

» Text created using certain TrueType fonts may
not be converted correctly into an embroidery
pattern due to the shape of the character. These
characters cannot be embroidered correctly.
Test sew before embroidering on your project.

« In addition, text created using some TrueType
fonts cannot be converted at all.

M Font Filter

A font listed in the [Font] selector can be selected.

1  Click text or a monogram, or select the [Text]
tool or [Monogram] tool.

Click the [Text] tab.

Click q beside [Font Filter] in the [Font]
group, and then click [Font Filter Settings].

NENTEL TSR,
e T o

h A_: o AR s e . i
re= | Frel | i l W Aeaiia
s | [ e ot |

6 o filter the fonts, click [Font Filter] so that it

appears as |Fant Fiiter |,

Clicking the button switches between filtering
and unfiltering the fonts.

E_" LEEE

The font filter cannot be applied to small text fonts.
»» "Small Text" on page 118
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Advanced Operations for Entering Text

M Text size 3  Change the text attributes.

Click the [Text Size] selector. Type the desired
height and press the <Enter> key, or select the 3 T R s —
desired value. =

T AATER =

Built-in fonts are listed in the [Font] selector with the e

recommended minimum size. We recommend

using these fonts at a size equal or greater than the el |

size indicated. oL FRTT

QO—fews T Hm e
=| Font Filt
50 2k [o01 ABC sedfoi| lomm-) | |- © — vemcammet UV inn 4
I © — Far ok
[ ¢ Chm -
O—flo i =l o
© — betirzey [ 2] kb 2
@® Recommended minimum size O — ke E !_ |
P . . —— Dwsctn =% (=]
M Specifying various text attributes o ' a8 | &l
1  Select the text. Ol
(o) — —

2  Click the [Text Attributes] tab. — "
N i i _. .-.- .?- T _-
= B et e --.-||-|| b i CE e Yo,
L]E;‘:i ARG o= = e W T

AL AR AR AR
Suale 2
—— . i B AR AT
| Fom @ = =
i T o AEC AR /
| ]| B c O— Hembim |
':\_"} o =, ﬂ ™
b e p apc#ac | F3T
[TEC-FATREIN e —
If the [Text Attributes] pane is not displayed,
click the [View] tab, then [Attributes], and o .
then click [Text Attributes]. Kerning
0.0 mm 5.0 mm

(between "A" and "B")
ABC A BC

e Vertical Offset

ABC ABC

9 Rotate Angle
0° 20°

ABC % @

109




e Character Spacing

0.0 mm 2.0 mm
ABC ABC
6 Line Spacing
100% 150%

ABC

def

def

® Alignment
det | ‘Nt | &t

Direction

Horizontal Vertical

ABC

e Transform
»» “"Transforming text" on page 111
0@

Click to return to the default setting.
@ Name Drop

»» "Name Drop Feature (Replacing Text)"
on page 127

M

« Both [Kerning] and [Character Spacing] set
the spacing between characters. [Character
Spacing] is always applied to the entire text
pattern, while [Kerning] can be applied to
individual characters.

»» Refer to "Editing individual characters" on
page 113 for more details about selecting
individual characters in a text pattern.

 Settings specified for [Kerning], [Vertical
Offset] and [Rotate Angle] in the [Text
Attributes] pane are applied to all selected
characters.

Advanced Operations for Entering Text

1
2

a

W Specifying TrueType font

attributes

Select text in a TrueType font.

Click [TTF Settings] in the [Font] group.
| .._.“L]",,n.' "-"

e T T e

= ‘q. T A i Daci —

It L= igw

Select a font style from the [Font style]
selector, select a character set from the
[Script] selector, and then click [OK].

TrueType Font Attribute Setting

Font: Arial Black Fant style:
Sample IHeguIar
AaBbeZz Italic .
EBold

Bald Italic
Black. v

Cancel |

The settings for [Font style] and [Script] differ
depending on the TrueType font that is selected.

If text created from multiple TrueType fonts is
selected, this command is not available. In
addition, if text of the same font but different font
styles or scripts is selected, this dialog box
appears with the attribute settings for the first
letter in the text. In either case mentioned above,
selecting only one character from within text
displays a dialog box containing only that
character's attributes.
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Advanced Operations for Entering Text

B Transforming text

ABCDE B A®BCDE

1  Select the text.

2  Select the [Transform] check box, and then
click the transformation shape button.

(¥ = LA
G S TR - Ee—

\RECDEF

—

= L 18
MEE;E | apc ane |epe dma
ST
Bl BT B 40
Sl ABEG MDD ARG

Depending on the selected shape, a dotted
line and ‘ or ‘ appear around the text.

ABCDE W néDE
Q

A text pattern contains data for both line and
region sewing. Therefore, if this command is
selected, depending on the form of the font, there
may be a gap between the line and the region in
the text.

3 Drag ‘ to transform the text.

antos WP ARCDE

M

. ‘ can only be dragged vertically.

. ‘ can only be dragged horizontally.

» To return the transformed text to its original
shape, clear the [Transform] check box.

‘ABCDE ™ ABCDE

If was selected in step 2, the following
operations can also be performed.

Drag ‘ < and ‘ to transform the text.

L Adiusts the text si?e.
§ g
¥
B0y

“ :Moves the text along the circle.

’ :Adjusts the radius of the circle.
" '. "
o R
L ? [ 6‘_ [

pBOY.
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M

Depending on the shape selected under
[Transform], different handles appear for editing
the text.

¥ Transfom

¥ Transtom

ABC|ABG, AEC ABG [aBC| A pBC ABg
ABC| ABC| 227 \Ss. ABC | ABC| 227 NS,
Ayg) aB<| ABC ABC AR B ASC| ABC
A5G| laBo| ASC| ABC AsC aBc ABC ABC

Fitting text to an outline

Abcdef

1 Select the text or small text and an outline.
‘Abcdef

2  Click the [Home] tab.

3  Click [Group] in the [Edit] group, and then
click [Fit Text to Outline].

Urirgel - Lapsg & Edimg

u e v Y ppangs 1l
el B U N -
| e
i || sesag
T = = =il

Advanced Operations for Entering Text

4

Specify the desired settings in the [Fit Text to
Outline Attribute Setting] dialog box, and
then click [OK].

Fit Text to Outline Attribute Setting e
|
o — Horizontal Yertical Text |
Alignment; Alignment; Orientation; e
[_ABC ~| |_ABC ~| |B&C -
e =" the other side TR Cancel |

o Horizontal Alignment

I—_,g BC - y,bﬁdet/,
I—_lchv Ab%i

[—aBc-|  Yad
caBCT -] D Pogs

[A B C~| pPeyes

e Vertical Alignment

[_ABC ~| »"%r
[ABE— -] pPTep.

9 Text Orientation

R8C -~
[ABC -

e the other side

pYOdoe .

o g

[ the ather side

W the ather side

112
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Advanced Operations for Entering Text

a

« When fit text to outline is specified, the text
transformation is cancelled.

« Only one string of text can be arranged on a
single outline.

M

» To change the position of text on the outline,
select the text, and then drag it.

» The settings for some text attributes ([Size],
[Character Spacing], [Vertical Offset] and
[Rotate Angle]) can be changed for single
characters, even with text fit to an outline.

»» "Editing individual characters" on page 113

B Releasing text from an outline
Abcdef

v”"“’@u-}/\/

1 Select text or small text that is arranged on an
outline.

2  Click the [Home] tab.
3 Click [Group] in the [Edit] group, and then

click [Release Text from Outline].

irrirtacs - Larvonil & B

e [IED |_-\- Wit i frore
s - —" e

=

F B i F1kE

Editing individual
characters

1  Select the text.

2  Select characters in the text.

To select a single character, click <. for the
character.

‘ABCDEE
¥
*ABCDEF

o Rotation handle
e Size handle
9 Vertical offset handle

Individual characters can be rotated, resized
or repositioned. In addition, when text is
selected, click the [Text] tab to change the
thread color and sewing attributes.

M

Multiple <> can be selected and the selected <.
can be changed in the same way that embroidery
pattern points are selected.
 Drag the pointer.
— All points within the box are selected.
* Hold down the <Ctrl> key while clicking the
points.
— To deselect a point, click the selected
point.
» Hold down the <Shift> key while pressing an
arrow key to select multiple points.
» Hold down the <Ctrl> key while pressing an
arrow key to change the point that is selected.

»» "Selecting points" on page 66
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Advanced Operations for Entering Text

2 When you release the mouse button, the

Changlng a CharaCter Slze character spacing is changed.

and character's attributes
You can easily use drag operations to change the AB c
size and text attributes.

B Changing the size

1 Bring the pointer onto the upper right ‘ B Changing the vertical offset
handle. 1 Bring the pointer onto the lower ’ handle.
2 Drag the handle. 2  Drag the handle vertically.

ABG ABG
£

SR A
ABG- ABG

3 When you release the mouse button, the
character size is changed.

3  When you release the mouse button, the
character offset is changed.

AasC ARY

M Changing the kerning M Rotating the characters
1 Place the pointer onto the character body 1

other than the ‘ ‘ @ handles, and drag 2
the character horizontally.

¥
ABG ABG:

Bring the pointer onto the @ handle.
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Drag the handle.
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Advanced Operations for Entering Text

3  When you release the mouse button, the
character angle is changed.

AB

Converting text patterns

Text pattern

4 N

*Blocks: A group of shape patterns with multiple
sewing direction lines

After being converted, text attributes are no longer
available, but the following editing operations can be
performed.

Convert to Blocks

The pattern is converted while maintaining the
multiple sewing direction lines.

The character shapes can be partially rearranged.
Convert to Outline

The text is converted to shapes, which can be
edited.

Various sew types or embossing/engraving effects
can be applied.

M

For details on the shape pattern and text pattern,
refer to page 8.

115

M Converting text to blocks

Phd g

Text can be converted into blocks, allowing you
reshape characters. By changing the sewing
direction line in each of these small regions, you can
create text patterns that appear like manual
embroidery.

1  Select the text or monogram text.
2  Click the [Text] tab.

3 Click [Convert to Blocks] in the [Edit] group.

—
I T P lpme e 'u:
e

a

Small text cannot be converted into blocks (shape
patterns with multiple sewing direction lines).

M

» The text pattern is converted with the original
sewing quality maintained.

» The shapes of created blocks can be edited in
their finest details.

»» For details on editing blocks or outlines, refer
to "Reshaping Embroidery Patterns" on
page 66

 Since the text data is no longer available, the
text cannot be edited.




Advanced Operations for Entering Text

B Converting text to outline pattern . : :
g P Selecting connection point

E‘Eﬁ?:’;; positions in a text pattern
- . - o
» » 2! | - The positions for connection points between

i.t.;l;

1o characters within the same text (end point of one
RhREr character and the start point of the next character)

can be specified.

The available settings are [Default], [Closest] and

1  Selecttext. [Farther].
2  Click the [Text] tab. 1  Select the text or monogram text.
3 Click[Convert to Outline] in the [Edit] group. If the [Sewing Attributes] pane is not
- displayed, click the [View] tab in the Ribbon,
Uindifed - Lagcad & Exiting and then click [Sewing Attributes].
- oy o] T comers s 2 Click a setting under [Connection Points].

e | = ——

i L. PRI | Hime Bieeya Wi sm-

M ~ ==
. |

Transformed shapes are grouped. In addition, hole
sewing is automatically specified for openings

(such as the triangle inside the letter "A"). &
| el Solaf
| :l-m.-... rll. 1 ]
P el e [
a " I::-r-l T 'l Faiis

T
Text patterns created with built-in fonts 025 and | | |

029, user-defined fonts or small text fonts cannot o (o) ()
be converted to outlines.
o Default

i
M 2
» When a pattern is converted outlines, the sewing !B

quality will decrease slightly.

» The sewing direction will become uniform, but it
can be edited.

Stitches are created in the default sewing
order for good stitching quality of all
»» "Specifying the sewing direction" on page 51 characters.
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« Since the text data is no longer available, the
text cannot be edited.
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Advanced Operations for Entering Text

e Closest

ABC

Stitches are created at the shortest distance
between the end point of one character and
the start point of the next character. This
shortens jump stitches and reduces the
number of times that the thread is trimmed.

9 Farther

ABC

Stitches are created at a farther distance
between the end point of one character and
the start point of the next character. This
lengthens jump stitches so they can easily be
trimmed manually.

A Connection Points setting can be selected
not only for region sewing, but also for line
sewing.

a

» These settings are not available with text
created using built-in fonts 025 or 029, a
TrueType font, a user-defined font or a small text
font.

» These settings are not available for text
containing characters of different colors.

» These settings are not available for text where
the sewing order of the characters is not
continuous.

117

Embroidery attributes for
text

The Sew group in the Attributes tab allows you to set
the embroidery attributes (thread color and sew
type, outline and inside region on/off).

When text is selected, settings can be specified for
the following.

e Limi e - L P

85 s+ [N
T || At st iy —‘
- _[ |
(1) e (2]

o Line color/Region color
Sets the thread color for outlines and
inside regions.

»» "Color" on page 46

e Line sew type
Sets the sew type for the outlines.

Except with builtin fonts 025 and 029, and
a user-defined fonts, all sew types are
available for lines in text.

»» "Line sew types" on page 49

9 Region sew type
Sets the sew type for an inside region.
[Satin Stitch], [Fill Stitch] and [Prog.
Fill Stitch] are available for lines in text.

»» "Region sew types" on page 49

a

» Text patterns created using built-in fonts 025
and 029 or user-defined fonts only have an
inside region. The thread color and sew type for
only the region can be selected.

« Sewing attribute that can be set with Text under
sewing. For details, refer to "Region sewing
attributes" on page 331.




Advanced Operations for Entering Text

i i

« Toturn off line sewing, select [Not Sewn (Line)] Sample small text font patterns are available in the
from the [Line sew type] selector. [Import] pane when [Text] is selected in the

« To turn off region sewing, select [Not Sewn [From] selector and [Small Text] is selected in the
(Region)] from the [Region sew type] selector. [Category] selector.

« The variety of embroidering effects possible »» "Example of Importing Embroidery Data" on
differs depending on the selected combination of page 13
settings for line sewing and region sewing.

Line sewing Region sewing

specified specified B Editin g sm all text

(Text Outline Sew (Text Body Sew .

T T Small text attributes can be selected from the [Text]

ype) ype) .

tab, the [Text Attributes] pane and the [Color]
pane. When the small text tool is selected, the

Any other than [Not | Any other than [Not [Text] tab appears as shown below

Sewn (Line)] Sewn (Region)] PP ’

LT T T
LE L]

[Not Sewn (Line)] Any other than [Not
Sewn (Region)] m

The [Text] tab appears when a small text pattern

Any other than [Not | [Not Sewn or the small text tool is selected.
Sewn (Line)] (Region)]

Small text fonts

S, 05 @B Calgary Medium talic SR |T|||.| |~

Small Text SL01ABC UtshBold S (56mm)
.02 ABC Belgium 5 (56 mm)
0\ S, 03 ARBC Calgary Medium talic 5 (5-6 mm)

S04 ABC Utsh SR (34 mm)

» "Fonts Suitable for Embroidering” on SL05 ABC Calgary Medum talic SR (3-4 mm)
page 303 S, 06 % Script 01 SR {4-6 mm)

Sp, 07 #84% Block 035 (56 mm)

5t08[ABL|  [Block 07 SR{4-6 mm)|

M Entering small text é é é ¢!)

Precautions for embroidering small text patterns.
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1  Click the [Home] tab.
o Font number

2  Click [Text] in the [Tools] group, and then
e Font sample

click ase

_ ©® Font name
=t s EL m L] Imiigd - Ly i
s O Recommended size
o | i <] »> "Font List" on page 340

3 Enter text in the same way that regular text is
entered, starting with step 3.

»» "Entering text" on page 106
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Advanced Operations for Entering Text

a

Only built-in fonts specifically for small text can be
used.

»» For a list of the built-in fonts specifically for
small text, refer to "Small Text" on page 342.

The settings for all small text attributes except the
font are specified in the same way that they are
specified for regular text patterns.

However, with small text, settings cannot be
specified for the following.

e Sew type

¢ Sewing Attributes
¢ Transform

¢ Name Drop

M

To edit an entered small text, select the small text
with the [Select] tool, and then type the new text
into the text field in the [Text Attributes]
pane.There are three other ways to edit text.

»» "Editing entered text" on page 107

B When sewing small fonts

For best results when using your embroidery
machine to embroider patterns containing small font
patterns, follow the recommendations described
below.

1 Reduce the thread tension to less than what is
used when embroidering normal designs.

2  Sewataspeed slower than what is used when
embroidering normal designs.
(For details on adjusting the thread tension
and sewing speed, refer to the Operation
Manual provided with your embroidery
machine.)

3 Do not trim the jump stitches between the
characters.
(For details on setting the machine for thread
trimming, refer to the Operation Manual for the
embroidery machine.)

119




Tutorial 4: Monograms

Tutorial 4: Monograms

The sample file for this tutorial is located at Documents (My documents)\PE-DESIGN 10\Tutorial\Tutorial_4.

Step 1 Entering monograms

Step 2 Adding a decorative pattern

Step 3 Changing character size of the monogram

Step 4 Changing the thread color and sew type of the monogram

Step 1 Entering monograms 4  Click [Edit Text] in the [Edit] group.

Unttbed —Lmpout & Eddamng
1  Display the [Import] pane.

Q
@
=,
=.
| T — «Q
2  Select[Text] from the [From] selector and - el 01— FBFI
[Monogram] from the [Category] selector. el o bbb =3
Click [TM_002.pes], then [Import]. g_.
e i — The text pattern appears as dotted lines, @
| dwwet | Bl Caat B ek . A T and the cursor appears at the end of the <
|n:_ T = | text. ;,U
. @
||:ql'm Pk yipery E | e 3
1 — 2]
{ o W 0
ﬂl{lﬁl i =
Tt s | SRR | TSt ] %
=
5 Pressthe <BackSpace> key to delete the (f'
text, and then use the keyboard to type in 1
"XYZ". —+
6  Press the <Enter> key.
— The text appears in the Design Page.
—_— »
il | | ] |

M

Sample monogram patterns are available in the
[Import] pane when [Text] is selected in the . .
[From] selector and [Monogram] is selected in
the [Category] selector.

3  Select the imported monogram pattern, and
then click the [Text] tab.
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Tutorial 4: Monograms

M

« In this example, a monogram pattern was
imported from the [Import] pane; however, a
pattern can also be created by selecting the
Monogram tool, then typing in text.

»» "Entering text" on page 106

» Characters can also be entered from the
character table in the [Text Attributes] tab.

Ji s P Al

o sy B Bt

* You cannot insert line feeds.

* A maximum of three characters can be entered.

* Only uppercase letters (the characters

displayed at the character table) can be entered.

Step 2 Adding a decorative
pattern

A decorative pattern can be added.

1 Display the [Import] pane, and select
[Decorative Pattern] from the [From]
selector.

2  Select the monogram.

121

3  Select [Monogram Decoration] from the

[Category] selector. Click [Deco09.pes],
then [Decorative Import].

Ll vmmi - TR Coind . 0 kg . ] Tk k..

4 p 4 »< >

Dl ps Oeofps:  DeoollfEn

€ >4 >y

Dl py  OocoMpe | Pomliion -

= it freverron
HEmt | et

— The decorative pattern is added.

M

« If a monogram is selected, the [Decorative
Import] button and [Maintain aspect ratio]
check box will appear.

To import the decorative pattern adjusted to the
size of the monogram while maintaining its
original height-to-width proportion, select the
[Maintain aspect ratio] check box. Clear the
check box to import the decorative pattern with
its height-to-width proportion adjusted to the
monogram.

« If no monogram is selected, the button will

appear as the [Import] button. Clicking this
button will import the decorative pattern at its
standard size.




Step 3 Changing character size
of the monogram

B Changing the character size of the
monogram

Click the [Text Size] selector, and then type in "22".

1 } 1-._].. [y 'h.d
e T
iR A W e -
i E oy R
= =l i

Diamond and Script are fonts exclusively for
monograms. You can also use the built-in fonts or
TrueType fonts.

»» "Editing monograms" on page 123

Step 4 Changing the thread color
and sew type of the
monogram

Click the point for the monogram character whose
settings are to be changed.

<Ky

@ Click here.

Kt

Tutorial 4: Monograms

B Changing the thread color
1 Click [Color] tab to display the color palette.

2 Click [TANGERINE].

Ll [ —

4 R

Koy o

m R ER
AEECE

[ § F |
]

i B
aEE ]

3  Select the characters "YZ", and then click

[RED]. |
Ko 5o
P
EE

B Changing sew type
1  Click the [Text] tab.

2 Click the [Text Body Sew Type] selector in
the [Sew] group, and then select [Fill Stitch].

s nsiici ==

S E—
Crr—
1 :_"'
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Advanced Operations for Entering Monograms

Advanced Operations for Entering

Monograms

Editing monograms

Monogram attributes can be selected from the
[Text] tab, the [Text Attributes] pane, the [Sewing
Attributes] pane and the [Color] pane. When the
Monogram tool is selected, the [Text] tab appears
as shown below.

3 m-b_“.. ] e Pl Soemsiery vt
1 Furd B A

M

The [Text] tab appears when a monogram or the
Monogram tool is selected.

B Monogram font

Click the [Font] selector, and then select the
desired font.

0O 6 ©

M. ‘r; Diamand
T XYZ Anal

M. (r; Diamond

% 332 e

ol Y F senf

i W_‘E‘ Serpt 01

19 %Y 2 Totaly Gothic

120 x Y Z Vista Sans Alt Regular

H XYZ Sample
B XYZ sharoni

H ez Aldhabi

|

o Font Type
* A number identifies built-in fonts.

. l'% identifies Monogram fonts.

e Font sample
If a single string of text is selected, the
fonts in the list appear with the selected
characters.

9 Font name
0 Most recently used fonts

123

M

Diamond and Script are fonts exclusively for
monograms. You can also use built-in fonts, user-
defined fonts and TrueType fonts.

»» For a list of the built-in fonts and monogram
fonts, refer to "Font List" on page 340.

The settings for all monogram attributes except the
font are specified in the same way that they are
specified for regular text patterns.

However, with monograms, settings cannot be
specified for the following.

« Rotate Angle, Character Spacing, Line Spacing,
Alignment, Direction

¢ Transform
¢ Name Drop
¢ Fit Text to Outline

M

« To edit an entered monogram, select the text
pattern with the [Select] tool, and then type the
new text into the text field in the [Text
Attributes] pane.

» There are three other ways to edit text.
»» "Editing entered text" on page 107




Tutorial 5: Creating Name Drop

Tutorial 5: Creating Name Drop

By creating an embroidery pattern containing text and using the Name Drop function, you can easily create a
number of similar embroidery patterns, for example, for uniforms, by replacing only the name in the pattern.

&0,

Ern&f‘ *‘ih E:";'*‘

S 5D

qn drﬁ

ﬂ.rf‘g

The sample file for this tutorial is located at Documents (My documents)\PE-DESIGN 10\Tutorial\Tutorial_5.

Step 1 Designing the embroidery pattern
Step 2 Creating the list
Step 3 Outputting patterns using text from the text list

Step 1 Designing the embroidery
pattern

1 Display the [Import] pane, and select [Design
Library] from the [From] selector.

2  Select [Misc] from the [Category] selector,
and then drag the rainbow pattern into the
Design Page.

3  Click the [Home] tab.

Click [Text] in the [Tools] group, click & ,
and then click the Design Page.

[P IT=- ETEnE

g _ -
T e A i
i

Type in "Fernand", and then press the
<Enter> key.

E= & .-:- d — =t e e
L I sy B
. T ; i
. TFernand =

Select the text pattern, select the [Transform]
check box, and then click 5‘.

f

[T ——

b":_" I Bl e B rs . il

FEI -

ciialt I

- = -

F e laeti]

¥, PEC ABC 4 .
45T ABC REC A
PG ARG spc AEG
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Tutorial 5: Creating Name Drop

7  Drag the pattern to adjust its position.

Step 2 Creating the list

1 Select "Fernand", and then select the [Name

Drop] check box, and click [Name Drop List]
button.

10 . . . . 150 Text Attributes
~ limport H color #Mlfsewing At

ABUTABCAE
aBC|/ABC 22" X
ABC)[ABS %80 A
PBC|laBgl ABC A
ARG laPS |ABC| A
AsC|laBC ABC] A

¥ Name Drop | | fiame Drop Cist 7
TErEEE

2  Enter text in the list. In this example, we will
add text at the end of the list.

(1) Click acellinthe + row and click [Edit
Text], or click the cell to enter input mode.

Name Drop List

| Edit Text Il Inzert I Delete Import C!

[ 1 |

1 Fermand

+

(2) Use the keyboard to enter the text.

Name Drop List

Edit Text I Insart I Delste

| 1 |

1 Fernand

+ |Gabrielle|

|mpart C!

(3) When entering text, press the <Enter>
key so that the cell in the next row enters
input mode.

Repeat steps (1) through (3) to create the text
list.

M

Selecting a cell containing entered text allows you
to preview that text.

Narme Drop List

oo | [ e oo impor .| e

6 Dorian
+

Step 3 Outputting patterns using
text from the text list

Let's practice outputting the patterns to files.
Embroidery data with the text replaced by each row
of text in the list can be outputted.

1 Click[To Folder].

Link. To Folder.

"Dutput MName Drop Data

2  Select the drive and folder in the dialog box

that appears after clicking |2, type the name

of the file in the [File Name] box, and then
click [OK].

To Folder “

C:AUsersiNAT 38WDEND acuments'PE-DESIGH 10

|F\Ia Marne: IHainbou\l |

Mate: The files will be saved with sequential numbers.

Cancel

— This application begins checking that there
are no errors in the embroidery data. If no

errors were detected, it begins outputting
the data.




Tutorial 5: Creating Name Drop

M

The files are named "<file_name>xxx.pes" (where
"xxx" are consecutive numbers starting with 001).

3  After the data has been outputted, the
following message appears. Click [OK].

byt heEriting =}

n Frahed aetputing Herm Drop deis

An embroidery file is saved in the selected
folder for each line of text in the list.
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Name Drop Feature (Replacing Text)

Name Drop Feature (Replacing Text)

Text attributes with Name M
Drop attribute app lied The [Name Drop List] dialog box for a text pattern
can be displayed by selecting a text pattern with
o 0 0 the [Name Drop] attribute applied, clicking [Text]
[ ] 1 in the [Home] tab, then clicking [Text], then [Open
— EI @ é : Name Drop List].
"""" Difectior = | 4l ill:-.llj q.l: — I-: Ak
— SRR T e Ty
@E@ESL‘] "-"I:'| . i.—'\'— ﬂik T
~% ﬁf
.
ARG APS
AT [aBC
— tlane Diop | Name Diop L 1 © Maintain aspect ratio
A G If this check box is selected, the height-to-
= width proportion of the text is maintained.

O © 90 0606

M Alignment
o Name Drop
If this check box is selected, the [Name Y Ye BB
Drop] attribute is applied. © = .A..BC

a

* When the [Name Drop] attribute is applied, the
settings for [Kerning], [Vertical Offset],
[Rotate Angle], [Character Spacing], [Line
Spacing], the character size and color will be
reset.

4g°D + amcp @s anoomng

ABCDEFg

» The [Name Drop] attribute is not available with
text where the [Fit Text to Outline] command
has been specified, small text or monogram text.

e Name Drop List
Click this button to display the [Name
Drop List] dialog box.
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Name Drop Feature (Replacing Text)

Functions in the Name M
Drop List dial 0g box If the pattern contains two text patterns with the
[Name Drop] attribute applied, the text list
006 0 O © 0 appears as shown below.
| | | | | Name Drop List
Name Drop List ‘ o ‘
O R A §
L 2
o1 P

B Saving /importing a text list (CSV)

2, || TR
|_ =1 e Saves the created Name Drop List.
| | Click this button, select the drive and
© © © folder, type the name of the file in the [File
o Name Drop List Name] box, and then click [Save] to save
5 the list as a .csv file.
Create the list of text to be used to replace
text in the pattern. Double-click a cell to @ Imports a Name Drop List as a .csv file.
enter input mode. Click this button, select the drive and
Select a row to dlsp|ay a preview of the fOlder, click the name of the ﬁle, and then
pattern with the text in that row. A row in click [Open], or double-click the file's
the text list can be selected by pressing icon.

the or key.

e Click + to add arow at the end of the
list.
(Up to 500 rows can be added.)

B Outputting patterns using text
from the text list

6 Click to send to machines by using the
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© Edit Text Link function. This button is available if an
Enters input mode for the text in the embroidery machine compatible with the
selected cell. (Input mode can also be Link function is connected to the
entered by double-clicking a cell.) computer. Connect a compatible
@ select arow, and then click [Insert]. A embroidery machine that has been
new row is inserted above the selected started in Link mode.
one. »» "Using the Link Function to Embroider
@ selectarow, and then click [Delete]. The From the Computer” on page 204
selected row is deleted. Q To Folder

»» "Outputting patterns using text from the
text list" on page 125

M Editing a pattern with text
replaced

@ Select text in the [Name Drop List] dialog
box and click [OK] to return to the Design
Page and edit the pattern with the text
replaced.
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Creating Embroidery Patterns Using
Images

Embroidery patterns can easily be created from
images. In addition, this section provides details
on creating an embroidery pattern that is
combined with an image.




Stitch Wizard: Automatically Converting an Image to an Embroidery Design

Stitch Wizard: Automatically Converting
an Image to an Embroidery Design

An embroidery pattern can be created from a digital camera photo, a scanned illustration, or a clip art image.

B Auto Punch (»» p. 132)

-

M Cross Stitch (»» p. 135)

A\ 2

B Photo Stitch 1 (»» p. 139)

M Photo Stitch 2 (»» p. 144)
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Tutorial 6-1: Auto Punch

Tutorial 6-1: Auto Punch

In this section, we are going to use the Auto Punch function to automatically create an embroidery pattern from
an image. This creates an embroidery pattern from shapes and colors in the image.

Step 1 Importing image data into Layout & Editing

Step 2 Starting the Auto Punch wizard

Step 3 Applying an image mask and adjusting its size and position

Step 4 Creating a border from the mask outline and converting to an embroidery pattern

Step 1 Importing image data into
Layout & Editing

1  Click the [Image] tab.

2  Click [Open] in the [Image] group, and then
click [from File].

& CEEHRE

e e E

24 ; e
L G :"-' .:I ::..I ||: . .:I;.' =, = e — =

ey Ea AL

I: ....... o el an

' E.-. S » Images with few and distinct colors work best
: with [Auto Punch].

« Repeat steps 1 to 4 to choose another picture
3 Double-click the [Documents (My image. Otherwise, the image can be replaced

documents)\PE-DESIGN 10\Tutorial\ with the dialog box in Step 4.
Tutorial_6] folder to open it. »»> "Select Mask dialog box" on page 147

m * You can import picture images from a scanner,
or clipboard, and import that image.
When this application is installed, the [PE-

. - » ing | Data" 1
DESIGN 10] folder is installed in the Documents mporting Image Data” on page 150
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folder.
Step 2 Starting the Auto Punch
4  Select the file [penguin.bmp], and then click wizard
[Open], or double-click the file's icon.
e o 1 Click the [Image] tab.
== noe
ke izl 2  Click [Auto Punch] in the [Stitch Wizard)]
el " i— R
By — - Fit & group.
8 T i = g 0ROy =T
~ P e T
—" ILQ E:-I- rag rl-':\.-'.-:‘. I? @ ;::1 ll;-
e e v | i b ] ssnm e

— The image appears in the work area.
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Tutorial 6-1: Auto Punch

Step 3 Applying an image mask
and adjusting its size and
position

1 Click m to select the circle mask.
Drag handle to adjust the size of the mask,
and drag the mask to adjust its position.
Click [Next].

e

O

The mask outline selected here can be used as
line data (border) in Step 4.

»» "Select Mask dialog box" on page 147.

2  Drag the image to adjust its output location
and size. The white background indicates the
sewing area in the Design Page.

Click [Next].

Check Mask Shape/Modify Image

7964801 mm < Previous Cancel

»» "Check Mask Shape/Modify Image dialog
box" on page 148

133

Step 4 Creating aborder from the
mask outline and
converting to an
embroidery pattern

Select the [Add mask outline] check box, check
the preview image, and then click [Finish].

amE =i Rl

oL T =

— The image is automatically hidden and
stitches are automatically input.




Auto Punch Features

Auto Punch Parameters
dialog box

o Result View
The resulting analyzed image appears in
the Result View box.

e Omit Region Colors/Omit Line Colors
In the [Omit Region Colors] list and
[Omit Line Colors] list, click the colors to
select whether or not they will be sewn.
You can select whether or not areas will
be sewn by selecting their colors. Colors
that are crossed out are set to not be
sewn.

M

» To select whether or not a part of the image is to
be sewn, click in the Result View box, or click in
the [Omit Region Colors] and [Omit Line
Colors] lists.

 Areas filled with a crosshatch pattern in the
Result View box will not be sewn.
In addition, lines that appear as dotted lines will
not be sewn.

@ These areas will not be sewn.

Auto Punch Features

© zoom

e Create Lines
Click this button to display the [Select
Regions] dialog box, where the areas to
be converted to lines can be selected.

T
=1 1
N
—— -
I I
|
|
— L
| il

Click the areas to be converted to lines,
and then click [OK].

e p—

@ Thread Chart
Select the thread chart to be used.

@ Add mask outline
If this check box is selected, line data is
created from the mask outline.

0 Noise reduction
Sets the level of noise (distortions) that is
removed from the imported image.

6 Segmentation sensitivity
Sets the sensitivity for the image analysis.

Q Max. Number of Colors
Sets the number of colors used.

@ Retry

To view the results of the changes, click
this button.
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Tutorial 6-2: Cross Stitch

Tutorial 6-2: Cross Stitch

The Cross Stitch function creates cross-stitch embroidery patterns from images. In this section, we will create

a cross-stitch embroidery pattern from an image.

Step 1

Importing image data into Layout & Editing

Step 2 Starting the Cross Stitch wizard

Step 1 Importing image data into
Layout & Editing

Select the [Tutorial_6] folder, and then select
[tulip.bmp] as the image.

»» “Importing image data into Layout &
Editing" on page 132

S——— [ = ]

Step 2 Starting the Cross Stitch
wizard

1  Click the [Image] tab.

2 Click [Cross Stitch] in the [Stitch Wizard]
group, and then click [Color].

i-q '!-}LIIHL L.
T T ot Lo ﬂ\?ﬁ @t
!:--".Ill' I et 5 I E“
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3

Click [Next].

From this dialog box, an image mask can be
applied, and its size can be adjusted and
shape edited. For this example, we will simply
continue to the next step.

»» "Select Mask dialog box" on page 147
Click [Next].

Check Mask Shape/Modify Image

Z

350890mm < Previous Cancel

From this dialog box, the size and position of
the image can be adjusted. For this example,
we will simply continue to the next step.

»» "Check Mask Shape/Modify Image dialog
box" on page 148




Tutorial 6-2: Cross Stitch

5 Click [Next].

In this dialog box, the cross size and the
number of colors can be specified. For this
example, we will use the default settings.

6 Click [Finish].

Q

2 @

: * 2
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In this dialog box, stitches can be added, ‘é
deleted or edited, and colors and the number o
of times each stitch is sewn can be specified. 3
For this example, we will use the default 5
settings. >
«Q

™

]

— The image is automatically hidden and
stitches are automatically input.
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Cross Stitch Features

Cross Stitch Features

Cross Stitch Parameters
dialog box

o ?9

o Result View
Areas that will not be converted to cross-
stitching are shown with a crosshatch
pattern.

e Omit Colors
In the Omit Colors list, click the colors to
select whether or not they will be sewn.

M

» To select whether or not a part of the image is to
be sewn, click in the Result View box, or click in
the [Omit Colors] list.

 Areas filled with a crosshatch pattern in the
Result View box will not be sewn.

@ These areas will not be sewn.

9 Zoom

e Cross size
Sets the size of the pattern.

@ Thread Chart
You can select the brand of thread to use
in the created cross stitch pattern.

137

@ Max. Number of Colors
Sets the number of colors used in the
created pattern.

0 Retry

To view the results of the changes, click
this button.

e Next

Continues to the next step ([Edit Cross
Stitch] dialog box).

M Edit Cross Stitch dialog box

Click a button in (1) to select the type of stitch,
select a thread color in (2), and then click or
drag in (3) to edit the stitches.

o Selecting stitches
Selecting stitches to be added/deleted

& (cross-stitches): Specifies a cross-
stitch inside a box.

| (backstitches): Specifies a back stitch
inside (T~ or |~ ) oron the edge (| |

or — ) of a box.

e Color Option
To change the color, click [Change
Color] to display the [Thread Color]
dialog box, and then click the desired
color.
To select the color to be used for a stitch,

click Vo , and then click the stitch to
be sewn with that color.




Cross Stitch Features

9 Editing area

+ For cross-stitches
Clicking a box: Adds one stitch.

+ For backstitches
Clicking an edge of a box: Adds one
stitch at the edge.
Clicking a diagonal line in a box: Adds
one stitch on the diagonal.

+ For both cross-stitches and
backstitches
Dragging the pointer: Adds
consecutive stitches.
Right-clicking/dragging with the right
mouse button held down: Deletes one
stitch/deletes consecutive stitches.

e Zoom

@ Display Template
To display the imported image, click
[Display Template].

@ Add mask outline

If this check box is selected, line data is
created from the mask outline.

0 Cross Stitch Times/Backstitch Times
For the number of times each stitch is to
be sewn, select [Single], [Double] or
[Triple].

a

If [Previous] is clicked to return to the [Cross
Stitch Parameters] dialog box after the stitches
have been edited, the edited stitches are reset to
their previous arrangement.
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Tutorial 6-3: Photo Stitch 1

Tutorial 6-3: Photo Stitch 1

By using the Photo Stitch 1 function, embroidery patterns can be created from photos. This type of embroidery
pattern created from a photo has detailed and overlapping stitching.

Step 1 Importing photo data into Layout & Editing
Step 2 Starting the Photo Stitch 1 wizard
Step 3 Applying an image mask and adjusting its size and position
Step 4 Selecting appropriate thread colors and creating an embroidery pattern
Step 1 Importing photo data into Step 3 Applying an image mask
Layout & Editing and adjusting its size and
Select the [Tutorial_6] folder, and then select position
[swimming_girl.jpg] as the image. 1  Drag the handles to adjust the shape of the
»» “Importing image data into Layout & mask. Drag the mask to adjust its position.
Editing" on page 132 —
i [ ] ' L]
— =i -
1 ag o i

2  Then click Next.

Step 2 Starting the Photo Stitch 1 3

wizard Click [Design Settings].

s s m
—r-

1  Click the [Image] tab.

2 Click [Photo Stitch 1] in the [Stitch Wizard]
group, and then click [Color].

g - e
b B mn;-.._? s
R e

)
[N

With [Photo Stitch 1], an embroidery pattern can
be created in color (Color), sepia (Sepia),
grayscale (Gray) or one color (Mono). For this
example, select [Color].
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4  Select[Hoop Size] and choose a Design
Page size of 100 x 100 mm from the selector.
Then, click [OK].

e S [ = ]
e
u=t ———
5 click [Fit to page] to change the final finishing
size.
L]
==l

M

» The size of the embroidery pattern appears in
the lower left corner of the dialog box. The user
can change the size freely with this display.

* The minimum sizes of embroidery patterns that
can be sewn are listed below.
¢ Face only: 100 x 100 mm
+ Head and face: 130 x 180 mm

»» "Check Mask Shape/Modify Image dialog
box" on page 148 and "Gray Balance /
Modify Image dialog box" on page 149

6 Checkthe preview of the area to be converted
then click [Next].

Tutorial 6-3: Photo Stitch 1

Step 4 Selecting appropriate
thread colors and creating
an embroidery pattern

——

At this point, the embroidery pattern can be
completed by clicking [Finish]. However, this
section will describe how to improve the photo
stitching by changing various settings.

1  From the [Thread Chart] selector, select
[Brother Chart (Photo Stitch)].
In the [Max. Number of Colors] selector,
specify "20".
Click [Update Preview].

Pt Wb | Pwrwmmmn

2  Slide the [Brightness] slider one position to
the left, and the [Contrast] slider two
positions to the right.

Click [Update Preview].

sy bgman s [ amar
Care  Fiw |
Dol

Surdk B |

= e e
T o gt

M

Make adjustments as needed, depending on the
image. If it is difficult to adjust the tone, click
[Select from Candidates].

»» "Select from Candidates" on page 143.
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Tutorial 6-3: Photo Stitch 1

3 While looking at the preview on the right side,
select colors from the list for the most
frequently used colors (light blue for the
background) and for the more characteristic
colors (deep rose for the lips), and then click
[Reserve].

— For this example, four colors (cream brown,
light blue, salmon pink and deep rose) are

reserved.
[ [ =T | =i
- .
e al Py
L] i [P
. m o i
LR ™ —
¥ N nrer
" | I ey
B | ] ey
18 -~ i Iﬁ: [t
-
l.
== arn [] [

4 Inthe [Max. Number of Colors] selector,

specify "10", and then click [Update Preview].

Py Wl | P

— The image is automatically hidden.

M

If the created embroidery pattern contains colors
that you do not wish to emphasize (for example,
grays in the face), change the sewing order in the
[Sewing Order] pane so that the undesirable color
is sewn before all other colors.

»» "Changing colors" on page 85.

Tips for improved results

If the actual thread colors differ from the thread
colors on the screen, the embroidering results will
be greatly affected.

[Brother Chart (Photo Stitch)] is a thread chart
based on the Brother embroidery thread colors and
flesh tones, and has been adjusted to account for
the difference between thread colors on the screen
and actual thread colors; however, colors may
appear differently depending on your operating
environment.

If the thread colors on the screen are different from
the actual thread colors, use the user thread color
lists and adjust the thread colors to achieve better
results.

»» "“Editing user thread color lists" on
page 192
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Photo Stitch 1 Features

0 Color options

Photo Stitch 1 Parameters
dialog box
With Color, Sepia or Gray

| e

e o e

Photo Stitch 1 Parameters

Cancel Frish

(5]

Select the thread colors in the color options o
specify the desired settings under [Sewing Option]
9 and [Color Option] 9 and then, click [Update
Preview] e to preview the effects of the specified
settings. Click [Finish] @ to convert the image to
an embroidery pattern.

Photo Stitch 1 Features

Color/Sepia/Gray

Thread Chart

You can select the brand of thread to
use in the created pattern.

Select whether thread colors will be
selected automatically (on) or manually

Auto Select (off). Select this check box to turn on
this function.

Number of Sets the number of colors selected by

Colors the Auto Select function.

List of colors
used

Displays the thread colors that are
being used. With this list, the thread
colors that are being used can be
checked or changed.

Add

Click this button to add a thread color to
the list of colors used.

When clicked, the [Add] dialog box
appears.

Add
Thread Chatt

BROTHER EMBROIDERY v

Color | Code | Brand A
17 EMER!
812 EMBRI

3% EMBRIv

< >
13 Cancel

Select a thread chart, then a thread
color, and then click [OK] to add the
color to the list. Added thread colors will
be reserved as thread colors that must
be used.

Remove

Select a thread color in the list of colors
used, and then click this button to delete
the selected color from the list. This is
used to delete unnecessary thread
colors and reduce the number of colors.

Reserve

Specifies thread colors that must be
used. Select a thread color in the list of
colors used, and then click this button to

display ; in the Reserved column. To
cancel this setting, click to icon so that it

appears as -

Mono

List of colors
used

Displays the thread colors that are
being used.

Change
Color

Click this button to display the [Thread
Color] dialog box, where the thread

colors can be changed.
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Photo Stitch 1 Features

Q Update Preview
Update the previewed image after settings have

9 Sewing Option

Selecting a setting closer to [Fine] been changed.
Detail creates more details in the pattern and
increases the number of stitches. (The D:I
stitches will be overlapping.)
When the value is lowered, the sewing * |f the [AUtO Select] check box is selected, the
Run Pitch pitch (stitch length) will be shortened, thread colors will be automatically selected from
resulting in finer stitching. the chart selected in the [Thread Chart]
Sew Page §elector. .If thread colors are reserved,. they will
Color If this check box is cleared, the parts of included in th.e. collors selected according to the
(Available the pattern that are the same color as Bg;ﬂber specified in the [Number of Colors]
only with the Design Page will not be sewn. ’ .
Color, Sepia | If it is selected, those parts will be sewn. gettrt]ﬁl gg‘ﬁ?hsée[l_?ﬁ:]eggegﬁ ::)ti( ;ggfgfgl’qéhe
and Gray) . . . . [Number of Colors] box are not applied, and
Add mask | If this check box is selected, line data is only the thread colors in the current list of colors
outline created from the mask outline. used will be used to assign thread colors.
Click this button to display the [Others] « When thread colors are added/deleted, the
dialog box, where the following settings [Auto Select] check box is cleared. To use
can be specified. added thread colors and automatically select
[Conversion Priority]: other thread colors, select the [Auto Select]
To give prlorlty_ tp creating a pattern as check box, and then update.
([:gistecrt]oétzlci){ﬁnal photograph, select . The th(ead colors in.the list of colors used are
To give priority to reducing the number Ils(tjed,.ln ﬁrder, s_,tartlng from(}he brlghlt:')est. This
of jump stitches, select [Jump Stitch order Is the sewing order and cannot be
Reduction]. changed.
Others
[Image Typel:
If [Photo] is selected, the thread colors
will be mixed together, which will result D:]
in a more natural look.
If [Cartoon] is selected, the thread Creating beautiful photo embroidery
colors will not be mixed together, which » [Brother Chart (Photo Stitch)] in the [Thread
will result in a more simply colored look. Chart] selector is a thread chart created to allow
Select [Photo] for image data from a you to preview, in colors nearest to the actual
photograph, etc. Select [Cartoon] for embroidered thread colors, patterns using
image data from an illustration, etc. Brother embroidery threads. This chart provides

9 Brightness / Contrast

The top slider is used to adjust the brightness.
The bottom slider is used to adjust the contrast.

Select from
Candidates

The image can be automatically
adjusted.

Click this button to display nine patterns
with different brightness and contrast
levels based on the original image.
Select one of the candidates, and then
click [OK].

wipw
PP
Wiow

a color scheme that best corresponds to your
expected result.

However, the colors may appear differently
depending on the computer environment. By
editing the colors to create a user thread chart
corresponding to the threads that you have, you
can create patterns while viewing them in colors
nearest to the actual threads that will be
embroidered.

»» "Editing user thread color lists" on page 192

» The following types of photos are not
appropriate for creating embroidery patterns.
+ Photos where the subject is small, such as in
photos of gatherings
+ Photos where the subject appears dark, such
as photos taken in a room or taken with
backlighting

« An image with a width and height between 300
and 500 dots is suitable.
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Tutorial 6-4: Photo Stitch 2

Tutorial 6-4: Photo Stitch 2

We will create an embroidery pattern with [Photo Stitch 2] in a method different than that used with [Photo
Stitch 1]. Although this embroidery pattern will also be created from a photo, this type of embroidery pattern
contains repeating zigzag stitches. This produces a more general rendering than with [Photo Stitch 1];

however, the data is created with well-regulated stitching.

Step 1 Importing photo data into Layout & Editing

Step 2 Starting the Photo Stitch 2 wizard

Step 3 Applying an image mask and adjusting its size and position
Step 4 Changing the sewing angle

Step 1 Importing photo data into
Layout & Editing

Select the [Tutorial_6] folder, and then select
[girl2- face.bmp] as the image.

»» “Importing image data into Layout &
Editing" on page 132

. =]
Bl o — r-)
T S i
T == X
LY
]

Step 2 Starting the Photo Stitch 2
wizard

1  Click the [Image] tab.

2 Click [Photo Stitch 2] in the [Stitch Wizard]
group, and then click [Mono].

H T = rithes - La
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Step 3 Applying an image mask
and adjusting its size and
position

TN .
Click L.J to select the circle mask.

Drag handle to adjust the size of the mask,
and drag the mask to adjust its position.

Click [Next].

»»> "Select Mask dialog box" on page 147

2  From this dialog box, the size and position of

the image can be adjusted. For this example,
we will simply continue to the next step.

Click [Next].

»» "Check Mask Shape/Modify Image dialog
box" on page 148 and "Gray Balance /
Modify Image dialog box" on page 149
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Tutorial 6-4: Photo Stitch 2

Step 4 Changing the sewing
angle

1  Inthe [Direction] box, type "45".

2 Click [Update Preview].

Photo Stitch 2 Parameters

Sewing Dplion Color Opten

Line interval
20 =] om
M Densiy

5 = foeiom
Dhecion _CnargeColr. |

e

=] degee

™ Addmask mlhm‘

Biightess / Conast

o

— %
oY "o

<Puvon Carsl o

3  Click [Finish].

Photo Stitch 2 Parameters

Line iterval
20 = o

Max Densiy

75 = weim
Chonge Gl
e [Erormeoer. |

[ =] degee

I~ Add mask oue.
o

Biightness  Conast

0o Y o

Updio P

<Prvos Caeel
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Photo Stitch 2 Features

0 Sewing Option

Photo Stitch 2 Parameters
dialog box

| | Photo Stitch 2 Parameters
Sevia Ot ][ Gl Ot
ThesdChot
GROTHER EVGRODERY <]
Vs Doty
: Calrset
45 =3 e || e =]
Diecin TeadColos Used
i
B = degee
I~ Add mask outline: ey
i i
Sevia st |[ Gl ot
ey -
= [BLACK.
Mo Densty
5 =] et
S B ||
= dege
2 Brightness / Contrast
T~ Add mask outline i
RALERILLAL
0 Y o
Ut i
R

Specify the desired settings under [Sewing Option]
o and [Color Option] 9 and then click [Update
Preview] 9 to preview the effects of the specified
settings. Click [Finish] Q to convert the image to
an embroidery pattern.

Photo Stitch 2 Features

T »
Line interval $ Line interval
Fah

Lower value Higher value
Max. Density — i

o) —ae

e ——— pm—pp o

0° 45° 90°

Direction &m g‘% 2 ‘%
Add mask If this check box is selected, line data is
outline created from the mask outline.

9 Color Option

Color

Thread Chart

You can select the brand of thread
available in the [Color Set] selector.

If [Auto Select] is selected, the most
appropriate four colors will automatically
be selected.

Selecting a different option specifies the
four colors used when creating the
embroidery pattern.

The color choices are: cyan (C),

Color Set | genta (M), yellow (Y), black (K), red
(R), green (G) and blue (B). Select one
of the following combinations that
contains the colors most used in the
image.

Color combinations: CMYK, RGBK,
CRYK, BMYK

Thread .

Colors Used Displays the four selected thread colors.
Under [Thread Colors Used], click a
color. Then, click [Change Color] to
display the [Thread Color] dialog box.

g?)ﬁ)nrge Select the new color and click [OK].
The selected thread color will be applied
to the image shown in the preview
window.

Mono
Click on the [Change Color] button to
open the [Thread Color] dialog box if

Change )

Color you wish to change the color of the
photo stitching. Select the color and
click [OK] to make the color change.

Color/Mono

Brightness /

The top slider is used to adjust the
brightness.

Contrast The bottom slider is used to adjust the
contrast.

Update Updates the previewed image after

Preview settings have been changed.
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Advanced Stitch Wizard Operations

Advanced Stitch Wizard Operations

Image To Stitch Wizard

Click || at the top of the window (in the [Quick
Access Toolbar]) to display the Startup Wizard,
and then click [Create Embroidery Patterns Using
Images]. If an image has been imported, the next
dialog box appears.

e

o Sample image before being converted

e Sample image of embroidery pattern
after being converted

9 Select the conversion method.

0 Select to start up Design Center and
import the image into the Design Page.

6 Description of conversion method
@ Click to continue to the next step.

M

If no image has been imported into the Design
Page, the [Open an image file] dialog box
appears.

IFRAERLAEENRA Y
[}

Adjusting the Mask and
Image

M Select Mask dialog box

The [Select Mask] dialog box appears no matter
which conversion method was selected.

AN N

o Mask shapes
The image will be masked with the
selected shape.

9 The mask can be reshaped or
repositioned. Select the tool appropriate
for the operation to be performed.

% | : Drag the handles to enlarge/
reduce the mask. Drag the mask
to adjust its position.

» : Points can be entered, moved and
deleted to create a mask with the
desired shape.

To add points, click the outline of
the mask. To move a point, select
the point, and then drag it. To
delete points, select the point, and
then press the <Delete> key.

a

With a small original image, it may not be possible
to reduce the size of the mask.
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Advanced Stitch Wizard Operations

9 If [Auto Generate] was clicked, an outline * Move the [Original] — [Sharp] slider to
of mask was automatically detected from adjust the sharpness of the image's
the image. outlines. A setting more towards [Sharp]
The [Auto Generate] button is available makes a more noticeable boundary
only with images that have a light-colored between bright and dark areas.
background, like in this photo. + Move the [Dark] — [Bright] slider to adjust

the brightness of the image.

Move the [Low] —[High Contrast] slider to
adjust the contrast of the image.

@ Clicking [Open Image] allows you
replace the image with a different one.
The [Open an image file] dialog box
appears. Select a file.

The next step differs depending on the color range
selected for the embroidery pattern.

B Check Mask Shape/Modify Image
(!} dialog box

If Color, Sepia or Gray was selected for [Photo
Stitch 1], [Photo Stitch 2] or Cross Stitch, or if
[Auto Punch] was selected:

A mask shape edited with | » or
created by clicking [Auto Generate]
will be added at the top of the list. Then,
this mask shape can be selected the
next time a pattern is created using a
Stitch Wizard. A maximum of five
shapes will be added, and they will be
arranged in order of the most recently
used.

These mask shapes appear no matter
which Image To Stitch function is
selected.

n

The following dialog box appears.

I

e Zoom

@ Clicking the [Image Tune] button displays e
an [Image Tune] dialog box. e

B |:| . = 1|
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o Adjust the position and size of the image.
Drag the image to the desired position.
Drag the handle to adjust the image to the
desired size.

9 Click [Design Settings] to change the
size of the Design Page. Specify the
settings in the [Design Settings] dialog
box.

L) -

»» "Specifying the Design Page Settings" on
page 14

9 Click [Fit to page] to adjust the image to
the size of the Design Page.

0 Embroidery pattern size
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Advanced Stitch Wizard Operations

M Gray Balance / Modify Image
dialog box

If [Mono] was selected for [Photo Stitch 1] or
[Photo Stitch 2]:

The following dialog box appears.

Gray Ealante,l/iudlfy Image

Q—
e —_ e
e T
| |
(4] (5]

o Adjust the position and size of the image.
Drag the image to the desired position.
Drag the handle to adjust the image to the
desired size.

e Click [Design Settings] to change the
size of the Design Page. Specify the
settings in the [Design Settings] dialog
box.

»» "Specifying the Design Page Settings" on
page 14

9 Click [Fit to page] to adjust the image to
the size of the Design Page.

e Embroidery pattern size
@ Drag the slider to adjust the gray balance.
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Importing to Design Center

We will create embroidery data in Design Center by
using an image that was opened in Layout & Editing.

1  Click the [Image] tab.

2  Click [Design Center] in the [Stitch Wizard]

group.

EEY ; Lnitlad -

- e -

e T F R 1
o | R Gl adTe Brirle| e

H [ fiTi=maed

— Design Center starts up and the image
appears in the Design Page.

»» "Basic Design Center Operations" on
page 211 and "Line Image Stage" on
page 224




Importing Image Data

Importing Image Data

An imported image can be used with the Image To Stitch Wizard, as a template for manual punching, or for
printing onto iron-on transfer sheets or printable fabric when using "Print and Stitch".

An image can be imported using any of the following four methods.
e From afile * From the Clipboard

e From a scanner (TWAIN Device)

a

Only one image can be added to the work area. If you try to display a different image, it will replace the
previous one.

M Image file formats 3 Select the drive, the folder and the file. Click
Images in the following formats can be imported. [Open].
- Windows bitmap (.bmp), Exif (.tif, .jpg), Windows - — -
Metafile (.wmf), Portable Network Graphics g = — e g
(.png), Encapsulated PostScript (.eps), GIF (.gif) . — Lkar it f;}

7] =
» Vector image data in the ".wmf" (Windows
Metafile), ".emf" (Enhanced Metafile) and ".svg" ~a swramy e
(Scalable Vector Graphics) file formats can be S =
converted to shape patterns as it is without = bt £k i =

some information not supported.
»» "Importing vector images (WMF/EMF/SVG)" ;
on page 93

« If an EPS file doesn't contain a "Preview" image, 5 fmngt & B0 N0
it can not be displayed correctly. When you : _
create afile in EPS format, be sure to save it with B [ i —
preview image. i
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Importing image from afile

1  Click the [Image] tab.

2 Click [Open] in the [Image] group, and then
click [from File].

& H*,u. ’ [I]

inw -

@ ,_} A * If the [Preview] check box is selected, the
P contents of the selected file will appear in the
s el A+ Ll 1 Pt [PI'EViEW] window.
E i | — « Various clip art images can be found in the
[ emrauie D [ClipArt] folder (in the folder where PE-DESIGN
| B o Bacomi was installed) at:
T C:\Program Files (x86)\Brother\PE-DESIGN 10
aiaacletinl el \ClipArt

150




Importing Image Data

4  From the [Sources] list, click the desired

Im portl ng Imag € fro m the device to select it. Click [Select].
clipboard skasonce M
1  Click the [Image] tab. Sorrees.
2  Click [Open] in the [Image] group, and then
click [From Clipboard].
& CEEEESLD
Bl poe Fi @ J a
o -‘:' e T If no TWAIN device is installed, there will be no
TS - oy — o names displayed in the [Sources] list. First, install
[, | the driver software for the TWAIN device.
| TR =
—inmsasicam 5 Click the [Image] tab.

6 Click [Open] in the [Image] group, and then

— The image on the clipboard is imported into
click [From TWAIN Device].

the Design Page.

& B =i 2 f i ¥
This can only be done when there is image data on I_E: < :J.: £y Lj @ ‘_j'
the Clipboard. b | - ik

fimy ‘_I-_ Heh

1= . .I:I'.: =T i i
mporting image from a W
scanner (TWAIN Device) LIRS
— The driver interface for the device selected
D:I in the Select Source dialog box appears.
TWAIN is an application interface (API) ] ) ) ]
7  Specify the necessary settings for importing

standardization for software that controls scanners

and other devices. an image, and then import the image.

a

1  Check that the scanner or other TWAIN ) ) ) o
device is correctly connected to your For information on using th_e driver interface, refer
comouter to the help manual for that interface, or contact the

p ) manufacturer of the interface.

2  Click the [Image] tab.
— The imported image will be pasted into the

3 C!ick [Open] in the [Image] group, and then Design Page at its original size.

click [Select TWAIN device].
PR T

L s bAoA

i = = .‘:. iz e

TR = T .'.'.‘..:.'_‘.
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Changing the Image Settings

Changing the Image Settings

Adjusting the density of
the background image

1  Click the [Image] tab.

2 Drag the slider, or click -E} or -E-:j in the
[Image] group.

E_'I "-PLI'I e
el e L b B

Hide (off) [ 50% | 100%

25% 75%

M

Press the shortcut key <F6> to switch between
displaying the image (On (100%)) to displaying it
faded at each density (75%, 50% and 25%) to
hiding the image (Off).

Changing the size, angle
and position of the image

M Selecting an image
1  Click the [Image] tab.

2 Click [Modify Image] in the [Image] group.

E_'l LEE LS ="
SE= o WP

=pF LR Firy FrpEre

— The image is selected and appears as
shown below.

O)

2.

@ Handle
® Red line

M

The status bar shows the dimensions (width and
height) of the image.

B Moving an image
Drag the selected image to the desired location.

B Scaling an image

Drag the handle to adjust the image to the desired
size.

M

If the <Shift> key is held down while a handle is
dragged, the image is enlarged or reduced from
the center of the image.
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Changing the Image Settings

M Rotating an image
An image can be rotated in 90° increments.

1  Click the [Image] tab.

2 Click [Rotate Right] or [Rotate Left] in the
[Edit] group

t_-\.l ?u 'l AL
"ﬁ:m Ty - 1

[ el @

e a = T o L Py T e
=gy = i fpere

Rotate Right

%&'

Rotate Left

3

M Deleting an image
1  Click the [Image] tab.

2  Click [Delete] in the [Edit] group.

? -
‘h-"' l;_]_ |, g | v
s [ -
-ﬁ_ "ﬁ:m Ty Stk Ry I‘ w I._.T 1
I I - 7T ke 1 L e 4]
=T s Lei . Pl cPm
=gy = il i fpere

An image can also be deleted by selecting it, then
pressing the <Delete> key.

»» "Changing the size, angle and position of
the image" on page 152
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Saving the image data

B Saving as afile
1  Click the [Image] tab.

2 Click [Save] in the [Image] group, and then
click [to File].
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3  selectthe drive, the folder and the format.
Type in file name. Click [Save].
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The image data can be saved in either of the
following formats: Windows bitmap (.bmp), Exif
(.jpg).

M Outputting to the Clipboard
1  Click the [Image] tab.
2 Click [Save] in the [Image] group, and then
click [to Clipboard].
"é.';.-flél-ﬁ TbL

A

peE] -f“*--w@aﬁ

i

£l ks iy

weinH, ik
|E T Vil PN AL

TR ——— —_— e C




Tutorial 7: Print and Stitch

Tutorial 7: Print and Stitch

In this example, we will create a design that combines embroidery and an image.

Print the background image on fabric.
Embroider

-l"

-

The sample file for this tutorial is located at Documents (My documents)\PE-DESIGN 10\Tutorial\Tutorial_7.

Step 1 Creating a design combined with a background image
Step 2 Printing the background image

Step 3 Printing the positioning sheet

Step 4 Embroidering

Step 1 Creating a design 4  import the file [Bear_Background.jpg].

Q
@
=,
=.
«
m
5
combined with a Select the file Bear_Background.jpg in the 3
3 folder [Documents (My documents)\PE- a
background image DESIGN 10\Tutorial\Tutorial_7]. 3
For this example, we will use the gift box image T
(Bear_Background.jpg) and the embroidery pattern = - - %
of the bear (tutorial_7_Bear.pes). di e = @
A D i, mra S 3
1  Start up Layout & Editing. = v 2
Specify a Design Page size of 130 x 180 mm. = = §
»» "Specifying the Design Page Settings" on a 3
page 14 - 2
: St i ~&d
2  Click the [Image] tab. e o

3 click [Open] in the [Image] group, and then
click [from File].

» "Importing Image Data" on page 150.
5 Display the [Import] pane.
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Tutorial 7: Print and Stitch

6  Import the file [tutorial_7_Bear.pes]. 8  Transform the text to fit with the design of the
Select [Tutorial] from the [From] selector and Image.
[Tutorial_07] from the [Category] selector. o Click [Text Attributes] tab.
Drag [tutorial_7_Bear.pes] to the Design e Select the [Transform] check box, and
Page. .
— — the.n click A8,
. . w3 Tenl Atk 0N
Ly -; ::_ U lrmeny ot B iraey b | M ros sinm
- I} I..-.-...-'-
x 1
R —— Happy Hirthday!
.‘h‘ o ™ e 4
I TalE = Shew L _|
S o= -
47 . bBe 4pt
' ABC Abe ,AE& AR
e . ARC ABG 42" 6.
»» “Importing embroidery designs" on : ‘“‘I BEC AR
page 91 ﬁﬂ-ﬁ ARG AR APC
7  Enter the text. (2] F-&a_-;- qﬂﬂ ABC aﬁﬂl}
Select built-in font [No. 30], and thread color F-Hﬂvn..!c} :“.IE'E;. .ﬁ,E:_G
[DEEP ROSE]. _
Type in "Happy Birthday!".  Marwbiem: (1oL |
e e TR ) _'-1' =
fanmg § ) e © Drag the rotation handle to adjust the
= mrrmmmett |} angle of the pattern.
- ..-.-:.... [¥ T— e
il ' = _l b [ - 504
" EE mm (1) 47_% = 1“ ‘t-I'J.
EmE E _{ i'- }i’ -
B EEE
EEE [ ]|
BEANES.
11108 @ Drag & or a handle to adjust the size of
up & the pattern.
- vy AR N oy »» "Transforming text" on page 111 and

"Rotating patterns" on page 33

»» "Entering text" on page 106

9  After the design is finished, save the
embroidery data onto media so it can be
transferred to the embroidery machine.

»» For details on saving embroidery
patterns, refer to "Saving" on page 95.

For details on transferring designs to an
embroidery machine, refer to
"Transferring Embroidery Designs to
Machines" on page 201.
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Step 2 Printing the background
image
Print the background image on an iron-on transfer
sheet or printable fabric.

1 Click @ then [Print], then [Print Setup].
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2  Specify the print settings.
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o Select the printer to be used.

e Under [Paper] and [Orientation], select
the appropriate settings for the iron-on
transfer sheet or printable fabric to be
printed on.

9 Select [Image print mode].

e Select [Print the image on printable
fabric or an iron-on transfer sheet].

Tutorial 7: Print and Stitch

6 To print a flipped image on an iron-on
transfer sheet, select the [Print a flipped
image] check box.

Some printers will automatically print an
image flipped if an iron-on transfer sheet
is selected as the paper. If this type of
printer is being used, clear the [Print a
flipped image] check box.

For details, refer to the instructions for the
printer being used.

3 Click [Change Position].

4  Check the image position.

st P Mol ikl n

If any part of the image extends out of the print
area, drag the image to adjust its position.

5 Click [OK].

6  Click [Print].

M

To check the print image, click [Print Preview].
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Tutorial 7: Print and Stitch

7  Specify the appropriate settings in the [Print
Setup] dialog box, and then click [OK].

»» "Printing" on page 96.
— Printing begins.

M

For details on printing on iron-on transfer sheets or
printable fabric, refer to the instructions for the
iron-on transfer sheets and printable fabric.

Step 3 Printing the positioning
sheet

Print a sheet for aligning the image and the
embroidery.

1  Specify the print settings.

- i
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o Under [Paper] and [Orientation], select
the appropriate settings for the paper to
be printed on.

e Select [Print a sheet of paper for
aligning the printed image and the
embroidery].

Click [Print].

3 Specify the appropriate settings in the [Print

Setup] dialog box, and then click [OK].
»» "Printing" on page 96.
— Printing begins.

To check the print image, click [Print Preview].

Step 4 Embroidering

1 If an iron-on transfer sheet is used, transfer
the image onto fabric.

M

For details on transferring from iron-on transfer
sheets, refer to the instructions for the iron-on
transfer sheets.

2  Hoop the fabric in the embroidery frame.
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Tutorial 7: Print and Stitch

3 Place the positioning sheet on the fabric to be
embroidered so that it is aligned with the m

printed image. « For details on using the embroidery machine,
refer to the Operation Manual included with the
machine.

« Some patterns of completed samples for "Print
and Stitch" are provided in the following folder.
Documents (My documents)\PE-DESIGN 10\
Sample\Layout & Editing\Print and Stitch

« If the positioning sheet is too large, cut it to
an appropriate size so it can easily be used
for aligning the positions.

« Tape the positioning sheet to the fabric to
secure it in place.

4  Attach the embroidery frame to the
embroidery machine.

Be sure that the positioning sheet does not
move out of place.

5  Align the needle with the mark at the center of
the positioning sheet.

* If the embroidery machine has a built-in
camera, press the start positioning button
to detect the positioning mark and
automatically align the embroidering
position.

» With other embroidery machines, manually
align the positions.
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6  After positioning is finished, remove the
positioning sheet from the fabric.

7  Startthe embroidery machine to embroider
the pattern.
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Operations for Specific Applications

This section describes operations for creating
embroidery patterns using manual punching and
for specific applications such as appliqués,
embroidered patches and large-sized embroidery
patterns.




Tutorial 8-1: Creating Appliqués

Tutorial 8-1: Creating Appliqués

The Applique Wizard provides instructions for easily creating appliqués. For this example, we will create an

appligué that has holes (empty regions).

Finish

The sample file for this tutorial is located at Documents (My documents)\PE-DESIGN 10\Tutorial\Tutorial_8.

Step 1 Creating an appliqué pattern

Step 2 Using the Applique Wizard

M

The Applique Wizard cannot be used if a pattern
containing text with the [Name Drop] attribute
applied is selected.

Step 1 Creating an appliqué
pattern

1  Click the [Home] tab.

2 Click[Shapes] in the [Tools] group, and then

click

i-"*" = RN Lmmied - Layn
> A
Ir.-I-!:— ...I | — - i

3 Drag the pointer in the Design Page to draw a
circle.

4  Select [ asdescribedin steps 1 and 2, and
then drag the pointer in the Design Page to
draw a heart on top of the circle.

5  Select the two patterns, click [Modify
Overlap] in the [Edit] group, and then select
[Set hole sewing] to apply hole sewing.

e - L e & Ellling
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»» "Hole sewing" on page 39

Step 2 Usingthe Applique Wizard

1 Select the outer pattern, and then click
[Applique Wizard] in [Home] tab to start the
[Applique Wizard] dialog box.

vkt - Lawyouad 8 Eckving -

- )|} 0 sy P || T Py ||
MM u9 AF AN e

Be sure to select the outer pattern before starting
the [Applique Wizard].
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2  Specify settings in the [Applique Wizard]
dialog box in the following order o -

o 6 o

o Applique Material
e Applique Position
9 Tack down

O Covering Stitch
6 Output Pattern

e Create an applique with hole sewing
This check box appears when using a
pattern with hole sewing applied and
[Replace] is selected under [Output
Pattern].

M

Tutorial 8-1: Creating Appliqués

Appligue Matenal
-

- ==
St M
« '

* ‘ez

& Running Stitch
" Cutting

Mo

To return all parameters to their default settings,
click [Default].

3 Specify cutting lines for the appliqué in
[Applique Material].
The outline of the appliqué can be sewn as

running stitches or the appliqué can be cut out,
or it can be neither sewn nor cut out.

— For this example, select [Yes] then
[Cutting].

Applique Material

0

* Yes
" Running Stitch
* Cutting

Mo

Running Stitch

Select this setting to sew the
cutting line, then cut along
the cutting line with scissors.

Cutting
In order for this setting to be
available

»» "Basic requirements for
Cutwork functions" on
page 173

Select this setting to cut the
fabric with a machine
installed with cutwork
needles.

[Applique Position] is specified

automatically.

— The guideline for attaching the appliqué
piece is set to be sewn automatically.

Specify basting of the appliqué in [Tack

downl].

The appliqué piece can be basted onto the
base fabric. Select one of three stitches.

— For this example, select [Yes] then [V

Stitch].

WW

Satin Stitch

111

MNAN

E Stitch V Stitch
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Tutorial 8-1: Creating Appliqués

163

Specify the stitching for securing the appliqué
in [Covering Stitch]. Select the sew type and
other attributes ([Width] and [Density]) for
finishing the appliqué.

— For this example, select "Satin Stitch", and
then set[Width] to "3.0 mm" and [Density]
to "5.0 line/mm".

Satin Stitch
Settings can be
specified for [Width]
and [Density].

E Stitch

Settings can be
specified for
[Stroke], [Interval]
and [Pitch].

V Stitch

Settings can be
specified for
[Stroke], [Interval]
and [Pitch].

»» For details on setting [Stroke], [Interval]
and [Pitch], refer to"E/V Stitch" on
page 328

7  Under [Output Pattern], select whether

covering stitches will be added around the
entire pattern ([Add]) or covering stitches will
be sewn for shape lines ([Replace]).

— For this example, select [Replace].

Add

Settings can be
specified for
[Distance from
original Pattern].

Replace

8 Specify hole sewing in [Create an applique

with hole sewing].

Mo " No

I ¥ Create an applique with hale sewing |

Select this check box when creating an
appliqué with holes (empty regions).

— For this example, select this check box.

M

This check box appears when only the outer
pattern with hole sewing applied or only a text
pattern (with fonts other than built-in fonts 025 and
029, a user-defined font or a Small Text font) is
selected, or when [Replace] is selected under
[Output Pattern].

* Multiple text patterns can be selected if certain
conditions are met.




Tutorial 8-1: Creating Appliqués

B About the Output Pattern settings

m Add

The shape of the appliqué material appears as
shown below, depending on whether the [Create
an applique with hole sewing] check box is

¢ Covering stitches will be created around the
original pattern.

selected or not. ¢ Under [Distance from original Pattern], specify
When the [Create an applique th(_a _distance of the covering stitches from the
with hole sewing] check box is original pattern.
cleared (1 A
i|
When the [Create an applique
with hole sewing] check box is
selected
9 CcClick [OK] to exit the Applique Wizard dialog ~ -
box. ¢ This can be used to combine various patterns.
FoE ) = i .
L i

S |k

i "'"Flsh
I ‘ ! 1

The [Add] setting is not available if the stitch

- ; . . L pattern does not exist, for example, when both the
line and region sew types are set to [Not Sewn].

D:I Replace

When [Cutting] is selected under [Applique « Covering stitches will be sewn for outlines in the
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Material]: oY
. ) . o original pattern.
* Uncut sections will remain in cutting lines o )
specified with the Applique Wizard. Be sure to * The original pattern will be deleted.
]c‘:_u_t tﬁegn with scissors after embroidering is « Shape and text patterns can be used as the
inished.

original pattern. However, the following patterns

cannot be used.

- Open lines

- Closed lines that are intersecting

- Text created with built-in fonts 025 and 029,
an user-defined font or a Small Text font

- Original patterns containing both a shape
pattern and a text pattern
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M

When multiple patterns are selected, covering
stitches will be created as shown below.

« If the patterns do not overlap
Covering stitches will be created for each
pattern.

[Add]
e W
[f*.?,llf, _a.h_‘f:'\]‘"
v v 22U
> [Replace]

« If the patterns overlap

With the [Add] setting, covering stitches will be
created for an outline around all patterns.

[Replace]
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Tutorial 8-2: Creating Embroidered Patches

Tutorial 8-2: Creating Embroidered
Patches

The Embroidered Patch Wizard provides instructions for easily creating embroidered patches.

F mah:Fi SI1

The sample file for this tutorial is located at Documents (My documents)\PE-DESIGN 10\Tutorial\Tutorial_8.

Step 1 Creating the patch pattern
Step 2 Using the Embroidered Patch Wizard

4  Drag each pattern to arrange them so that
m they are well balanced.
The Embroidered Patch Wizard cannot be used if

a pattern containing text with the [Name Drop]
attribute applied is selected.

Step 1 Creating the patch pattern

suoneolddy 21j198ds 10j) suonelado -

1  Select the appropriate [Shapes] tool, and
then draw a heart.

»» "Drawing various shape" on page 62.

2 Import the fish pattern from the [Aquatic]
category of the Design Library.

»» "From Design Library" on page 91.

3  Select the [Text] tool, and then type in "I,
"Fresh" and "Fish".

»» "Entering text" on page 106.
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Tutorial 8-2: Creating Embroidered Patches

Step 2 Using the Embroidered
Patch Wizard

1  Selectall patterns, and then click the [Home]
tab.

2 Click [Embroidered Patch] in the [Cut and
Sew] group to start the [Embroidered Patch
Wizard].
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3  Specify settings in the [Embroidered Patch
Wizard] dialog box in the following order o -

s
smamm

@ satin Stitch
9 Cutting Line

M

To return all parameters in the [Embroidered
Patch Wizard] to their default settings, click
[Default].

4 uUnder [Satin Stitch], specify a border for the
embroidered patch.
— For this example, select [Yes], and then set
[Width] to "3.0 mm", [Density] to "4.5 line/
mm" and [Distance from original Pattern]
to "5.0 mm".

a

» [Width], [Density] and [Distance from original
Pattern] will be available if [Yes] has been
selected.

» Use [Distance from original Pattern] to specify
the distance between the original pattern and
the border.

5  Under[Cutting Line], specify the cutting lines

for the embroidered patch.

The cutting line of the embroidered patch can
be sewn as running stitches or the
embroidered patch can be cut out.

— For this example, select [Running Stitch],
and then set [Distance from satin stitch]
to "3.0 mm".

Running Stitch

Select this setting to sew the
cutting line, then cut along
the cutting line with scissors.

Cutting Line

% Rurning Stitch

" Cutting
Cutting Line CUtting
: In order for this setting to be
available

v

 Rurming Stitch

»» "Basic requirements for
Cutwork functions" on
page 173

Select this setting to cut the
fabric with a machine
installed with cutwork
needles.

& Cuiting

6  Click [OK] to exit the [Embroidered Patch
Wizard] dialog box.

M

* When [Cutting] is selected under [Cutting
Line], uncut sections will remain in the cutting
lines created with the Embroidered Patch
Wizard. Be sure to cut them with scissors after
embroidering is finished.

» The thread color of the satin stitching is the color
currently specified in the Design Page.
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Tutorial 8-2: Creating Embroidered Patches

Practical use of Satin
Stitch and Cutting Line

When [Satin Stitch] is set to [Yes]

The distance between the patch pattern and the
satin stitches is specified under [Distance from
original Pattern], and the distance between the
satin stitches and the cutting line is specified under
[Distance from satin stitch].

@ Patch pattern
® Satin Stitch
(® Cutting Line

If multiple patterns are selected for the patch
pattern, the finished result differs depending on the
distances between the patterns as well as between
the patterns, satin stitches and cutting line in
addition to the width of the satin stitches.

v v»@® @
v v @0
© > @

When [Satin Stitch] is set to [No]

The distance between the patch pattern and the
cutting line is specified under [Distance from
original Pattern].

@ ®

@ Patch pattern
@ Cutting Line

If multiple patterns are selected for the patch
pattern, the finished result differs depending on the
distances between the patterns and between the
patterns and cutting line.

v @
© >
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Tutorial 8-3: Creating a Cutwork Pattern Filled with Net Stitching

Tutorial 8-3: Creating a Cutwork Pattern
Filled with Net Stitching

Cutwork patterns, combining embroidery and cutting with cutwork needles, can be created using the extended
functions. By using the [Cutwork Wizard], a cutwork pattern can easily be created.

Finish

The sampile file for this tutorial is located at Documents (My documents)\PE-DESIGN 10\Tutorial\Tutorial_8.

Step 1 Creating an outline shape for cutwork

Step 2 Using the Cutwork Wizard

2  Select [Outline Shapes] from the [From]
selector, select [Leaves] from the [Category]
selector, select [OL_clover01.pes], and then

For the cutwork functions to be available, click &),
then [Design Settings]. Under [Machine Type],

select @ . click [Import].

When the cutwork functions are not being used, it is e i =

not necessary to select this setting. {tmprd B Gk Syl . e s
»» "Specifying the Design Page Settings" on | ot [t e 1!|

page 14

[

[
Step 1 Creating an outline shape s | 4
for cutwork

O el pea DL LT ps

o &N

DL tel] e D _efMpos  [1_owi B ey

¢ 3¢ ¢f

OL_ il bt O LafITps: DL beiBipsi 1

1  Display the [Import] pane.

M

Patterns in [Outline Shapes] from the [From]
selector are appropriate for creating the cutwork
patterns.
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Tutorial 8-3: Creating a Cutwork Pattern Filled with Net Stitching

3  Enlarge the pattern imported into the Design
Page.

4  ungroup the pattern. Select the pattern,
right-click it, and then click [Ungroup].
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Step 2 Using the Cutwork Wizard

1 Select the four leaves, and then click the
[Home] tab.

2  Click [Cutwork Wizard] in the [Cut and Sew]
group to start the [Cutwork Wizard].

M

e The [Cutwork Wizard] can also be used if
closed shape patterns or text patterns are
selected.

« If aline of the pattern crosses itself, the
[Cutwork Wizard] will not be available.

» Text with built-in font 025 or 029 or a user-
defined font cannot be used.

» Shape patterns and text patterns cannot be
combined.

3  Specify settings in the [Cutwork Wizard] in
the following order o - 6

o ©6 o © 5]

o Stabilize Cut Edge
e Cutting Line
9 Secure Water-Soluble Stabilizer

O nNet Fill

6 Covering Satin Stitch

M

To return all parameters to their default settings,
click [Default].

4  Specify running stitching along the edge
before cutting in [Stabilize Cut Edge].
By specifying that running stitches be sewn

before the fabric is cut, the cut edges are
reinforced, preventing them from unraveling.

— For this example, select [Yes].

Stabilize Cut Edge

* Yes
Mo
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Tutorial 8-3: Creating a Cutwork Pattern Filled with Net Stitching

171

Specify cutting line type in [Cutting Line].

Select whether the fabric will be cut along the
cutting line or whether the cutting line will
remain as running stitches.

— For this example, select [Cutting].

Cutting
In order for this setting

to be available
@ »» "Basic
requirements for
Cutwork

functions” on
page 173

Cutting Line

& Cutting

™ Running Stitch
Select this setting to
cut the fabric with a
machine installed with
cutwork needles.

Running Stitch

Cutting Line g )
Select this setting to
sew the cutting line,

LT then cut along the
}( cutting line with
scissors.

 Cutting

& Running Stitch

Specify securing of the water-soluble
stabilizer in [Secure Water-Soluble
Stabilizer].

Running stitches will be sewn to secure the
water-soluble stabilizer after the fabric has
been cut. In order to prevent embroidery from
losing its shape after it has been cut, place
water-soluble stabilizer in the cutout areas
and sew it in place.

— For this example, select [Yes].

Secure
“Water-Saluble Stabilizer

Specify net fill stitching inside the cutout areas
in [Net Fill].

By sewing net fill stitching in cutouts, inner
cutouts can be reinforced while allowing for a
greater design variety.

— For this example, select [Yes].

Het Fill
AN
LTH | |HF)
e

& Yes

" No

Select the parameters according to the
procedure from step 8 to 10, when [Net Fill]
is set to [Yes].

Specify the net fill stitch pattern in [Pattern].
Five net fill stitch patterns are available.

— For this example, select [Pattern 2].

Pattern 1

Pattern 4

Pattern 5




10

11

12

Tutorial 8-3: Creating a Cutwork Pattern Filled with Net Stitching

Specify the pattern spacing for the net fill stitch
in [Spacing].
— For this example, set it to [3.0 mm].

e
RN WA |
XN

PLVAT,

2.0 mm 10.0 mm

Specify the pattern direction of the net fill stitch
in [Direction].
— For this example, set it to [0°].

0° 90°

Specify satin stitching after cutting in
[Covering Satin Stitch].

Satin stitching is sewn along the edges of
inner cutouts.

The zigzag stitch or the stem stitch is used as
an underlay for the satin stitching.

— For this example, select [Yes].

Covering
Satin Stitch

[
L'HI
N

™

D

& Yes
" No

Select the parameters according to the
procedure from step 12 to 13, when
[Covering Satin Stitch] is set to [Yes].

Specify the width of the satin stitching in
[Width].

— For this example, set it to [4.0 mm].

3.0 mm

13 Specify the density of the satin stitching in
[Density].

— For this example, set it to [6.5 line/mm].

5.0 line/mm 7.0 line/mm

14 Click [OK] to exit the [Cutwork Wizard].
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On Using the Cutwork Functions

On Using the Cutwork Functions

Before using Cutwork functions, check the following.

Basic requirements for
Cutwork functions

M Set the "Machine Type" to multi-
needle embroidery machine

For the Cutwork functions to be available, click @
then [Design Settings]. Under [Machine Type],
select @ .

|| 2]

=aa i | o

B Outline shapes and text can be
used to create a cutwork pattern

¢ Outline shapes that have been drawn with the
tools indicated below.

¢ Text created in fonts other than built-in fonts 025
and 029, a user-defined font or a small text font.

vl NETT - e
wd Bhed = W - Tal
=
A [oe] R kS !
e 1 9 o
P ¥
Hapna Fown
=

173

« Patterns when [Outline Shapes] is selected in
the [From] selector of the [Import] pane.
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B Use a multi-needle machine that
has been upgraded to work with
Cutwork functions

The embroidery machine should be set to cutwork
mode in the settings screen before starting to
embroider. Refer to the included Operation Manual
for the details of embroidery machine operation.

Cutwork functions cannot be used with single-
needle embroidery machines. In addition, some
multi-needle machines may not support the
functions. Be sure to check that your machine is
compatible with the cutwork functions.
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Layout & Editing window for cutwork patterns

The settings and window areas specifically for cutwork functions are described below.
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1 Sewing Order
The cutting lines appear in one frame in the
[Sewing Order] pane, and the icon for the
cutwork needle appears beside the frame.

2 Design Page
The cutting lines appear as gray dotted lines in
the Design Page, regardless of whether the
[Solid View], [Stitch View] or [Realistic View]
is selected.

3 Sewing Attributes
In the [Sewing Attributes] pane, detailed
cutting settings can be specified for the cutwork
functions.

»» "Cutting" in the "Line sewing attributes"
on page 329

g
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5

4 Previewing cutting lines
In the [Stitch Simulator] pane, the cutwork
needles are displayed in four different shades of
gray.
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In a stitch simulation, the cutting lines appear as
short gray lines, indicating the needle drop
points for making the cuts.

While being edited In a stitch simulation
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On Using the Cutwork Functions

5 Checking Design Property
When [Cutting] has been assigned to a line
from the [Line sew type] selector, [Design
Property] screen appears as shown below.

Design Property

FieName:  Untiled Design Name
Fie Version: 100

Category
Modiied Date:
Widh 99.40mm Author

Height 151.30 mm
Sticheount: 13363

o
&t Conmert
st 6
5
clor | Co Descr
7
C

Basic Color
LEAF GREEN
de 1 Cutwork Neede 1
22 Cutwork Neede 2
o3 Cutwork Neede 3
le4  Cutark Needle 4
LEAF GREEN

M

[Color order] can be also viewed in the [Design
Property] screen in the Design Database.

a

« In patterns with [Cutting] selected in the [Line
sew type] selector, the line color and region
sewing settings are not available.

« Designs containing the line sew type [Cutting]
are saved as cutwork patterns.

»» “"Transferring/saving/exporting the cutwork
patterns" on page 175

» Created cutwork patterns can be used only with
embroidery machines upgraded for cutwork.
« With PE-DESIGN 10, the line sew type
[Cutting] changes to [Running Stitch] in the
following situations.
¢ When the [Machine Type] setting (on the
[Design Page] tab of the [Design Settings]
dialog box) is changed from a multi-needle
embroidery machine to a single-needle
embroidery machine

¢ When a cutwork pattern is imported while
[Machine Type] (on the [Design Page] tab) is
set to a single-needle embroidery machine

« Cutwork pattern cannot be transferred to a
machine by using an original card or the Link
function.

« Cutwork pattern cannot be created in Design
Center. To set the line sew type to [Cutting],
use Layout & Editing.

175

Transferring/saving/
exporting the cutwork
patterns

In addition to transferring cutwork patterns to a
machine, they can be saved or printed.

M Transferring

Transferring using USB media

By using commercially available USB media,
cutwork patterns can be transferred to embroidery
machines compatible with the USB media.

»» "Transferring to a machine by using USB
media" on page 201

Transferring directly to a machine's
memory
Cutwork patterns can be transferred to embroidery

machines that can be connected to a computer
using a USB cable.

»» "Transferring directly to a machine's
memory" on page 201

a

» Cutwork patterns cannot be transferred to a
machine by using an original card or the Link
function.

« The cutwork patterns can be transferred to
embroidery machine only after the upgrade for
cutwork has been installed and certified to the
machine.

M Saving

Saving cutwork patterns in the PES format

For details, refer to "Saving and Printing" on
page 95.

a

Designs containing the line sew type [Cutting] are
saved as cutwork patterns.




W Exporting

Exporting cutwork patterns in other
formats

Created cutwork patterns can be converted to other

formats (.dst, .hus, .exp, .pcs, .vip, .sew, .jef, .csd,
xxx, and .shv) and outputted.

When exported as another format, the cutting lines
will be changed to a running stitch.

On Using the Cutwork Functions
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Tutorial 9-1: Creating Split Embroidery Designs

Tutorial 9-1: Creating Split Embroidery
Designs

Layout & Editing has a function for creating split embroidery designs when the embroidery pattern being
created is larger than the embroidery hoop.

The sampile file for this tutorial is located at Documents (My documents)\PE-DESIGN 10\Tutorial\Tutorial_9.

Step 1 Specifying the Design Page size in Layout & Editing

Step 2 Creating the embroidery design

Step 3 Checking the embroidering order

Step 4 Attaching stabilizer to the fabric

Step 5 Using the Positioning Sheet, mark the embroidering position on the fabric
Step 6 Hooping the fabric

Step 7 Embroidering

Step 1 Specifying the Design
Page size in Layout &
Editing

1 Click @ then [Design Settings].

-. EF L | Lk i

St el el W

L]

2 Specify the Design Page size and the size of
the design sections.

T ey €3
gl |
-'\-l _o
1 .
Tomm i
w3 = _e
—
Frr——— _e

o Select the type of embroidery machine to
be used.

177

9 Select [Custom Size], and then type or
select the desired width and height for the
Design Page. This setting is to specify the
exact width and height of a design. For
this example, set width to 230 mm and
height to 330 mm.

9 Click the [Section Size (for Hoop Size)]
selector, and then select the size of the
sections (your embroidery hoop). For this
example, select 120 x 170 mm
(130 x 180 mm).

M

« With the [Section Size (for Hoop Size)] setting,
the width and height of the sections are 10mm
smaller than the actual hoop size in order to
provide space for fine positioning adjustments
with adjustment sections. The 10mm is for
overlapping.

* Itis not necessary for the [Section Size (for
Hoop Size)] to match the Design Page size.
Select the hoop size to be used for sewing.

3  Click [OK].
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Step 2 Creating the embroidery Step 3 Checking the
design embroidering order
For this example, we will use one of the lace Check the sewing order to see the order that the
embroidery patterns provided with the software. design sections will be sewn and determine which
) parts of the fabric should be hooped.

1 Display the [Import] pane. The design sections are sewn in order from left to
2  Select[Tutorial] from the [From] selector and fight, top to bottom.

[Tutorial_9] from the [Category] selector. 1 Click @ then [Desian Propert

Click [tutorial_9-1.pes], then [Import]. ! @ [Desig perty].

LT e ﬁ' MIETEEN ¥ |
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| timpud B Cobe Sy il Mliren s |

|I:-lp,|- I'i.l...:r_-'li“

¥, i

| T |1vial_32 ot 51 56 .

i
|hl|. |1u-|-' '|| |
i 1
| |
|

2  Uncheck the [Show about selected

Object(s)] to view the separate design
sections. Click on [Next] and [Previous] to

e | move back and forth through each section.
Check the design, and then click [Cancel].
»» "Importing embroidery designs" on p—
page 91. P Tm——
<P
P Show about selected Objzct(s).

Urtiled Design Name
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100
Categoy
12000 mm Author  —
17000 mm
P Kepwords

toh cour
22nin Commert

olor changes: 2

otal colors: 2

Color List @ Colorchanges Tt colors

[ Color | Code | Brand | Deseriplion [ Basic Color T
1 017 EMEROIDERY  LIGHT BLUE LIGHT BLUE
2 . NOTDEFINED ~ NOT DEFINED

a

Before an embroidery pattern created in a custom
Design Page is saved, running stitches are added
at the edges of the design sections so that the
design sections can easily be aligned during
sewing. This alignment stitching appears in the
[NOT DEFINED] color and cannot be edited.

»» Memo of "Step 7 Embroidering" on page181
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Tutorial 9-1: Creating Split Embroidery Designs

Step 4 Attaching stabilizer to the
fabric

Stabilizer must always be used when embroidering
to stabilize the fabric. There are many types of
stabilizer; the type that you will use depends on the
type of fabric that you are embroidering on. For
large-size designs that are split into sections, the
stabilizer must be adhered to the fabric, for
example, iron-on stabilizer. In some cases, you may
need to use two pieces of stabilizer for your
embroidery.

When using spray adhesive, spray the adhesive
onto a hooped piece of stabilizer that is strong
enough for the entire large-size embroidery. In
some cases, you may need to use two pieces of
stabilizer for your embroidery.

a

 For bestresults, attach the stabilizer to the fabric
(as described on this page). Without the correct
stabilizer, the design may become misaligned
due to puckering in the fabric.

* Be sure to check the recommendations on the
stabilizer package.

Step 5 Using the Positioning
Sheet, mark the
embroidering position on
the fabric

M

» The positioning sheets are included in the
package.

» The Positioning Sheets are also in the
[Positioning Sheet] folder and can be printed
out with a printer.

* Location of the Positioning Sheets: C:\Program
Files (x86)\Brother\PE-DESIGN 10\Positioning
Sheet.

« The positioning sheets in the PDF files are at
actual size. When printing the positioning sheet
from the PDF file, be sure to print it at actual
size. Do not print while reducing or enlarging to
fit the paper size.

179

1 Punch a hole at the end of each arrow on the
positioning sheet.

2 Place the positioning sheet on the fabric, and
then insert the tip of a marking pen into each
hole to mark the fabric.

3 Connectthe points marked on the fabric to
draw reference lines.

4  Place the positioning sheet on the fabric, and
mark points A, B, C and D.

5 Tomark an area to the right of the previously
marked area, align points A and D on the
positioning sheet with marks B and C on the
fabric.




Tutorial 9-1: Creating Split Embroidery Designs

6 Tomark an area below the previously marked
area, align points A and B on the positioning

Step 6 Hooping the fabric

sheet with marks C and D on the fabric. 1  Insertthe embroidery sheet into the inner ring
f of the embroidery hoop, and then place them
on top of the fabric with the centerline on the

embroidery sheet aligned with the reference
lines (drawn on the fabric) for the first pattern
section to be sewn.

7 Repeat steps 5 through 6 to reposition the
positioning sheet and draw the embroidering
position for each section of the embroidery

pattern.
2  Keeping the reference lines on the embroidery
Q sheet aligned with the reference lines for the
 The intersection of the horizontal and vertical first pattern section, place the fabric and inner
line indicates the center of the embroidery hoop. ring of the embroidery hoop into the outer ring
 While carefully considering how the fabric will be of the hoop, and then pull the fabric so that it
hooped, place the positioning sheet on the is tight.

fabric, and then draw lines to indicate the
embroidering position. In addition, because all
embroidery areas are not drawn on the
positioning sheet for large embroidery hoops, be
careful that the embroidery area does not extend
from the marked area on the fabric as shown
below.
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3 Finish hooping the fabric, and then remove the
embroidery sheet.
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a

« Place the fabric and hoop on a level surface, and
then make sure that the inner ring is pressed in
well enough that the top edge of the inner ring
aligns with the top edge of the outer ring.

« Ifthe embroidery sheet is not used, the marks on
the embroidery hoop can be used to hoop the
fabric vertically and horizontally.

However, since the center point on some
embroidery machines is off center, the
embroidery sheet should be used for best
results.

< Another way to hoop the fabric is to use sticky
stabilizer that can be hooped separately, tear
away the protective paper, then carefully align
the fabric onto the sticky surface using the
embroidery sheet as a guide.

 Tip: The sticky stabilizer should be removed
right away after the embroidery design is
finished.

 Tip: The fabric can be hooped more easily if
double-sided tape is affixed to the back of the
inner ring, which is placed on top of the fabric,
and then the fabric is clamped between the inner
ring and the outer ring.

Step 7 Embroidering

1  When large-size embroidery designs are
transferred to the embroidery machine, the
patterns appear on the embroidery machine
display as shown below. For this example,
select the first embroidery pattern section

(Aa).
w2
7]

If there is no stitching in section Aa, select the first
section that contains stitching. Click on
[Application] button, and then click [Design
Property] to check the embroidering order.

2 Attachthe embroidery hoop to the embroidery
machine, and then using the machine's layout
adjusting functions, align the needle position
with the intersection of the lines drawn on the
fabric.

3  Embroider the selected pattern.

4 Remove the embroidery hoop from the
embroidery machine, and then remove the
fabric from the hoop.

181

5  Hoop the fabric for the next design section.

»» "Hooping the fabric" on page 180

M

When an embroidery design created in a custom
Design Page is saved or transferred to an original
card, alignment stitching (single lines of running
stitches with the color [NOT DEFINED], with a
pitch of 7.0 mm, and starting with fixed stitches
with a pitch of 0.3 mm) is added at the edges of the
design sections. (The alignment stitching appears
in the print preview and is printed in red.)

Sample data for this tutorial

1) Embroider the upper-left design section.

— Alignment stitching is sewn below and on
the right side of the embroidered design
section.

2) Hoop the fabric for the upper-right design
section with the left side of the hoop aligned on
the alignment stitching on the right side of the
design section sewn in step 1, and then
embroider the design.

— Before the design section is embroidered,
alignment stitching is sewn on the left
side. Make sure that this alignment
stitching aligns with the alignment
stitching sewn in step 1. After the design
section is embroidered, alignment
stitching is sewn below the design
section.
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3) Hoop the fabric for the lower-left design section
with the top of the hoop aligned on the
alignment stitching at the bottom of the design
section sewn in step 1, and then embroider the
design.

— Before the design section is embroidered,
alignment stitching is sewn at the top.
Make sure that this alignment stitching
aligns with the alignment stitching sewn in
step 1. After the design section is
embroidered, alignment stitching is sewn
on the right side of the design section.

4) Hoop the fabric for the lower-right design
section with the left side of the hoop aligned on
the alignment stitching on the right side of the
design section sewn in step 3 and with the top
of the hoop aligned on the alignment stitching at
the bottom of the design section sewn in step 2,
and then embroider the design.

— Before the design section is embroidered,
alignment stitching is sewn on the left side
and at the top. Make sure that this
alignment stitching aligns with the
alignment stitching sewn in step 3 and in
step 2.
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6 Continue hooping the fabric and embroidering
until the entire embroidery design is sewn.
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Tutorial 9-2: Creating Design for Multi-
Position Hoops

This program enables you to create multi-position designs that you can stitch in any multi-position hoop
attached to your embroidery machine.

c . C

Example of multi-position hoop: 100 x 172 mm hoop

Although the size of the design that can be embroidered using an multi-position hoop is 130 x 180 mm (or 100
x 100 mm, depending on the sewing area of the embroidery machine), first determine which of the three
installation positions (indicated as a, b, and c in the illustration above) the multi-position hoop will be installed
at and determine the orientation of the design.

When creating the design, each design section can only be as large as the sewing area of the embroidery
machine.

The sampile file for this tutorial is located at Documents (My documents)\PE-DESIGN 10\Tutorial\Tutorial_9.

Step 1 Selecting the Design Page size
Step 2 Creating the design

Step 3 Optimizing hoop changes

Step 4 Checking the pattern

Step 1 Selecting the Design Page 2 select © GJziif under [Machine Type], and

size then select [Hoop Size] and choose a Design
B Page size of 130 x 300 mm or 100 x 172 mm
1 Click @ then [Design Settings]. from the selector. Then, click [OK].
. T by L]
1 Pami b i
| —_— = =
a- = e e
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—
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M

* Settings for multi-position hoops are indicated
by " x".
» Choose the appropriate setting after checking

the size of the hoop available for your machine.

Step 2 Creating the design

1  The Design Page appears on the screen as
shown below.

1 «a

<«—b

« Areaa
Embroidering area when the multi-position hoop
is installed at the top installation position.

* Areab
Embroidering area when the multi-position hoop
is installed at the middle installation position.

* Areac
Embroidering area when the multi-position hoop
is installed at the bottom installation position.
The dotted lines separate each area.

» The size of one pattern must be no larger
than 100 x 100 mm (or 130 x 180 mm).

» Each pattern must completely fit within a
single area (a, b, or c).

: The position of this pattern is correct since it fits

completely within area a.

. The position of this pattern is correct since it fits

completely within either area b or area c.

: The size of this pattern is acceptable, but its

position must be corrected since it does not fit
completely within any of the areas.

(It will be necessary to correct the position in
order to fit in either b or c.)

: This pattern must be corrected since it is too

large.
(It will be necessary to correct the position and
size in order to fit in either a, b, or c.)

2 Create the design, making sure that it meets
the following conditions.
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Step 3 Optimizing hoop changes

Click @ then [Design Settings].

_ =0 e Lmmried - Lsyn
| ... o ;
d- [
i — T

]

2  Click [Output] tab.

I CEap ?l;'Tlll.Il

e [T

Mattiii Ta
| £

3  Selectthe [Optimize the number of times to

changethe hoop’s position] check box, and
then click [OK].

M

» A check mark appears when this function is
turned on; no check mark is displayed when this
function is turned off.

* When the Optimize hoop change function is
turned on, the sewing order that you have set is
optimized to reduce the number of times that the
hoop installation position is changed.

For the example shown on this page, the sewing

order is: a (pattern 1) — b (pattern 2) —» a

(patterns 3 & 5) — ¢ (patterns 4 & 6)

If the Optimize hoop change function is turned

off, each pattern is sewn according to the sewing

order that you have set.

s For the example shown on this page, the sewing

‘ order is: a (pattern 1) — b (pattern 2) —» a
(pattern 3) — c (pattern 4) — a (pattern 5) —» ¢

(pattern 6)

Therefore, since the number of times for

changing the hoop installation position is not

optimized, it may be changed more often than if

it was optimized.

Design Settings n

Design Page  Output |

- Sewing Area
£ Design Page area

& Use esisting design area

“ [V Dptimize the number of times to change the hoop’s position I

~Jump Stitch Trimming

Minimum jump stitch length for thread trimming: 10 _|j mm

Cancel &
Since the pattern may not be sewn correctly or the
fabric may not feed evenly if the hoop installation
position is changed too often, we recommend
turning on the [Optimize hoop change] function.
Turning on this function will change the sewing
order that you have set, therefore, check the
sewing order before you begin embroidering.

185




Tutorial 9-2: Creating Design for Multi-Position Hoops

M Saving the design

The entire design is saved as a single file (.pes).

1 Click @ then [Design Property]. D:I

Step 4 Checking the pattern

ﬁ,l i . e If the file size or the number of color changes is
larger than the specified number, or if one of the
patterns does not completely fit within an
embroidery area, the error message appears.

L L]

B Writing the design to an original

o
A design for a multi-position hoop is created by

| see considering the pattern in each hoop installation
i, position as one pattern, then combining them.

Therefore, when this type of design is written to an
original card, one multi-position hoop design is
saved as a combination of multiple patterns.

2 Checkthe sewing order of each pattern and
the number of times the hoop position will be

O
©
changed. @
)
>
Design Property 6
o = About b H =
out hoop postion 1/ 3 7
A o] D o
0 o
o3 -
%)
File Mame : Untitled Design Mame : ’_ ©
FieVergon 100 o [~ n : This pattern is sewn when the hoop is 3
Mosiier Date installed at the top installation position =
Width: 100,00 mm Author [ . o
Height 100.00 rm (position a). >
Stitch count: 218 Keynords ,7 - B B ©
i e H : This pattern is sewn when the hoop is o
ewing time : 1 min Caomment . . . . . =
B metims: 1 installed at the middle installation position &’
Total colors 1 (position b) &),.
o
Coarlit: @ Colorchanges ¢ Total colors u : This pattern is sewn when the hoop is 2
Color | Code | Brand Description Basic Color H H H H™
TIR T+ 1ChFOTERT O CReEn (Lo GReen |nsta_ll_ed at the bottom installation position
(position c).
Only the patterns that would be sewn at the Therefore, the frame installation position sewing
current position in the hoop installation order order for the pattern shown above is b, a, then c.

appear in the Design Page, and the
embroidering area for the current hoop
position is outlined in red.

o The position in the hoop installation order
for the currently displayed pattern.

e To display information for patterns at
other positions in the hoop installation
order, click [Previous] or [Next].

a

If a pattern is larger than the embroidery area or if
a pattern is positioned so that it does not
completely fit within an embroidery area, the error
message appears. After the pattern causing the
error is displayed, select the pattern and change
its size or position.
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Notes on embroidering using the multi-
position hoop

« Before embroidering your design, sew a trial
sample of the design on a scrap piece of fabric
from your design, making sure to use the same
needle and thread.

« Be sure to affix stabilizer material to the back of
the fabric and tightly stretch the fabric within the
hoop. When embroidering on thin or stretch
fabrics, use two layers of stabilizer material. If no
stabilizer material is used, the fabric may become
over-stretched or wrinkled or the embroidery may
not be sewn correctly.

»» For more ways to stabilize large designs,
refer to "Attaching stabilizer to the fabric"
on page 179

¢ Use the zigzag stitch for sewing the outlines in
order to prevent embroidering outside the
outlines.

O X

¢ For patterns that require the hoop to be installed
at different installation positions, design the
embroidery pattern so that the various parts of
the pattern overlap in order to prevent
misalignment while embroidering.

@® Overlap

187

M Printing a Design Page for a multi-
position hoop

On the first page, a complete image of the Design
Page is printed at actual size. (However, for a 130 x
300 mm Design Page, a reduced image of the
Design Page is printed.) On the following pages, an
image of each design section and its sewing
information are printed in the sewing order.

When [Actual Size] is selected:
An image of the pattern in each design section is
printed on a separate page as the corresponding
sewing information.

When [Reduced Size] is selected:
An image of the pattern in each design section is
printed on the same page as the corresponding
sewing information.

»» "Printing" on page 96
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Tutorial 9-3: Embroidering With the
Jumbo Frame

This section describes the procedures for creating embroidery data and for embroidering using the jumbo
frame (frame size: 360 x 360 mm; with mounts on both sides of the embroidery frame).

a

« If the jumbo frame was selected, the size of the Design
Page becomes 350 x 350 mm in order to create margins
that allow automatic positioning using the built-in camera.

* The jumbo frame described here was designed specifically
for our multi-needle embroidery machines equipped with a
built-in camera. It cannot be used with any other machine,
such as single-needle embroidery machines. Check the
Operation Manual provided with your multi-needle
embroidery machine to determine if it is compatible with the
jumbo frame.

Jumbo frame: 360 x 360 mm embroidery frame

M

For details on embroidering using the camera and on affixing the embroidery positioning stickers, refer to the
Operation Manual provided with the embroidery machine.

The sample file for this tutorial is located at Documents (My documents)\PE-DESIGN 10\Tutorial\Tutorial_9.
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Step 1 Selecting the Design Page size

Step 2 Creating the embroidery design

Step 3 Checking a divided pattern

Step 4 Attaching stabilizer to the fabric

Step 5 Embroidering

Step 1 Selecting the Design Page 2 Click @ under [Machine Type], select

size 360 x 360 mm (Jumbo Frame) from the
N [Hoop Size] selector under [Page Size], and

1 Click '@ then [Design Settings]. then click [OK].
- || 2]
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Tutorial 9-3: Embroidering With the Jumbo Frame

a

Check the size of embroidery frames that can be
used with your machine before changing the
setting.

3 The Design Page appears on the screen as
shown below.

TR £ RPN PP IO £ S R

o Side 1 embroidering area
Area embroidered first

e Side 2 embroidering area
Area embroidered second

The embroidery pattern is automatically
divided into the different areas.

a

The embroidery pattern is split with a section
overlapping o and 9

If the pattern arranged in this section uses satin
stitches, the stitch may change when the pattern is
split. Therefore, we recommend shifting the
pattern or changing the sew type to fill stitches.

Step 2 Creating the embroidery
design

For this example, an embroidery pattern provided
with this software will be used in the procedure
described below.

1 Display the [Import] pane.

Select[Tutorial] from the [From] selector and
[Tutorial_9] from the [Category] selector.
Click [tutorial_9-3.pes], then [Import].

| ] i =

| hmaar Bt Sdang it Minet st

|p.. [Tixd _._:l

||::|m.|l |[Tuss T _-_-l
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»» “Importing embroidery designs" on
page 91.

Step 3 Checking a divided

pattern

Before starting to embroider, the divided embroidery
pattern can be checked. If a pattern that you do not
wish to be divided has been split onto Side 1 and
Side 2, you can check the embroidery pattern, then
adjust it so it is not split.

1

Click @ then [Design Property].

t" AEIEENT : iy
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Tutorial 9-3: Embroidering With the Jumbo Frame

2  Click [Next] to view the next side of the
embroidery design.

T R

To view the embroidery pattern of the separate
sides, uncheck the [Show about selected
Object(s)].

Design Property

About hoop pasition 1/ 2

<< Previous Hext »>

¥ Shows ahout selected Dbject(s):

Desion Name

File Name Untitled

M Saving the design

The entire design is saved as a single file (.pes).

»» "Transferring to a machine by using USB
media" on page 201, and "Transferring
directly to a machine's memory" on
page 201

a

An embroidery design for the jumbo frame cannot
be transferred to the machine by using an original
card. Transfer these designs directly to the
machine's memory or to the machine by using
USB media.

Step 4 Attaching stabilizer to the
fabric

Always use stabilizer when embroidering.

For large designs split into sections, the stabilizer
must be attached to the fabric, for example, by using
iron-on stabilizer, self-adhesive stabilizer or spray
adhesive. Use stabilizer appropriate for the fabric.

In addition, be sure to use stabilizer that is strong
enough and large enough for the entire
embroidering area. You may need to attach two
layers if thin stabilizer is used.

»» See more information about stabilizer,
"Step 4 Attaching stabilizer to the fabric"
on pagel79.

Step 5 Embroidering

Embroider using the embroidery positioning stickers
included with the embroidery machine. These
stickers are detected by the embroidery machine's
built-in camera to automatically position the fabric.

1 Hoop the fabric in the embroidery frame.

\\ \

= "

2  Attach the embroidery frame to the
embroidery machine.

3  Selectthe pattern for side 1, and then start the
embroidery machine to embroider the side 1
embroidering area.
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Tutorial 9-3: Embroidering With the Jumbo Frame

4 When embroidering is finished, follow the
instructions on the embroidery machine to
affix embroidery positioning sticker on the
embroidering area.

An image of the needle location appears in the
screen with the positioning detection area framed
by a line.

Affix an embroidery positioning sticker so that it fits
within the line. For details, refer to the Operation
Manual for the machine.

— The embroidery machine's built-in camera
detects the embroidery positioning sticker.

5  After the sticker have been detected, remove
the embroidery frame, rotate it 180°, and then
re-attach it to the embroidery machine.

™\
A
¥

— The embroidery machine's built-in camera
detects the embroidery positioning sticker
again.

191

6 Followthe embroidery machine instructions to
remove the embroidery positioning stickers.

7 Selectthe pattern for side 2, and then start the
embroidery machine to embroider the side 2
embroidering area.

* For details on using the embroidery machine,
refer to the Operation Manual included with it.

 Carefully remove the embroidery frame and
reattach it correctly. If the embroidery frame is
not correctly attached or if there is slack in the
fabric, the embroidery pattern may become
misaligned.

B Embroidery data for the jumbo
frame

* When the embroidery design is being saved in
[Layout & Editing], older file format versions are
not available.

In addition, the embroidery design is saved as
data specifically for our multi-needle embroidery
machines equipped with a built-in camera. It
cannot be sewn with any other machine.

« An embroidery pattern created in a Design Page
set to the jumbo frame size in [Design Center]
cannot be transferred directly to the machine.
Import the embroidery pattern into [Layout &
Editing], and then transfer it to the embroidery
machine.




Specifying/Saving Custom Sewing Attributes

Specifying/Saving Custom Sewing

Attributes

Saving frequently used
sewing attributes

Frequently used sewing attributes can be saved
together, and recalled when specifying sewing
attributes.

M Saving the settings in a list
1  Click the [Sewing Attributes] tab.

»» "Specifying sewing attributes” on
page 54

2 i necessary, change the settings, and then
click (=),

3 click[Save As].

Load/Save Default Settings
Catton fabric
Default
- =
Fleece
Knit Fabric:
inen
Sheer fabric
Synthetic leather
Termy cloth
Close

4 Type in a name for the group of settings, and
then click [OK] to register the group in a list.

Save As
Enter the name for the set of sewing attributes
[l
Cancel

M

« The saved setting can also be used on a
different computer. Simply copy [sastu.txt] from
[C:\Program Files (x86)\Brother\PE-DESIGN
10\Settings] on the original computer to the
Settings folder at the same path on the
destination computer.

* In Explore click on C:\Program Files
(x86)\Brother\PE-DESIGN 10\Settings. Single
left click on the Settings folder to view the
contents. Single right click on sastu.txt and
select copy from the menu. Paste to a USB
device and transfer to a different computer.

M Deleting a group of settings from
the list

1 In the [Load/Save Default Settings] dialog
box, select the group of settings to be deleted.

2 Click [Delete] to delete the selected group of
settings from the list.

M Recalling agroup of settings from
the list

1 In the [Load/Save Default Settings] dialog
box, select the group of settings to be recalled.

Load/Save Default Settings

[ et |
Catton fabric -
Default
Cenim
Fleece 4
e =T| it fabric: Delete
Linen
Sheer fabric
Synthetic leather
Temy clath %

o A group of settings that you have saved
will appear with "*" beside its name.

e Sewing attributes appropriate for various
fabrics are already available. Select the
type of fabric to be embroidered to specify
the recommended settings for that fabric.

2 Click [Load].

— The settings in the [Sewing Attribute
Setting] dialog box change to the saved
settings.

Editing user thread color
lists

If you have a list of thread colors that are frequently
used, they can be saved in a user thread chart.

1  Click [Option], then [Options].
- owrm

==

Pesd - Lilwran i Eoiing
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Specifying/Saving Custom Sewing Attributes

2 Click [Edit User Thread Chart]. M Creating a new thread chart
Dsticrs 1  Click [New Chart] @.
D R Brmss L . .
oo 3 2  Type in the name of the chart, and then click
I aEEgs I [ = i [OK] .
5 Thariniei | M 2 EeRFCLERT
s Tk = I m g M New Thread Chart
£ . — _T; ‘_'::"z'_:ﬂ
i s i T Name: |
L 1 A Cancel
3  Auser thread chart can be saved, edited or
deleted. D:I
o 2] © 0000 A saved thread chart can be selected from the
oot | | [User Thread Chart] selector and [Thread Chart]
BROTHER EMBROIDERY | [rychart 2| NewCrat. | selector.
[ T Color | Code [ Brand A [ Tcofr [ Code [ Band Rename Gt
1 M 500  EMBROIDERY| l [
2 001 EMBROIDERY 2 002 = Delete Chart
3 I 200 EMBROIDERY 3 085 EMEBRO| ZEBY'
g % Emg:g}gg;; 4 N 036 EMBRO s Import Chiatt.
6 124 EMBROIDERY
T Dewom ;
9 MM 807  EMBROIDERY > — P -
PEE ame B Renaming a thread chart
- GeRonay
ST e 1  From the [User Thread Chart] selector (®,
17 208 EMBROIDERY
BEaE g select the chart.
Sofmis ZERER. et |
‘ | ’ | [—J 2 Click [Rename Chart] @.
N . .
| —lj—J 3 Type in the name of the chart, and then click
(o (0] ®® @ [OK].
L Rename Thread Chart
Select an existing thread chart.
Adds thread colors from a existing thread _caedl |
chart.

When editing or deleting a thread chart,

select the thread chart here before

performing the operation. o Deleting a chart

1  From the [User Thread Chart] selector (),
select the chart.

Imports the thread chart.
Deletes a thread chart.
Creates a new thread chart.
Changes the thread chart name. 2 Click [Delete Chart] ©.

Displays thread colors in existing thread 3  If a message appears, click [Yes].
chart.

Deletes a thread color.

Displays thread colors in the user thread
chart.

Changes the order of the thread colors.

6 60 00000 O 00

Adds a new thread color.
@ Edits a thread color.
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Specifying/Saving Custom Sewing Attributes

B Importing athread chart B Adding a new item
1  Click [Import Chart] ©. 1  Click [New Item] @®.
2 Selectthe drive, the folder, and the btc, btc2 or 2 Tocreate a new color, click [Mix].
csv file, and then click [Open]. —
-m.-.-u'l-.-r-. Fomar B2 Thread Ik -
s F— = i o - Color I —
e A0 "_'I an ':_-: G " i Code
| ET—— RIS G e bt [
— peses [
&
- 3  Specify the color, and then click [OK] to add
‘ ! the specified color to the [Edit Thread] dialog
T : e | box.
I Zoip -
. —— @@
Files in the .btc, .btc2 or .csv format can be ErEErEEE
imported. EFrTEFEEN
EffEEREN
»» "User thread chart files" on page 195 EfEEENEEN
EEEEEEEN
3 If amessage appears, click [Yes]. [ .
e
M Editing a chart N R i
1 From the [User Thread Chart] selector @ — =
iy ] B

select the chart.

2  Continue with the appropriate procedure. To D:I
save the changes, click [OK]. . . .
g [OK] The color cannot be changed if the slider (a) is

. . moved to the top of the scale.
B Adding items from a thread chart P
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1 From the [Thread Chart] selector @ select 4
the thread brand or a user thread chart.
If multiple user thread charts have been
created, thread colors can be selected from D:I
different user thread charts.

If necessary, type in the code, brand and
description into the appropriate boxes.

Only numbers can be entered for the code.

2  Fromthe list @), click the thread colors.

D:I 5 Click [OK] to add the new item to the user

o ) thread chart @
To add multiple items, hold down the <Shift> or

<Ctrl> keys while selecting thread colors. m

) An asterisk (*) appears in front of the index number
3 cClick [Add] @ for items created or edited by the user.

— The selected items are added to the list in
the user thread chart @
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M Deleting items

1 From the list for the user thread chart @
select the item to be deleted.

2  Click [Delete] @ to delete the item from the
user thread chart.

M Editing an item

An item registered in the list for a user thread chart
can be edited to change the color or thread number.

1 From the list for the user thread chart @
select the item to be edited, and then click
[Edit Item] @.

2  Edit the item details in the same way as
adding a new item.

Edit Thread

Thiead Inf

Colar: M - -
ol Cancel

Code: 0517

il

Brand:

Description;  |Green

M

As with newly added items, an asterisk (*) appears
in front of the index number of edited items.

M

User thread chart files

Existing user thread charts can be imported, or
edited user thread charts can be used on a
different computer.

» A newly created user thread chart is saved, in
the .btc2 format with the same name as the
thread chart, at [C:\Program Files
(x86)\Brother\PE-DESIGN 10\MyChart].

 Existing user thread charts, created with the
previous versions of the application such as PE-
DESIGN NEXT, can be used in PE-DESIGN 10.
Import the file "chart2.btc" from the following
location;
[C:\Program Files (x86)\Brother\PE-DESIGN
NEXT\Color].

 The file "chartl.btc" in the [Color] folder cannot
be imported.

» A user thread chart file in the .csv format can be
imported.
The .csv file should contain information for
Code, Brand, Description, R, G and B,
separated by commas with one color on each
line. The RGB values must be within 0-255.

Example: For a .csv file

100,MyBrand,Black,10,10,10
101,MyBrand,White, 245,245,245

B Changing the order of items

1 From the list for the user thread chart (),
select the item to be moved.

2 Click [Up] or [Down] @ to change the order
of the item.
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Specifying/Saving Custom Sewing Attributes

a

Thread colors in embroidery patterns created with
this application may appear differently on the
embroidery machine, depending on the model
used.

1. Embroidery machines without a function for
displaying thread colors

The specified thread color information cannot
be displayed at all.

2. Embroidery machines with a function for
displaying thread colors

Of the thread color information specified in the
embroidery pattern, only the thread color
names are displayed on the machine.
However, the names that are displayed are
limited to the machine's preset thread color
names. Therefore, the machine displays the
names of its preset thread colors that are
closest to the colors specified in the embroidery
pattern.

3. Embroidery machines with a thread color
index

Some machines can display the thread
information specified with this application.
However, for thread colors that have been
edited or added by the user (thread colors with
an asterisk (*) at the left side), only the thread
number is displayed.
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Using Manual Punch Tool

Using Manual Punch Tool

By using the [Manual Punch] tools, you can create embroidery patterns whose sewing direction lines can be

manually adjusted.

M

Shapes drawn using the [Manual Punch] tools can be edited in the same way as shapes drawn using the

[Shapes] tools.

Creating an original logo

Using the [Manual Punch] tools, an embroidery
pattern can be created using an image of your logo
in the background.

1  Open animage of the logo to be used to
create the embroidery pattern.
»» “Importing Image Data" on page 150

(T ] W

-
=
"

apple

For this example, we will create a pattern of the red
design at the far left.

M

A faded copy of the background image can be
displayed in the [Design Page].

»» "Adjusting the density of the background
image" on page 152
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First, select the [Manual Punch] tool. Click
the [Home] tab, click [Shapes], and then click

i
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Mona Porst

Srap
(77 Select this tool to create straight block

patterns (region sewing).
(Shortcut key: <Z>)

(&7 Select this tool to create curved block

patterns (region sewing).
(Shortcut key: <X>)

/v Select this tool to create running

patterns (line sewing).
(Shortcut key: <V>)

¢ Select this tool to create feed patterns
(jump stitches).
(Shortcut key: <B>)

»»  "Jump Stitch and Jump Stitch Trimming"
on page 297




Using Manual Punch Tool

3 Click points 1 through 4, in order. 7  Click point 13, then point 14 (last point of

running stitching connecting the parts), and

5 then press the <Enter> key.

3I—\ Specify the point so that it overlaps/connects
F 3 the part created in step 5.

M

To remove an entered point, right-click it or press
the <BackSpace> key.

4  Select the Curve tool. 8 Click @ cure inthe [Input] group of the

) [Manual Punch] tab.
Click g7 curve in the [Input] group of the

[Manual Punch] tab. 9  Click points 15 through 23, in order.

o Bl : P Click point 24 (last point of the pattern part),
' e i e T Ul and then press the <Enter> key.

™ S i il Faié

i Specify the point so that it overlaps/connects
1 the part created in step 7.

S FEF HY

5  Click points 5 through 11, in order.

Click point 12 (last point of the pattern part),
and then press the <Enter> key.
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10 Click ¢ straignt in the [Input] group of the
[Manual Punch] tab.

11

Instead of pressing the <Enter> key, the pattern
part can be completed by double-clicking.

6 Click //Running in the [Input] group of the
[Manual Punch] tab.
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Using Manual Punch Tool

11 Click points 25 through 27, in order.

Click point 28 (last point of the pattern part),
and then press the <Enter> key.

Specify the point so that it overlaps/connects
the part created in step 9.

Image of finished logo

=

pple

« If parts are connected to previous and following
ones, jump stitches will not be created in order
to automatically optimize entry and exit points.
We recommend checking stitching with the
Stitch Simulator before sewing.

»» "Checking the stitching with the Stitch
Simulator" on page 80

« Manually adding or adjusting sewing direction
lines in shape patterns afterward allows you to
continue creating patterns using the same
Manual Punch tools.

»» "Specifying the sewing direction" on page 51
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Transferring Data

This section describes operations for transferring
embroidery designs to embroidery machines.




Transferring Embroidery Designs to Machines

Transferring Embroidery Designs to

Machines

The procedures for transferring the created embroidery pattern to an embroidery machine differ depending on
your embroidery machine model. For details, refer to the Operation Manual provided with your embroidery

machine.

Transferring to a machine
by using USB media

Designs can be transferred to
an embroidery machine
compatible with the USB Host
function.

a

The "PE-DESIGN Software Key" cannot be used
as USB media. Do not save embroidery files on
the "PE-DESIGN Software Key" for transferring.

1  Plug the USB media into the computer.
2  Click the [Home] tab.

3 cClick [Send] in the [Sew] group, click [Send
to USB Media], and then select the desired

drive.
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— Data transfer begins.

a

If there is already a file with the same name at the
destination, the following dialog box appears.

Select whether to overwrite the existing file, to stop
copying or to copy the file using a different name.

Copy File H
There s alieady a file with the sams name in this location
Untitlsd PES
 Lopy and Replace
" Don't copy
" Copy using another name
Cancel

4  After the data has been transferred, the
message "Finished outputting data." appears,
indicating that the transfer is finished. Click
[OK], and then remove the USB media.

M

If multiple USB media are connected, specify
where the data is to be transferred in the area
shown below.

- =y Triie] g i ' ks Lheandy
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Transferring directly to a
machine's memory

Designs can be transferred to
embroidery machines that can
be connected to a computer
using a USB cable.

1 Connect the embroidery machine to the
computer.

2  Click the [Home] tab.

3 Click [Send] in the [Sew] group, click [Send
to Your Machine], and then select the
desired drive.

B-i4 14 -8 _
miin

i

o e

— Data transfer begins.
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Transferring Embroidery Designs to Machines

1} Transferring to a machine
by using an original card

Designs can be transferred to

If there is already a file with the same name at the
destination, the following dialog box appears.
Select whether to overwrite the existing file, to stop

copying or to copy the file using a different name. an embroidery machine
. B equipped with a card slot.
There is already a file with the same name in this location.
Untitled PES
 Topy and Replacel &
Ot « Be sure that the hoop size of the design does not
' Cop using anather name exceed the hoop that will be used on the
embroidering machine.
» When writing to an original card that already
_Ceed | contains data, all data on the card will be

4  After the data has been transferred, the

message "Finished outputting data." appears,

indicating that the transfer is finished. Click
[OK].

M

* For details on transferring designs with this
method, refer to the Operation Manual provided
with your embroidery machine.

« If multiple machines are connected, specify
where the data is to be transferred in the area
shown below.

LS - B i1 % il s ¥

il Gk Bl Gl . Fomid bn e tlanewe ]|

« If the connected embroidery machine has been
set to Link mode, the command [Send to Your
Machine], mentioned in this procedure, cannot
be selected. To select this command, return the
machine to normal mode.

deleted. Before writing to a card, save all
necessary data to a hard disk or other media,
and check that no necessary data remains on
the card.

»» "From an original card" on page 92

« An embroidery design for the jumbo frame
cannot be transferred to the machine by using
an original card. This size is designed
specifically for our multi-needle embroidery
machines equipped with a built-in camera.

»» "Tutorial 9-3: Embroidering With the Jumbo
Frame" on page 188

»» For details on writing multiple embroidery
designs, refer to "Transferring
Embroidery Designs to Machines" on
page 246.

1  Plug the USB card writer module. Insert an
original card into the USB card writer module.

S

2  Click the [Home] tab.
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Transferring Embroidery Designs to Machines

3  Click[Send] inthe [Sew] group, and then click
[Write to Card].

\trtpad oo & Gniag - o El
s

= - Sy -k
" . Lk
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4 Whenthe following message appears, click
[OK].

Layout & Fditing E

ﬂ il mympeglzarg daby sl b ciebend

— Data transfer begins. The following
message appears while the data is being
transferred.

Mow transmitting...

Please wait for a while.

5 After the data has been transferred, the
following message appears, indicating that the
transfer is finished. Click [OK].

et s Edfihing “

“ ‘Wrmap ko migme cod w roTaieked
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a

Transferring split embroidery designs
Embroidery patterns for the split patterns created
on the custom-sized Design Page are written to
cards split into their separate sections.

If the total size of the pattern exceeds the capacity
of the media or the machine's memory or if the
pattern is split into over 80 sections with a Design
Page size of 90 x 90 cm (35.4" x 35.4"), you will
need to split the pattern and write the separate
sections onto several media.

If all pattern sections cannot be saved with a single
operation, the [Select Hoop Sections] dialog box
appears. Select pattern sections until the media
becomes full.

VY

The card capacity indicator at the top of the dialog
box shows the amount of space available on the
card (white) and the amount of space used by the
pattern sections (blue).

When a pattern section is selected, the total
amount of space used by the selected pattern
sections appears in blue. If the capacity is
exceeded, the entire card capacity indicator
appears in red. To deselect a pattern section, click
it again.

Click [Write] to write the selected pattern sections
to the media. (The [Write] button is available only
when a pattern section is selected and there is
sufficient space on the media for the selected
pattern sections.)

»» For details on creating split embroidery
designs, refer to "Tutorial 9-1: Creating Split
Embroidery Designs" on page 177.




Using the Link Function to Embroider From the Computer

Using the Link Function to Embroider
From the Computer

Embroidery designs can be embroidered by transferring the embroidery data from the
computer to one or more embroidery machines compatible with the Link function. These
embroidery designs are embroidered after the data is sent from the computer to the
embroidery machine in the same way that a document is printed after the data is sent from

a computer to a printer.

a

The Link function can be used only with
embroidery machines compatible with the
function; it cannot be used with other machines.
For details, refer to the Operation Manual
provided with your embroidery machine.

The Link function cannot be used with the
following embroidery designs.

+ Size exceeds the area that can be
embroidered with the machine

+ Embroidery designs in a Design Page of a
custom size or for the jumbo frame

+ Patterns for the 240 x 360 mm hoop

Up to four embroidery machines can be
connected using the Link function.

a

Create an embroidery design in [Layout &
Editing].

Set the embroidery machine in Link mode.

» Turn on the Link function of the embroidery
machine, and then turn off the machine.

For details on setting the machine in Link mode,
refer to the Operation Manual provided with your
embroidery machine.

3

Use the USB cable included with the
embroidery machine to connect the machine
to the computer.

* Turn on the embroidery machine.

a

 For details on connecting the machines to the
computer, refer to the Operation Manual
provided with your embroidery machine.

« If the machine is positioned far from the
computer, we recommend you to use a self-
powered USB hub. Do not use USB extension
cables or repeater cables.

* Do not connect or disconnect the USB cable
while the machine is turned on.

» Select[Power Options] in [Control Panel], and
then set both [System standby] and [System
hibernates] to [Never].

M

One or more embroidery machines can be
connected to PC by using the Link function.

4  Click the [Home] tab.
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Using the Link Function to Embroider From the Computer

5 cClick[Send] in the [Sew] group, and then click
[Link].

£ - Lot & DTy

L=
| T B [T
L e e —
i T = =T

o Transferred design
e Queue

Displays the data before it is transferred
to the embroidery machine.

— When the machine is ready to start loading
the data, data transfer begins. While the
data is being transferred, a message
appears in the screen of the embroidery
machine, and the design moves to the
transferred design area.

If the data sent from [Layout & Editing] does not
appear in the transferred design box, continue the
operation by using the machine's operation panel.

M

If you want to send more than one design to the
[Link] dialog, repeat step 4 for each design. The
[Link] dialog will remain open while the selected
design from [Layout & Editing] will be sent to the
Link.

205

6 After the design has been transferred, press
the start/stop button on the embroidery
machine to begin embroidering.

M

The transferred data cannot be edited from the
embroidery machine. The received data can only
be embroidered. However, embroidering settings
can be specified.

When embroidering is started, the following appears
in the [Link] dialog box.
i i = =

T
g

.

[

9 Shows the status of the embroidery
machine.

Each status indication is described below

Status Description

Press the button on the
embroidery machine (Start/Stop
button) to start sewing.

Ready

Waiting If there is no data in the queue
9, select [Link] as the
destination in the application,
and send data.

If this is the status even though
there is data in the queue e

continue the operation by using
the machine's operation panel.

Sewing The machine is sewing.

Paused The machine has temporarily
been stopped.

Color Change the thread spool on the

change machine.

Check Check the bobbin thread or the

thread upper thread on the machine.

Check frame | Install a different embroidery

frame on the machine.

Error Check the details of the error
that occurred on the machine.




Using the Link Function to Embroider From the Computer

M If multiple designs were sent to a M If multiple embroidery machines
single machine are connected
Multiple embroidery designs can be embroidered The [Distributor] dialog box appears, in addition
after being sent to the [Link] dialog box. In this case, with the [Link] dialog box for each embroidery
the dialog box appears as shown below. machine. The designs in the [Distributor] dialog will
all be selected. Specify which file is to be transferred
D:] to which machine.
« Design Database is available to send multiple D:I
designs at a time.

»» "Sending embroidery designs to machines by Distributor dialog box

using the Link function" on page 250 (1) (2] (3)
» With the [Name Drop] function, you can also ' | | Brtass o
send multiple designs where only the text is | |
replaced. i = 3 el
»»> "Outputting patterns using text from the text ﬂﬁg h % %
list" on page 128 Lastat s reast |
00006 0 e = 3
¥ ||-| | = =T - %
 e— — i — = =] — 28
L Pl | b = =
%‘A.:‘ B -'lt - ¥ ¥ . . 3
f W& ailllF 0 Selects all embroidery designs. a
i = | e | b
=t e Deselects the embroidery designs. 8
) ) ) 9 Deletes the selected embroidery design. o
The following operations can be performed from this (The design is deleted without being
dialog box. moved to the <Recycle Bin>.)

o Moves the selected design(s) to the
beginning of the embroidering order.

® Moves the selected design(s) one &
position forward in the embroidering . . . .
« Sending a design to the Distributor dialog for
order. ; >
. multiple machines.
© Moves the selected design(s) one « For multiple designs to be sent, repeat Step D
position backward in the embroidering for each design.
order.

e Moves the selected design(s) to the end
of the embroidering order.

6 Automatically adjusts the embroidering
order of the designs to reduce as much as
possible the number of thread color
changes.

@ Deletes the selected design(s) from the
[Link] dialog box.

M

Before the message "The machine will move.
Keep your hands etc. away from the machine."
appears on the machine and [OK] is pressed, the
embroidering order of the designs, including the
first one, can be changed since the first design has
not yet been sent to the machine.
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Using the Link Function to Embroider From the Computer

1  Select a machine in the [Machine Name] o

selector, select an embroidery file, and then
click [Send] ©

Ciariads [ - |
| Duasea | :1_'
éﬂ“ -85
[ [ ] [T [
0 —=— =1o
i i = =N
] Er—— —
| B
|
Ea= |
R
L—— Machine name

M

* The initial machine name is the machine's ID.
For details, refer to the Operation Manual
provided with your embroidery machine.

» The name of the machine can be changed.
For details, refer to "Changing the embroidery
machine name appearing with the Link function”
on page 208

— The embroidery designs are moved to the
[Link] dialog box.
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Repeat step 1 to move each design to the
[Link] dialog box.
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Using the Link Function to Embroider From the Computer

M

« The embroidering order of designs in the queue
can be changed.

»» For details, refer to "If multiple designs were
sent to a single machine" on page 206.

« If additional machines are connected while the
[Link] dialog box is displayed, corresponding
queues will appear. If a machine is
disconnected, the corresponding queue will
disappear.

« To display the [Property] dialog box for a file,
double-click the file's icon, or click a file to select
it, right-click it, and then click [Property] from
the menu that appears.

 To reduce this dialog box to a button on the
taskbar, click the [Minimize] button.

To disconnect the USB cable, or shut down the
computer

« After data transferring to embroidery machine
and the transferring message on the screen of
the machine is closed, you can disconnect the
USB cable, or shut down the computer.

When connected to the embroidery machine
again, you can continue the Link operation.

* The embroidery machine can finish sewing the
design currently being embroidered even if the
computer is turned off.

« If the embroidery machine is turned off while it is
embroidering, the resume operation can be
used the next time it is turned on. At that time,
transmission can be resumed using the Link
function by clicking [Link] in [Design Database]
or in the [Option] menu of [Layout & Editing]
to display the [Link] dialog box.

« If the embroidery machine connection cannot be

detected, the [Link] dialog box will close
automatically.

« To display the [Link] dialog box again after the
computer has been restarted, click [Link] in
[Design Database] or in the [Option] menu (in
the upper-right corner) of [Layout & Editing].

« To display the [Distributor] dialog box, click
[Distributor] in the [Option] menu of the [Link]
dialog box.

B Changing the embroidery

1

2

M

machine name appearing with the
Link function

Click [Machine Name] in the [Option] menu
of the queue whose name is to be changed.

T8 == .
i E| A
| N
Tmman |
A L

Type the name in the [Machine Name] box,
and then click [OK].

Machine Name

Dive: [ER
Mo.: [T234567830

Machine Name (10 characters) : 1234567830

A name (up to 10 alphanumeric characters/
symbols) can be specified for the embroidery
machine.

a

When an embroidery machine is connected to
the computer, the embroidery machine is
recognized by the computer as a removable disk
and is assigned a drive letter. If this drive letter
is the same as one that has already been
assigned by the computer, designs cannot be
sent from the computer to that embroidery
machine. This problem occurs, for example, if a
network drive has been assigned a computer
drive letter. If this occurs, cancel the assignment
for the drive with the conflicting drive letter.
When the number of embroidery machines
connected to the computer via USB is
increased, the operating system may require
that the computer be restarted. At that time,
restart the computer.
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Design Center

This section describes the basic operations
performed in Design Center. A simple step-by-
step procedure is provided to create an
embroidery pattern from a template image, such
as an illustration.




Basic Design Center Operations

Basic Design Center Operations

In Design Center, embroidery patterns can be created from an original image. In addition, you can specify
colors and sewing attributes for the lines and regions that are more detailed than those specified with the [Auto
Punch] function in Layout & Editing.

An embroidery design is created in the following four stages.

Step 1
Original Image Stage

Step 2
Line Image Stage

Step 3
Figure Handle Stage

Step 4
Sew Setting Stage

Open an image file, and
select the colors to be used
for creating the outlines.

The original image is
converted to a black-and-
white line image.
Outlines can be drawn or
erased.

Example:

The stripes in the scarf are
erased.

Stripes are added to the
scarf.

The line image is converted
to a figure handle image.
Points in the figure handle
image can be edited to
change the design.

Example:

The eyes are moved, and
the facial expression is
changed.

A star is added to the tail of
the plane.

The sew type and thread
colors are specified in the
outline to complete the
embroidery design.

Example:

By applying colors different
than in the original image,
the design is given a
different appearance.

machine.

» If the data is saved, work can be stopped at each stage, then started again.

» The most appropriate images to use are those with few and distinct colors. Images or photos that are
intricate or have gradations are not suitable since it is difficult to extract their outlines.

« Line image data is saved in the .pel format, and figure handle data is saved in the .pem format.

* The embroidery data is saved in the .pem format. To transfer .pem data created in Design Center to an
embroidery machine, import the pattern into Layout & Editing, and then transfer the data to an embroidery

»> “Importing into Layout & Editing" on page 220 and "Transferring Embroidery Designs to
Machines" on page 201

This section describes the basic operations performed in Design Center. For details on the procedures or
settings, refer to "Design Center Window" on page 221.

211




Step 1 Original Image Stage

M Extract outlines from an image

1 Click the down arrow in the bottom-left corner
of the [Start] screen to show the [All Apps]
view.

2 Click [Design Center] under the title [PE-
DESIGN 10] in the screen.

Basic Design Center Operations

4 Click | .

5  Select the desired image file, and then click
[Open].

Airplane image is located at:
Documents (My documents)\PE-DESIGN 10
\Sample\Design Center.
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Basic Design Center Operations

In the image displayed in the [Pick Colors]
window, select the colors to be used for the
outlines (embroidery lines).

Step 2 Line Image Stage

. M Using the Eraser
— The selected color appears in a box on the

right side, and || appears in the check box 1

To erase a line, click [Eraser] in the [Tools]
to show that the color is selected.

e group, and then select a tool D according to
Ciil oo Lires |mage

the size of the area or thickness of the line to
be erased.
':o., - - % % .‘___"'H i A
i Ml = | %
:_‘:-r.\_: LT - i ..::-:-. -.-:-'..
s T -
- I ™= —_—
g Ll === « om0 0
s [i#eol — T
[t
Frisiess 2  Move the pointer over the line to be erased,
T Lo fEsvsssed g _ _ _
. = and then click the line or drag the pointer to
a1 T M L J ket erase the line.
The desired color can be selected more
easily if the [Zoom] slider is used to
enlarge the image.

If a color other than that for the outline
was selected, clear the check box
beside the color to deselect it.

After selecting the colors to be used for the
outlines, click [OK].

B Using the Pen
— The line image appears in the Design

1 Todraw lines, select the [Pen] in the [Tools]
Page.

group, and then select a tool ] with the
desired thickness of the line to be drawn.
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2  Dragthe pointer to draw a line. To add a point,
click in the Design Page.

\
AN\

M

To draw vertical or horizontal lines, hold down the
<Shift> key while moving the pointer.

M

« Iflines are drawn or erased incorrectly, click =
(Undo button) to undo the last operation.

» To change the display size, use [Zoom]
command.

« The part of the work area that is displayed can
easily be changed by using the [Pan] tool.

. ] o
B sacinis
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=i e bk
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M Editing the extracted outline

1  When the line image is finished, click [To
Figure Handle] in the [Stage] group or &
(the second icon from the left) in the upper-
right corner of the screen.

e

— g

s Sy

Basic Design Center Operatio

2  Click [OK].

Figure Object Conversion Setting

Resolution
" Fine
& Nomal
 Coarse

¥ Thinning Process : 5

Pick Area... |
a8 I

Cancel |

Design Page Seltings... |

— The line image is converted to a figure
handle image.

Step 3 Figure Handle Stage

B Moving outlines
1  Click the [Figure Handle] tab.

ns

2 Click T in the [Tools] group, and then click

the outline to be moved.
8 [ LI .

T R

sE il e w "
Lo LE

o

e R

@ Rotation handle
® Scale handles
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Basic Design Center Operations

3  Move the pointer over the outline so that the

shape of the pointer changes to <§E> and then
drag the outline.

M

Drag a handle to change the size or angle. To
delete the outline, press the <Delete> key.

M Adding lines to the figure handle
image

1  Click [Input Line] in the [Tools] group.

w1 L?l.'.l
b | ——
% llesd] A o)
eilE il el J g
el | .
B e L]

2  Click the start point (1), and then click the next
point (2).
i i B --

o1
(o )

5]

— A line is drawn connecting the two points.
Continue clicking to draw additional lines.

M

» To remove the last point that was entered, right-
click.

» To draw vertical or horizontal lines, hold down
the <Shift> key while moving the pointer.

215

3 Double-click the end point.

©

B Reshaping outlines
1 Click [Select Point] in the [Tools] group.

o BRI Y L]
e | [
== T
L7 S <
T R ay
Forl | B i
2 Emay

2 Click an outline.

A\ 8

@® Point
® Pink Line

3  Toadd a point, click the outline (1).

To create a corner, drag the point (2).

\\«%X




Basic Design Center Operations

4 |f the point is deleted, the corner is removed. 2  Select a point, and then click [Split at Point]
Click the point to be deleted, and then press in the [Edit] group to split the line.
the <Delete> key, or click [Delete] in the TR e ———
Clipboard] group. P =
[Clip Igroup LB RN _ j_ .
5, foaeliEla g i Eephrg P Do as - = :

W A ey K

' ; M Connecting lines
Two points can be connected to form a line.

1  Perform steps 1 and 2 in "Reshaping

5 To change the shape of the line, drag the
outlines" to select a line.

point.
2  While holding down the <Alt> key, drag the
selected point to the other point that you want
to connect to it.
| — The shape of the pointer changes to Q;? ,
and a red square appears when the two
F points are overlapping.

J
Ja1ua) ubisag

P .

« If multiple points are selected, all of the points
will be moved or deleted. 9
» To select additional points, hold down the <Ctrl>
key and click each point, or drag the pointer over

the points.
3  Release the mouse button to connect the two
points.
M Splitting lines
Lines can be split at a point. /rr-*/ﬂ
1  Perform steps 1 and 2 in "Reshaping \

outlines" to select a line.
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Basic Design Center Operations

M Continuing to the Sew Setting
Stage

When the figure handle image is finished, continue

to the Sew Setting Stage.

1  Click[To Sew Setting] in the [Stage] group or
% in the upper-right corner of the screen.
- =N
e '}El-u- i
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Even after continuing to the Sew Setting Stage,
you can return to the Figure Handle Stage to edit
the figure handle image.

Step 4 Sew Setting Stage

We are now going to apply sewing attributes to the
different parts of the outline to create the embroidery
pattern.

B Specifying sewing attributes
1  Click the [Sew Setting] tab.
2 To specify the sew type for the line, click

[Line] in the [Tools] group, and then select
the desired tool from [Line Sew Tool].

= el & momi e Fild - [eg

,_JE|L.1' g
|""_;. Err i =

- —I - £

@ [Line sew type] selector

E l'] : Click this button to apply sewing
attributes to the entire outline.

,ﬂ, : Click this button to apply sewing
attributes to a portion of the outline.

To specify the sew type for the region, click
[Region] in the [Tools] group.

L] I"L':E g P - T

.: il::ll :': "': __. B lnEn -J--

@

@® [Region sew type] selector

M

Sewing attributes cannot be applied to regions if
the region is not completely enclosed in an outline
in the Figure Handle Stage.

3 CcClick .
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4 Click the desired color. P R ;
. 7 When using %J@ click the region where the

- sewing attributes are to be applied.
ey [T - 3 e EETL e, ."-_
" E R ER
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5 Click the down arrow in the sew type selector
and choose the desired sew type.

6 When using} l'l or /J'i_ click the outline

where the sewing attributes are to be applied.

3 1] - Rl o ('?
T SRR OO0 E . 128
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f W To change the sewing attributes, repeat steps ™
LS & -~ ".."'I |
A L I 0 1 through 7.
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Basic Design Center Operations

a

Sewing attributes for region cannot be applied to
open regions (regions not fully enclosed in an
outline), as shown in the illustration below.

L2

~

If attributes cannot be applied to a region, return to
the Figure Handle Stage and make sure that
region is closed. Edit any broken lines with the Edit
Point tool.

»» "Adding lines to the figure handle image" on
page 215

M

» From the [Sewing Attribute Setting] dialog
box, detailed settings for attributes, such as the
width of satin stitches and the run pitch, can be
specified.

»» "Specifying sewing attributes" on page 233.

» The Reference Window is useful for specifying
colors while checking the colors of the original
image.

Using the Reference Window

This allows you to select colors while checking
the colors in the original image.

1. Click the [View] tab.

2. Select the [Reference Window] check box
in the [Show/Hide] group.

- N\ = e -
r\-Q'-:l'.' '_EI B E L.. _J

Figure Handle View
Reference Window || [, Modify Templatz || [
QU &
In
Show/Hide Template

3. Click the [Image] tab.

— The image opened in Original Image
stage appears.

Reference Window ﬂ

Original I Reference

If [Reference] has been clicked, click
[Original].
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Step 5 Importing into Layout &
Editing
The embroidery pattern created in Design Center
can be imported into Layout & Editing. In addition,

the created data can be transferred to the machine
using functions in Layout & Editing.

a

If the sewing attributes of an outline or region are
not set, the embroidery pattern cannot be
imported.

1  Click the [Sew Setting] tab.

2 Click [Send to Layout & Editing] in the
[Stage] group.
x _!|.. L e -~

ik !. 4 fr— No@ s

— Layout & Editing starts up.

3  Select either to import a pattern as stitch
pattern or as outline pattern.

A T Cl s
Cegen B BBk
1"y D
g e |'5\.l.-:::! [
Aonad i Yool S, H L s
[
O g F r!l ¥ ﬁl
—_—
: -’-'-upu-. i £ I

4  specify settings for [Import], [Magnification]
and [Orientation], and then click [Import].

M

For details on the settings [As Stitches] and [As
Outlines] beside [Import], refer to "Importing
embroidery design from Design Center" on

page 94.

Basic Design Center Operations
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Design Center Window

Design Center Window

A W N P

ol

8
9

3 4 5 6
1—* =i = ABEELPEM - Dargr Dot l_lﬁij_‘l.lJ!'
I A/E=NTE
2 O L e e it o 0L i
9
8
He'twreree Wiooos i
T
—7
10 —am— —11

Application button
Ribbon
Quick Access Toolbar

Stage button
Indicates the current stage. Click to move to a different stage.

Option button
Help button

Reference Window (»» p. 228)
Displays all outlines and patterns in the work area, giving you an overview while you work on a detailed
area.

Design Page
Work area

10 Status Bar
11 Refresh Window button
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»» "Understanding Windows" on page 11




Original Image Stage

Original Image Stage

. . @ Most Recently Used Files
Usin g the wizard From the list, click the name of the file,
and then click [Open].

@ Always show Wizard at Startup
Select this check box to start up the

This wizard provides a step-by-step guide for
creating embroidery patterns.

Click ©*. , and then select [Wizard] from the wizard each time Design Center is started
command list. up.
ety B Opening an image

-  reate ot When you click the [From Image] button in the

[How do you want to produce embroidery?]
_ dialog box, the [From Image] dialog box appears.

[EEET R S

O— % W —0
b 3
o—1. —o0

o e © ©0

| e L o |—-:I‘h— |

k

o Open Image File
Clicking this button that displays the
[Open] dialog box to select an image file.

»» "Image file formats" on page 150

e S ® From Clipboard
© — e Clicking this button to paste the image on
the Clipboard into the Design Page. This
function can only be used when there is
(6] e Sryopepe i ey an image on the Clipboard.

o From Image
Clicking this button displays the [From
Image] dialog box.

e New Line Image
Clicking this button opens a new Design
Page in the Line Image Stage.

»» "Drawing a new line image freehand" on
page 225.

9 New Figure
Clicking this button opens a new Design
Page in the Figure Handle Stage.

»» "Drawing a new figure handle image
freehand" on page 227.

@ open PEM
Clicking this button displays the [Open]
dialog box so that a .pem file can be
selected.

9 From TWAIN Device
Clicking this button to import an image
from a TWAIN device (such as a scanner)
connected to your computer, then paste it
in the Design Page.

e Use Current Image
Clicking this button to use an image
opened in the Original Image Stage. This
function can only be used when an image
is opened in the Original Image Stage.
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Original Image Stage

M

e To import an image from a file TWAIN device

+ Connect the TWAIN device to the computer,
and then click [Image], then [Open from
TWAIN Device], or click [From TWAIN
Device] in the [From Image] dialog box.
When the [Select Source] dialog box
appears, select a device. Next, click [Select].

+ For information on using the driver interface,
refer to the help manual for that interface, or
contact the manufacturer of the interface.

* Tips for scanning illustrations for Design Center
+ If the outline is not clear, trace the outline on
tracing paper.
+ Better scanning results may be produced by
reducing the tone of the image.

223

Opening afile

1 Click ** .|, and then select [Open] from the
command list.

- EEL) Smags e

|

o

2  Select the drive and the folder.

3 Toopenafile, selectit, and then click [Open],
or double-click the file's icon.

« If an image file is selected, the file is opened in
the Original Image Stage.

« If a .pel file is selected, the file is opened in the
Line Image Stage.

« Ifa.pem file is selected, the file is opened in the
Figure Handle Stage or the Sew Setting Stage.




Line Image Stage

Extracting the outlines of
an image
1 In the Original Image Stage, click [To Line
image].

w WA I S Fig

»» "Original Image Stage" on page 212.

2  Selecting the colors to be used for the
outlines, and then click [OK].
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© Zzoom slider
Use this slider to adjust the zoom ratio for
displaying the image.

e Tone slider
Use this slider to reduce color tones in
images where it is difficult to select the
outline color.

9 Noise reduction slider
Use this slider to reduce image noise
(distortions) in images where the outline is
not clear.

e Click the outline color(s) to convert into
black outlines.

@ Displays the colors selected in O To
deselect a color, clear the corresponding
check box.

@ To extract the color boundaries, click
[Detect Outlines] check box.

Line Image Stage

M

When the extracting color boundaries using
[Detect Outlines], the colors are converted to line
image as shown below.

o Click [Preview] to preview the line image
in the Design Page.
i it — o am Bl o ]

e
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Line Image Stage

Drawing a new line image
freehand

Click * ., and then select [New Line Images] from
the command list.

El: Hedr R ¥ iz - Dawgpe

L e L

-
a.
H

Using the Pen and Eraser tools, the line image can
be drawn freehand in the Design Page.

»» "Line Image Stage" on page 213.

M

In the Line Image Stage, the file will be saved as a
.pel file.

»» "Saving embroidery patterns" on page 237,
and "Drawing a new figure handle image
freehand" on page 227.
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Figure Handle Stage

Changing settings for
converting to outlines

1 In the Line Image Stage, click [To Figure
Handle].

. eI ' fl

e o | W[5

L Furdl i

»» "Line Image Stage" on page 213.

2 Specify the desired settings in the [Figure
Object Conversion Setting] dialog box, and
then click [OK].

Figure Object Conversion Setting

S\

e ——— Design Page Seltings |

o Select a setting under [Resolution].
Fine
Select this setting only if the image
contains many small details.

Normal

Select this setting to provide a sufficient
resolution without making the file too
large.

Coarse
Select this setting to keep the file as small
as possible.

e To replace the black outlines with figure
handle lines along the center of the
outlines, select the [Thinning Process]
check box, and then use the slider to
select the degree of detail.

M

When the slider is set to [Much], even very thick
black lines will be replaced with a line along the
center.

Figure Handle Stage

P~

ON

¥
—

To replace the black lines with figure
handle lines following the border of the
outlines, clear the [Thinning Process]
check box.

P~

OFF

¥
o

9 Use the [SIZE] slider to set the size.

e You will not be able to enlarge the image
beyond the limits of the Design Page
area. If necessary, click [Design Page
Property], and then change the Design
Page size.

6 To create outline data from a part of the
image, select the specific area by clicking
[Pick Area], then dragging the pointer (+)
to draw a selection frame around the area
to be selected.

b e b Bk =
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Figure Handle Stage

a

It may not be possible for outline data to be created
from an image when moving from the Line Image
Stage to the Figure Handle Stage, even after
various outline conversion settings have been
specified. If this occurs, return to the Line Image
Stage, and correct the outlines in the line image or
apply corrections to the image.

Drawing a new figure
handle image freehand

Click *., and then select [New Figure Data] from
the command list.

Fopmr Bl Dl

« Inthe Figure Handle Stage, the file will be saved
as a .pem file.

« To retrieve data from a saved .pem file, use the
command [Import Figure] in the [Figure
Handle] tab.
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Specifying the Design
Page size
1  Click the [Figure Handle] tab.
2 Click [Design Page Settings] in the [Design
Page] group.
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3  Select the Design Page size, and then click

[OK].
Do pw S ey
RS (1)
=LTH =]
s xm (2]

o Select a machine type.
The settings available in the [Page Size]
selector differ depending on the machine
type selected here.

e To adjust the Design Page size according
to the hoop size, select [Hoop Size], and
then select the desired hoop size from the
selector.

9 To specify a custom Design Page size,
select [Custom Size], and then type or
select the desired width and height for the
Design Page.

e To return to the default settings, click
[Default].

a

» Do not select a hoop size larger than the
embroidery hoop that can be used with your
machine.

» Do not create a Custom Hoop larger than the
embroidery hoop that can be used with your
machine.




Editing outlines

Bl Scaling outlines
Scaling numerically:

1 Select the outline.
2  Click the [Figure Handle] tab.

3 Click[Numerical Setting] in the [Edit] group,
and then select [Size].

g1 [T T TR
L 'I- W i e—— S I‘-L F
- CIL
4  Selectasize, and then click [OK].
Size
Width Height
. =1 =1,
o— i |1nn = w |1nu =
C |94.u j = IBE.E j o

© ——— ¥ Maintain aspect ratio

(] | Previewl{

o To change the width and height
proportionally, select the [Maintain
aspect ratio] check box.

9 Select whether the width and height will
be set as a percentage (%) or a dimension
(millimeters or inches).

Type or select the desired width and
height.

M Flipping outlines horizontally or
vertically

1 Select the outline.

2 Click [Flip Vertically] or [Flip Horizontally] in
the [Edit] group.

1 [T T TR
A i & ! o | s =
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Figure Handle Stage

M Rotating outlines

Rotating manually
1 Select the outline.

2  Move the pointer over the rotation handle. And
then drag.

Rotating numerically
1 Select the outline.

2  Click [Numerical Setting] in the [Edit] group,
and then select [Rotate].

R I FCA - D
S
e T
N - |

3  Type or select the desired rotation angle, and
then click [OK].

Rotate
G ID i| degres
(] | Presview

M

An angle can also be selected by dragging @ in
the [Rotate] dialog box.

Viewing outlines in the
Reference Window
1  Click the [View] tab.

2  Selectthe [Reference Window] check box in
the [Show/Hide] group.

Ay EEHE

Figure Handle View

i| Reference Window || [8y, Modify Template || [
S0 &

Show/Hide Template
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Figure Handle Stage

M Zooming

The [Reference Window] can be switched to
display either the entire Design Page or only the
embroidery pattern.

Click the [Pan/Zoom] tab, click [td].

Reference Window n
Pan/Zoam | Image |
—
B
Displays the entire Design
Page.
Reference Window n

Pan/Zoam | Image |

Displays the entire
pattern.

B Moving the display area frame

The part of the outline displayed in the Design Page
can be selected from the [Reference Window].

1  Move the pointer over the display area frame.

2  Drag the display area frame so that it
surrounds the desired part of the outline.

— The selected part of the outline is displayed
in the Design Page.

B Redrawing the display area frame
Instead of moving the display area frame, the frame
can be redrawn to display the desired part of the
outline in the Design Page.

Click the area to be displayed, or drag the pointer
over the desired part of the outline in the
[Reference Window].

229

M Displaying a different reference
image

1  Click the [Image] tab.

Reference Window ﬂ

Pan/Zoon|

Original:  Reference

2 Click [Reference], then click .

Reference Window ﬂ

Pan/Zoom Image |

Qriginal

3  Select the reference image, and then click
[Open].

[ [ =]
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Changing the background
image
B Changing the display of the
background image
Click the [View] tab.
2 Drag the slider, or click {=j or (+} in the
[Template] group.
[ I...\'I:.I | Fr

" e e |

B H e S K imaowrs: | srasuls

69 @

Hide (off) | 50% | 100%

25% 75%

M

Press the shortcut key <F6> to switch between
displaying the image (On (100%)) to displaying it
faded at each density (75%, 50% and 25%) to
hiding the image (Off).

B Changing the size and position of
the background image

1 Select the template. Click [Modify Template]
in the [Template] group.

e mgeey 1 Em

2 Drag the template image to move it to the
desired location.

Drag a handle to enlarge or reduce the size of
the template image.

Figure Handle Stage

Changing application
settings

B Changing the grid settings
1  Click the [View] tab.

= L.'\'l:.l J Fr

2

2 Specify the grid settings in the [Grid] group.

Show Grid |—
[¥] with Axes | (2]
Interval: {50 3 —

Grid

o To display the grid, select the [Show
Grid] check box.
To hide the grid, clear the [Show Grid]
check box.

e To display the grid as solid lines, select
the [with Axes] check box.
To display the grid as dots (intersecting
points of the grid) , clear the [with Axes]
check box.

9 To set the grid spacing, type or select a
value in the [Interval] box.

B Changing the measurement units

Click [Option], then [Options], then [System Unit],
and then select the desired measurement units
(Imm] or [inch]).

»» "System unit" on page 20
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Sew Setting Stage

Sew Setting Stage

1 In the Figure Handle Stage, click [To Figure
Handle] to display the [Stage] group.

2 Click [To Sew Setting] in the [Stage] group.

i i L e Bl - ]

TR |I|

In the Sew Setting Stage, the colors of the Design
Page and background can be changed from the
[Design Settings] dialog box (displayed by
clicking the [Option] menu, and then selecting
[Design Page Settings].)

- Pemign Ceniee
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4 Click the enclosed region to apply the sewing

attributes.
[>D
® @

@ Marching lines

a

« Ifthe attributes cannot be applied to a region, go
back to the Figure Handle Stage and make sure
that region is closed.

« Edit any broken lines with the Edit Point tool.

Setting region/line sewing
B Region sewing
1  Click the [Sew Setting] tab.

2 Click [Region] in the [Tools] group.

® il 1 Fr

i A '
B Gl e N R s

B | o o O T R |

3 i necessary, change the color and sew type.

»» "Sewing attributes" on page 232

231

M

« Although a region may seem closed, if the
sewing attributes cannot be specified for the
region, the region may not actually be closed.

« To find the opening in the region, use the line
drawing mode in the Figure Handle Stage to
divide the region into smaller regions, and then
check which region sewing attributes cannot be
applied to in the Sew Setting Stage.




Sew Setting Stage

M Line sewing Sewing attributes

1  Click [Line] in the [Tools] group, and then

: o The Sew pane on the [Sew setting] tab, available in
select the desired tool (}.U,, or /.Ji.) from the Sew Setting Stage, allows you to set the color
[Line Sew Tool]. and sew type of region and outlines.

. F— The sewing attributes that are available depend on

o " the tool selected.
o :—'|._._l. L |, B — U
= Example 1: When @ is selected
| e ilv PHEEEEEEE Fi Sltitr:h -

2  If necessary, change the color and sew type. @ ®

»» "Sewing attributes" on page 232. ® Region color button

. . . . ® Region sew type selector

3  Click the outline to apply the sewing attributes.

( Example 2: When }WU," or /mu, is selected

iv ————— Running Stitch T

I
@ )

@ Line color button
® Line sew type selector

M Sew type

1  Clickin a sew type selector.

2  Click the desired sew type.
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Line sew type Region sew type
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@ Marching lines L™ =

D:I 3 Click the region or line to apply the sew type
setting.

When /,,U” is selected, settings are applied only to

a portion of the clicked outline. D:I

 To turn off sewing, select [Not Sewn (Line)]

from the [Line sew type] selector or [Not Sewn
(Region)] from the [Region sew type] selector.

« If the sewing has been turned off, the regions
appear in white or the lines appear as dotted
lines.
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Sew Setting Stage

e To Expert mode/To Beginner mode
Click to switch the mode.

© o»

Click to load/save the sewing settings.

M Specifying sewing attributes
1  Click the [View] tab.

2  Select the [Sewing Attributes] check box in
the [Show/Hide] group to display the [Sewing

Attributes] dialog box. »» "Saving frequently used sewing

. attributes" on page 192
T ElE 1
B - @ Hide Hint/Show Hint
Click to switch between displaying and
hiding the hint view
6 With each change in the sewing

attributes, a preview of the stitching can
be checked here.

» For region sewing
1 Change the sewing attributes displayed under

Beginner mode Expert mode
c.: oﬂ [Line sew] or [Region sew].
IxRER ] »»> For details on the different sewing
S Bt attributes and settings, refer to "Line
bty [55 i g ,@__I sewing attributes" on page 325 and
e = @ ® "Region sewing attributes" on page 331
@ [5 =] degees o I Gradaon _Feiten . ) . )
v e 2 Whenthe line sewing attributes are displayed,

click an outline to apply the line sewing

s.:t:?f:f = attributes to the outline.

F Half Stitch
St Pt (w]|[®)
4.0 _l; mm

Frequency [0 =%

When the region sewing attributes are
displayed, click a region to apply the region
sewing attributes to the region.

Step pitch

B B B

M

Saving frequently used sewing attributes

» Frequently used sewing attributes can be saved
together, and recalled when specifying sewing
attributes.

» Perform this operation in the same way that it is
performed in Layout & Editing.

e For line sewing »» For details, refer to "Saving frequently used

sewing attributes" on page 192

Beginner mode (1] Expert mode (1]
i: a
= | 2
VUline sew ! VLine sew . C I
™ Under sewing ¥ Under sewing
Zigzag width  [20 = m =} Zigzag width  [20 =] nm o olor i
Density 45 = ne/m 0 :):::::wch [15 =] inernm =] 1 ClICk the [VI eW] tab
tomes AL A
2  Select the [Sewing Attributes] check box in
| [preman the [Show/Hide] group to display the [Sewing
MY AN Attributes] dialog box.
LTI 3 Click the [Color] tab.

EENE

Thiead Chart [BROTHER EMBROIDERY = |

Click to return to the default setting.
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4  From the [Thread Chart] selector, select a
thread color chart or a user thread chart.

..u.- wik
-

- |
ERERES

5  Fromthe list of thread colors, click the desired
color.

»» For details on the four buttons under the
list, refer to "Special colors" on page 48

6  Click the region or outline to apply the color
setting.

B Creating a gradation

The density of the color can be adjusted at various
locations to create a custom gradation pattern.

1 In Expert mode of the [Sewing Attribute
Setting] dialog box, select the [Gradation]
check box, and then click [Pattern].

| vomeny  pmoun o

Density |4.5 _I;' line/mm @
| v Gradationll |
Direction

% Ceamctant

Sew Setting Stage

2  Specify the desired settings in the [Gradation
Pattern Setting] dialog box, and then click

[OK].
WHUUHM . M|H]]}]}]]]ﬂ\|\HHH\HHH\HHHH\\\\ 2]
Hitrren.. |

I T I Cancel ‘

o To select a preset gradation pattern, click
the desired pattern under [Select
pattern].

e Move the sliders to adjust the density of
the gradation pattern.

9 The preview area shows the setting
changes that you make.

M

Gradation can be specified if satin stitches, fill
stitches or programmable fill stitches have been
selected for the region sewing and [Manual] has
been selected as the sewing direction.

a

An additional color (used for blending in Layout &
Editing) cannot be specified with the gradation
setting in Design Center.

Applying effects to
concentric circle and radial
stitches

In order to increase the decorative effect, you can
move the center point of regions set to the
concentric circle stitch or radial stitch.

1  Click the [Sew Setting] tab.
2 Click [Region] in the [Tools] group.

w i TR | lin
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b
3  Select the desired color and sew type

([Concentric Circle Stitch] or [Radial
Stitch]).
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Sew Setting Stage

4  Click the region.
— The center point ( || ) appears.

5  Drag the center point to the desired location.
iie ——a . al =

Lk Loasg Ol

To move the center point later, click @/JU/ and then

right click the region with the concentric circle
stitch or radial stitch applied. The center point
appears and can be moved.

235

Preventing overlapping
stitching of regions (hole
sewing)

By specifying hole sewing, the stitching in
overlapping regions will not be sewn twice. Hole
sewing can be set only when one region completely
encloses another.

1  Click the [Sew Setting] tab.

2  Click [Hole Sew] in the [Tools] group.

w i TR 1 lir
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3 Click the region that completely encloses
another region.

4  Click [OK] to set hole sewing.

Set hole sewing




M

To cancel hole sewing, click the white inner region.
The inner region will be sewn twice when it
appears in the same color as the outer region.

Set hole sewing

Applying stamps

Stamps can be applied to regions in the Sew Setting
Stage of Design Center.

1  Click the [Sew Setting] tab.

2 Click [Stamp] in the [Tools] group, and then
select the desired tool from [Stamp Tools].

LY .|_':'.H-\. . Pz
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é : Click this button to apply a stamp.

ké: Click this button to edit the applied stamp.

Settings for stamps are specified in the same way
that they are in Layout & Editing.

»» "Applying and editing stamps" on
page 58

M

Some stamp patterns are provided with this
application; however, by using Programmable
Stitch Creator, you can edit the patterns that are
provided or you can create your own.

Sew Setting Stage

Checking and editing the
sewing order

1  Click the [Sew Setting] tab.

2 Click [Sewing Order] in the [Check Design]
group.

. (115 S ——— -
LA |I|-:--.-i-

3 10 change the sewing order of a color, select
the frame for the color, and then drag the
frame to the desired position.

Colaor ] Part ]

* To select additional frames, hold down the
<Shift> or <Ctrl> key and select each frame.

« The frames containing regions are separated
from the frames containing outlines with a thick
vertical line. Frames from one side of the line
cannot be moved to the other side.

» To enlarge the pattern for better viewing, click

:
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4 Toviewthe sewing order of multiple patterns
of the same color, select the frame, and then
click the [Part] tab.

Sewing Order

]
-
°
~
N
§

5 To change the sewing order of a pattern,
select the frame for the pattern, and then drag
the frame to the desired position.

6 Click [OK].
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Sew Setting Stage

Checking the stitching in
the Stitch Simulator

1  Click the [Sew Setting] tab.

2  Click [Stitch Simulator] in the [Check

Design] group to view stitching using the
stitch simulator.

. (115 P g -
| =SS

LTS
The basic operations are the same as those
described for Layout & Editing.

»» "Checking the stitching with the Stitch
Simulator" on page 80

Viewing embroidery

patterns in the Reference
Window

Embroidery patterns can be viewed in the
Reference Window in the Sew Setting Stage in the
same way that they are in the Figure Handle Stage.

»» "Viewing outlines in the Reference
Window" on page 228.
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Saving embroidery
patterns

The file can be saved at each stage.

W Overwriting

Click * ., and then select [Save] from the
command list.

Vager MM Douas

M Saving with a new name

1 Click *. , and then select [Save As] from the
command list.

Fopmr Bl Dl

2  Select the drive and the folder, and then type
in the file name.
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Sew Setting Stage

3 Click [Save].

M

» Image data from the Original Image Stage can
be saved as a bitmap file (.bmp).

* Inthe Line Image Stage, image data is saved as
a .pel file.

« In the Figure Handle Stage and the Sew Setting
Stage, pattern data is saved as a .pem file.

a

If you select a file type of a previous software
version, saved .pem files can be opened with that
version of the software; however, some
information may be lost.

v
1]
23
«
=)
O
®
=)
—
1]
=

238




Sew Setting Stage

239




Design Database

Using Design Database, the created embroidery
data can be managed. In addition, while viewing
images of the file contents, the files can be
organized, or multiple embroidery designs can be
transferred to embroidery machines.




Design Database Window

Design Database Window

Lary aw. Bl - |
1—
'T,::“ el s y
por r
2 L:.I':-" u - I ':an I e " -_-..-n " [ ]
= 18 i iy ® X B
o = [} & T
] = B S L gy
4— l = —11
6 — bR ) Firas ] 10
i
P i
e —9
77—y N
8 —
1 Toolbar 11 Writing box display/non-display button
2 Folder pane Click when writing/transferring designs.

Click this button to hide or display the Writing list.
3 Contents pane

Displays thumbnails of all embroidery design in D:I
the selected folder.

. Settings for the following can be selected from the
4 Card reading button Option menu.

Reads an original card. » Select mm or inch as the system units.

5 Folder content display button + Select Blue, Black, Silver or Aqua as the
Displays the folder contents. application color.

6 Send to selector
Select where the embroidery files will be written
or sent.

7 Write button
Begins writing the selected designs (displayed in
the writing list).

8 Remove button
Returns the selected design (displayed in the
writing list) to the unselected state.

9 Writing list
Displays the list of designs to be written to the
original card, USB media or embroidery
machine.

10 Add button
Adds the design selected in the contents pane to
the writing/transfer list.
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Starting Up Design Database

Starting Up Design Database

1  Click the down arrow in the bottom-left corner
of the [Start] screen to show the [All Apps]
view.

2 Click [Design Database] under the title [PE-
DESIGN 10] in the screen.

3  Click a folder in the folder pane.

— All embroidery files in the folder are
displayed in the contents pane on the right.

» The displayed files have the following
extensions.
.pes, .phc, .dst, .exp, .pcs, .hus, .vip, .shv, .jef,
.sew, .csd, .xxx, .pen

» .pem files are not displayed since they cannot be
read by the machine. Import the embroidery
design into Layout & Editing from Design
Center, and then save it as a .pes file.

 Zipped file can not be read in this application.

»» “Importing into Layout & Editing" on page 220
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Organizing Embroidery Designs

Organizing Embroidery Designs

Creating new folders
1 In the folder pane, on the left, select the folder.

2 Click [File], then [Create New Folder].

- —er -

3 Type in the name of the new folder, and then
press the <Enter> key.

Moving/copying files to a
different folder

1 In the folder pane, locate the folder where you
want to move the embroidery design.

2  Inthefolder pane, click the folder that contains
the embroidery design.

3 Drag the embroidery design in the contents
pane to the folder you previously located in the
folder pane.
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— If the two folders are on the same drive, the
selected embroidery design is moved to
the other folder.

— If the two folders are on separate drives,
the selected embroidery design is copied
into the other folder.

M

» To copy the file from one folder to another on the
same drive, hold down the <Ctrl> key while
dragging the embroidery design.

» To move the file from one folder to another on
different drives, hold down the <Shift> key while
dragging the embroidery design.

» The file can also be removed from the current
folder (or copied) by selecting the menu
command [Edit] - [Cut] (or [Edit] - [Copy]).
Then, the file can be added to the new folder by
selecting it in the folder pane, then selecting the
menu command [Edit] - [Paste].

Changing file names

a

The names of embroidery designs can be changed
from Design Database only when the sewing
information (menu command [Display] —
[Details]) is displayed.

»» "Changing how files are displayed” on
page 244

1 In the folder pane, select the folder containing
the embroidery design.

2  Select the embroidery design. Then click

again.

Lot D

= B [ e

3 Type in the new name of the embroidery
design, and then press the <Enter> key.

M

When renaming a file, the file extension cannot be
changed.
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Deleting files

1 In the folder pane, select the folder containing

the embroidery design that you want to delete.

2 In the contents pane, select the name of the
embroidery design.

3 Press the <Delete> key.

— The file is moved to the Recycle Bin.

Changing how files are
displayed

The embroidery designs in the contents pane can
be displayed as large thumbnails or small
thumbnails, or they can be listed by their sewing
information.

B Large Thumbnails

Click or click [Display], then [Large
Thumbnails].

Organizing Embroidery Designs

B Small Thumbnails

Click or click [Display], then [Small
Thumbnails].

£ 4

M Sewing information

Click g or click [Display], then [Details].

v

| Classification &

| stitc... | Colors| width| Height| Type |
07 2 1a6 27 PES 5/21/2010 7:0

¥y z
{233101M18.pes 1589 a 4 37 336 PES 5/27/2010 7:0(
33101110 pes 218 4 4 400 1 PES 5/27/2010 701
{&33101120.pes 1838 3 3308 389 PES 5/27/2010 70
33101121 pes 1919 3 3 a6 344 P 5/27/2010 701
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Opening Embroidery Designs

Opening Embroidery Designs

Opening files with Layout
& Editing
1 In the folder pane, select the folder containing

the embroidery design that you want to open
in Layout & Editing.

a

Be sure to select a folder that contains .pes files.

2 Inthe contents pane, select the .pes file.

3 Click[File], then [Open in Layout & Editing].

Importing files into Layout
& Editing

Files in the following formats can be imported.
.pes, .phc, .dst, .exp, .pcs, .hus, .vip, .shv, .jef, .sew,
.csd, or .Xxx

1 In the folder pane, select the folder containing
the embroidery design that you want to import
into Layout & Editing.

2  Inthe contents pane, select the embroidery
design.

3 click [File], then [Import Into Layout &
Editing].

— The selected embroidery design appears in
the Layout & Editing window.

a

Files in the .pen format cannot be imported into
Layout & Editing.
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Transferring Embroidery Designs to Machines

Transferring Embroidery Designs to
Machines

a

The procedures for transferring the created embroidery design to an embroidery machine differ depending
on your embroidery machine model. For detail, refer to the Operation Manual provided with your embroidery

machine.
Transferring to a machine 2 Click [LAL]) _
by using USB media/USB _ -
cable/original card SRE R 58
1 Prepare the media to be useql to make the = . . i.l '; L §
transfer, or connect an embroidery machine to 4
the computer. = A ) = g )
& : A L ._' .“. T
Be sure that the hoop size of the design does not ) ':I.-. ez, --E Lk 'IE-II

exceed the hoop that will be used on the ———

embroidering machine. '

o s -

« If the design is to be written to an original card, |
insert the original card into the USB card writer =" o
module. | |5 o0 B X

« If the design is to be written to USB media, plug : g > % ¥ B ¥
the USB media into the computer.

« If the design is to be transferred directly to an
embroidery machine, connect the embroidery
machine to the computer. For details on
transferring design, refer to the Operation
Manual provided with your embroidery machine. —_—

+ In order to use the Link function to transfer @ ®
embroidery designs, an embroidery machine
compatible with the Link function must be (@ Contents pane (Available designs)
running in Link mode. ® Writing list (Selected designs)

»» "Using the Link Function to Embroider From
the Computer" on page 204

)
@
<.
Q
S
@)
o
—
Q
o
Q
0
o
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Transferring Embroidery Designs to Machines

3  Click the [Send To] selector, and then click
the destination.

il [FIUSE Media -

1 UsE Media
S [G:] Sewing Machine
[) Card Writer

2 Lirk

0000

o Sends designs to the USB media.

e Sends designs directly to an embroidery
machine.

9 Sends designs to the USB card writer.

e Sends designs to embroidery machine(s)
by using the Link function.

n

If Link is not available in the [Send To] selector,
check that the embroidery machine is running in
Link mode and that the cable is correctly
connected.

»» "Using the Link Function to Embroider
From the Computer" on page 204

The remaining steps differ depending on the
destination where the data is to be sent.
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M Using USB media

Designs can be transferred to
an embroidery machine
compatible with the USB Host
function.

a

The "PE-DESIGN Software Key" cannot be used
as USB media.

4. Select i from the [Send To] selector.

M

If multiple USB media are connected, i for each

connected device appears. Select the USB media
where the design is to be written.

5 cik| & |

6 selectafolderin o select an embroidery file
from the contents pane 9 and then click

| & |toadd the file to the writing list. After
all embroidery files to be written are added to

the writing list, click 5§ .

0- S . . '. § Le
£ S % ¥ IE ¥
C+H—o

— The designs in the writing list are written to
the USB media.

— When the designs have been written, the
message "Finished outputting data."
appears.




Transferring Embroidery Designs to Machines

M Transferring

(! § directly to a
+ Do notremove the USB media while designs are machine's memory
being written. Designs can be transferred to
e If thereis already a file with the same name at embroidery machines that can
the destination, the following dialog box be connected to a computer
appears. Select whether to overwrite the using a USB cable
existing file, to stop copying or to copy the file '
i iff .
using a different name 4. sSelect =¥ from the [Send To] selector.

Copy File H

There is alteady a file with the same name in this location m

Untitled PES . . .
If multiple embroidery machines are connected,

€ Dort comp i=f for each machine appears. Select the
® EmpemaimE machine to be used to embroider.

G | 5 cick[ &= |

6 Selectafolderin o select an embroidery file
from the contents pane e and then click

[ [ & |toadd the file to the writing list. After
If a volume label has been specified for the USB all embroidery files to be written are added to
media, " i [(Drive Letter):] (Volume Label)" the writing list, click &1 .

appears in the [Send To] selector. =
If a volume label has not been specified,

" § [(Drive Letter):] USB Media" appears. =<

For details on changing the name (volume label) 0 = ' 3
for the USB media, refer to the manual provided - - ¥ o
with the USB media. - @
L F—© <
=]
= 5
[ 3 —— 5
e > QJ
%]
@

— The designs in the writing list are written to
the embroidery machine's memory.

— When the designs have been written, the
message "Finished outputting data.”
appears.

a

» Do not remove the USB cable while designs are
being written.

* If there is already a file with the same name at
the destination, a dialog box appears. Select
whether to overwrite the existing file, to stop
copying or to copy the file using a different
name.

248




Transferring Embroidery Designs to Machines

M Using an original
card

Designs can be transferred to

an embroidery machine

equipped with a card slot.

e

« Files other than .phc files can be written.

* |f no USB card writer module is connected to the
computer, an original card cannot be selected as
the output destination. Before transferring, make
sure that a USB card writer module is connected
to the computer.

4. Select from the [Send To] selector.

5 under [Machine Type], select the type of
embroidery machine to be used.

b aching Type:

Caml] g

o Single-needle machine
9 Multi-needle machine

6  From the [Hoop Size] selector, select the
appropriate size of embroidery hoop.

[100%100 /110 %110 mm =l

a

0- = & 3 8 le
> % ¥ B =
= . e
R ——

* An embroidery design for the jumbo frame
cannot be transferred to the machine by using
an original card.

« If the pattern in the selected embroidery file is
larger than the hoop size selected in step 6, or
the number of stitches or number of colors for
the pattern exceeds the maximum for the hoop
selected in step 6, that file cannot be added to
the writing list. Only the embroidery designs
displayed in the writing list will be written to the
original card.

» Do not select a hoop size larger than the
embroidery hoop that can be used with your
embroidery machine. Otherwise, the created
original card will not work correctly with the
embroidery machine.

» When writing to an original card that already
contains data, all data on the card will be
deleted. Before writing to a card, save all
necessary data to a hard disk or other media,
and check that no necessary data remains on
the card.

»» "From an original card" on page 92

M

« Embroidery files can also be added to the writing
list by right-clicking the file, then clicking [Add to
Writing List], or by selecting a file in the
contents pane and dragging it to the writing list.

 Afile can also be removed from the writing list by
right-clicking it in the writing list, then clicking
[Remove from Writing List].

7 cik| & |

8 selectafolderin 0 select an embroidery file
from the contents pane 9 and then click
| ¥ |toadd the file to the writing list. After
all embroidery files to be written are added to

the writing list, click 4]
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9 If the files are to be written to an original card,
the following message appears. Click [OK].

Cexign Databage “

ﬂ Al wrepegl cqre doby sl b chelobe
| | Caracid

Do not remove the card or unplug the USB cable
while designs are being written to the card (while
the LED indicator is flashing).




Transferring Embroidery Designs to Machines

10 When a message appears, indicating that
writing is finished, click [OK].

M

Patterns created on a custom-sized Design Page
are written to cards split into their various hoop
sections.

»» Note of "Transferring to a machine by using an
original card" on page 202

» To rewrite the embroidery files written on

the original card, click to select

those files, and move files to the writing list
in the same manner.

» To check the embroidery design file being
written to the original card, click

- appears in the folder pane, and
all embroidery designs written to the
original card appear in the contents pane.

_— e .

» Embroidery designs written to the original card
appear as [Card Data] in the contents pane.

« To display the contents of the folder in the

contents pane, click . Switch the

display by clicking| £ |and| [ |

M Sending
embroidery
designs to
machines by using
the Link function

An embroidery machine

compatible with the Link function must be running in

Link mode.

»» "Using the Link Function to Embroider
From the Computer" on page 204

4. Select 2 from the [Send To] selector.

5 click[ &= |

6 Selectafolderin o select an embroidery file
from the contents pane e and then click

==

7  Continue the procedure as described in

Step B of "Using the Link Function to
Embroider From the Computer" on page 205.

a

Files in the .dst, .exp and .phc formats cannot be
transferred with the Link function. When [Link] is
selected in the [Send To] box, .dst, .exp and .phc
files do not appear in the contents pane.

In addition, embroidery files with the Design Page
size set to [Custom Size] or with [Hoop Size] set
to 360 x 360 mm (Jumbo Frame) do not appear
in the contents pane.

M

To display the [Link] dialog box again after the
computer has been restarted, click [Link] in the
[Option] menu.
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Searching for an Embroidery Design

Searching for an Embroidery Design

1 Inthe folder pane, select the folder. ® Date Modified
In the boxes, type the modification date

2  Click [File], then [Search]. range (from when to when).

3 Specify the search conditions. Select the When searching for .pes files, the
check box of the search conditions to be following conditions can also be specified.
specified. 9 Design Name

-t = o Type the design name in the box.
g I: :IeNime angel :ZETWNW @ @ Category
e Y ——— 9 In the box, type specific characters or the
0- O - —® embroidery category.
o _: Stitch Court: : — | & ,—: I'Enmmlem I @ m Author
(5) —}r I In the box, type the author's name to be
(6] v [ — searched for.
o :E |—_| ,—_, @ Keywords
- P In the box, type the keyword to be
o searched for.
@ Comment
o File Name In the box, type the comment to be
Select to search for files with a specific file searched for.
name. Type the file name in the box. D:I

D:I « To also search through the subfolders (folders

Wildcard characters ("?" to represent a single within the selected folder), select the [Search

character and " " to represent multiple subfolders] () check box.

characters) can also be used. * All characters entered in the box beside [File

Name] will be considered as a single set of
characters. However, you can search for files
9 Format matching multiple words in the boxes below
Select the check box beside the desired [Search Conditions (only for PES files)] by
file format. separating the words with a space.
9 Stitch Count
In the boxes, type the lower and upper 4  Click [Search].
limits of the range for the number of ) ] ) -~
stitches. —->A |ISt.C.)f files matching the specified search
conditions appears.
e Color Changes . -
In the boxes, type the lower and upper
limits of the range for the number of color
changes. . E
© Total Colors =
In the boxes, type the lower and upper =
limits of the range for the total number of

thread colors.

O width
In the boxes, type the lower and upper
limits of the width range.

0 Height
In the boxes, type the lower and upper
limits of the height range.
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Converting Embroidery Design Files to Different Formats

Converting Embroidery Design Files to

Different Formats

Embroidery design files can easily be converted to a file of one of the other formats (.pes, .dst, .exp, .pcs, .hus,

.vip, .shv, .jef, .sew, .csd, or .xxx).

1 In the folder pane, select the folder containing
the embroidery design that you want to
convert.

2 Inthe contents pane, select the embroidery
desired format.

3 Click [File], then [Convert Format].

4 Fromthe [Format Type] selector, select the
desired format.

Convert Format “

Format Type:  |PES -

Olutput Ta:
™ Same folder

" Following foldsr

u

LAl sershHAT38WDE Documents\PE- g

Cancel |

5 Under [Output To], select whether the new
file is added to the same folder as the original
file (Same folder) or to a specified folder
(Following folder).

M

To change the folder where the new file will be
added, click & .

6 Click [Convert].

— The file is converted, and the new file is
added to the specified folder.

M

* With [DST Settings] on the [Option] menu, the
number of jumps for thread trimming can be
specified for .dst files.

»» "Specifying the number of jumps in
embroidery design of the DST format" on
page 301

« If multiple files with different formats are
selected to be converted while [Same folder] is
selected, any file with the same format as the
new one will not be converted. However, if the
files are being added to a different folder than
the original one, any file with the same format as
the new one will be copied to the different folder,
instead of being converted.

« If the file is converted to a .pes file, the thread

colors are converted as if the file was imported
into Layout & Editing.

a

Files cannot be converted to the .phc or .pen
formats.
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Checking Embroidery Designs

Checking Embroidery Designs

Previewing files Checking file information
Sewing information such as the file name, size,
Toolbar button: r@ stitch count, sewing time, color count and

modification date can be checked in the Property
dialog box. With .pes file, additional information
about the embroidery design can be viewed.

. 1}

# IEREi O L8 « The displayed sewing time is an estimate. The
e f ; actual sewing time depends on the machine
L i . model used and the specified settings.

Willes [BTRp O3 The sewing time is not displayed with .pen files.

1  Selectafolderin @, select an embroidery file
from the contents pane e

. g Toolbar button: E:'f‘__l

1 In the contents pane, select the embroidery
o 12/ design corresponding to the information that
you want to view.

2 Click I:@ , or click [Display] menu, then 2  Click I}%__l , or click [Display] menu, then
[Preview].

[Property].

it

FieNane: 01124 pes Design Name:

Flevesio: 80

Modiied Date: ~ 5/27/2010 Coegoy: [
%7

widh:

I L

1539

ColorList & ColorChanges " Ttal Colors

[ Color | Code | Brand | Description [ Basic Color |
001 EMBROIDERY WHITE WHITE

1
2 83 EMBRDIDERY BEIGE BEIGE
3 NI 707 EMBROIDERY DARKGRAY — DARK GRAY
4 M 500 EMBROIDERY BLACK BLACK.

PES files (version 4.0 or later)

M

[I] Select [Color changes] beside [Color List] to

Files in the .pen format cannot be previewed. display the thread color change information in the
color list. Select [Total colors] to display the
information for all thread colors in the color list.

»» "Checking embroidery design information” on
page 88
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Checking Embroidery Designs

M

* Non-PES files and PES files (version 3.0 or
earlier)

Property

e

File Marne; 331ME27 . pes
File \ersion: 20
Wodified D ate: 54277200

Wéidth 388 mm
Height: 338 mm
Stitch Count, 1557

Sewing Time: 5 mn

Color Changes: 3

Tatal Colors: 3
Calor List : @ Color Changes ¢ Tolal Colors
| Calar ‘ Code | Brand | Description | Basic Color ‘
1 o EMEROIDERY WHITE WHITE
2 I 405 EMBROIDERY BLUE BLUE
3 205 EMBROIDERY YELLOW TELLOW

« If the Design Page size was set to [Custom
Size] or if [Hoop Size] was set to a multi-
position hoop (100 x 172 mm or 130 x 300 mm)
or a jumbo frame (360 x 360 mm), a [Property]
dialog box similar to the one shown below

Property
|:| e p———

174 U
« » [0}
(%]
Fi tutora 31 pes Design Name: —.
i a0 )

i sz O
Wi 20 =]

H 0 Author
5e 44 min Reaiet D
co s 2 =
Ta 2 — 19
Couli: @ CobrChanges O TotolCobrs o
[ Color | Code | Brand | Desciption [ Basic Color | Q
017  EMBROIDERY LIGHTBLUE  LIGHT BLUE 0
NOTDEFINED NG DEFINED

» The red box in the dialog box shows the position
of the displayed pattern section.

To display information for other hoop positions,

cIick[ €4 ]or[ Fr ]
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Outputting a Catalog of Embroidery Designs

Outputting a Catalog of Embroidery

Designs

Images and sewing information for all embroidery designs can be outputted in a number of formats. Select
among the following modes according to your preferences.

Printing

Images of all embroidery designs in the selected
folder can be printed as a catalog or as an
instruction guide.

e
FEEE e

575 (S el

Fal ﬂ G

r!ﬂ

1 In the folder pane, select the folder containing
the embroidery designs.

2  Click [File], then [Print Setup].

3 under [Paper] o and [Orientation] 9
select the appropriate settings.

Print Setup ?
- Printer
Hame:  |Miciosoft PS5 Dacument wier x| Propeties
Status; Ready
Type: Microzoft XPS Dacument Writer w4
‘where:  PORTPROMPT:
Cormrment
(1) Paper - rientation (=]
b Porrait
See b s “
 Landscape
Source: | Automatically Select =
L utomatically Select = e
@ Color Changes
o Print Layout " Total Calors
By By OOy =t [~ Color Description
G [ [EEls]
‘8 B W £ © tene
ABC " Code
Print Print Preview.
Netwark... TR Cancel

4  select[Color List] ©.
Color changes
The thread color information for each color
change is displayed.

Total colors

The thread color information for the necessary
threads is displayed. This allows you to check
the total number of thread colors.

»» "Checking embroidery design
information" on page 88

5  Select[Print Layout] €.

Catalog style 4

Catalog style 1

o

Instruction Guide style

Catalog style 12

..-1 |# I.' .i: -#-
FEEE ®

ll- .-\.!.l'_'l

t'ﬂ i

it ol
-'H'I

6 under [Color Description] 6 select
whether the thread colors appear as the name
of the color or as the brand and thread
number.

7  Click [Print].
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Outputting a Catalog of Embroidery Designs

M Outputting as a CSV file

« If one or more embroidery designs were A .csv file containing the sewing information (file
selected in the contents pane, only the selected name, dimensions, number of stitches, number of
designs are printed. colors, file path, file properties (.pes files only) and

« If the brand name, thread number or file the names of thread colors and thread numbers) for
EfOp?fttieZ is too long, some of the text may not selected embroidery designs can be outputted.

e printed.

« If [File], then [Print] is clicked, the embroidery 1 Inthe folder pane, select the folder containing

designs are printed according to the settings the embroidery designs.

already selected in the [Print Setup] dialog box.
2  Click [File], then [Create CSV].

. . 3  Select the drive and the folder, and then type
OUtpUttl ng as an HTML flle in the name of the .csv file.

Instead of being printed, the catalog of embroidery o L=

designs can be outputted as an HTML file. s -. _" e it
1 Inthe folder pane, select the folder containing g :- - i -
the embroidery designs. ==
2 Click [File], then [Create HTML]. ~
3  Select the drive and the folder, and then type LY
in the name of the HTML file. o 5
i = e =
T y— q ke B — .
W rin 4 click[Save].
L =
“ S
— ] O
L. = = L
i — ; i | )
g il QJ
Fia R e S T L b i n
-... = LI o)

4  Toadd atitle at the top of the file and in the title
bar, type the title in the [Page Title] box.

5 Under [Page Layout], select how the designs
appear on the page.

6 Click [Save].
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Programmable Stitch Creator

Programmable Stitch Creator allows you to create
and edit stitch patterns, which can then be used

as programmabile fill stitches or motif stitches in

both Layout & Editing and Design Center.




Basic Programmable Stitch Creator Operations

Basic Programmable Stitch Creator
Operations

Programmable Stitch Creator is an application for creating, editing and saving stitch patterns that can be used
for programmable fill stitch or motif stitch sewing. The following two types of patterns can be created in their
corresponding mode.

Fill/stamp stitch patterns

O T Ry B T gy

» These patterns can be used as stamp patterns and for sewing with the programmable fill stitch in
Layout & Editing or Design Center.

» These patterns can be created with a single line or with multiple lines. In addition, these patterns can
be used to create an embossing/engraving effect in sewn regions.

» These patterns are created in Fill/Stamp mode.

engrave emboss

=

Motif stitch patterns

» These patterns can be used for sewing lines with the motif stitch and for sewing regions with the motif
stitch, piping stitch and stippling stitch in Layout & Editing or Design Center.

» These patterns are created with a single line, which gives the look of a single-stroke drawing, and they
are used for decorative machine sewing.

* These patterns are created in Motif mode.
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Creating Fill/Stamp Stitch Pattern

Creating Fill/Stamp Stitch Pattern

Existing programmable stitch patterns can be edited to create new patterns.

)

r':.-_.'ll"l-r-i-[ L T

N,

£ Mo '-.u-.-.p.'!_?p ill-.. T e 1

Step 1 Opening a fill/stamp stitch pattern

Step 2 Drawing lines to edit the fill/stamp stitch pattern

Step 3 Applying embossing/engraving effects to the fill/stamp stitch pattern
Step 4 Saving the edited fill/stamp stitch pattern

Step 5 Using the edited fill/stamp stitch patterns in Layout & Editing

Step 1 Opening afill/stamp stitch
pattern

First, we will open a fill/stamp stitch pattern to be
edited. In this example, we will use pattern
wavel.pas.

1 Click the down arrow in the bottom-left corner
of the [Start] screen to show the [All Apps]
view.

2 Click [Programmable stitch Creator] under
the title [PE-DESIGN 10] in the screen.

3 click wH'l and then select [Open] from the
command list.

4

Select Fill/Stamp File(*.PAS) in the Files of

type selector.
Select the pattern file wavel.pas.

¥ = "
- - =ik

= e

& = =i

L= e

e — =

The pattern file can be found at the following
location.

For example, (Drive where PE-DESIGN was
installed)\Program Files (x86)\Brother\PE-
DESIGN 10\Pattern.

M

To view the data in the selected folder as
thumbnails in the [Browse] dialog box, click
[Browse].

Browse

‘ I ‘ I
) S m
wave2 waved il
=l
Cancel

B
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Creating Fill/Stamp Stitch Pattern

Step 2 Drawing lines to edit the
fill/stamp stitch pattern

1  Click the [Home] tab.

2 Click [Draw Line] in the [Tools] group.

..H':'. QOEEs G ol g
v /[l @
T R | Lk 1y e s

L Ly

3 Click points (1) through (4).

» To remove the last point that was entered, right-
click the mouse button.

»» "Reshaping a fill/stamp stitch patterns" on
page 264

» The grid width can be changed.
»» "Changing the grid settings" on page 273

4  Double-click (5) (end point).

5 Repeat the previous operations.

Step 3 Applying embossing/
engraving effects to the
fill/stamp stitch pattern

1  Click (1), and then double-click (2).
Next, click (3), and then double-click (4).

&L

— Lines are drawn along the top and bottom
edges of the Design Page.

1
4

M

In order to create an effect, the lines must form a
closed region.
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Click [Region (engrave)] in the [Tools]
group, and then click the first and fourth wave

regions.
..!$.; LE _ I_r| F | F
—
ﬁ_ = -,-.‘l._'.' Lo
iR d-i il whhE P | REEE
ol [F e CE Al

sl

!

— These regions appear in red and will be
sewn with short stitches to give the effect of

engraving.

Click [Region (emboss)] in the [Tools]
group, and then click the second and fifth

wave regions.

liritie

i | HELEH

i AR HE
% /5| < EaiiEl
s Wil e M '.I-.ﬂ.!
el ¥
[
F .{; o
: ol I..
L

[PLEE ]

— This region appears in blue and will be
sewn with no dropped stitches to give the

effect of embossing.

.

Creating Fill/Stamp Stitch Pattern

M

To remove the embossing/engraving effect, use
the [Region (reset)] tool. Click [Region (reset)] in
the [Tools] group, and then click a region with an

effect applied.

A CEEE
& 7F =i
[ | il e | RN
v e
IFEL

o |

[ | |
Lo
T
& MIELEi

e L

[LER ]

Step 4 Saving the edited fill/

stamp stitch pattern

Fill/stamp stitch patterns are saved in the .pas

format.

1 Click '--Ef;, and then select [Save As] from the

command list.

llu:ll.u Ecgnrws

s

Select the drive and the folder, and then type

in the file name.
i s [ -

ARERRENRE
r

When saving a fill/stamp pattern, specify the
size beside [Default Size]. Click [mm] or

[inch] to select the measurement units.

3 Click [Save].
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Creating Fill/Stamp Stitch Pattern

Step 5 Using the edited fill/stamp
stitch patterns in Layout &
Editing

1  Start up Layout & Editing.
2  Select an embroidery pattern.

3  From the [Region sew type] selector (in the
[Shapes] tab), select [Prog. Fill Stitch].

4 Display the [Sewing Attributes] pane.

»» "Specifying sewing attributes" on
page 54

5 Click below [Programmable fill] in the
[Region sew] section.

6  Select the drive and folder where the pattern
was saved in Step 4.

Browse

C:\Pragram Files (+36\Brother\FE DE 515N 10WFatiem

T
ST

net patlll patd2 patd3

=

263

7  Click the edited fill/stamp stitch pattern, and

then click [OK].

— The pattern is applied to the inside regions
of the embroidery pattern.

— N — - —
S — —

« Afill/stamp stitch pattern can also be applied as
a stamp by using the Stamp Tools.

»» "Applying and editing stamps" on page 58

» For best results, refer to "Notes on
programmable fill stitches and stamps" on
page 335.




Editing a Pattern in Fill/Stamp Mode

Editing a Pattern in Fill/Stamp Mode

M Selecting patterns
1  Click the [Home] tab.

2 Click [Select] in the [Tools] group to use the
[Select] tool.

!* Ry E ; lirdtie

x| Bl |

3 Click the pattern.

>

@ Rotation handle
® Handles

® ©

4 To select an additional pattern, hold down the
<Ctrl> key and click the other pattern.

M

* You can also select patterns by dragging the
pointer across the pattern.

» Hold down the <Ctrl> key and click a selected
pattern to deselect it.

B Moving patterns
Selected patterns can be dragged to move them.

M

» To move the pattern horizontally or vertically,
hold down the <Shift> key while dragging it.

» Pressing the arrow keys moves the selected
pattern one grid mark in the direction of the
arrow on the key.

M Scaling patterns

Drag a handle of the selected pattern to adjust its
size. Drag the rotation handle to rotate the pattern.

M

« If the <Shift> key is held down while a handle is
dragged, the patternis enlarged or reduced from
the center of the pattern.

* Click [Flip Vertically] in the [Flip] group to flip
the selected pattern(s) up/down. Click [Flip
Horizontally] in the [Flip] group to flip the
selected pattern(s) left/right.

El & i |:'l'l|tl.'l] Prl:lrw'rrrm

Sl [T Deinle ) it
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« Using commands other than those mentioned
above, selected patterns can be edited in other
ways, for example, duplicated or deleted.

»» "Menus/Tools" of "Programmable Stitch
Creator" on page 317.

B Reshaping a fill/stamp stitch
patterns

1 Click [Select Point] in the [Tools] group.

ECEHER e

2  Click the broken line.
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Editing a Pattern in Fill/Stamp Mode

3 To edit a point, click the point to select it.

&

Il Selected point
[I: Unselected point

* To move the point, drag it to the new
location.

« Toinsert a point, click the line to add a new
point.
— A new point appears selected.

« Todelete the point, click |} Delete| Or press
the <Delete> key.

M

« If aline is composed of two points and you
delete one of them, the entire line is deleted.

» To select multiple points, hold down the <Ctrl>
key while clicking the points, or dragging the
pointer over the points.

» Hold down the <Ctrl> key while pressing the

key or key. The selection direction

changes to the end or start point.

« Hold down the <Shift> key while dragging the
points. The points are moved horizontally or
vertically.

» Press an arrow key. The points move in the
direction of the arrow on the key.
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Creating Motif Stitch Pattern

Creating Motif Stitch Pattern

Now, we will create a new motif stitch pattern. Motif stitch patterns are created in Motif mode.

Step 1 Enter motif mode

Step 2 Shaping a single line to create motif stitch pattern

Step 3 Saving the created motif stitch pattern

Step 4 Using the edited motif stitch pattern in Layout & Editing

Step 1 Enter motif mode
1  Start up Programmable Stitch Creator.

2 Click 1--1'- and then select [New Motif
Pattern] from the command list.

@= S

STE  Sagyema

Step 2 Shaping a single line to
create motif stitch pattern

In Motif mode, you can create original patterns by
changing the shape of a single line.

1  Click the [Home] tab.

2 Click [Select Point] in the [Tools] group.

Cipt ke e linte

G

dr

Ty

L

siaZ] el
[

o

R [PLEE ]

Blue square: Start point
Red square: End point

3  Select (1), then drag the point.
The line that moves turns green when moving

a point.
1
U,
. a
/
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Creating Motif Stitch Pattern

4  Click the line to insert points.
Click (3) located between (1) and (2).
Click (4) located between (3) and (2).

1
/ 34
z E|E/|D
2
5  Select (4), then drag the point.
4

6  Click between (2) and (4) to insert point (5),
and then drag point (5).

267

7  Click (6) located between (4) and (5), then

drag the point to (1).
Select (3), then drag the point to (2).

M

» To move the point horizontally or vertically, hold
down the <Shift> key while dragging it.

» Pressing the arrow keys moves the selected
point one grid mark in the direction of the arrow
on the key. If the grid is not displayed, the
pattern moves a distance smaller than the
smallest grid interval in the direction of the arrow
on the key.

» To delete a selected point, press the <Delete>
key.

» These patterns can be applied in line sewing
and region sewing in Layout & Editing, and
region sewing in Design Center.




Step 3 Saving the created motif
stitch pattern

Motif stitch patterns are saved in the .pmf format.

1 Click w-E};, and then select [Save As] from the
command list.

El-.—:-un--

iy ol - Bages

|'__'| "
'_El = a

2  Select the drive and the folder, and then type
in the file name.
3 i - |

ATIAFNNERTANE Ny
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1
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— When saving a motif pattern, specify the
size beside [Default Size]. Click [mm] or
[inch] to select the measurement units.

3  Click [Save].
Step 4 Using the edited motif
stitch pattern in Layout &
Editing
1  Start up Layout & Editing.
2  Select an embroidery pattern.

3 Fromthe [Line sew type] selector (in the
[Shapes] tab), select [Motif Stitch].

4  Display the [Sewing Attributes] pane.

»» "Specifying sewing attributes" on
page 54

Creating Motif Stitch Pattern

5 Click [ below [Motif] in the [Line sew]
section.
— e iR —— . T

6  Select the drive and folder where the pattern
was saved in Step 3.

Browse

| C\Program Fies (+86/\Brother\PE DESIGN 10 atterty

i~ o S

moti085 motif0ge motig? maliEs

7  Click the created motif stitch pattern, and then
click [OK].

— The pattern is applied to the outlines of the
embroidery pattern.

A motif stitch pattern can be used when the motif
stitch, piping stitch or stippling stitch has been
selected as the sew type of a region.
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Editing a Pattern in Motif Mode

Editing a Pattern in Motif Mode

B Moving and deleting several
points at atime

1  Click the [Home] tab.

2 Click [Select Point] in the [Tools] group.

FTREISTE S e

%

D [P Sl

Blue square: Start point
Red square: End point

3 Toselectasingle point, click an empty square.

To select multiple points, hold down the
<Ctrl> key while clicking the points, or
dragging the pointer over the points.

| n

B0

B: Selected point
[ Unselected point

M

Hold down the <Ctrl> key while pressing the

key or key. The selection direction changes
to the end or start point.

4  Edit the points.

* To move the points, drag them to the
desired location.

* Todelete the point, click | [} Delete| Or press
o i)
the <Delete> key.

a

The start point (blue square) and end point (red
square) can not be deleted.

M Scaling patterns

1 Click %  inthe [Tools] group.

TR I it : liniiie

k[

i [PLEE ]

2  Drag the handle to adjust the selected
pattern(s) to the desired size.

M

* If the <Shift> key is held down while a handle is
dragged, the pattern is enlarged or reduced from
the center of the pattern.

« To flip the pattern along a vertical axis, click
[Flip Vertically] in the [Flip] group.

« To flip the pattern along a horizontal axis, click
[Flip Horizontally] in the [Flip] group.

'J.'-' . liriried - Progrsmmnt s

L]

o P i

o i gy g
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Programmable Stitch Creator Window

Programmable Stitch Creator Window

3
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Application button
Ribbon
Quick Access Toolbar

Help button

ga b WO DN B

Preview window (»» p. 272)
Shows how the pattern will be sewn.

Design Page
7 Work area
8 Status Bar
»» "Understanding Windows" on page 11
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Opening a Template

Opening a Template

Opening an image in the
background
1  Click the [View] tab.

2 Click [Open Template] in the [Template]

group.
..iéj-. HEEE ' liritee
- i -
= T —piE - B Wl o
i - =1

3 Select the drive, the folder and the file, and
then click [Open] or double-click the file's

icon.

. :’h—'_.-.. -
= i N

SRR &

M

* Only one image can be added to the work area.
If you try to display a different image, it will
replace the previous one.

« There are many different types of files that can
be opened.

»» "Image file formats" on page 150

Changing the density
background image

1  Drag the slider in the [Template] group, or
click @ or Ej

ITRREAET = TE] ' lriise
[ gy - [— E
Hatila] &7 L]
S &

(I

Hide (off) | 50% | 100%

25% 75%

M

« This function is not available if no template
image has been imported into the work area.

* Press the shortcut key <F6> to switch between
displaying the image (On (100%)) to displaying
it faded at each density (75%, 50% and 25%) to
hiding the image (Off).
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Preview Window

1  Click the [View] tab.

2  To switch between displaying and hiding the
[Preview] window, select or unselect the
[Preview Window] check box in the [View]
group.

PR T TE TR

i, e

sy

Preview n

KRR KE

In Motif mode

In Fill/Stamp mode

Preview Window

Saving Patterns

Overwriting

Click w-l'- and then select [Save] from the
command list.

@.‘: Zefhe

=

e i Eagmew

e N i M

B
H : =i

— If no file name has been specified or if the
file cannot be found, the [Save As] dialog
box appears.

Saving with a new name

The files are saved as.pas files in Fill/Stamp mode,
and as .pmf files in Motif mode.

1 Click w-l'- and then select [Save As] from the
command list.

El::-un-- A0

o e Wity B My ot Fi
=

2  Select the drive and the folder, and then type
in the file name.
; = - |

— When saving a motif pattern, specify the
size beside [Default Size]. Click [mm] or
[inch] to select the measurement units.
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Changing the Settings

3 Click[Savel. Ch ang | ng the
M Settings

Saved files can be used in Layout & Editing or
Design Center.

»» "Using the edited fill/stamp stitch patterns in

Changing the grid settings

Layout & Editing" on page 263 and "Using the . .
edited motif stitch pattern in Layout & Editing" 1 Click the [View] tab.
on page 268 2  Select the desired spacing of the grid lines
from [Interval] in the [Grid] group.
TS L gt
= by e
A S gl o S e | Bl i =
= W o e e :
Timsadib - a..l.-:_.
None

No grid is displayed.

Narrow
The spacing of the grid lines is changed to 1/
32 of the Design Page width.

Medium

The spacing of the grid lines is changed to 1/
16 of the Design Page width.

Wide

The spacing of the grid lines is changed to 1/8
of the Design Page width.
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Font Creator

User-defined fonts can be created using Font
Creator. These fonts can be recalled to be used in
Layout & Editing.




Basic Font Creator Operations

Basic Font Creator Operations

With Font Creator, user-defined font characters that can be used in Layout & Editing can be created and
edited. Using these custom characters, original embroidery patterns can be created.

[ g =

2=
Step 1 Selecting a character to be created
Step 2 Opening a background image
Step 3 Creating a font character pattern
Step 4 Creating other font character patterns
Step 5 Save the font character pattern
Step 6 Creating an embroidery pattern using the created font characters
Step 1 Selecting acharacter to be Step 2 Opening a background
created image
1  Click the down arrow in the bottom-left corner 1  Click the [View] tab.
of the [Start] screen to show the [All Apps] ) )
view. 2 Click [Open] in the [Template] group, and

then select [Select Image File] from the list.
2 Click [Font Creator] under the title [PE-

DESIGN 10] in the screen. A n‘ 'J'j_ :
3  Click the [Home] tab. e | ] LA | i
4  Click the [Select Character] box in the = orn R i
[Character] group, and then select "T" from I:' rhmi iy
the list. ~
el
L . 3  Import the Capital_T.bmp.

b L-]

The image file can be found at the following
location.

Documents (My documents)\PE-DESIGN
10\Sample\Font Creator\Font Template
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Basic Font Creator Operations

6 Click T in the [Tools] group, and then drag

m the red triangle icons to move the set lines so
. ) that they are aligned with the left and right of
'cl)'gg:]% 3re many different types of files that can be the character.

»» "Image file formats" on page 150

4 Move the character so that the top aligns with
the [Capital Line]. To adjust the height of the
character, drag a handle to adjust the height
between the [Capital Line] and the [Base

Line].
| @
S T
he °
¢ @ SetlLine
[ 7  Click the [View] tab.
8 Inthe [Template] group, drag the slider (or
click E} or {-Ej) to change the density of the
QID template image to "25%".
. . Rt L [ - “hay it e
@ Capital Line e AT -
® Handles B K et T [r———
® Base Line -"_.‘ |l inend
@ SetLine b s iy
-IH-'III s 12} 2
- 69— o
e [ a
* Red lines are added above, below and to the left 2
o

and right of the sample image. Use these lines
as guides for adjusting the [Base Line], [Capital Hide (off) [50% | 100%
Line] and [Set Lines].

« If the handles have disappeared, right-click the
image, and then click [Modify Template] in the
menu that appeared. D:I

25% 75%

« This function is not available if no template

S  Click the [Home] tab. image has been imported into the work area.

* Press the shortcut key <F6> to switch between
displaying the image (On (100%)) to displaying
it faded at each density (75%, 50% and 25%) to
hiding the image (Off).

Step 3 Creating a font character
pattern

1  Click the [Home] tab.
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Basic Font Creator Operations

2  Click the [Manual Punch] in the [Tools] 3
group, and then select the desired tool from
[Manual Punching Tools].

Click @ , and then click in the Design Page
to specify points (1) (start point) through (4).

.."1._.' --.’lil:-'. - ! >
e n 2 4
i h = r_.l { . T T
i g :.:._- :.I.- o N g ; r
Weme farniwy 1w =R

P ree NS

@ : Straight block-type punching patterns

(region sewing).
(Shortcut key: <Z>)
4  Click [Manual Punch], select /\/ , and then

: Curved block-type punching patterns
& ypep gp click point (5) through (7).

(region sewing) -

(Shortcut key: <X>) 5 /S
6

@ : Semi-automatically created straight

block-type punching pattern

By semi-automatically tracing, points
can be specified along the lines of a
template.

(Shortcut key: <C>)

/\/ : Running-type punching pattern (line
sewing)
(Shortcut key: <V>) 5 Click [Manual Punch], select @ , and then

. click points (8) through (10).
‘1 Feed-type punching pattern (jump 9

stitches)
(Shortcut key: <B>) 10% 8

M

* When entering points, you can switch between
the various tools. This is very easy if the shortcut
keys are used.

» Atemplate image is needed in order to use the
semi-automatic block-type punch tool. If there is
no image, this tool will create a punching pattern
like the straight block-type punch tool. In
addition, this tool cannot be used if a TrueType
font is used as the template.

» Once the pattern is drawn, you can still
transform straight block-type patterns into
curved block-type patterns and vice versa.

»» For details, refer to "To Straight/To Curve" on
page 288
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Basic Font Creator Operations

6 Click [Manual Punch], select /\/ , and then Step 4 Creating other font
click point (11). character patterns

1  Click the [Home] tab.

1 2  Click the [Select Character] box in the
[Character] group, and then select "g" from
the list.

| e

-y e

7  Click [Manual Punch], select @ , and then _ _
) ) 3 Import file Small_g.bmp in the same way that
click points (12) through (13). "T" was imported.
S o
= g
glh i J'3
.‘f_' ......
LY
“*k Imn
13, 4 Inthe same way that "T" was adjusted,
” change the character size and position, and -
then drag the red triangle icons to move the g
8 Double-click point (14) (the last point of the set line so that they are aligned with the left -
entire pattern), or click point (14) and press the and right of the character. Q
<Enter> key. g
=
14 T
i )
@ SetlLine
m If the red lines are not shown, change the

To remove the last point that was entered, right- density of the template image.

click the mouse button, or press the
<BackSpace> key.
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Basic Font Creator Operations

279

Click | & | in the [Tools] group, and then drag
the blue triangle icons to move the mean line
and descender line so that they are aligned
with the top and bottom of the character.

——O

@® Mean Line
® Descender Line

Click [Manual Punch], select /\/ , and then
click points (1) through (7).

7

Click [Manual Punch], select 6}7 , and then
click points (8) through (24).

1

Click [Manual Punch], select /\/ , and then

click points (25) through (26).
2+6

25, "




Basic Font Creator Operations

9 Click [Manual Punch], select EF , and then Step 5 Save the font character
click points (27) through (33). pattern
27
1 Click * %, and then select [Save] from the
29 28 command list.

T L mirid - Fom
o [#]

2  Select the [MyFont] folder at the following

location.
10 Click [Manual Punch], select // , and then : - -
click points (34) through (38). il il
!:_
=~
&
I —-
38 For example, (Drive where PE-DESIGN was
34 installed)\Program Files (x86)\Brother\PE-
37 P DESIGN 10\MyFont.

And then type in the file name. For this
example, type in the name "My font 1".

Click [Save].

Tn
o
>
—
@)
-~
1]
=4
o
-

11 Click [Manual Punch] and select &7 Next,
click points (39) through (46), and then 0«

double-click point (47) (end point), or click . .
point (47) and press the <Enter> key. ;th%gr;aoallltgv%iaognfciassgﬁé in the [MyFont] folder

« The font will not be usable in the Layout &
Editing if it's stored in a different folder.

For example, (Drive where PE-DESIGN was
installed)\Program Files (x86)\Brother\PE-
DESIGN 10\MyFont.

« If any part of the character pattern extends off
the Design Page, a message appears. Edit the
character pattern so that no part extends off the
Design Page, and then save it again.

41 4’/&/5/ D:I

If the background image is displayed, the
information for the background image will be
saved with the font file. The next time that the font
file is opened, the background image is displayed.

280




Basic Font Creator Operations

Step 6 Creating an embroidery
pattern using the created
font characters

1  Start up Layout & Editing.

a

If Layout & Editing is already started, exit it, and
then start it again. The new font is detected when
the application starts up.

2  Click the [Home] tab.
3 cClick [Text] in the [Tools] group, and then
select A from [Text Tools].

i::?'uﬁ e ) Unimind Lve
i':-_1 ;"ﬂl—r ‘f:' ' i | 5

e WP e
':'"":"‘ _-_Tﬁ Ay feee l;.‘i =

4 Click in the Font selector, and then select
"My font 1",

i—_ﬁ_.-_-:u-. 1= Urring- L
L3 _A‘ = LD Bl 33
- AT =L

m ANg Teeiciefn e
[t Tl T T

W[ | &G

Fonts created in Font Creator appear with the Tfy
icon in front of the font name.

M

Since fonts for only "T" and "g" were created in the
previous examples ("A", "B", "C", etc. were not
created), only these characters appear in the
sample when [Font] selector is clicked.
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Click in the Design Page.

Input the text, and then press <Enter> the key
or click the Design Page.

i'i: W] Y e Urring- L
ETe o -

% WAl 8OO

sqr e &

.
tramg wan o == o

- ~p=

»» "Creating Embroidery Patterns
Containing Text" on page 100




Font Creator Window

Font Creator Window

Untiitlass - Fortt Creatar - o IEl
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Application button
Ribbon

Quick Access Toolbar
Help button

Preview Window (»» p. 289)
Shows how the stitch pattern will be sewn.

a b W N P

6 Design Page
7 Guidelines (fixed) (»» p. 283)
8 Guidelines (movable) (»» p. 283)
9 Work area
10 Status Bar
»» "Understanding Windows" on page 11
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Font Creator Window

About the Design Page M

gu idelines « The heights and widths specified for the [Base
o _ Line], [Capital Line] and [Set Lines] are the
The standard guidelines for creating fonts are reference mask for creating the font character.

shown in the Design Pages. The contents of each of « When characters created with Font Creator are
the guidelines are as shown below. imported into Layout & Editing, the width and

height of the characters will be in the following

6 area.
¢ Character hegn: from Base Line o to
|_ 7\
|

Capital Line
|
6 o L — 0

+ Character width: from Set Line (Left) @ to Set
@ Triangle icon

2] Line (Right) @

« Inorder to align the height of the characters, the
O [Ascender Line], [Mean Line] and [Descender
Line] appear the same with all characters.
Therefore, if the height of any of these lines is
"o changed, the setting is maintained, even when a
)_‘ different character is selected to be edited.

]

« The widths of the [Set Lines] can be set
separately for each character.

o Base Line

e Capital Line
The font's standard height will be from the
Base Line to the Capital Line line. These
line cannot be moved.

9 Mean Line
When in lower case, the standard height
of the font will be from the Base Line to
this line. It can be moved by dragging the
triangle icon on the right edge.

e Descender Line
This line is the standard for characters
with parts that hang down (descenders)
such as "g" and "y". It can be moved by
dragging the triangle icon on the right
edge.

6 Ascender Line
This line is the standard for characters
with parts that extended above
(ascenders) such as the accent mark. It
can be moved by dragging the triangle
icon on the right edge.

Set Line (Left)

Set Line (Right)

This line will be the font width. The font
width can be adjusted by dragging the
triangle icon on the bottom edge.

o0

283




Opening a File
Creating a new font

Click {4/, and then select [New] from the command
list.

Opening a File

Opening a font file

1 Click A/, and then select [Open] from the
command list.

R

=
H -

2 The created font is saved in the [MyFont]
folder at the following location.
(Drive where PE-DESIGN was
installed)\Program Files (x86)\Brother\PE-
DESIGN 10\MyFont

e i [ =
- oS
. = -
- Enn o =
':' [rpe——_— P
)
s
et
EHe
- '_.d.d

3 Toopenafile, selectit, and then click [Open],
or double-click the file's icon.
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Selecting a Character and Preparing the Template

Selecting a Character and Preparing the

Template

Selecting the character to
be created

Ml Selecting from the selector
1  Click the [Home] tab.

2  Click the left or right arrow buttons of the
[Select Character] box in the [Character]
group to select a character before or after the
one that is currently displayed.

AF ' i e

P EE=

M Selecting from a character list

1  Click the [Select Character] box in the
[Character] group.

rrm o nEm

2  Click the character to be created.

2

S [=<[x|=|a
a

R
Eémmg
u<4N%
o []e|e
oo ==
BEEE
AREE
~lalz[~
BAOEE
ARED
HREE
FIEEE]
<[ [o[o

Directly type in text.
Add

285

M

» Characters where pattern has already been
created appear with a blue background.

» The blank box in the upper-left corner is a space.
Click this box to select a space.

a

If any part of the character pattern extends off the
Design Page when a different character is
selected, a message appears. Before selecting a
different character, edit the character pattern so
that no part extends off the Design Page.

M Adding/deleting registered
characters

1 Click[Add/Remove Characters] in the
[Character] group.

I ujr 1 Linfriies® - Fomi Crealor

S L LLILE] —rE

2  From the keyboard, enter the character to be
registered.

Add/Remove Characters

3|4|5(6|7|8|9]|A|B
MI{N|O
c e
s u

<
EIEHGEE
ST=lz|=
S[=<— |~
<~ [o[o

JK[L[M[N]o[PQ[R
Z[alb|c|d|e|Flaln
plalr 1 v [w %




Selecting a Character and Preparing the Template

3 cClick [Add].

Add/Remove Characters

6|7|8[9|AB
Q
e
u

3|4

4<7\.

EIEHGEE

5
L
b
r

< - [w|o
MEEIE
c

QR
glh
WX

S =] z|=~
o [<|—|~

KL [v[n]o]P
alb|c|d|e|f
q s [t]u]v

J
z
P

Directly lype in test

I
oK Cancel

4 Todelete a registered character, select the
character, and then click [Remove].

The box is selected in red. Each click of the
character switches between selecting and
deselecting it.

5  When the settings can be applied, click [OK].

M

If a character is registered even though a font has
not been created, the information for the registered
character is saved in a font file.

Opening a template
(TrueType font)
1  Click the [View] tab.

2 Click [Open] in the [Template] group, and
then select [Select TrueType Font] from the

list.
__.-.III_--\,:"|.|__J: - Wleitied - F
" Hiwe e

[ et rr—
I___' T =l B g Bs

ree i .
i kil

1 = -

3  Fromthe [Font] selector, select the font. From

the [Style] selector, select the character style.
And then click [OK].

Select TrueType Font

Font

T Araoi AaBbYyZz -
Syl

Fregular -

Cancel

rrew .

While working on a character in a font, the
same TrueType font appears until a different
template is selected for the background. Each
time a different character is selected in the
[Select Character] box, the template of the
character in the same TrueType font appears.

M

« If the character selected in the [Select
Character] box is not available in the TrueType
font, "?" appears as the template.

 Ifa TrueType font was selected as the template,
it cannot be moved or resized.

« Inthis case, it can automatically be converted to
a font character pattern.

»» "Automatically converting TrueType fonts" on
page 287.

« In addition, the character cannot be drawn with
the semi-automatic block-type punch tool.
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Creating a Font Character Pattern

Creating a Font Character Pattern

Automatically converting
TrueType fonts

1 Open the TrueType font to be used as a
template.

»» "Opening atemplate (TrueType font)" on
page 286.

2  Click the [Home] tab.

3 click [Convert from TrueType] in the [Edit/
Arrange] group.

S
|

Ubled - Faré Cremine

4 ifa TrueType font has not been selected for
the template, the [Select TrueType Font]
dialog box appeatrs.

Editing Font Character
Patterns

M Selecting patterns
1  Click the [Home] tab.
2 Click T in the [Tools] group to use the

[Select] tool.
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3  Click the pattern.
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@ Rotation handle
® Handles
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4 To select an additional pattern, hold down the
<Ctrl> key and click the other pattern.

M

* You can also select patterns by dragging the
pointer across the pattern.

* Hold down the <Ctrl> key and click a selected
pattern to deselect it.

B Moving patterns
Selected patterns can be dragged to move them.

M

» To move the pattern horizontally or vertically,
hold down the <Shift> key while dragging it.

« Pressing the arrow keys moves the selected
pattern one grid mark in the direction of the
arrow on the key. If the grid is not displayed, the
pattern moves a distance smaller than the
smallest grid interval in the direction of the arrow
on the key.

M Scaling patterns

Drag a handle of the selected pattern to adjust its
size. Drag the rotation handle to rotate the pattern.

M

« If the <Shift> key is held down while a handle is
dragged, the patternis enlarged or reduced from
the center of the pattern.

 Click [Flip] in the [Edit/Arrange] group, and
then select [Flip Vertically] to flip the selected
pattern(s) up/down.
Select [Flip Horizontally] to flip the selected
pattern(s) left/right.
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« Using commands other than those mentioned
above, selected patterns can be edited in other
ways, for example, duplicated or deleted.

»» "Menus/Tools" of "Font Creator" on page 318.




Editing the Points of a Font Character Pattern

Editing the Points of a Font Character
Pattern

Editing points and To Straight/To Curve
reShaplng patterns 1  Select the point(s).
1 Click the [Home] tab. 2  Click [Point] in the [Edit/Arrange] group, and

then select the desired command from the list.

2 Click [Select Point] in the [Tools] group.
. . ~ Lewzge! <50 Cams - ol
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3 Click the pattern. | | L -
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4 7o edit a point, click the point to select it.
»» For details on the commands To Straight,

- o To Curve, To Smooth, To Symmetry and
B To Cusp, "Transforming straight lines
A ’
I e ) into curves or curves into straight lines"
on page 70 and "Changing the curve
type" on page 70.

a

B These commands are not available with patterns
entered using the [Running] or [Feed] tools.

@ Unselected point
® Selected point
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* To move the point, drag it to the new
location.

« Toinsert a point, click the line to add a new
point.

— A new point appears selected (as a
small black square or circle).

* To delete the point, click | peete| Or press
the <Delete> key.
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Checking the Created Font Patterns

Checking the Created Font Patterns

Checking and editing the
sewing order

1  Click the [Home] tab.

2 Click [Sewing Order] in the [Edit/Arrange]
group.
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. Click to enlarge each pattern to fill its
frame.

3  Select a pattern in the [Sewing Order] dialog
box.

il

7 2

Sewing Order

=
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4  The sewing order can be changed by
selecting the frame containing the pattern that
you want to move, then dragging the frame to
the new location. A vertical red line appears,
indicating the position where the frame is

being moved.
Sewing Order
.
1 2 B
I‘@‘zﬁ%%l oK =

An alternative method for moving the frames is by
clicking the buttons at the bottom of the dialog box.

@ : To move to the beginning of the
sewing order.

5 : To move ahead one position in the
sewing order.

289

4 : To move back one position in the
sewing order.

@ : To move to the end of the sewing

order.
To change the sewing order, click [OK].

Previewing the embroidery
pattern
1  Click the [View] tab.

2  To switch between displaying and hiding the
[Preview Window], select or unselect the
[Preview Window] check box in the [View]

group.
il :l\.':l..l:-. P MI{;’"
(] - [ e e |
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Preview Window Bl
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Checking and selecting
from the list of created
characters

A list of characters included in the font file currently
being edited can be viewed.

1  Click the [Home] tab.

2 Click [Browse Characters] in the
[Character] group.

Mg hoori L perd - Roae il - =N
2
—— T Mo | e r
£ e
T — chervp oy ol T
m Eyerw ELETE
Browse
I 1
SPACE T g
S

To select a character, click the character, and then
click [Select].

Checking the Created Font Patterns
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Saving Font Character Patterns

Saving Font Character Patterns

Overwriting

Click * /!, and then select [Save] from the
command list.

El LT

[ Ll
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— If no file name has been specified or if the
file cannot be found, the [Save As] dialog
box appears.

a

If any part of the character pattern extends off the
Design Page, a message appears. Edit the
character pattern so that no part extends off the
Design Page, and then save it again.

Saving with a new name

The font character patterns are saved as .pef files.

1 Click " 41, and then select [Save As] from the
command list.

'l - S Cum

2  Select the [MyFont] folder at the following

location.
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For example, (Drive where PE-DESIGN was
installed)\Program Files (x86)\Brother\PE-
DESIGN 10\MyFont

And then type in the file name, then click [Save].

a

» The font will not be usable in the Layout &
Editing if it's stored in a different folder.

» The created font is saved in the [MyFont] folder
at the following location.

» Saved files can be used in Layout & Editing.

»» "Creating an embroidery pattern using the
created font characters" on page 281

« If Layout & Editing has already started up when
a new character is saved in Font Creator, that
character will not appear in the [Font] selector
list in Layout & Editing. In this case, exit Layout
& Editing, and then start it up again.
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Changing the Settings

Changing the Settings

Changing the drawing
mode

There are two drawing modes in Font Creator.

* Fill mode
Blocks appear filled in. In this mode, the
overlapping positions of patterns can be
viewed better.

* Outline mode (Fill mode Off)
Blocks do not appear filled in. In this mode,
points can be edited more easily.

[ —

Perform the operation described below to switch
between these modes.

Click the [View] tab.
Click [Fill Mode] in the [View] group.

R CEE
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Scaling/Moving the
background image

Click [Modify Template] in the [Template] group.

IR ; Sample pel -
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— The background image is selected.

The background image can be moved or
resized in the same way that font character
patterns are edited.

»» "Editing Font Character Patterns" on
page 287.

M

The background image cannot be scaled or moved
if a TrueType font is used as the template.
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Changing the Settings

Changing the grid settings

1  Click the [View] tab.

CL s ’ Klmiitied - Fonk Crostire
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2  Specify the grid settings in the [Grid] group.

(1) —|. Show Grid  Interval [NARROW [= (3)

(2] with Axes | MarROW
(4] T. Snap to Grid MEDIUM
Grd | wipe

o To display the grid, select the [Show
Grid] check box.

e To display the grid as solid lines, select
the [with Axes] check box.

9 In the [Interval] box, select the grid
spacing.

e To input the font in a uniform thickness or
match vertical and horizontal positions,
select the [Snap to Grid] check box.

M

The pointer will move by the amount set in
[Interval] box.

The snap feature works whether or not the grid is
displayed.
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Supplement

This section provides hints and detailed
techniques for creating even more attractive
embroidery.




For Basic Operations

For Basic Operations

Enlarging/Reducing Stitch
Patterns

Imported stitch patterns can be enlarged or reduced
in Layout & Editing in the following three ways.

1 Stitch patterns can be simply enlarged/reduced.

2 Stitch patterns can be enlarged/reduced while
the <Ctrl> key is held down.

3 Using the [Convert to Blocks] tools, stitch
patterns can be enlarged/reduced after being
converted to a group of shape patterns with
multiple sewing direction lines.

With method 1, the stitching will become more
dense or light without the number of stitches sewn
changing. In other words, greatly enlarging or
reducing the pattern changes the quality of the
embroidery since the thread density is adjusted.
Use this method when only slightly enlarging/
reducing the stitch pattern.

With method 2, the size of the pattern is changed
while maintaining the thread density and needle
drop point pattern. However, if the original thread
density and needle drop point pattern in the stitch
pattern are not uniform, the thread density and
needle drop point pattern may not be maintained,
even by using this method. Enlarge/reduce the
pattern while checking the preview. Do not use this
method when only slightly enlarging/reducing the
stitch pattern.

With method 3, the thread density is maintained
while the pattern is enlarged/reduced. However, the
needle drop point pattern is not entirely maintained.
Use this method when you wish to change the
stitching or shape. Do not use this method when
only slightly enlarging/reducing the stitch pattern.

a

This software allows you to create a wide variety of
embroidery patterns and supports wider ranges for
the setting of the sewing attributes (thread density,
sewing pitch, etc.). However, the final result also
depends on your particular embroidery machine
model. We recommend that you make a trial
sewing sample with your sewing data before
sewing on the final material. Remember to sew
your trial sample on the same type of fabric as your
final material and to use the same needle and the
same machine embroidery thread.
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Sewing Direction

In order to limit pulling or puckering, select a stitch
direction perpendicular to the larger edge of the
area.

Pulling or puckering more likely to occur

Pulling or puckering less likely to occur

Sewing Order

After creating an embroidery pattern made of
several different parts (in Layout & Editing or Design
Center), be sure to check the sewing order and
correct it if necessary.

With Layout & Editing, the default sewing order is
the order in which the elements are drawn.

With Design Center, the default sewing order is the
order in which the sewing attributes are applied.

Be careful when changing the sewing order since
overlapping areas may be incorrectly positioned.




For Basic Operations

Sewing Wide Areas

For best sewing results, set [Under sewing] to
[On] when sewing wide regions.

»» For more details, refer to "Under sewing"
on page 331.

¢ Changing the [Sewing Direction] setting
prevents pulling-in or puckering of the stitching.

¢ When embroidering, use stabilizer material
specifically for embroidering. Always use
stabilizer material when embroidering lightweight
or stretch fabrics, otherwise the needle may bend
or break, the stitching may pull and pucker, or the
pattern may become misaligned.

¢ When satin stitching is sewn in a wide area, the
stitched area may shrink after sewing, depending
on the material and the type of thread used. If this
happens, switch to this alternate method: Select
the fill stitch and use stabilizer material on the
reverse side of the fabric.

Pattern

juswe|ddng

After sewing
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On Settings

On Settings

Jump Stitch and Jump
Stitch Trimming

M Machine thread trimming
according to settings specified in
Layout & Editing

If ® is selected in the [Design Settings] dialog

box of Layout & Editing, trimming can be turned on
or off at each jump stitch location.

These settings are saved in embroidery data files
(-pes).

If you are using our multi-needle embroidery
machine with the Jump Stitch Trimming function
turned on to embroider this imported .pes file, the
machine will trim the thread according to the PES
data settings.

a

For details on the jump stitch trimming function of
the machine, refer to the Operation Manual
provided with your embroidery machine.

W Specifying trimming settings in
Layout & Editing
1 Select® in the [Design Settings] dialog
box.

»» "Specifying the Design Page Settings" on
page 14

2 Display the trimming locations in Layout &
Editing.

»» Memo of "Changing the display of the
embroidery design" on page 78

3 Turn on/off jump stitch trimming for each
embroidery pattern.

»»  "Jump Stitch Trimming" on page 87

297

If necessary, change settings for the
following.

* Automatically turning off trimming when the
jump stitch length is less than that
specified.

»»  "Jump Stitch Trimming" on page 87 and
"About Minimum jump stitch length for
thread trimming" on page 87

» Default setting for turning on/off jump stitch
trimming when a new embroidery pattern is
created.

»» "Adding jump stitch trimming to new
patterns” on page 302
Stitching

Jump stitch Stitching

a

These settings are applied only when
embroidering with our multi-needle embroidery
machines. These settings are not applied with any
other embroidery machine.




Changing Various Settings

Changing Various Settings

Customizing the window

M Quick Access Toolbar/Ribbon

A menu appears when = inthe [Quick Access
Toolbar] is clicked.
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Click [More commands] to add or remove the
commands appearing in the list of the [Quick
Access Toolbar].

Click [Show Below the Ribbon] to move the
[Quick Access Toolbar] below the Ribbon. To
return it to its original position, display the menu as
described above, and then click [Show Above the
Ribbon].

If a check mark appears beside [Minimize the
Ribbon], the Ribbon is minimized. When a tab is
clicked, the Ribbon appears. After a command is
selected, the Ribbon is minimized again. To restore
it to its original display, clear the check mark.

Example: With [Show Below the Ribbon] selected
and a check mark beside [Minimize the Ribbon]
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B Quick Access Toolbar commands
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The first time this application is started up, the
following commands appear in the Quick Access
Toolbar (A).

[F : Undo
~l: Redo
-] Wizard

':*:':{‘ : Zoom in

Click = , then select or unselect the check boxes
beside the commands to switch between displaying
and hiding them. When the check mark is cleared,
the command is hidden. Alternatively, changes to
the commands listed in the [Quick Access
Toolbar] can be specified in the [Options] dialog
box and all applied at the same time.

»» "Customizing Quick Access Toolbar" on
page 300

B Import/Color/Sewing Attributes/
Text Attributes pane, Sewing
Order pane and Stitch Simulator
pane

Floating

Each tab or the entire pane can be undocked to

become a dialog box that can be moved around the

screen.

« Double-click the title bar of the pane, or tab.

« Right-click the pane or tab, and then click
[Floating].

« Drag a tab out of the pane.
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Changing Various Settings

Docking
Each pane can be docked back to the window.

« Double-click the title bar.
* Right-click the pane, and then click [Docking].

¢ Drag the title bar to the location where the pane
will be docked.

Hide

When a tab or a pane is no longer needed, it can be

hidden.

« Click 2 in the upper-right corner of the dialog
box.

« Right-click the tab or dialog box, and then click
[Hide].

¢ To hide the tab, click [View] tab in the Ribbon,
and then click the name in the [View] tab. To
display the tab again, perform the same
operation.

Auto Hide

When a pane is temporarily not needed, it
can be moved to the side bar, then
displayed by clicking it or positioning the
pointer over it. The pane is automatically
hidden again when it is no longer being &
used, for example, when you click rt]
anywhere outside of the pane.

* Right-click the tab or the title bar of the pane, and
then click [Auto Hide].

« In the upper-right corner of the pane, click .
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To cancel Auto Hide, right-click the title bar, and

then click [Auto Hide], or simply click -2 inthe title
bar.

M

 The Stitch Simulator pane cannot be temporarily
hidden (Auto Hide).

» These panes can be returned to their default
displays.

»» "Customizing Shortcut keys" on page 301
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M Using access keys

When the <Alt> key is pressed, a KeyTip (label
showing the letter of the access key) appears on
each command. On the keyboard, press the key
corresponding to the command that you wish to use.
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CCEET

u. o
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Select Clipboard

To stop using the access keys and hide the
KeyTips, press the <Alt> key.




Changing Various Settings

Changing Options Settings 1  Click [Customize].

(1) (3]
From the [Options] dialog box, the commands I~ - =
appearing in the [Quick Access Toolbar] and - — T= ®
settings for the application's appearance can be - - o
selected, and also the settings on shortcut keys, . LI i
jump stitches, thread charts can be specified or (o) = o - | I_e
changed. Follow the procedure described below to a=
display the [Options] dialog box. =
= —0
Click @ and then click [Options] on the bottom of 7] R (4]
the window.
E" ._':F| AN @ = il
. i i 2 Repeat the following operations until the
desired commands are displayed.
=" @ choose commands from selector
1=} Select a command category.
H - @ commands list
Select the command to be added.
© Add button
Selected command is added.
) ergine The command appears in ®.
% fm ivin e Remove button
= Selected command is removed.
The command is removed from ®.
e -
m Select an icon in ®), and then click the
buttons at to move it to the desired
The [Options] dialog box can also be displayed position.
i ither of the followi thods.
using either of the following methods e Reset button
« Click = atthe right end of the Quick Access Reverting to the default commands.
Toolbar, and then click [More Commands]. Settings for the following can also be specified
* Click [Option] in the upper-right corner of the from this dialog box.

window, and then click [Options]. 0 Show Quick Access Toolbar Below the

Ribbon
Select where the Quick Access Toolbar is

. . displayed. Select the check box to display
O CUStomlzmg QU|Ck Access the Quick Access Toolbar below the

Toolbar Ribbon.
.@. REEEY S = 3 After the settings have been specified, click
Home Image View [OK] to apply them.

k o Cut L Duplicate ﬁ

21 Copy J,'— Arrange Copy ~
Select (|| . Text

ste = [T Delete
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Select Clipboard ©)

@ Quick Access Toolbar
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Changing Various Settings

W Customizing Shortcut keys

1 Click [Customize] in the command list, then
[Customize] beside [Keyboard shortcuts].
L

2 Inthe [Categories] list, select a command
category. Then, in the [Commands] list,
select the command whose shortcut keys are
to be specified.
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— The default shortcut keys appear in the
[Current Keys] box 0

3  usethe keyboard to record the new shortcut
keys inthe [Press new shortcut key] 9 box,
and then click [Assign] e The new shortcut
keys appear in the [Current Keys] box o

— Usage information about the entered key
combination appears. If the key
combination has already been assigned to
another command, the name of that
command appears at 9

To remove the default or specified shortcut
keys, select the shortcut keys in 0 and then
click [Remove] @

To revert to the default settings, click [Reset

Al @.

4 Repeat steps 2 and 3 until the desired shortcut

keys have been specified for the commands,
and then click [Close].
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5 Click [OK] in the [Options] dialog box.

M Editing user thread charts

For detailed instructions, see "Editing user thread
color lists" on page 192.

B Specifying the number of jumpsin
embroidery design of the DST
format

With the DST format, you can specify whether or not
the jump stitches are trimmed according to the

number of jump codes. The number of codes differs
depending on the embroidery machine being used.

Click [DST Settings] in the command list, specify
the number of jumps, and then click [OK].

To specify a setting for importing, enter a value
beside [DST Import Setting]. To specify a setting
for exporting, enter a value beside [DST Export
Setting].

1 - B L R
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DST Import Setting

If the number of consecutive jumps in the DST
file is less than the number of jumps specified
here, those consecutive jumps will be
replaced with a stitch.

If the number of consecutive jumps in the DST
file is greater than or equal to the number of
jumps specified here, those jumps will be
replaced with a jump stitch where the thread is
trimmed.

DST Export Setting

When .pes files are output, jump stitches with
thread trimming are replaced with more
consecutive jump codes than the specified
number of jumps.




B Adding jump stitch trimming to
new patterns

When creating a new embroidery pattern for our

multi-needle embroidery machines, you can specify

whether or not to add jump stitch trimming to the

pattern.

a

These settings are applied only when
embroidering with our multi-needle embroidery
machines. Before these settings can be specified,
select © under [Machine Type] in the
[Design Settings] dialog box.

Click [Jump Stitch Trimming] in the command list,
select the [Add jump stitch trimming to the

entered patterns.] check box, and then click [OK].

s | —
—

==

When the check box is selected, scissors
icon appear beside the frames to indicate
jump stitch trimmings are applied.

Sewing Order qa =
E-| % %
v (=] X
&
v

@ Scissors icon

Changing Various Settings

B Changing the system unit

For detailed instructions, see "System unit" on
page 20.

M Adjusting the screen calibration

For detailed instructions, see "Adjusting on-screen
measurements (Screen Calibration)" on page 19

B Customizing User Interface
Settings

The color scheme of the applications can be

selected.

Click [User Interface Settings] in the command list,

select the desired color scheme from [Application

Color], and then click [OK].
= m

=

With the [Show Status Bar] check box, select
whether to display or hide the status bar. To display
the status bar, select the check box.

If the [Reset Pane Position] button is clicked, the
docked panes ([Import]/[Color]/[Sewing
Attributes]/[Text Attributes] panes, [Sewing
Order] pane and [Stitch Simulator] pane) return to
their default displays after the application is
restarted.
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For Making an Effective Use of This Application

For Making an Effective Use of This

Application

Converting Characters
(Japanese, Chinese,
Korean, etc) to Embroidery
Patterns

Embroidery patterns can be created from various
characters, such as Japanese, Chinese, Korean
etc, using TrueType fonts.

For this example, we will create an embroidery
pattern from Japanese characters.

1  Start up Layout & Editing.

2 SelectaTexttool, and then select a Japanese
TrueType font (for example, "MS Gothic").

3 Display a character code table different from
the one that appeared in step 2. ([Start] — [All
Programs] — [Accessories] — [System
Tools] — [Character Map])

4 Select [MS Gothic] from the [Font] list in
[Character Map], and then select the
[Advanced view] check box. Next, select
[Windows]: [Japanese] from the [Character
set] list, select the desired character, and then
click [Select].

(This example shows the Japanese hiragana
for the word meaning "Good Afternoon".)
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5 After selecting all of the desired characters,
click [Copy] to copy the characters.

6 Clickinthe Design Page where you want to
enter the text.

7  Paste the characters into the text field in the
[Text Attributes] pane, and then press the
<Enter> key.

M

If Japanese or Korean can be entered directly from
the computer keyboard, those characters can be
entered directly into the [Edit Text Letters] dialog
box.

Fonts Suitable for
Embroidering

B When converting TrueType fonts
to embroidery patterns

For best results when converting TrueType fonts to

embroidery patterns, select a font where all lines are

as thick as possible, such as with a Block font.
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For Making an Effective Use of This Application

Displaying the embroidery
designs in PES format as
thumbnails

Embroidery files in PES format can be viewed as
thumbnails with Explorer (Windows® Explorer in

Windows® 7 and File Explorer in Windows® 8.1). It
helps you to manage embroidery designs more
easily.
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To display embroidery files by using thumbnails,

click | -
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For Making an Effective Use of This Application
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Menus/Tools and Reference

This section lists the various Ribbon commands
and tools in each application window. For details
on each command and tool, refer to the
corresponding page in this manual.

This section also contains font samples and
information on the various sewing attributes.




Layout & Editing

Layout & Editing

Application button menu

ﬁ" ol - - No. | Menu | Reference

O —glis —_— 1 | New p. 90

@—j- 2 | open p. 90

®—H - 3 | Save p. 95

@ _H 4 | Save As p. 95

® — 5 Print p. 96

6 Design Property p. 88

®— : 7 Design Settings p. 14

©— Cins 8 | Fabric Selector p. 17

— ; 9 | Wizard p. 10

® — ] 10 | Export p. 95

@ —1> &

Ribbon menu tabs

B Home tab

® 6 ® ® (@) @

E-:'.;' [_éEE L s Liatirie - |Lagi & Faitig \‘ - :'_

—| £ T T Datem - ) -

| h w :,,_,: -ldl- b - il s TS —- H:J ::I i .I,.I. L

Epirdl Byus | 2 Cofin an i - e L Fr RIS i

T e e S s

e @ O ® ® ® 9@

No. | Menu | Reference No. | Menu | Reference
1 Select Tools p. 31 13 | Pan p. 77
2 Cut — 14 | Measure p.78
3 Copy — 15 | Import Patterns p. 91
4 Paste p. 55 16 | Arrange p. 32
5 Duplicate — 17 | Emboss/Engrave p. 57
6 Arrange Copy Tools p. 35 18 | Modify Overlap p. 40
7 Delete — 19 | Group p. 39
8 | Text Tools p. 106 20 | Applique Wizard p. 161
9 Shapes Tools p. 60 21 | Embroidered Patch Wizard p. 167
10 | Zoomin p. 77 22 | Cutwork Wizard p. 170
11 | Zoon out p. 77 23 | Sew Embroidery p. 201
12 | Other Zoom Tools p. 77
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Layout & Editing

M Image tab
® ®
& RESzh Y 4 =ik Unttiid - Layenst & Edfitiog - ol
(. ilF vim Duteen - [ -
S R e L .'\. dda Bight
i *® 22’
il e g ey |-'|'.| ili ey -'.-.. ..-\. || .. P
o ® 6 O ® ® ®
No. | Menu | Reference \[eH | Menu | Reference
1 | OpenImage p. 150 7 Delete Image p. 153
2 | Save Image p. 153 8 | Auto Punch Wizard p. 132
3 Modify Image p. 152 9 Cross Stitch Wizard p. 135
4 Background Image Density p. 152 10 | Photo Stitch 1 Wizard p. 139
5 Rotate Right p. 153 11 | Photo Stitch 2 Wizard p. 144
6 Rotate Left p. 153 12 | Import to Design Center p. 149
M View tab
® ® ®
E?‘_EI ) ettt - Lisfon i Eitien - ol
4 o - e T e l
9 . = s ITaid Tk, .-"";';"-._"; Tihamle s Li FEnE I - AR T
Nt n - 0 By e Fows Sriors ' Tia ﬁ Y ] Py eI L s
EdE | Das agbyie Traing| T
T T rmlu-\.-n.-\..-\. o i g
| anpe || [ - o
O ® ®6 ® 00O @ @ ® ®
No. | Menu | Reference \[eH | Menu | Reference
1 | Solid View p. 78 9 Import Pane p. 13 =
2 | Stitch View p. 78 10 | Reference Window p. 81 g
3 Realistic View p. 79 11 | Show Grid p. 18 %
4 | View Thread Trimming p. 79 12 | Show Grid with Axes p. 18 5'
5 Realistic View Settings p. 79 13 | Snap to Grid p. 18 %
6 | Sewing Order p. 82 14 | Grid Spacing p. 18 2
7 Stitch Simulator p. 80 15 | Ruler p. 18 ?U-
8 Attributes Setting p. 29 16 | Guideline p. 19 g.,
o
S
o
@
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Layout & Editing

M Text tab (Text)

® ® ®
E-:':' et El it Tisll Liibmany - Lapptia] S Ecktiini - :'_
SRS [T ———— fL— N
& A S ABg e R T
Sl | T i Pk P W AP < R
o ©® ® ® O (@) ®® ®

No | Menu | Reference No. | Menu | Reference
1 | Select Tools p.31 9 | Text Outline Sew Type p. 117
2 | Text Tools p. 106 10 | Region color p. 117
3 Font p. 107 11 | Text Body Sew Type p. 117
4 Text Size p. 109 12 | Edit Text p. 107
5 Font Filter p. 108 13 | Convert to Blocks p. 115
6 Font Filter Settings p. 108 14 | Convert to Stitches p. 71
7 TrueType Font Attribute Setting p. 110 15 | Convert to Outline p. 116
8 Line color p. 117

M Outline tab (Shapes (Outline))
@00 ®
&-‘:_53 e | e L1|'m-|;a-L:'||:.n-!|Ennh; - :'_
o JET P IR (Y (S e [
T R A T
et || 3HEBEE s
®© 60 @)

No. | Menu | Reference No. | Menu | Reference
1 Select Tools p. 31 Pencil (Open Curve) p. 63
2 | Closed Straight Line p. 63 Line color p. 65
3 | Closed Curve p. 63 Line sew type p. 65
4 Pencil (Closed Curve) p. 63 10 | Region color p. 65
5 Open Straight Line p. 63 11 | Region sew type p. 65
6 Open Curve p. 63
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Layout & Editing

W Outline tab (Shapes (Rectangle))

® O
SE=Es | Satns et - Loy 1 ¢ Exkinegy - oIl
&.':'Il i srge vim TioE Dastwemy -~ [ -
X s

No. | Menu | Reference No. | Menu | Reference
1 Select Tools p. 31 4 Line sew type p. 65
2 Edge radius p. 61 5 | Region color p. 65
3 Line color p. 65 6 Region sew type p. 65

B Manual Punch tab (Shapes (Manual Punch))

®
& ] oy L Lovviicisd - Layeu il & Bkt - ol
= I L e T T Dateemy - [ -
‘ - g A v
' [ D B A e e

No. | Menu | Reference No. | Menu | Reference
1 | Select Tools p. 31 5 | Feed p. 197
2 | Straight Block p. 197 6 | Region color p. 65
3 | Curved Block p. 197 7 | Block sew type p. 65
4 | Running p. 197
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Layout & Editing

B Shapes tab (Shapes (Shapes/Circle/Arc))

® ® ® ®
E‘f“_E N R § Uiatiried - Laytut & Ealling - okl
4 W Eapge Hm e Dastwemy -~ [ -
hi { s T 3 L AR i ST semn .
S, wpen 8 B = it Tt 0P
PSS I[ Tmm B HHHEE naa 5 s Pivis bak
| L | tominy Bf Ty |FE B384 e 2|
© @0 ® @ ® ® ® ®
No | Menu | Reference No. | Menu | Reference
1 | Select Tools p.31 9 Line color p. 65
2 | Split Outline p. 42 10 | Line sew type p. 65
3 | Add Direction Line p. 52 11 | Region color p. 65
4 | Delete Direction Line p. 53 12 | Region sew type p. 65
5 Reverse Direction Line p. 53 13 | Convert to Stitches p. 71
6 Edit Point p. 70 14 | Create Offset Lines p. 44
7 Delete Point p. 67 15 | Create Floral Pattern p. 42
8 Split at Point p. 67
M Stitches tab (Stitches)
S urndn:-i.wﬁﬁinrq - ol
He T T Dusteemy ~ [ -
= r
] ¥ W
5 .' -I.'. .'-I ¥ II '.:I'- -
o
® & 6 O
Menu | Reference No. | Menu | Reference
1 Select Tools p. 31 Split at Point p. 73
2 Split Stitch Data p. 74 Convert to Blocks p. 75
3 | Change Color p.71 Convert to Outline p. 76
4 Divide by Color p. 75
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Design Center

Design Center

Application button menu

Vi e . e
i.".' No. | Menu | Reference

O— S 1 | wizard p. 222
@ — i i 2 New Line Image p. 225
@ — T 3 New Figure Data p. 227
@ 4 Open p. 223
® H 5 Save p. 237

6 Save As p. 237
®—H

Ribbon menu tabs

M Original Image tab

=l . Al ana 334D - Diasign Contis - o ikl
P Wi 1 rw B -

Reference . Reference

1 Open Image — 2 To Line image p. 224

ELine Image tab

[ = 2 L Alifilatwi PEL - Dailiyh Cormai - ol
- L TIET TR B

Py | B 2mom Rer Ta Magws 1 Fige

L Hindw
| | | | .I.I- |

<
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@
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o
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o
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o
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o
©
o
®
=
o
®

No. | Menu | Reference No. | Menu | Reference
1 Pen Tools p. 213 4 Pan Tool p. 214
Eraser Tools p. 213 5 To Original image p. 222
3 Zoom Tools p. 214 6 To Figure handle p. 227

312




Design Center

M Figure Handle tab

® O ®
L] :,_.:-_3 L o ;H:mP'FH-I.:;u'-;nLunu - ol
= AT - mﬁ'-. B e 1-
g o T " A % L
ke . T i I R s
Spph gk ewed | Docms  Pam - smpemr] || D1 Pey | Tolinr Te Im
(51 § NE kb el g ragh el
A 08k
O ® ® ® 60 oO® ® @)

No. | Menu | Reference No. | Menu | Reference
1 | Select Tools p. 214 10 | Delete p. 216
2 Edit Point Tool p. 215 11 | Split at Point p. 216
3 Line Tool p. 215 12 | Flip vertically p. 228
4 | Zoom Tools — 13 | Flip horizontally p. 228
5 Pan Tool — 14 | Numerical Setting p. 228
6 Cut — 15 | Import Figure p. 227
7 Copy — 16 | Design Page Settings p. 227
8 Paste — 17 | To Line image p. 224
9 Duplicate — 18 | To Sew setting p. 217

M View tab
® ®

b R | Al e PER - Diaaign Contton - ol
- Fins HaaT yirm rﬁn--l B Groe -

B v W [y i b |l M

o [ N

[Tl T T

| SRR —— |

@) ® ® ®

No. | Menu | Reference No. | Menu | Reference
1 Reference Window p. 228 4 | Show Grid p. 230
2 Modify Template p. 230 5 | Show Grid with Axes p. 230
3 Background Image Density p. 230 6 Grid Interval p. 230
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Design Center

M Sew Setting tab

. :I_.:-_EE. ﬁl.l:par'upﬂur-l.:;ui;n:uﬂ - 5'_
B R N Y —
—T1 = I o =i A
e |; '-I- e M- HEZIEN nanad h | = @ o L E;
Bogiery Cim Hply Tms  Toem B Tmaiery ccTepsirs Topeie Dyl Te "guoy Tredn Lamai
bt © il || W Eniag
[ | o] ]
O @ ® ®@ ® 6® O ® ® ® ®
No. | Menu | Reference \[o R | Menu | Reference
1 Region Tool p. 231 8 Sew Type p. 232
2 Line Tools p. 232 9 Sewing Order p. 236
3 Hole Sew Tool p. 235 10 | Preview —
4 | Stamp Tools p. 236 11 | Realistic Preview —
5 | Zoom Tools — 12 | Stitch Simulator p. 237
6 Pan Tool — 13 | To Figure handle p. 226
7 Color p. 232 14 | To Layout & Editing p. 220
M View tab
L3 ,:__:EE. ;i.l:wr'uP'FH-l.:v.u'-;nLuﬂ - ol
= T [ L [ o - -
ot Dl et
namg by
@) ®

Reference . Reference

1 Reference Window p. 228 2 Sewing Attributes p. 233
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Design Database

Design Database

List of menus

HMFile menu
Menu Toolbar Reference Menu | Toolbar | Reference
Open in Layout & Editing — p. 245 Print Setup — p. 255
Impt_)rt IS I — p. 245 Print Preview — —
Editing
Create New Folder — p. 243 Print — p. 255
Convert Format — p. 252 Create HTML — p. 256
Delete — p. 244 Create CSV — p. 256
Search — p. 251 Exit — —
M Edit menu
Toolbar Reference Menu | Toolbar | Reference
Cut % Paste ﬁrﬁ p. 243
p. 243
Copy DD Select All — —
M Display menu
Menu Toolbar Reference Menu | Toolbar | Reference
Large Thumbnails El Property I}"i—l p. 253
Small Thumbnails El p. 244 Refresh — —
Details El Toolbar — p. 241
Preview ET@ p. 253 Status Bar — —
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Design Database

M Option menu

Menu | Toolbar | Reference | Toolbar | Reference

Select mm Blue
Svst Unit [ — p. 20
ystem Unit | inch Application | Black . b. 302

Link — p. 250 Color Silver ’

DST Settings — p. 301 Aqua

M Help menu

Menu | Toolbar | Reference Menu | Toolbar | Reference

Instruction Manual — p. 4 About Design Database — —
Customer Support — p.5
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Programmable Stitch Creator

Programmable Stitch Creator

Application button menu

Ao i . EREE - s
* No. | Menu | Reference
@ e : . 1 | New Fill/Stamp Pattern —
® o 2 | New Motif Pattern p. 266
@ — 3 | Open p. 260
®—H 4 | save p. 272
®—H 5 | Save As p. 272
Ribbon menu tabs
B Home tab
@
:;j; RAsT=R = " Lt e - P | e L ‘illlmtﬂnh = O _
e —— i-
I ._l; i_||| -{.,;II _I!- rq,‘ F .' |-:.-. e .,.1.. -u il
ek | Criart | Da Oegrr Fosime -c: L oy !
iy L e, = e B
| | | n . i
O ®©® ® ® 6 ®
No. | Menu | Reference No. | Menu | Reference
1 Select Tool p. 264 8 Copy —
2 Edit Point Tool p. 264 9 Paste —
3 Draw Line Tool p. 261 10 | Duplicate —
4 Region (Reset) Tool p. 262 11 | Delete p. 269
5 Region (Engrave) Tool p. 262 12 | Flip vertically p. 264
6 Region (Emboss) Tool p. 262 13 | Flip horizontally p. 264
7 Cut —
B View tab
:;; e R HE . Ldirhe - Py i atrima e Silien Chaance - oIl
e S 4 - vy i-
8 e g sl AR ol L e
=~ .'|: | T v
® © o ®
No. | Menu | Reference No. | Menu | Reference
1 Open Template p. 271 4 Show/Hide Status Bar p. 270
2 Background Image Density p. 271 5 Show Grid p. 273
3 Show/Hide Preview window p. 272
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Font Creator

Application button menu

Font Creator

[TE Elua = Uittt -1
# No. | Menu | Reference
@ — r Pl Wit il ikl | 1 NeW p 284
@ —ts 2 Open p. 284
3 Save . 291
o—H-=- P
3 4 Save As p. 291
@ _H e
ke [
Ribbon menu tabs
B Home tab
® © @) ®®
Hf!..u':':Efn'- 1 - F{on Crastce - - |
- L E— = i-
e W u ] b ok csl S nsans | A ¥ o = r
_h :-l * t : i ; e 3 oo (R 8 b ve Tt , E: | E g
RrigH E:I-:.-I I.I:-.--‘ Sre an |rﬁ Rl | TP Lrm .r-I .:-I:|_---:|-.|'
e o el =2
® ® ® @ @

No. | Menu | Reference \[o R | Menu | Reference
1 | Select Object Tool p. 287 11 | Previous Character p. 285
2 Edit Point Tool p. 288 12 | Select Character p. 285
3 Manual Punch Tool p. 277 13 | Next Character p. 285
4 | Zoom Tool — 14 | Browse Characters p. 290
5 Pan Tool — 15 | Add/Remove Character p. 285
6 Cut — 16 | Sewing Order p. 289
7 Copy — 17 | Convert TrueType Font to Data p. 287
8 Paste — 18 | Point Edit p. 288
9 Duplicate — 19 | Flip p. 287
10 | Delete p. 288 20 | Align —
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Font Creator

M View tab
® @
_ A,:, HaBE" = - Lok - Pt ot - ol
|| S i -
AT, vty v g i Py WLl | W 6B ||.r|||'I s
i ﬁ. th R — A "r LE L LR T
] Fil
Pae NeAk Tk wred
" | tiraly | | [
©) ® @

No. | Menu | Reference No. | Menu | Reference
1 Open Template p. 275 6 Show/Hide Status Bar p. 282
2 Modify Template p. 292 7 | Show Grid p. 293
3 Background Image Density p. 292 8 Show Grid with Axes p. 293
4 | Fill Mode p. 292 9 | Snap to Grid p. 293
5 Preview Window p. 289 10 | Grid Spacing p. 293
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Sewing Attributes

Sewing Attributes

The sewing attributes for each sew type are first set to their default settings; however, by changing the settings
of the sewing attributes, you can create custom stitching.

»» For more details, refer to "Line sewing attributes" on page 325 and "Region sewing attributes" on
page 331.

Line sew types

Zigzag Stitch (»» p. 325) Running Stitch/Triple Stitch (> p. 325)
" i l.d--_ N - !
it R )
d_.--"--.\-\""--.\_\_ - P = s e
- e Sy : e e

-——_____._‘_,.-'"'.--““— | i -|
—— L

Motif Stitch (»» p. 326) Stem Stitch (»» p. 327)

W“-&'

g o

'ﬂhmﬁtmﬁﬁ-nmwmoum% 1 f e
L L N L L 'l.'-J‘z:i ‘h M
7

SEGSEEEEEE 4

A - - -I'm

%ﬂ*"s

Candlewicking Stitch (»» p. 327) E/V Stitch (»» p. 328)

-""*. -’
-l' 1) -,ﬂ

.-'"".“.n'

Chain Stitch (»» p. 329) Cutting (»» p. 329)
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Sewing Attributes

Region sew types

Satin Stitch ("> p. 331) Fill Stitch (» p. 333)

AO X%g

Programmable Fill Stitch (Prog. Fill Stitch)  Piping Stitch (»» p. 336)
(»» p.333)

Motif Stitch (»» p. 337)

Zigzag Net Fill Stitch (»» p. 339)
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Sewing Attributes

Motif Stitch Pattern Pattern Pattern
Pattern Pattern Motif039 \‘li;'i\‘;t’f;v MOtif059 'ﬂ:'ﬂ
motifoo1 | i || motifozo motifodo | RN || MOtif080 | g g
motif002 motifo21 | A1 AL motif041 motifoél | = iga
Motif003 motifo22 leaYes) motif042 motif062
motif004 motifo23 | MOMOA3 | we—x || momoed | L Lk
. . o motif044 NN motif064 | 7 /0
motif005 motif024 IRER RO NANY
motif006 iy AL motifo2s | —1-7-77 motif045 _*__;_ motifo65 ;
moti007 | <. motitozs | AL AL motifo4s | S S0 motioes | ")
motif008 motito27 | [T 1T Motif047 | <—g=<= | || motif067
motifo09 | /7 /) motif028 | -7 motif048 | -oio-i- || motifoss | fifin S
K OR T t (AT
motif010 motito29 | < < motifoas | L L7 || motfoss | gt ied
motifo11 motifo30 | L/ /L motif050 motif070 | ftS T
\
. . X % motioss | AV || mottors | MElE= | F
motifo12 motifodl | N AVAAYAY =11 S
A A M _ c
R @
) . NIVIVAY: : | | | : TR L] —
motifo13 motifoz2 | X)X X motif052 | Ll || motif072 | i e 9
/ N\, \, AN -t
A =)
. AN . TN motif053 | (X I T || motifo73 | < < )
motif014 JAYAY motif033 :*l':'T+:l+:T' ,IVIVI“Ij PO el 3
motifo1ls motifo34 /A\V/A\VIA\Y,A\’ motif054 LIL:_‘_:' SLE:__:' | motif074 F_Eh
(17171 o
motif016 motifo35 e motif055 :i,::: ::5:1 motif075 b
Y- ¥ Y- / v
motifo17 motifo36 \ /*\ /*\ /,\ /, motif056 motif076
motif018 motif037 | 4 4 motifo57 motif077
Motifo19 motif038 motif058 \/—,; ‘(\-\,* :I,;\:, motif078
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Sewing Attributes

Motif
INET =]

Pattern

Motif
Name

Prog. Fill Stitch Pattern

Fill
Pattern

INETlE]

netl

Pattern

motif079 motif085
motif080 motif086
motif081 motif087
motif082 motif088
motif083 motif089
motif084

Fill
Pattern
Name

pat9

net2

patl0

net3

patll

net4

patl2

patl

patl3

pat2

patl4

pat3

patl5

pat4

patl6

pat5

patl17

pat6

stampl

pat7

stampl_

pat8

stamp2

323

Fill
Pattern

Name

stamp2_

Pattern

Fill
Pattern

Name

stampJ

stamp3

stampK

stamp3_

stampL

stamp4

stampM

stamp4_

stampN

stamp5

stampO

stamp5_

stampP

stamp6

stampQ

stamp6_

stampR

stamp?7

stampS

stamp7_

stampT

stampA

stampU

stampB

stampV

stampC

stampW

stampD

stampX

stampE

stampY

stampF

stampZ

stampG

tatamil

stampH

tatami2

stampl

tatami3




Fill
Pattern
Name

Pattern

Fill
Pattern
Name

Pattern

tatami4 wave2
tatami5 wave3 | |l
(! IRRIN]
wavel waves '-.:'|I'|,'|,'|"|,:'-,:'-,:-
UEARAARRNN

Sewing Attributes
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Sewing Attributes

B Line sewing attributes
The available attributes differ depending on the selected sew type.

»» "Specifying sewing attributes" on page 54

Zigzag Stitch

Off On
Under sewing TR e e g
N
Narrow Wide
Zigzag width A N\N\N\N\N\/
Coarse Fine
Density
NN AN
Off On
Half Stitch

The inside stitching is dense. The stitching is adjusted to a
more even density.

Sharp Corners % é

This sewing attribute is available only when a text pattern is selected.
»» "Selecting connection point positions in a text pattern" on page 116

Connection
Points

Running Stitch

Short Long
Run pitch Specify the length of one stitch.

1time 5 times
Run time(s) Specify the number of times the outline is sewn.

%1 %5
Connection This sewing attribute is available only when a text pattern is selected.
Points »» "Selecting connection point positions in a text pattern” on page 116
Triple Stitch

Short Long
Run pitch Specify the length of one stitch.
Connection This sewing attribute is available only when a text pattern is selected.
Points »» "Selecting connection point positions in a text pattern” on page 116
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Sewing Attributes

Motif Stitch
Select a pattern for the motif stitch.
E-q' Click @ to display the [Browse] dialog box. Select a folder, and then select the desired pattern
(.pmf file) from the list of patterns that appears.
Specify the pattern size. The pattern can be Smaller Larger
120= enlarged or reduced while maintaining the width-to-
oy m . )
height proportion. LRI LI LILE
1 Short Tall
1 Height . .
_I (vertical length) Specify the pattern height. W
50 =i R
— 2
o E. 2 Width Short Long
= (horizontal Specify the pattern width.
length) PRRRQRRRRE SR EGFEF
:\;z;lcr)\taln aspect When selected, the height-to-width proportions of the pattern are maintained.
PERE | Nomal  prenes
Specify the arrangement of the patterns along a
I(thc/;irzrgsgf horizontal axs. Mirror
All patterns or each pattern can be flipped along the B Tttt
arrangement) horizontal axis.
PRl Atemate gt it
BBt | Nomal gz
V-Arrange Specify the arrangement of the patterns along a
(verticalg vertical axis. =EFFE] | Mirror
All patterns or each pattern can be flipped along the R s R
arrangement) vertical axis.
B=i==]| Alternate LT LT TR
Offset 0.0 mm Offset: 4.5mm
[ Ererareres I G
He >
Spacing Narrow Wide
B :
o [ zeaaeze: [ —&]—
Short Long
Run pitch Specify the length of one stitch.
Feed Run
Start/End Type | 77T A A

»» "If the entry/exit points of sewing have been changed" on page 330

Connection
Points

This sewing attribute is available only when a text pattern is selected.
»» "Selecting connection point positions in a text pattern” on page 116
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Sewing Attrib

utes

Stem Stitch

Narrow Wide
Width

Narrow Wide
Spacing

45° 135°
Angle

Triple Single
Stiteh Type MM

Feed Run
Start/End Type | 77T A

»» "If the entry/exit points of sewing have been changed" on page 330

Connection
Points

This sewing attribute is available only when a text pattern is selected.
»» "Selecting connection point positions in a text pattern" on page 116

Start/End Type

»» "If the entry/exit points of sewing have been changed" on page 330

Candlewicking Stitch
Dense Medium Light
pensity e e
Smaller Larger
Size
et e e i ey
Narrow Wide
Spacing
Feed Run

Connection
Points

This sewing attribute is available only when a text pattern is selected.
»» "Selecting connection point positions in a text pattern” on page 116
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E/V Stitch

Sewing Attributes

Select the E Stitch or the V Stitch.

Stroke time(s)

Narrow Wide
1 Interval
00 0 0 0 0 0 0 0 0 0 5 5 5 A SO O OO (OO
Short Long
2 Stroke width
v LLLLLLEL
Narrow Wide
3 Run pitch
SR OUUOR U0, U, SO OO, U SO AU (R SO0 AV A O G A
1time 5 times
. Specify the number of times the line
Run time(s) is Sewn. (U000 0 ., 0, 0, . O O, O, O, 00, 0, 0. 00 00
w1 Bl
1time 3 times

Specify the number of times each
stroke is sewn.

e e Il

Arrange

OO0

Connection Points

This sewing attribute is available only when a text pattern is selected.
»» "Selecting connection point positions in a text pattern” on page 116

V Stitch

1

2
50 5 mm ‘
£ £ 12-5 =1 mm

1 Interval

Narrow Wide

VAAAARAARNAINAT moneoomssssolbssssssslirssssond

Short Long
—H— 2 Stroke width
20 B N
[T LN SEPD L NP L NP L NI NP N )
3 Narrow Wide
3 Run pitch
MG AL AA AN SAANS
With the V stitch, the line and the 1time 5 times
Run time(s) strokes are sewn the same number N A A A A A A A
of times. 1 %5
Arrange

Connection Points

This sewing attribute is available only when a text pattern is selected.
»» "Selecting connection point positions in a text pattern” on page 116
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Sewing Attributes

Chain Stitch
Triangular Diamond-shaped
Stitch Type ~FFFE] TOTGOT
Smaller Larger
Size === ===
1time 6 time
Time =] =]
%1 “E
Arrange = ~FFEE] = e
Feed Run
""""" A A

Start/End Type

»» "If the entry/exit points of sewing have been changed" on page 330

This sewing attribute is available only when a text pattern is selected.

Connection X . . . L . N
Points »» "Selecting connection point positions in a text pattern" on page 116
Cutting
Specify whether or not sections of the cutting
line are to be left uncut. Off On
Leave uncut This prevents the fabric from moving out of
sections place during cutting.
If it is set to [On], cut them with scissors after
the cutting step is finished.
For more cleanly cut edges, for example, on Cutting only Cutting for covering
Use patches, select [Cutting only]. If the cut edge edge of fabric

will be embroidered, for example, on appliqués,
select [Cutting for covering edge of fabric].

g:mmﬁ
O —
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Sewing Attributes

M If the entry/exit points of sewing have been changed

If the entry/exit points of line sewing with the motif stitch, stem stitch, candlewicking stitch or chain stitch have
been changed or optimized, select a setting for [Start/End Type] in the line sewing attributes.

»» "Start/End Type" on page 326 and "Moving entry/exit points, the center point and stitch pattern
reference point" on page 50

If [Feed] was selected under [Start/End Type], jump stitches are entered at the beginning or end of pattern
stitching (with a motif stitch, stem stitch, candlewicking stitch or chain stitch). If [Run] was selected under
[Start/End Type], running stitches following the path are entered at the beginning of and between pattern
stitching.

Before the entry/exit points are changed

E@%Bg %g Eg %g B@ B@%@ Path of actual stitching

%%Mzaﬁg/%ig

Entry point/Exit point

When the entry point is moved
Feed

PEPER PR DR
%2% Bgzégé/ Entry point

/_% Jump stitch

E%?m@g@péw =

Exit point

Run

S IRHEIEDE N
g-%% Bg;%‘é/mtry point

; . L2 :—Bg_ Running stitch
%&%9@2@@%%%@6

<
1]
>
c
[
g
_|
o
o
7]
QO
>
o
Py
0]
—
®
=
[}
=
o
®

Exit point

a

« After changing the Start/End Type, check the stitching with the stitch simulator.

»» "Checking the stitching with the Stitch Simulator" on page 80

» Embroidery patterns where the Start/End Type of line sewing with the motif stitch, have been changed or
optimized in an application earlier than version 8 are opened or imported with this stitching specified as
jump stitches.
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Sewing Attributes

M Region sewing attributes
The available attributes differ depending on the selected sew type.

»»  "Specifying sewing attributes" on page 54

Satin Stitch

To specify underlay stitching, select the check box, and then specify settings for the following attributes.

Specify the type of underlay stitching to be sewn.

» For text patterns or for shape patterns with « For shape patterns with a single sewing direction
multiple sewing direction lines line

(] Edge only ] Single

Region only (single layer of zigzag
Under Double

shaped stitches)
sewing

Region only (single layer of pipin
g y (single lay piping

stitches) « For regions in Design Center

Edge and region (single layer of @
zigzag shaped stitches)

Region only (double layer of zigzag @ Double
shaped and piping stitches)

i Single

[Density]
Select [Dense], [Medium] or [Light] as the density for the underlay stitching.

Coarse Fine

[Gradation]

Density This cannot be specified under the following
conditions.

» The sewing direction is set to [Variable]

» Text pattern

* When a feathered edge is specified

Click [Pattern] to set the gradation pattern.

»» "Creating a gradation/blending" on page 47

Off On

This cannot be specified for text pattern. [Manual]
[Manual]: Sews at a fixed angle.

Drag @ or select a value to specify the angle. If
there are multiple sewing direction lines, a value

. . cannot be specified for the angle.
Direction P 9

[Auto]: Automatically varies the sewing direction
according to the shape of the region.

To specify half stitching, select the check box.

This cannot be specified if the sewing direction is -

set to [Manual] and there is only one sewing L ,

direction line. The inside stitching is The stitching is

dense. adjusted to a more
even density.

Half Stitch
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Sewing Attributes

The inside of region setting is not available if the
[Gradation] check box is selected.
This cannot be specified under the following

N\

Inside of region

Running | concitons. S
« The sewing direction is set to [Auto]. Along outline
e Text patterns
* When a feathered edge is specified
On outline
No compensation .
Longest compensation
Pull com- Lengthen the sewing region in the sewing direction
pensation to adjust for pattern shrinkage during sewing.
Connection This sewing attribute is available only when a text pattern is selected.
Points »» "Selecting connection point positions in a text pattern” on page 116
4 Specify the edge
of the stitching
O where the
] feathered edge is
4 to be applied.
x Top edge only
| Top side of pattern
For <pattern11> WWWWWWWWWWWV\
']
g
4 Bottom edge only
Bottom side of pattern MWMAMMMMMIW\M
Tu
Feathered Click || to display the [Browse] dialog box. For <pattern18>
edge Select the desired pattern from the list of patterns '”

that appears.

This sewing attribute is available only when a
shape pattern is selected. In addition, this attri-
bute cannot be selected under the following con-
ditions.

* When a gradation is specified

* When the sewing direction is set to [Auto]

* When hole sewing is specified

“I I” ”|I Top and bottom edges

s

Specify the width of the

2.0 = feathered edge

Short Long

Il

Feathered edge settings not specified

Feathered edge settings specified
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Sewing Attributes

Fill Stitch
Under
sewing ) )
Density »» "Satin Stitch" on page 331
Direction
= =
Specify the shape of the returning ends of the stitching. 1
Stitch Type This cannot be specified if the sewing direction is setto | [ 1
[Auto]. I ;
I
1
Half Stitch
Running »» "Half Stitch" on page 331 and "Running Stitch Path" on page 332
Stitch Path
Short Long

Step pitch Specify the length of one stitch.

0% 50%
Frequency
Pull com- N .
. »» "Pull compensation" on page 332
pensation
Connection This sewing attribute is available only when a text pattern is selected.
Points »» "Selecting connection point positions in a text pattern” on page 116
Feathered
»> “Feather " on 2
Edge eathered edge" on page 33

Programmable Fill Stitch (Prog. Fill Stitch)

Under sewing

Density

Direction

Half Stitch

Running Stitch Path
Pull compensation

»» "Region sewing attributes" on page 331 and 332

This sewing attribute is available only when a text pattern is selected.
Connection Points »» "Selecting connection point positions in a text pattern” on page 116

Feathered Edge »» "Feathered edge" on page 332

M

P> "Satin Stitch" in the "Region sewing attributes" on page 331

333




Sewing Attributes

Programmable fill

Click E-q to display the [Browse] dialog box. Select a folder, and then select the desired

=
pattern (.pas file) from the list of patterns that appears.
. . Smaller Larger
Specify the pattern size. The pattern can
10.0 _I;I o be enlarged or reduced while maintaining 8%88%%% ééééé
the width-to-height proportion. VYV VeV AR
1 Heiaht Short Tall
eig . VOVOV VY
—1 i Specify the pattern TOCOCOTOCT
- gty | el oo JNOOK
= 75 [ | '8N0 N I Y a1
———2 > Width Short Long
75 (hor:zontal Specify the pattern NNV IONNS N
longth) width. VNV V.V VNN
AN 2CCTCTC

Maintain aspect ratio

When selected, the height-to-width proportions of the pattern are maintained.

1350 2 450
Direction 180° 0°
225° 315°
270°
row 0%
vvivivivivi
ViV, <
QO <
Offset | umn Row 50% Column 50%

IO NINAVIION
L) v & v
IO ¢ MY, &

Base Sewing

To specify base stitching, select the check box, and then specify settings for the following

attributes.
Specify the shape of the returning ends |§| |§|
. of the stitching.
Stitch Type This cannot be specified if the sewing
direction is set to [Auto].
Short Long
Step pitch Specify the length of one stitch.
0% 50%
Frequency
Pattern

@ﬂ

Area where the embossing or
engraving effects are applied

This area is sewn with the stitching settings
/ specified for the base sewing of the
programmable fill stitch.

Alolo

OO0
OO0

| This area is sewn with the stitching settings
specified by the pattern file.
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Sewing Attributes

Notes on programmable fill stitches and stamps

In some case of the sew type and pattern directions setting of a programmable fill stitch or a stamp, lines will
not be sewn.

Use the Realistic View to view exactly how the stitch pattern will be sewn. To get an even better view, make
test samples of different settings.

Examples of programmable fill stitching:

=

Example 1 Example 2 Example 3

Stitch direction: 45° (default) Stitch direction: 90° Stitch direction: 0°

Taylaylagisg oy oo AL
_[ _J .-—-\_I = R By 1 P Farm - t I i I, 1 J E

L S s ' e _I. - L s [T R ‘i - - - 1

S e L,

iy, I o - L - - - | i s

.I-..I._ .E .-;‘.;___:.- el gt s ety 'E 8 -F -I i 1
B — =g —r= | . —— —— '} "

L I.:-: I.L..! I.'. | s e s s B STy 11 L i

ey g § ey, | ; " Fdy 4 ]
Ty Ty S, Gy [ " - |

Sy beyinying e e ™ NNy

»» "Changing the display of the embroidery design" on page 78, and "Programmable Stitch Creator"
on page 258
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Piping Stitch
Stitching is created to run through the length of blocks.

Sewing Attributes

135° % 45°
Direction This cannot be specified for patterns 180° .
with multiple sewing direction lines. 80 0
225° 315°
270°
Specify settings for the following if the motif stitch pattern is not used.
Coarse
Density @
Short Long
Run pitch Specify the length of one stitch.
0% 50%
Frequency Specify the shift in the stitches.

Use Motif the following attributes.

To use a motif stitch in the pattern, select the check box, and then specify settings for

Motif |F'attern1 anily vI

»»  "Motif Stitch" in the "Region sewing attributes" on page 337

Pattern1/Pattern2
Pattern and size of the

H-Arrange

V-Arrange

motif stitch patterns | pp  "Motif Stitch" in the "Line sewing attributes" on page 326

H-Offset
V-Offset
H-Spacing

V-Spacing

Row offset

Run pitch

»»> "Motif Stitch" in the "Region sewing attributes" on page 337
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Sewing Attributes

Motif Stitch
Motif [Patternl only] [Pattern2 only]
Select the pattern to be used for the motif stitch. Skl dvekstedyekts o s o s e
|F'attern'| only v KISICTSIEToTe
o7 2 Gy P B R B B = B = 8
&3 Pz o B B2 B B e B )
atternl an
P land 2
[y ey e yeiyaiyed
R B D R
ey s ey
AR APd T T T
Patternl/Pattern2 Specify settings for each pattern.
Pattern and size of
the motif stitch
patterns Maintain
aspect ratio »»> "Motif Stitch" in the "Line sewing attributes" on page 326
H-Arrange
V-Arrange
HLOff 0.0 mm 2.5mm
-Offset
(horizontal spacing) Mﬁi ﬁm
* LG ARG
0.0 mm 2.5mm
ot (et
(vertical spacing) s e
Mﬁd L pOE R e
Narrow Wide
(hoonar (-]
(horizontal spacing) EE W - _“ﬁ
B GARAEAER A
M SRR L3
Narrow Wide
erteal o Yo EEE Ny
(vertical spacing) 'ﬁ‘
bbb A L
et [ 8
[k i ns o ko s P e s g
135° % 45°
Direction 180° 0°
225° 315°
270°
Smaller Larger
Row offset EEezze e P
A LA LT (N N W
Run pitch »»  "Motif Stitch" in the "Line sewing attributes" on page 326
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Sewing Attributes

Cross Stitch

Smaller Larger

Size

Single Triple

we >< %6

Times

Concentric Circle Stitch, Radial Stitch and Spiral Stitch

For details on moving the center point of the concentric circle stitch and the radial stitch, refer to "Moving the
center point and stitch pattern reference point" on page 51.

Concentric Circle Stitch Coarse Concentric Circle Stitch Fine

Concentic circle Densiy >

Radial Stitch Coarse

. Padial Dengty
Density : ; \é :;

Spiral Stitch Coarse Spiral Stitch Fine
. . . Short Lon
Run pitch Specify the length of one stitch. 9
Stippling Stitch
. . Short Lon
Specify the length of one stitch. 9
Run pitch This cannot be specified if the motif stitch is
used. The turns are The turns are more =z
smoother. angled. <'3D
Narrow Wide %
: & ¢ =
Spacing B % o
e SISISe S
3 - - ”
The pattern is finer. The pattern is coarser. ©
. To use a motif stitch in the pattern, select the check box, and then specify settings for the 3
Use Motif ) -
following attributes. Py}
1)
Pattern and size of the o
motif stitch patterns o
H-Arrange g
@
V-Arrange »> "Motif Stitch" in the "Line sewing attributes" on page 326
Offset
Spacing
Run pitch
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Sewing Attributes

Net Fill Stitch
Specify the pattern to be used for the net fill
Pattern stitch.
Fine Coarse
Spacing
The pattern is finer. The pattern is coarser.
Direction »»  "Motif Stitch" in the "Region sewing attributes" on page 337

Zigzag Net Fill Stitch

Pattern

=N

Specify the pattern to be used for the

zigzag net fill stitch.

266

VaVYAY

Under sewing

To specify underlay stitching, select the off on

check box. AAAVANANN  AARARIAMAY

»»  "Zigzag Stitch" in the "Line sewing attributes" on page 325

Zigzag width
Density »» "Zigzag Stitch" in the "Line sewing attributes" on page 325

Fine Coarse

Sp wv% Spacing

Spacing

The pattern is finer. The pattern is coarser.
H-Offset »»  "Motif Stitch" in the "Region sewing attributes" on page 337
V-Offset »»  "Motif Stitch" in the "Region sewing attributes" on page 337
Direction »»  "Motif Stitch" in the "Region sewing attributes" on page 337
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Font List

Font List

Text

No. Font Name Text Outlines
_ 10 mm
001|  Serif 01 ABCDE abcde | (0.39")
002|  Script0l | /BPPL shrde %g g;n;
' 10 mm
003 | GothicOl | AZRGIAFE abhcde (0.39")
. 10 mm
004 |  Serif 02 ABCDE  abede (0.39")
005|  Script 02 ABCDE abede (18?:2)?;
. 8 mm
006 Serif 03 ABCDE abede | (0.317)
007 | Block 01 ABCDE abcde (%.rgg:)
10 mm
008| Block02 | ABCDE abcde | (0.39"
' 10 mm
009 | Gothic 02 ABCBT abcde | (0307
10 mm
010| Block 03 ABCOE abede | (0.397)
011 | Decorative 01 | AACOE abcde %g g;n;
10 mm
012| Block 04 ABCDE abcde | (0399
9 mm
013| Block 05 ABCDE dbcde (0.35
014 Script 03 ARBCHDE abece %(?g;n;
015 | Decorative 02 ASBYE absida ?(());ngn;
016 | Decorative 03 ABCDE abede 2_(;) 3[2)";
_ 10 mm
017 |  Script 04 ABCDE abede | (0.39")
018 | Gothic 03 A BGDBG %8_ g;"}
019 | Script 05 HBEDE %gg;n;
9 mm
020 |  Block 06 ABCDE abcde (0.35")

Font Name Text Outlines

021| Gothic 04 LBEDG %g_ ggr)'
022 | Decorative 04 RABEHE  ahede :(L(()) :;grr)l
023 | Decorative 05 ABC.D.E&. (%?F)
024 Gothic 05 ARLDG %8 g;n;
025 | Decorative 06 ABCDE %8 g;n;
026 Gothic 06 Az@??j %Sg;n;
027 Block 07 ABCDE Z(I.(())?:grr)l
028 Gothic 07 ABIDE %8 Sr)r;rr;
029 Brussels_ Demi N 10 mm

Outline AJBCIDIY albede (0.39")
030 Me%?lm?;lic ABCDE abcde ?335?;
031 Isenbul | ABCDE abede | (050
032 | Los Angeles ABCDE abcde zg ::r;n;
033| Sapan | SBGDE abcde | (0.5,
0%4| sandiego | ABCDE abede | (0301
0ss| 55" | ABCDE abede | (050
0%| Aasa | ABCDE abcde | (0599
057| Bayem Book | ABCDE abcde | (041
0%| Begum | ABCDE abcde | (0599
039|  Benga M sbele | (030
040| Bergen | ABCDE abcde | (0aoh
041 | BerlinRegular | ABCDE abcde :(Lc())grgn)l
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Font List

341

Font Name Text Outlines Font Name Text Outlines
Bermuda 10 mm -, 9 mm
0421 “seript HABOCDE abede | (0.39") 065 Haiti ABCDE abede | (0.35)
10 mm Helsinki 10 mm
043| Blackstone | APCDE abede | (0.39") 066 | NarowBold | ABCDE abecde | (0.397)
10 mm 10 mm
044| BR-OCRA | ABCDE abcde| (039" 067| Hungay | ABCDE abede | (0.39)
(0.397)
Brougham 9 mm 10 mm
045 Bold ABCDE abcde/| (035 068|  Jakarta ABCDE abede | (0397
Brougham 9 mm 10 mm
046 | Condensed | ABCDE abcde | (0351 069 Jawa ABCDE abcde | (039"
ExtraBold
. 10 mm 070 Kentucky ABCDE abcde 28;;?
047 Brunei ABCDE abcde | (0.307 :
Kingston 10 mm
048 | Brussels Light ABCDE abcde 28;;"; 071 Regular ABCDE abede (0.39")
. 10 Letter Gothic 10 mm
049| Cao | ABEGDE abede (0_3?;?; 072 Bold ABCDE abcde | (0.397
Calgary 10 mm : 10 mm
050 Bolditalic ABCDE abede (0.39") 073 | Lillehammer AEBr0E abecde (0.39")
Calgary 10 mm . . 10 mm
051 BoMItalic LS ABCDE abede (0.39") 074 | Liverpool Italic ABCDE ab&da (0.39")
10 mm 10 mm
052| Canbera | 2BGD& abede | (030" 075 Mavtand | A BCDE abcde | 0397
A 9 mm
053| Connecticut | _gp@pe 1 1 23 3”;”; 076 | Miami Roman | - ABCDE abede | (0.35")
054 Cordoba 10 mm 077 Montreal ABCDE abed 10 mrp
ordo ABCRE abde | (0.39) apcde | (039
10 mm 8 mm
055|  Cyprus | AREDE abede | (0.39) 078 | PanamaBold | A\BCDE abede| (0.31")
. . 10 mm
056 Equador ABCPE abede (%r;gﬁ) 079 | Princeton ltalic | o op oy ce o/ (0.39"
os7| _Epsom omm 080 Riesa 1o mm
Expanded |ABCDE abcde| (0.35 ABCDE ahcde (0.39")
10 mm 10 mm
058 Epsom ABCDE abcde (0.39") 081 | Salamanca AB@DE abede (0.39"
059 Firenze Bold a 10 mT 082 Seattle 10 mm
Expanded |ABCDE abede | (039" Bolditalic |ABCOE abcde | (.39
Florida 8 mm ] 9 mm
060 Medium ABCDE abcde (0.31" 083| sofiaBold |ABCDE abcde (0.35"
9 mm o 10 mm
061 | Frankfurt Bold ABCDE abcde (0.35" 084 Helsinki ABCDE abcde (0.39")
Frankfurt 10 mm Tennessee 10 mm
921 ‘Medium | ABCDE abcde | (0.39) 985!  EyxtraBold | ABCDE abede | (0.39")
10 mm 10 mm
063| Germany | ABCDE abede | (0.39) 086| Themes | RBCDE abede | (0.39)
10 mm . 10 mm
004] BRSymbol | ABXAE apxde | (0397 087|  Tanin | ABCDE abede | (0.39)




Font List

Font Name ‘ Text Outlines Font Name Text Outlines
) 10 mm Modula 19 mm
088| il ABCDE abcde | (0.39") 1O utined sl | 0759
10 mm Modula Round 17 mm
oss| usromen | ApcDE abede |oamy | | |11 “rone | DEabede | oo
. 10 mm Modula Sans 10 mm
090|  Venezia | ABCDE abede | (039" 12 Bold ABCDE  abcde (0.39")
10 mm Not Caslon ‘ 30 mm
0911 Vermont | \4 BERDE abcde | (039" 13 Two ABAF FAE | (118
. 10 mm Remedy 4 25 mm
092/ Wellington ABCDE abede | 030 | | || Downe | “ABCBE abedg | (0989
093 Kinstler- 10 mm 115 Sabbath Black 13 mm
schreibschrift | AIBELE abocte (0.39") Regular ABCDCabede | (0517
Toms 10 mm 13 mm
0941 Handwritten ABCDE abede (0.39") 116 | Senator Ultra ABLDE abcde (0.51")
L 10 mm Soda Script 10 mm
095|  Luedickital ABCDE abcde | (0.39") 1 Bold ABCDE obede (0.39")
10 mm Suburban 10 mm
096 | Atranta Book | ABCDE abcde | (0.397) 118 Light ABCDE abcde | (039"
. 10 mm . 10 mm
097 | Atranta Demi ABCDE abcde (0.39") 119 | Totally Gothic AB”DE abcde (0.39")
098 Montana 10 mm 120 Vista Sans Alt 10 mm
ABGDE abede | (039 Regular ABCDE abcde | (0.397)
Base 900 10 mm
099 | Sans Heavy "
Italic ABCDE adee (0:397) Sm al I TeXt
Base 10 mm
100 quospace ABCDE abcde (0.39") Font Name | Text Outlines
Wide Bold
01| Aphabet 1o mm 01| UahBoldS | ABCDE abede | 020
phat ABCDE abede | (050" 0.24")
Darkside
Dalliance 10 mm S6mm
102 Roman ABCDE abede (0.39") 02 Belglum S ABCDE abcde 802240;
Dalliance 10 mm 5-6 mm
103 ) ,, Calgary
script | HABDCDE wbedle | (0.39") 03 | =B | A BCDE abede 80.2249-
104 | DogMa Script 10 mm 24)
Bold ABCDE abcde | (039 3-4mm
. 04 Utah SR ABRCDE abcde (0.12"—
105 Elliotts Apollo 10 mm 0.16")
venus Dioxide | ABCDE abede (0.39") Calgary 3.4 mm
106 Exocet 13 mm 05 | Mediumitalic | zg-NDE ghcde (0'12"'
Medum |ABCDE ABCDE | (051 SR 0.16)
Los Feliz Bold 9 -omm
0s eliz o mm 06 | Script 01 SR 0.16-
107\ " aic | ABCDEabcde | (o35 e ABCIE atece | 0
108 Mason Serif 12 mm 5-6 mm
Bold ABCDE ABCDE | (0.47") 07 | Block 03 S BO0DE abede | (020-
. 0.24")
109 Matrix Inline 17 mm
Extra Bold ABCDE abcde (0.67"
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Font List

No. | Font Name | Text Outlines | Size
4-6 mm
08 | Block 07 SR ARODF (0.16-
0.24")
5-6 mm
09 Germany S ABCDE abede (0.20-
0.24")
5-6 mm
10 Riesa S ABCDFE ahcde (0.20-
0.24")
Monogram
Symbol | Font Name | Text Outlines

M Diamond HBD (YZ
R X
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Troubleshooting

If a problem occurs, click § - or [Help], then [Customer Support] in the menu to visit the following Web site,
where you can find causes and solutions to various problems and answers to frequently asked questions.

Troubleshooting

If you have a problem, check the following solutions. If the solutions suggested do not correct the problem,
contact your authorized dealer or Brother Customer Service.

Problem

The software is not installed
correctly.

Estimated Cause

An operation not described
in the installation procedure
was performed. (For
example, Cancel was
clicked or the "PE-DESIGN
Software Key" was
removed before the
procedure was completed.)

Solution

Follow the instructions as the software
installs to correctly install the software.

The message "No PE-DESIGN
Software Key is connected.
Please connect a PE-DESIGN
Software Key." appeared.

The "PE-DESIGN Software
Key" is not connected.

Check that the "PE-DESIGN Software
Key" appears in the computer's list of
removable storage devices. If it does
not appear, unplug the "PE-DESIGN
Software Key", and then plug it in again.

The information on the
"PE-DESIGN Software
Key" is corrupted.

Leave it plugged in, and uninstall, then
re-install PE-DESIGN 10.

When trying to upgrade from
an older version, the message
"Cannot connect to the
Internet.” or "The server could
not be connected to. Wait a
while, and then try connecting
again." appeared and "PE-
DESIGN Software Key" could
not be upgraded.

The computer with "PE-
DESIGN Software Key"
connected to its USB port
could not establish a
connection to the Internet.

To upgrade "PE-DESIGN Software Key",
the computer with "PE-DESIGN
Software Key" connected to its USB
port must connect to the Internet. If
firewall software is being used, it must
be temporarily disabled during the
upgrade. If a connection to the Internet
cannot be established, contact your
authorized dealer.

Page

See "Reference
Guide".
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Troubleshooting

Problem

The error message
"Unexpected file format"
appears.

or

Your embroidery pattern or
image cannot be opened.

When opening an embroidery
pattern
(Application button > [Open])

Possible Cause

File Format

.pes

Solution

The data may be corrupted.

.phc (machine embroidery
format)

The file cannot be opened,
but it can be imported.

— ([Home] tab > [Import
Patterns] > [from File])
Otherwise, convert the file to
the PES format, and then
open it.

Other manufacturers'
compatible formats

(.dst, .hus, .exp, .pcs, .vip,
.sew, .jef, .csd,

Xxx, and .shv)

The file cannot be opened,
but it can be imported.

— ([Home] tab > [Import
Patterns] > [from File])
Otherwise, convert the file to
the PES format, and then
open it.

Incompatible formats

The file cannot be used.

When importing embroidery
patterns

([Home] tab > [Import
Patterns] > [from File])

.pes, .phc,

Other manufacturers'
compatible formats

(.dst, .hus, .exp, .pcs, .vip,
.sew, .jef, .csd,

Xxx, and .shv)

The data may be corrupted.

Incompatible formats

Convert the file to a
compatible format, such as
PES, and then use it.

When opening a background
image

([Image] tab > [Open])

or When opening an image

for Stitch Wizard

(Auto Punch, Photo Stitch 1
and 2, and Cross Stitch)

.bmp, .tif, .jpg, .wmf, .png,
.eps, and .gif

The data may be corrupted.

Images in formats other than
those listed above

The file cannot be opened.

— Use an image in one of
the formats listed above.

When importing an image as
an embroidery pattern
([Home] tab > [Import
Patterns] > [from Vector
Image])

.wmf, .emf, and .svg

The data may be corrupted.

Vector images in a format
other than .wmf, .emf, or
.svg

Convert the file to the .wmf,
.emf, or .svg format, and
then import it.

Raster images (.bmp, .jpg,
etc.)

Currently, these files cannot
be imported. Open them in
the background and use
them for tracing.
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New Features of PE-DESIGN 10

New Features of PE-DESIGN 10

New PE-DESIGN Security
Device

* The PE-DESIGN Software Key replaces the card
writer as the security device for PE-DESIGN 10.
> p7

Displaying Thumbnails of
Embroidery Files

« Embroidery (PES) files can be displayed as
thumbnails in Windows® Explorer. (?» p. 304)

Improved Functions for
Editing Patterns as
Outlines

« Multiple lines indicating the sewing directions of
an outline pattern can be specified. Sewing
direction lines can be added, moved, deleted and
reversed without changing the shape of the
outline pattern. (»» p. 51)

* Blocks entered with Manual Punch tools can be
edited as outline patterns. (»» p. 197)

- In this way, gradations, entry/exit points, under
sewing and line sewing can be specified for
blocks.

- In addition, blocks can be edited using shape-
editing functions, such as the Remove Overlap/
Merge, Set Hole Sewing and Create Offset
Lines commands as well as the Applique
Wizard.

Enhanced Functions for
Creating Stitching
Variations

¢ The stitching variations available for line sewing
(Line sew type) has been increased. (»» p. 329)
- Chain Stitch
- Cutting

 The stitching variations available for region
sewing (Region sew type) has been increased.
(> p. 339)

- Net Fill Stitch
- Zigzag Net Fill Stitch

The Optimize Sewing Order command has been
added. This command adjusts the sewing order
and entry/exit points to reduce the number of
thread color changes and jump stitches.

(»» p.83)

Convert to Outline commands for stitch patterns
have been added. These commands convert
stitch patterns to shape patterns. (»» p. 76)

The functions for editing points in stitch patterns
have been improved.

- The Split at Point command splits one stitch
pattern into two. (»» p. 73)

- The Connect Points command connects two
stitch patterns to create a single one. (»» p. 73)

The functions for editing points in shape patterns
have been improved.

- The Split at Point command splits one open
shape pattern into two and splits one closed
shape pattern into an open one. (»» p. 68)

- The Connect Points command connects two
shape patterns to create a single one and
connects the two end points of an open pattern
to create a closed one. (»» p. 69)

The Split Outline tool has been added. This tool
splits off the part of the shape pattern enclosed by
the specified points. (»» p. 42)

The Fabric Selector command has been added.
This command allows you to change the current
sewing attribute settings to the recommended
settings for the selected fabric type. (> p. 17)

The Matrix Copy command has been added.
This command creates copies of the selected
pattern at an equal distance apart. (>» p. 37)

The Paste Attributes command has been added.
This command allows the colors, sew types and
sewing attributes from the copied pattern to be
pasted to the selected pattern. (»» p. 55)

EMF and SVG files can also be converted to
embroidery data. (>» p. 93)

The Gradation Pattern Setting dialog box has
been improved. The gradation of patterns can
more easily be adjusted. (>» p. 47)

Patterns can be imported from Design Center into
Layout & Editing as shape patterns. (»» p. 94)
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New Features of PE-DESIGN 10

Additional and Enhanced
Wizards

« The Embroidered Patch Wizard has been
added. This wizard creates satin stitches and
cutting lines around the original selected pattern.
(»» p. 166)

¢ The Cutwork Wizard has been added. With this
wizard, a cutwork pattern can easily be created.
(»» p. 169)

* The Appliqgue Wizard has been enhanced.
(»> p. 161)

- This wizard can be used with combination
patterns that include both stitch patterns and
text patterns.

- This wizard can also create appliqué patterns
around the original selected pattern.

* The Startup Wizard has been enhanced. This
wizard enables access to the desired functions
and files with a single click. (»» p. 10)

¢ Functions in the Photo Stitch 1 have been
improved. (>» p. 142)

Improved User Interface Is
Easier To Use

¢ RichFaces Context menus from right-clicking
have been incorporated into the advanced user
interface. These menus allow users to easily find
the desired commands.

¢ The Guideline function has been added. This
function helps you align the embroidery patterns.
(»» p.19)

¢ The Show Stitched Objects command has been
added. This command allows embroidery
patterns to be displayed or hidden in the Design
Page. (> p. 82)

¢ The Hide Objects Not Stitched command has
been added. This command allows frames
containing patterns that will not be sewn to be
displayed or hidden in the Sewing Order pane.
(»» p.85)

¢ The function for displaying entry/exit points has
been improved. This function also displays the
entry/exit points of next (or previous) patterns in
the sewing order. (»» p. 50)

¢ The color list can be set to display Color changes
or Total colors. (»» p. 88, 97, 255)
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* The Import pane has been enhanced. From this

pane, embroidery patterns can be easily added to
the Design Page. (»» p. 13)

The Measure tool has been improved. (»» p. 78)

Enhanced Lettering
Functions

Font/character variations have been increased
and improved. (»» p. 340)

- The number of regular built-in text fonts has
been increased to 120 types.

- The number of built-in Small Text fonts has
been increased to 10 types.

- The number of symbols and accented
characters has been increased for some regular
built-in fonts.

- The characters for some regular built-in fonts
have been improved. In addition, the character
spacing and the size of characters have been
adjusted.

The user interface for selecting the font has been
improved.

- The names of built-in fonts appear in the Font
selector. (>» p. 107)

- The recommended minimum size of regular
built-in fonts appears in the Font selector.
(»» p. 107)

- The Font Filter command has been added.
This command filters the fonts in the Font
selector to list the selected font types.

(»» p. 108)

Others

Embroidery sample variations have been
increased.

A new embroidery frame setting (240 x 360 mm
frame) is available in the Design Settings dialog
box. (*Availability depends on the embroidery
machine model.) (>» p. 15)
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